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Digitalna kamera z izmenljivim objektivom ILME-FR7/ILME-FR7K

Pregled

Tipični načini uporabe

Konfiguracija sistema [1]

Upravljanje posamezne enote s priloženim infrardečim daljinskim
upravljalnikom [2]

Upravljanje posamezne enote s tabličnim računalnikom ali osebnim
računalnikom [3]

Upravljanje posamezne enote z zunanjim daljinskim upravljalnikom [4]

Upravljanje več enot z zunanjim daljinskim upravljalnikom [5]

Lokacije in funkcije delov

Pogled od spredaj [6]

Pogled od zadaj [7]

Priključni blok [8]

Pogled od strani [9]

Pogled od zgoraj [10]

Pogled od spodaj [11]

Podpora za objektiv [12]

Lokacije in funkcije delov infrardečega daljinskega upravljalnika
(priložen) [13]
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Zaslon spletne aplikacije

Pregled zaslona spletne aplikacije [14]

Struktura skupnega območja zaslonov [15]

Struktura zaslona delovanja v živo [16]

Struktura zaslona za upravljanje predvajanja [17]

Struktura zaslona z nastavitvami [18]

Meni kamere [19]

Prikaz zaslona kamere [20]

Priprava

Namestitev enote

Namestitev v pokončnem položaju na fiksnem mestu [21]

Namestitev v pokončnem položaju na visokem, fiksnem mestu [22]

Namestitev na strop [23]

Namestitev/odstranitev objektiva

Previdnostni ukrepi pri namestitvi/odstranitvi objektiva [24]

Preverjanje stikal objektiva [25]

Previdnostni ukrepi pri uporabi objektiva z zoomom [26]

Namestitev objektiva [27]

Odstranitev objektiva [28]
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Priključitev kablov [29]

Priključitev enote na omrežno napravo prek žične povezave [30]

Priključitev napajanja

Uporaba omrežnega napajanja [31]

Uporaba napajanja PoE++ [32]

Ponastavitev obračanja/nagibanja [33]

Konfiguriranje pred snemanjem

Inicializacija enote s spletno aplikacijo

Dostopanje do spletne aplikacije iz spletnega brskalnika [34]

Inicializacija enote [35]

Konfiguriranje osnovnih funkcij [36]

Priprava pomnilniških kartic

Podprte pomnilniške kartice [37]

Vstavljanje pomnilniških kartic [38]

Odstranjevanje pomnilniške kartice [39]

Formatiranje (inicializiranje) pomnilniških kartic [40]

Preverjanje preostalega časa snemanja [41]

Obnovitev pomnilniških kartic [42]

Snemanje
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Osnovne funkcije

Začetek/zaustavitev snemanja [43]

Preklapljanje med pomnilniškima karticama [44]

Preverjanje zvoka [45]

Določanje podatkov o času [46]

Ogled posnetka (Rec Review) [47]

Prilagajanje okvirjanja

Zaslon prilagajanja okvirjanja [48]

Prilagajanje smeri snemanja

Prilagajanje smeri snemanja s spletno aplikacijo [49]

Nastavitev hitrosti obračanja/nagibanja [50]

Nastavitev pospeševanja obračanja/nagibanja [51]

Prilagajanje smeri snemanja s priloženim infrardečim daljinskim upravljalnikom
[52]

Nastavitev zooma

Nastavitev vrste zooma [53]

Nastavitev zooma s spletno aplikacijo [54]

Nastavitev hitrosti delovanja zooma [55]

Nastavitev zooma s priloženim infrardečim daljinskim upravljalnikom [56]

Shranjevanje/obnovitev položaja kamere za obračanje/nagibanje in zoom

Umerjanje objektiva serije E [57]

Shranjevanje/obnovitev nastavitve obračanja/nagibanja, zooma in ostrenja z



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

uporabo spletne aplikacije [58]

Preimenovanje prednastavitev položaja s spletno aplikacijo [59]

Zamenjava shranjenega položaja z novim položajem prek spletne aplikacije [60]

Brisanje shranjenega položaja s spletno aplikacijo [61]

Spreminjanje hitrosti prehoda prednastavitev položaja [62]

Shranjevanje/obnovitev položaja za obračanje/nagibanje in zoom s priloženim
infrardečim daljinskim upravljalnikom [63]

Prilagajanje ostrenja

Zaslon prilagajanja ostrenja [64]

Ročno prilagajanje ostrenja (Manual Focus)

Ročno prilagajanje s spletno aplikacijo [65]

Ročno prilagajanje s priloženim infrardečim daljinskim upravljalnikom [66]

Ostrenje z določitvijo položaja ostrenja (Spot Focus) [67]

Začasna uporaba samodejnega ostrenja (Push Auto Focus (AF)) [68]

Uporaba enkratnega samodejnega ostrenja (Push Auto Focus (AF-S)) [69]

Samodejno prilagajanje ostrenja (Auto Focus)

Samodejno prilagajanje s spletno aplikacijo [70]

Samodejno prilagajanje s priloženim infrardečim daljinskim upravljalnikom [71]

Nastavitev območja/mesta samodejnega ostrenja (Focus Area) [72]

Hitra sprememba območja ostrenja (Focus Setting) [73]

Premikanje okvirja območja ostrenja z upravljanjem na dotik (Touch Focus Area)
[74]

Prilagajanje delovanja samodejnega ostrenja (AF Transition Speed, AF Subject
Shift Sensitivity) [75]

Ročna nastavitev cilja samodejnega ostrenja (AF Assist) s spletno aplikacijo [76]

Ročno ostrenje med samodejnim ostrenjem s priloženim infrardečim daljinskim
upravljalnikom [77]
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Začasna uporaba ročnega ostrenja med samodejnim ostrenjem (Push Manual
Focus) [78]

Sledenje z zaznavanjem obrazov in oči (Face/Eye Detection AF) [79]

Sledenje določenemu subjektu (Realtime Tracking AF) [80]

Prilagajanje svetlosti

Zaslon prilagajanja svetlosti [81]

Nastavitev osnovne občutljivosti [82]

Nastavitev ciljne ravni za samodejno prilagajanje svetlosti [83]

Prilagajanje zaslonke

Samodejno prilagajanje zaslonke [84]

Ročno prilagajanje zaslonke [85]

Prilagajanje ojačitve

Samodejno prilagajanje ojačitve [86]

Ročno prilagajanje ojačitve [87]

Prilagajanje zaklopa

Samodejno prilagajanje zaklopa [88]

Ročno prilagajanje zaklopa [89]

Prilagajanje količine svetlobe (filter ND)

O filtru ND [90]

Prilagajanje v prednastavljenem načinu [91]

Samodejno prilagajanje v variabilnem načinu [92]

Ročno prilagajanje v variabilnem načinu [93]
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Prilagajanje za naravne barve (White Balance)

Zaslon za nastavitev beline [94]

Samodejno prilagajanje beline [95]

Ročno prilagajanje beline [96]

Nastavitev beline z belim listom [97]

Konfiguriranje zvoka za snemanje

Zaslon za konfiguriranje zvoka [98]

Izbira vhodne zvočne naprave [99]

Samodejno prilagajanje ravni zvoka pri snemanju [100]

Ročno prilagajanje ravni zvoka pri snemanju [101]

Uporabne funkcije

Upravljanje z neposrednim menijem [102]

Dodeljivi gumbi [103]

Počasni in hitri posnetki [104]

Video snemanje s prekinitvami (Interval Rec) [105]

Snemanje slik iz predpomnilnika (Picture Cache Rec) [106]

Sočasno snemanje na pomnilniški kartici A in B (2-slot Simul Rec)
[107]
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Zaslon video signala [108]

Zastavice posnetkov [109]

Izravnava zaradi dihanja [110]

Snemanje proxy

Pregled snemanja proxy [111]

Snemanje posnetka proxy [112]

Snemanje z želenim videzom

Pregled videza [113]

Izbiranje videza [114]

Uvoz želenega osnovnega videza [115]

Prilagajanje videza [116]

Shranjevanje videza [117]

Brisanje osnovnega videza [118]

Snemanje s prilagajanjem videza v postprodukciji

Snemanje s prilagajanjem videza v postprodukciji [119]

Uporaba datoteke LUT za izhod HDMI in pretočno predvajanje [120]

Spreminjanje datoteke LUT [121]

Spreminjanje porazdelitve temnih in svetlih območij v posneti sliki [122]

Snemanje v RAW
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Snemanje videoposnetka RAW [123]

Snemanje videoposnetka RAW v načinu počasnih in hitrih posnetkov [124]

Prilagajanje zameglitve ozadja (funkcija Bokeh Control)

Vklop/izklop funkcije upravljanja zameglitve ozadja [125]

Prilagajanje stopnje zameglitve ozadja [126]

Shranjevanje in nalaganje konfiguracijskih podatkov

Pregled shranjevanja in nalaganja konfiguracijskih podatkov [127]

Shranjevanje datoteke ALL [128]

Nalaganje datoteke ALL [129]

Omrežne funkcije

Prenos datotek

O prenosu datotek [130]

Registriranje cilja za prenos datoteke [131]

Izbira datoteke in nalaganje

Nalaganje datoteke proxy na pomnilniški kartici z zaslona sličic [132]

Nalaganje originalne datoteke na pomnilniški kartici z zaslona sličic [133]

Preverjanje stanja prenosa datotek [134]

Nalaganje z varnim protokolom FTP [135]

Konfiguriranje pretočnega predvajanja
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O pretočnem predvajanju [136]

Nastavitev formata pretočnega predvajanja [137]

Nastavitev video kodeka za pretočno predvajanje [138]

Nastavitev zvočnega kodeka za pretočno predvajanje [139]

Začetek/zaustavitev pretočnega predvajanja [140]

Zaslon sličic

Zaslon sličic [141]

Predvajanje posnetkov in druge funkcije s posnetki

Predvajanje posnetih posnetkov [142]

Upravljanje posnetih posnetkov [143]

Meni kamere in podrobne nastavitve

Konfiguracija menija kamere [144]

Upravljanje menija kamere

Upravljanje menija kamere [145]

Vnos niza znakov [146]

Meni User

User [147]



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Meni Edit User

Edit User [148]

Meni Shooting

ISO/Gain/EI [149]

ND Filter [150]

Shutter [151]

Iris [152]

Auto Exposure [153]

White [154]

White Setting [155]

Offset White [156]

Focus [157]

S&Q Motion [158]

LUT On/Off [159]

Noise Suppression [160]

Flicker Reduce [161]

SteadyShot [162]

Meni Project

Base Setting [163]

Rec Format [164]

Cine EI Setting [165]

Simul Rec [166]

Proxy Rec [167]
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Interval Rec [168]

Picture Cache Rec [169]

SDI/HDMI Rec Control [170]

Assignable Button [171]

Meni Paint/Look

Scene File [172]

Base Look [173]

Reset Paint Settings [174]

Black [175]

Knee [176]

Detail [177]

Matrix [178]

Multi Matrix [179]

Meni Pan-Tilt

P/T Acceleration [180]

Meni TC/Media

Timecode [181]

TC Display [182]

Users Bit [183]

HDMI TC Out [184]

Clip Name Format [185]

Update Media [186]

Format Media [187]
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Media Life [188]

Meni Monitoring

Output Format [189]

Display On/Off [190]

Video Signal Monitor [191]

Marker [192]

Meni Audio

Audio Input [193]

Audio Output [194]

Meni Thumbnail

Display Clip Properties [195]

Set Clip Flag [196]

Lock/Unlock Clip [197]

Delete Clip [198]

Transfer Clip [199]

Transfer Clip (Proxy) [200]

Filter Clips [201]

Customize View [202]

Meni Technical

Color Bars [203]

Genlock [204]

Tally [205]
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Rec Review [206]

Zoom [207]

Lens [208]

APR [209]

Meni Network

Wired LAN [210]

File Transfer [211]

Meni Maintenance

Language [212]

Clock Set [213]

Hours Meter [214]

Nastavitve menija Shooting in privzete vrednosti

Nastavitve ISO/Gain in privzete vrednosti [215]

Nastavitve AGC Limit in privzete vrednosti [216]

Nastavitve kakovosti slike, shranjene za vsak način snemanja [217]

Spletni meni in podrobne nastavitve

Konfiguracija spletnega menija [218]

Upravljanje spletnega menija [219]
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Meni Shooting

Focus [220]

Meni Project

Base Setting [221]

Rec Format [222]

Simul Rec [223]

Proxy Rec [224]

Interval Rec [225]

Picture Cache Rec [226]

All File [227]

Meni Paint/Look

Base Look [228]

Meni Pan-Tilt

P/T Speed [229]

P/T Acceleration [230]

P/T Range Limit [231]

P/T Direction [232]

P/T Preset [233]

Meni Monitoring

Output Format [234]

Output Display [235]
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Meni Audio

Audio Input [236]

Audio Output [237]

Meni Technical

Tally [238]

IR Remote [239]

Meni Network

Camera Name [240]

User [241]

Wired LAN [242]

File Transfer [243]

FTP Server 1 do 3 [244]

SSL [245]

Referer Check [246]

Brute Force Attack Protection [247]

Meni Stream

Stream [248]

Video Stream [249]

Audio Stream [250]

Meni Maintenance

Language [251]

Accessibility [252]
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Clock Set [253]

Reset [254]

Information [255]

System Log [256]

HTTP Access Log [257]

Service [258]

EULA [259]

Software [260]

Povezovanje zunanjih naprav

Povezovanje zunanjih monitorjev in snemalnih naprav [261]

Upravljanje z daljinskim upravljalnikom RM-IP500 (izbirno)

O upravljanju z daljinskim upravljalnikom RM-IP500 (izbirno) [262]

Povezovanje daljinskega upravljalnika RM-IP500 [263]

Sinhronizacija z zunanjo napravo

O sinhronizaciji z zunanjo napravo [264]

Sinhronizacija faze video signalov (Genlock) [265]

Zaklepanje časovne kode na druge naprave [266]

Povezovanje zunanjega mikrofona ali zunanje zvočne naprave [267]

Upravljanje/urejanje posnetkov z računalnikom [268]
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Oddajanje signala prek optičnih vlaken [269]

Priključitev signala za snemanje v živo [270]

Dodatek

Previdnostni ukrepi [271]

Izhodni formati in omejitve [272]

Odpravljanje težav [273]

Sporočila o napakah/opozorilna sporočila [274]

Seznam elementov menija [275]

Prednastavljen položaj shranjenih elementov [276]

Sheme delovanja [277]

Posodabljanje programske opreme objektiva serije E [278]

Namestitev pokrovčka gumba za sprostitev objektiva [279]

Licence [280]
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Specifikacije [281]

Blagovne znamke [282]

[1] Pregled Tipični načini uporabe

Konfiguracija sistema

To enoto lahko kombinirate z zunanjimi napravami in oblikujete različne konfiguracije sistemov.

Objektiv serije E1.

Adapter z nastavkom LA-EA3/LA-EA4 serije A2.

Infrardeči daljinski upravljalnik (priložen)3.

Pomnilniške kartice CFexpress Type A, pomnilniške kartice SDXC4.
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[2] Pregled Tipični načini uporabe

Upravljanje posamezne enote s priloženim infrardečim
daljinskim upravljalnikom

S priloženim infrardečim daljinskim upravljalnikom lahko na daljavo upravljate posamezno
enoto.

 Video signal
 Pot signala

[3] Pregled Tipični načini uporabe

Bralnik kartic CFexpress Type A/bralnik kartic SD5.

ECM-680S, ECM-678*, ECM-674* mikrofon6.
Potreben je EC-0.5X3F5M 3-pinski › 5-pinski kabel za adapter XLR.*

Omrežni napajalnik (priložen)7.

Monitor8.

Daljinski upravljalnik RM-IP5009.

Infrardeči daljinski upravljalnik (priložen)1.

Monitor2.
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Upravljanje posamezne enote s tabličnim
računalnikom ali osebnim računalnikom

Na enoto lahko priključite tablični računalnik ali osebni računalnik in jo nato upravljate s spletnim
brskalnikom.

 Video signal
 Signal daljinskega upravljalnika

 Pot signala

[4] Pregled Tipični načini uporabe

Upravljanje posamezne enote z zunanjim daljinskim
upravljalnikom

Monitor1.

Tablični računalnik2.

Računalnik3.

Dostopovna točka4.
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Enoto lahko upravljate na daljavo z daljinskim upravljalnikom.

 Video signal
 Signal daljinskega upravljalnika

 Pot signala

[5] Pregled Tipični načini uporabe

Upravljanje več enot z zunanjim daljinskim
upravljalnikom

Z enim daljinskim upravljalnikom (RM-IP500) lahko na daljavo upravljate do 100 enot.

Monitor1.

Daljinski upravljalnik RM-IP5002.
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 Video signal
 Signal daljinskega upravljalnika
 Signal za snemanje v živo/kontaktni signal

 Pot signala

[6] Pregled Lokacije in funkcije delov

Pogled od spredaj

Ta tema opisuje lokacije in funkcije delov na sprednji strani enote.

Monitor1.

Video preklopnik2.

Ethernetno zvezdišče3.

Daljinski upravljalnik RM-IP5004.
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Namig

Ta opis se nanaša na ilustracijo enote brez nameščenega objektiva.

Glava kamere

Opomba

Glave kamere ne izpostavljajte močnim udarcem.

1.

Indikator za snemanje na pomnilniško kartico/snemanje v živo
Če je indikator konfiguriran kot indikator za snemanje na pomnilniško kartico, sveti rdeče, ko
snemate na pomnilniško kartico. Indikator utripa, ko je na snemalnem mediju premalo
preostalega prostega prostora ali ko je prišlo do napake.

2.
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Za podrobnosti glejte razdelek "Sporočila o napakah/opozorilna sporočila".

Če je indikator konfiguriran kot indikator za snemanje v živo, sveti rdeče ali zeleno glede na
zunanji signal za snemanje v živo.

Za podrobnosti glejte razdelek "Priključitev signala za snemanje v živo".

Slikovni senzor

Opomba

Izogibajte se neposrednemu stiku z rokami.

3.

Gumb za sprostitev objektiva
Pritisnite za odstranitev objektiva.

Za podrobnosti glejte razdelek "Odstranitev objektiva".

4.

Kontakti za signal objektiva

Opomba

Izogibajte se neposrednemu stiku z rokami.

5.

Indikator POWER6.

Indikator NETWORK
Stanje enote je prikazano s kombinacijo barve prikaza in stanja (sveti, utripa, ne sveti)
indikatorja POWER in indikatorja NETWORK.

7.

Indikator
POWER

Indikator
NETWORK Stanje enote

Sveti
zeleno*1

Sveti
zeleno

Vklopljena (omrežje je povezano)

Ne sveti Vklopljena (omrežje ni povezano)

Utripa
zeleno

Ne sveti Postopek vklopa je v teku

Sveti
oranžno

Ne sveti Stanje pripravljenosti za napajanje
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[7] Pregled Lokacije in funkcije delov

Pogled od zadaj

Ta tema opisuje lokacije in funkcije delov na zadnji strani enote.

Utripa
rumeno

Ne sveti Posodobitev programske opreme je v teku

Počasi
utripa
oranžno*2

Počasi
utripa
zeleno*2

Enota ne more delovati normalno. Za podrobnosti si oglejte
sistemski dnevnik. Če težava ni odpravljena niti po tem, ko
enoto preklopite v stanje pripravljenosti ali izklopite in ponovno
vklopite napajanje, stopite v stik s servisnim predstavnikom
podjetja Sony.

Hitro
utripa
oranžno*3

Hitro utripa
zeleno*3

Na enoti je prišlo do okvare. Stopite v stik s servisnim
predstavnikom podjetja Sony.

Utripa zeleno, ko je prejet ukaz iz priloženega infrardečega daljinskega upravljalnika.*1
Utripa počasi: utripanje enkrat na sekundo*2
Utripa hitro: utripanje štirikrat na sekundo*3

Senzor infrardečega daljinskega upravljalnika
Sprejema krmilni signal iz priloženega infrardečega daljinskega upravljalnika.

8.

Vhodna odprtina za zrak

Opomba

Pretok zraka ne sme biti oviran. V nasprotnem primeru lahko povzročite okvaro.

9.
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[8] Pregled Lokacije in funkcije delov

Priključni blok

Ta tema opisuje lokacije in funkcije delov na priključnem bloku enote.

Ročica za zaklepanje glave kamere
Zaklene premik glave kamere naprej/nazaj.

Opomba

Da se ne uščipnete v prste in poškodujete, morate pred uporabo ročice za zaklepanje izklopiti
napajanje enote in z ročico za zaklepanje obračanja/nagibanja zakleniti glavo kamere v
vodoravnem položaju. Za podrobnosti o ročici za zaklepanje obračanja/nagibanja si oglejte
razdelek "Ročica za zaklepanje obračanja/nagibanja" v poglavju "Pogled od strani".

1.

Drsni podstavek2.
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(ozemljitvena) povezava
Enoto ozemljite tako, da jo priključite na ozemljitveni priključek vtičnice ali na ozemljitveno
sponko.

1.

Priključek DC IN (standardni vtič DC)
Priključite na omrežni napajalnik.

Opomba

Uporabljajte samo priloženi omrežni napajalnik. Priključitev drugega adapterja lahko povzroči
požar ali okvaro.

2.

Omrežni priključek LAN (RJ-45)
Priključite omrežni kabel (kategorije 5e ali višje) za omrežno komunikacijo in napajanje
PoE++*.

Stanje prikaza indikatorja LED za hitrost
Prikazuje hitrost omrežne povezave.

3.

PoE++: napajanje prek Ethernet Plus Plus. Skladno s standardom IEEE802.3bt (tip 4, razred 8). Za
podrobnosti o povezovanju si oglejte navodila za uporabo napajalne naprave.

*

Prikaz Hitrost povezave
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Stanje prikaza indikatorja LED za povezavo/AKTIVNO
Prikazuje stanje omrežne povezave.

Opomba

Ko ta izdelek povežete z internetom, ga povežite prek sistema z zaščitno funkcijo, kot je na
primer usmerjevalnik ali požarni zid. Če ga povežete brez zaščite, lahko pride do težav z
varnostjo.

Ne sveti
10 Mb/s

100 Mb/s

Sveti oranžno 1000 Mb/s

Prikaz Stanje povezave

 Ne sveti Ni povezave

Utripa zeleno Povezava je vzpostavljena, podatki so aktivni.

Sveti zeleno Aktivna povezava

Priključek TC IN
Sprejema zunanji referenčni signal časovne kode.

Za podrobnosti si oglejte razdelek "Zaklepanje časovne kode na druge naprave".

4.

Priključek HDMI
Oddaja video iz enote kot signal HDMI.

Za podrobnosti si oglejte razdelek "Priključek HDMI (priključek tipa A)" v poglavju
"Povezovanje zunanjih monitorjev in snemalnih naprav".

5.

Pritrditveni vijak nosilne plošče za kabel HDMI
Da bi preprečili odstranitev kabla HDMI, s priloženim pritrditvenim vijakom (M2,6 × 6)
pritrdite priloženo nosilno ploščo za kabel HDMI, nato pa kabel HDMI pritrdite s kabelsko
objemko ali trakom, ki sta dostopna na trgu.

Za podrobnosti o pritrditvi nosilne plošče za kabel HDMI si oglejte razdelek
"Priključevanje kablov".

6.

Priključek OPTION7.
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Uporablja se za priključitev signala za snemanje v živo iz zunanje naprave.

Za podrobnosti glejte razdelek "Priključitev signala za snemanje v živo".

Sponka za kabel
Uporablja se za pritrditev kabla omrežnega napajalnika.

8.

Stikalo RESET
Pritisnite to stikalo s konico pisala ali podobne naprave za vsaj 5 sekund, da ponastavite
nastavitve enote na privzete tovarniške vrednosti.
S stikalom SETUP 1 lahko izberete, ali želite ponastaviti samo nastavitve omrežne
povezave ali vse nastavitve.

9.

Izhodni priključek OPTICAL
Oddaja signal SDI, pretvorjen v optični format, ko je priključen modul SFP+ (izbirno).

Za podrobnosti si oglejte razdelek "Oddajanje signala prek optičnih vlaken".

10.

Stikala SETUP

Konfigurirajo naslednje nastavitve.
Stikalo 1: Določa, katere nastavitve se ponastavijo, ko pritisnete stikalo RESET.

Stikalo 2: Določa, ali se vklopi/izklopi napajanje +48 V (fantomsko napajanje), ko je
priključena vhodna zvočna naprava. Nastavitev se uporabi nemudoma.
Ta funkcija je omogočena, če je možnost [Audio] > [Audio Input] > [AUDIO IN Select] v
meniju kamere nastavljena na [MIC].

11.

Nastavitev Opis

OFF
(privzeto)

Ponastavi samo nastavitve omrežne povezave. Ponastavljene bodo
omrežne nastavitve, varnostne nastavitve in informacije o uporabniku
(uporabniško ime in geslo) enote.

ON Ponastavi vse nastavitve na tovarniško privzete vrednosti.

Nastavitev Opis
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Opomba

Z nastavitvijo stikala 2 v položaj ON in priklopom mikrofona, ki ni združljiv z napetostjo +48 V,
lahko poškodujete priključeno napravo. Pred priklopom naprave preverite nastavitev.

Stikalo 3: Omogoči/onemogoči komunikacijo VISCA prek IP. Nastavitve se uporabijo, ko je
kamera vklopljena.
Nastavite v položaj ON, da lahko uporabljate enoto, ko je povezana z daljinskim
upravljalnikom (RM-IP500).

Opomba

Če geslo skrbnika ni bilo konfigurirano, je komunikacija VISCA prek IP onemogočena ne glede
na nastavitev stikala. Za podrobnosti o konfiguraciji gesla skrbnika si oglejte razdelek
"Inicializacija enote".

Stikalo 4: Spremeni hitrost operacij obračanja/nagibanja, poslanih z infrardečega
daljinskega upravljalnika. Nastavitev se uporabi nemudoma.

OFF
(privzeto)

Ne vklopi napajanja +48 V (fantomsko napajanje). To nastavitev
konfigurirajte, ko uporabljate zunanjo zvočno napravo (npr. mešalno mizo),
dinamični mikrofon ali mikrofon z vgrajeno baterijo.

ON
Vklopi napajanje +48 V (fantomsko napajanje) za mikrofon, ki je združljiv s
fantomskim napajanjem in priključen na priključek AUDIO IN (CH-1 ali CH-
2).

Nastavitev Opis

OFF (privzeto) Ne odziva se na ukaze komunikacije VISCA prek IP.

ON Sprejema ukaze komunikacije VISCA prek IP.

Nastavitev Opis

OFF (privzeto) Deluje pri običajni hitrosti.

ON Deluje pri največji hitrosti.

Priključek SDI OUT
Oddaja video iz enote kot signal 12G/6G/3G/HD-SDI.
Enoto je mogoče konfigurirati tudi za izhod signala RAW.

12.
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[9] Pregled Lokacije in funkcije delov

Pogled od strani

Ta tema opisuje lokacije in funkcije delov na strani enote.

Namig

Ta opis se nanaša na ilustracijo enote brez nameščenega objektiva.

Za podrobnosti si oglejte razdelek "Priključek SDI OUT (tipa BNC)" v poglavju
"Povezovanje zunanjih monitorjev in snemalnih naprav".

Senzor infrardečega daljinskega upravljalnika (zadaj)
Infrardeči senzor za priložen infrardeči daljinski upravljalnik.

13.

Izhod ventilatorja/zraka
Odvaja toploto iz notranjosti enote.

Opomba

Ne pokrivajte odprtine za izhod zraka. V nasprotnem primeru lahko povzročite okvaro.

Upoštevajte, da lahko območje v bližini izhoda zraka postane vroče.

14.

Priključek GENLOCK
Uporablja se za vhod zunanjega sinhronizacijskega signala.

Za podrobnosti si oglejte razdelek "Sinhronizacija faze video signalov (Genlock)".

15.

Priključek AUDIO IN (5-pinski priključek tipa XLR)
Uporablja se za vhod signala iz zunanjega mikrofona ali zvočne naprave.
Deluje kot priključek AUDIO IN CH-1 ali AUDIO IN CH-2.

Za podrobnosti si oglejte razdelek "Povezovanje zunanjega mikrofona ali zunanje
zvočne naprave".

16.
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Ročica za zaklepanje obračanja/nagibanja
Zaklene mehanizem obračanja/nagibanja enote. Uporabite jo v naslednjih primerih.

Ko transportirate ali pakirate enoto.
Ko nameščate ali odstranjujete objektiv. Za podrobnosti si oglejte razdelek "Namestitev
objektiva" ali "Odstranitev objektiva".
Ko uporabljate objektiv, ki ne podpira funkcije obračanja/nagibanja (kot so objektivi Sony
SEL100400GM/SEL200600G/SEL400F28GM/SEL600F40GM).

Namig

Obračanje/nagibanje je mogoče fiksirati pod naslednjimi koti.

1.
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[10] Pregled Lokacije in funkcije delov

Drsni podstavek2.

Odprtine za vijake za zunanje naprave (4 mesta)
Za vijake M3 z dolžino do 6 mm.

Opomba

Ne uporabljajte vijakov, ki so daljši od 6 mm. V nasprotnem primeru lahko povzročite okvaro.

3.

Indikator dostopa A4.

Indikator dostopa B
Indikator sveti ali utripa, ko je vstavljen snemalni medij.

Za podrobnosti si oglejte razdelek "Vstavljanje pomnilniških kartic".

5.

Reža za kartice CFexpress Type A/SD (A)6.

Reža za kartice CFexpress Type A/SD (B)
Uporablja se za vstavljanje snemalnega medija.

Za podrobnosti si oglejte razdelek "Vstavljanje pomnilniških kartic".

7.

Koda QR za omrežno povezavo
Uporablja se pri konfiguriranju začetnih nastavitev.

Za podrobnosti si oglejte razdelek "Dostopanje do spletne aplikacije iz spletnega
brskalnika".

8.
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Pogled od zgoraj

Ta tema opisuje lokacije in funkcije delov na zgornji strani enote.

Namig

Ta opis se nanaša na ilustracijo enote brez nameščenega objektiva.

Odprtine za vijake za zunanje naprave (2 mesti)
Združljive z vijaki 1/4-20 UNC za stojalo.
Največja dolžina 6 mm.

1.

? (oznaka za zajemanje slik)
Oznaka za zajemanje slik se nahaja v enaki ravnini kot slikovni senzor.
Oznako za zajemanje slik uporabite kot referenčno točko za natančno merjenje razdalje
med enoto in subjektom.

2.
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[11] Pregled Lokacije in funkcije delov

Pogled od spodaj

Ta tema opisuje lokacije in funkcije delov na spodnji strani enote.

Namig

Ta opis se nanaša na ilustracijo enote brez nameščenega objektiva.

Odprtine za pritrditvene vijake stropnega nosilca (6 mest)
Ko nameščate enoto na strop ali na polico na visokem mestu, pritrdite nosilec ohišja
(izbirno) na podnožje enote, in sicer tako, da šest pritrditvenih vijakov nosilca ohišja
namestite v te odprtine za vijake.

Za podrobnosti o namestitvi si oglejte razdelek "Namestitev v pokončnem položaju na
visokem, fiksnem mestu" in "Namestitev na strop".

1.
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[12] Pregled Lokacije in funkcije delov

Podpora za objektiv

Ta tema opisuje lokacije in funkcije delov podpore za objektiv enote.

Namig

Ta opis se nanaša na ilustracijo enote brez nameščenega objektiva.

Pritrditveni vijaki stojala (2 mesti)
Uporabljajo se pri namestitvi enote na stojalo kamere (možnost, vijaki 1/4-20 UNC z dolžino
do 5,5 mm).

Opomba

Ne uporabljajte vijakov, ki so daljši od 5,5 mm. V nasprotnem primeru lahko povzročite okvaro.

2.
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Podporna palica objektiva (2)
Podpira objektiv.
Uporablja se lahko tudi za namestitev splošne dodatne opreme za palice Ø15.

1.

Podpora za objektiv
Podporo za objektiv lahko pomaknete naprej/nazaj glede na objektiv in jo nato zablokirate.

2.

Pritrditveni vijak podstavka podpore za objektiv
Pritrdite ga na podstavek podpore za objektiv. Vijak lahko prilagajate navzgor/navzdol, da
ustreza višini podstavka podpore za objektiv.

3.

Oprijemalna ročica za podporno palico objektiva (2 mesti)4.
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[13] Pregled

Pritrdi podporo za objektiv v položaju naprej/nazaj.

Oprijemalna ročica pritrditvenega vijaka podstavka podpore za objektiv
Blokira pritrditveni vijak podstavka podpore za objektiv v navpičnem položaju.

Namig

Če je oprijemalna ročica v položaju, ki otežuje njeno vrtenje, sprostite oprijemalno ročico in jo
zavrtite v položaj, ki bo olajšal upravljanje. Ko ste dosegli želen položaj, zaprite oprijemalno
ročico.

A: Oprijemalna ročica pritrditvenega vijaka podstavka podpore za objektiv
B: Oprijemalna ročica za podporno palico objektiva

Opomba

Da podpora za objektiv ne bi ovirala obračanja/nagibanja, jo takrat, ko je ne uporabljate,
premaknite proti glavi kamere in premaknite pritrditveni vijak podstavka podpore za objektiv v
njegov najvišji položaj (najbližje objektivu).

5.
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Lokacije in funkcije delov infrardečega daljinskega
upravljalnika (priložen)

Ta tema opisuje lokacije in funkcije delov infrardečega daljinskega upravljalnika (priložen).

Gumb REC? (začetek/zaustavitev snemanja)
Pritisnite za začetek ali zaustavitev snemanja.

1.

Gumb MENU
Pritisnite, da prikažete ali skrijete meni kamere.

2.

Gumbi za upravljanje grafičnega uporabniškega vmesnika
Pritisnite za izvajanje operacij v meniju kamere, v pogovornih oknih s sporočili, ki vključujejo
gumbe, in drugih funkcij prikaza zaslona.

3.
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Gumb CANC./BACK
Pritisnite za preklic nastavitve ali vrnitev v prejšnji zaslon menija kamere v enoti.

4.

Gumbi za upravljanje obračanja in nagibanja
Pritisnite puščične gumbe za upravljanje obračanja/nagibanja kamere. Pritisnite gumb
HOME, da vrnete usmerjenost kamere na sprednjo stran.

5.

Gumbi za upravljanje prednastavljenih položajev
Pridržite gumb PRESET ter pritisnite enega od gumbov od 1 do 3, da za pritisnjeni številski
gumb shranite stanje nastavitve smeri kamere, zooma in ostrenja.
Za priklic shranjenega stanja pritisnite številski gumb s shranjenimi nastavitvami.

6.

Gumbi za upravljanje ostrenja
Uporabljajo se za prilagajanje ostrenja.
Za samodejno prilagajanje ostrenja pritisnite gumb AF.
Za ročno prilagajanje ostrenja pritisnite gumb MF, nato pa pritisnite gumb F (Oddaljeno) za
izostritev na oddaljenih subjektih ali gumb N (Bližnje) za izostritev na bližnjih subjektih.

7.

Dodeljivi gumbi od 1 do 3
Izvedejo funkcije, ki so z uporabo menija kamere dodeljene dodeljivim gumbom.
Če kateremu od dodeljivih gumbov dodelite funkcijo [Direct Menu], lahko z gumbi za
upravljanje grafičnega uporabniškega vmesnika prilagodite osvetlitev, nastavitev beline in
druge nastavitve.

Za podrobnosti o dodeljevanju z uporabo menija kamere si oglejte razdelek "Dodeljivi
gumbi".

Za podrobnosti o neposrednem meniju si oglejte razdelek "Upravljanje z neposrednim
menijem".

8.

Gumb (vklop/izklop)
Pritisnite za vklop enote ali preklop napajanja v stanje pripravljenosti.

9.

Gumb THUMBNAIL
Prikaže zaslon s sličicami posnetkov, ki so posneti na pomnilniško kartico enote.

Za podrobnosti o zaslonu sličic si oglejte razdelek "Zaslon sličic".

Z gumbi za upravljanje grafičnega uporabniškega vmesnika lahko izberete posnetke in
upravljate predvajanje.

Za podrobnosti o izbiri posnetkov in upravljanju predvajanja si oglejte razdelka
"Predvajanje posnetih posnetkov" in "Upravljanje posnetih posnetkov".

10.
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Baterija infrardečega daljinskega upravljalnika

Infrardeči daljinski upravljalnik potrebuje dve bateriji AA (LR6).
Vstavite bateriji v infrardeči daljinski upravljalnik, kot je prikazano na naslednji sliki.

Opomba

Uporabljajte samo manganove ali alkalne baterije, saj vse druge lahko počijo.

Uporabljene baterije odstranite v skladu z zakoni in predpisi države ali regije.

Gumb SLOT SEL (izbira reže za pomnilniško kartico (A)/(B))
Ko sta vstavljeni dve pomnilniški kartici, pritisnite gumb, da preklopite med pomnilniškima
karticama za snemanje.
Pritisnite ta gumb pri prikazanem zaslonu sličic, da preklopite med pomnilniškima karticama,
ki si ju želite ogledati.

11.

Gumb P/T RESET (ponastavitev obračanja/nagibanja)
Ponastavi funkciji obračanja/nagibanja. Pritisnite gumb, ko istočasno utripata indikator
POWER in indikator NETWORK ali ko je na nadzorni plošči za okvirjanje v spletni aplikaciji
prikazana možnost [Execute Pan-Tilt Reset].

12.

Gumba za upravljanje zooma
Za povečavo pritisnite gumb T (telefoto).
Za pomanjšavo pritisnite gumb W (široki kot).

13.
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[14] Pregled Zaslon spletne aplikacije

Pregled zaslona spletne aplikacije

S priključitvijo tabličnega računalnika ali osebnega računalnika lahko prek spletnega brskalnika
(v nadaljevanju je ta funkcija imenovana "spletna aplikacija") obračate/nagibate, nastavljate
zoom, snemate, predvajate posnete videoposnetke in konfigurirate enoto.

Za podrobnosti o zagonu spletne aplikacije si oglejte razdelek "Dostopanje do spletne
aplikacije iz spletnega brskalnika".

Opomba

Spletna aplikacija ne podpira zvočnega izhoda kamere.

Ko se zažene spletna aplikacija, se prikaže naslednji zaslon delovanja v živo.

Zaslon delovanja v živo

Za podrobnosti o zaslonu delovanja v živo si oglejte razdelek "Struktura zaslona delovanja v
živo".
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Na vrhu zaslona so prikazani gumbi in ikone, ki veljajo tako za zaslon delovanja v živo kot
tudi za zaslon za upravljanje predvajanja.

Za podrobnosti o skupnem območju zaslonov si oglejte razdelek "Struktura skupnega
območja zaslonov".
Med zasloni lahko preklapljate s pritiskom zavihkov za preklapljanje zaslonov v skupnem
območju.

Zaslon za upravljanje predvajanja

Pritisnite zavihek [Playback] za prikaz zaslona za upravljanje predvajanja.

Za podrobnosti o zaslonu za upravljanje predvajanja si oglejte razdelek "Struktura zaslona
za upravljanje predvajanja".

Zaslon z nastavitvami

Pritisnite zavihek [Settings] za prikaz zaslona z nastavitvami (v nadaljevanju "spletni meni").
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Opomba

V spletnem meniju se nastavitve ne uporabijo, dokler ne pritisnete gumba [OK]. Če spremenite
nastavitve na strani, na kateri je gumb [OK], obvezno pritisnite gumb [OK].

Za podrobnosti o zaslonu z nastavitvami si oglejte razdelek "Struktura zaslona z
nastavitvami".
V tem vodniku za pomoč se zaslon z nastavitvami spletne aplikacije imenuje spletni meni.

[15] Pregled Zaslon spletne aplikacije

Struktura skupnega območja zaslonov

Ta tema opisuje strukturo skupnega območja zaslonov.
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Ime kamere
Prikazano je ime kamere.
Ime lahko spremenite z uporabo možnosti [Network] > [Camera Name] v spletnem meniju.
Barva ozadja se spremeni glede na zunanji signal za snemanje v živo.

1.

Stikalo za vklop
Ko je enota vklopljena, je prikazana možnost [Power ON]. Če želite nastaviti napajanje
enote v stanje pripravljenosti, pritisnite stikalo in izberite možnost [Power Standby].
Ko je prikazana možnost [Power Standby], lahko napajanje enote vklopite s pritiskom stikala
in izbiro možnosti [Power ON].

2.

Zavihki za preklapljanje zaslonov za upravljanje
Pritisnite zavihek za prikaz ustreznega zaslona za upravljanje.
Zavihek [Live]: prikaže zaslon delovanja v živo.
Zavihek [Playback]: prikaže zaslon za upravljanje predvajanja.
Zavihek [Settings]: prikaže zaslon z nastavitvami (spletni meni).

3.

Oznaka za obvestila
Ko prispe sporočilo, se oznaka spremeni, kot je prikazano spodaj.

 (vklopljena obvestila)
Izvedite potrebne ukrepe glede na sporočilo, ki je prikazano na slikovni plošči kamere.

Opomba

Sporočila niso prikazana, če je možnost [Monitoring] > [Output Display] > [HDMI] v spletnem
meniju nastavljena na [Off]. Nastavite na [On] za pregled vsebine sporočil.

4.

Gumb stanja kamere
Pritisnite gumb, da se na ločenem zaslonu prikažejo informacije o posneti sliki
kamere/izhodnem slikovnem signalu in informacije o objektivu.

5.
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[16] Pregled Zaslon spletne aplikacije

Struktura zaslona delovanja v živo

Ta tema opisuje strukturo zaslona delovanja v živo.

Stikalo za zaklepanje upravljanja na zaslonu
 (odklepanje upravljanja): stikalo nastavite v levi položaj, da upravljate postopke na

zaslonu delovanja v živo in zaslonu za upravljanje predvajanja.
 (zaklepanje upravljanja): stikalo nastavite v desni položaj, da zaklenete postopke na

zaslonu delovanja v živo in zaslonu za upravljanje predvajanja ter tako preprečite
nenamerno neustrezno upravljanje.

6.
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Nadzorna plošča za prednastavljene položaje
Prikaže registrirani položaj prednastavitve z uporabo sličice. Dvakrat tapnite sličico za
vrnitev v položaj, ki je shranjen v prednastavitvi.

Za podrobnosti o prednastavljenem položaju si oglejte razdelek "Shranjevanje/obnovitev
nastavitve obračanja/nagibanja, zooma in ostrenja z uporabo spletne aplikacije".

1.

Slikovna plošča kamere
Prikaže trenutno sliko kamere in stanje enote.
Prikaže enako sliko kot izhod HDMI.
Nad sliko je prikazano naslednje stanje. Okrog slike se glede na sprejeti zunanji signal za
snemanje v živo prikaže tudi rdeči ali zeleni okvir.

2.
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Gumb [Display]
Pritisnite ta gumb, da se na sliki prikažejo informacije o kameri.

Št. Prikaz Opis

2-
1

Indikator načina ostrenja
Oglejte si razdelek "Indikator načina ostrenja" v
poglavju "Prikaz zaslona kamere".

2-
2

Indikator načina
snemanja, reže A/B,
intervala načina snemanja
Interval Rec

Oglejte si razdelek "Indikator načina snemanja, reže
A/B, intervala načina snemanja Interval Rec" v
poglavju "Prikaz zaslona kamere".

2-
3

Indikator stanja
pretočnega predvajanja

Prikazan med pretočnim predvajanjem (samo ko je
možnost [Stream Setting] nastavljena na [SRT-Caller]).

2-
4

Indikator stanja delovanja
izhodnega formata RAW

Prikazuje izhodno stanje signala RAW. Za podrobnosti
o RAW si oglejte razdelek "Snemanje videoposnetka
RAW".

2-
5

Indikator preostalega
prostora na pomnilniškem
mediju

Oglejte si razdelek "Indikator preostalega prostora na
pomnilniškem mediju" v poglavju "Prikaz zaslona
kamere".

2-
6

Indikator položaja zooma
Oglejte si razdelek "Indikator položaja zooma" v
poglavju "Prikaz zaslona kamere".

2-
7

Indikator načina
samodejne osvetlitve/ravni
samodejne osvetlitve

Prikaže indikator načina samodejne osvetlitve/ravni
samodejne osvetlitve. Za podrobnosti o samodejni
osvetlitvi si oglejte razdelek "Prilagajanje svetlosti".
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Ko so prikazane informacije o kameri, ponovno pritisnite ta gumb, da omenjene informacije
skrijete.

Poleg oznak se glede na stanje prikažejo tudi indikatorji in sporočila, povezana s
samodejnim ostrenjem.

Za podrobnosti o prikazanih informacijah o kameri si oglejte razdelek "Prikaz zaslona
kamere".

Gumb za zaustavitev samodejnega ostrenja s sledenjem v realnem času
Pritisnite gumb za zaustavitev sledenja subjektu.

Za podrobnosti o sledenju si oglejte razdelek "Sledenje določenemu subjektu
(samodejno ostrenje s sledenjem v realnem času)".

Gumb za snemanje START/STOP
Pritisnite gumb za začetek snemanja. Med snemanjem gumb za snemanje START/STOP
sveti rdeče.
Pritisnite gumb med snemanjem, če želite ustaviti snemanje.
Stikalo zadržanja lahko nastavite v stanje zadržanja, da preprečite nenamerno delovanje
gumba za snemanje START/STOP.

3.

Plošča za osnovno konfiguracijo kamere
Prikaže nastavitve osnovnih funkcij, ki so potrebne za zajemanje posnetkov z gumbi.
Pritisnite gumb, da se na spodnji plošči za nastavitev osnovne konfiguracije kamere (5)
prikaže ustrezen zaslon nastavitev za vsako funkcijo.

4-1 [FPS]

4.
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4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Za podrobnosti si oglejte opis posamezne funkcije.

Funkcija Reference

FPS "Počasni in hitri posnetki"

ISO/Gain
"Nastavitev osnovne občutljivosti" in "Samodejno prilagajanje ojačitve" in
"Ročno prilagajanje ojačitve" v poglavju "Prilagajanje ojačitve"

Exposure
Index

"Nastavitev osnovne občutljivosti", "Spreminjanje porazdelitve temnih in
svetlih območij v posneti sliki"

Shutter
"Samodejno prilagajanje zaklopa" in "Ročno prilagajanje zaklopa" v poglavju
"Prilagajanje zaklopa"

Iris
"Samodejno prilagajanje zaslonke" in "Ročno prilagajanje zaslonke" v
poglavju "Prilagajanje zaslonke"

ND Filter "O filtru ND" v poglavju "Prilagajanje količine svetlobe (filter ND)"

Scene
File

"Pregled videza" in druge teme v poglavju "Snemanje z želenim videzom"

Base
Look/LUT

"Snemanje s prilagajanjem videza v postprodukciji"

White
Balance

"Zaslon za nastavitev beline"

Dodeljivi gumbi/plošča za nastavitev osnovne konfiguracije kamere
Prikaže dodeljive gumbe med normalnim delovanjem. Pritisnite gumb "plošče za nastavitev
kamere", da se prikažejo ustrezni elementi nastavitev. Pritisnite gumb [X] ali ponovno
pritisnite gumb plošče za nastavitev kamere, da se vrnete na prikaz dodeljivih gumbov.

5.
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Za podrobnosti o dodeljivih gumbih si oglejte razdelek "Dodeljivi gumbi".
Za podrobnosti o plošči za nastavitev osnovne konfiguracije kamere si oglejte opis
posamezne funkcije.

Nadzorna plošča za okvirjanje/nadzorna plošča grafičnega uporabniškega vmesnika
Med nadzorno ploščo za okvirjanje in nadzorno ploščo grafičnega uporabniškega vmesnika
lahko preklapljate z zavihki na vrhu.
Nadzorno ploščo za okvirjanje uporabljajte za prilagajanje okvirjanja. Pritisnite zavihek [Pan-
Tilt-Zoom], da prikažete nadzorno ploščo za okvirjanje.

Za podrobnosti o delovanju si oglejte razdelek "Prilagajanje okvirjanja".

Namig

Nadzorna plošča za okvirjanje je kot na spodnji sliki prikazana s kontrolno palico, ko je
onemogočeno delovanje obračanja/nagibanja in je potrebna inicializacija obračanja/nagibanja.

Ko je delovanje obračanja/nagibanja zaklenjeno z ročico za zaklepanje obračanja/nagibanja

Ko delovanje obračanja/nagibanja ni inicializirano

6.
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Ko je treba ponastaviti delovanje obračanja/nagibanja

Ko je delovanje obračanja/nagibanja onemogočeno

Ko obračanje/nagibanje ni inicializirano ali ga je treba ponastaviti, lahko s pritiskom na sporočilo,
ki je prikazano pod kontrolno palico, hitro dostopate do gumba [Pan-Tilt Reset].

Nadzorno ploščo grafičnega uporabniškega vmesnika uporabljajte za upravljanje menija
kamere, predvajanja posnetkov in drugih funkcij. Pritisnite zavihek [Cam GUI] za prikaz
nadzorne plošče grafičnega uporabniškega vmesnika.
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Za podrobnosti o delovanju si oglejte razdelka "Upravljanje menija kamere" in
"Predvajanje posnetkov in druge funkcije s posnetki".

Nadzorna plošča kamere
Uporablja se za konfiguriranje funkcij, ki so potrebne za upravljanje kamere.
Z zavihki na vrhu lahko preklapljate med zasloni, ki jih želite prikazati.

Za podrobnosti si oglejte opis posamezne funkcije.

Zavihek (glavni zaslon)
Prikaže elemente nastavitev za pogosto uporabljene funkcije.
Funkcije zgornjega in spodnjega drsnika spremenite tako, da pritisnete gumb [ˇ] in izberete
funkcijo s prikazanega seznama. Izberete lahko naslednje funkcije.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

7.

Prikazano glede na nastavitve menija.*
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 Zavihek (ostrenje)
Prikaže elemente nastavitev, ki so povezani z ostrenjem.

 Zavihek (zvok)

Prikaže elemente nastavitev, ki so povezani z zvokom.

Zavihek (pretočno predvajanje)
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[17] Pregled Zaslon spletne aplikacije

Struktura zaslona za upravljanje predvajanja

Prikaže elemente nastavitev, ki so povezani s pretočnim predvajanjem.
Prikazani elementi se razlikujejo glede na nastavitev formata pretočnega predvajanja.
Ko je nastavljena možnost [SRT-Caller], lahko pretočno predvajanje zaženete/ustavite na
tem zaslonu.

Za podrobnosti si oglejte razdelek "O pretočnem predvajanju" in druge teme v poglavju
"Konfiguriranje pretočnega predvajanja".

Zavihek (drugo)
Prikaže elemente nastavitev, ki so povezani z drugimi funkcijami.
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Ta tema opisuje strukturo zaslona za upravljanje predvajanja.

Slikovna plošča kamere
Prikaže predvajano sliko in povezane informacije. Ko se predvajanje ustavi, se prikaže
zaslon slike kamere.

1.
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1-1 Datum in čas snemanja
1-2 Indikator stanja predvajanja
1-3 Indikator formata predvajanja (velikost slike)
1-4 Indikator formata predvajanja (kodek)
1-5 Prikaz imena posnetka
1-6 Številka posnetka/skupno število posnetkov
1-7 Indikator stanja pretočnega predvajanja
1-8 Indikator formata predvajanja (hitrost sličic in način zajemanja)
1-9 Indikator osnovnega videza

Nadzorna plošča za predvajanje

Prikaže gumbe za upravljanje predvajanja.

Gumb [Display]
Pritisnite, da preklopite med prikazom zaslona na sliki.

Gumb [Thumbnail]
Prikaže posnetke, ki so posneti na pomnilniško kartico, na slikovni plošči kamere v obliki
sličic.

2.

Gumb Funkcija

Gumb  (predvajanje/začasna
zaustavitev)

Predvaja posnetek. Med predvajanjem začasno
ustavi posnetek.

Gumb  (hitro pomikanje
naprej), gumb  (hitro
pomikanje nazaj)

Predvaja posnetek z veliko hitrostjo. Ko pritisnete
gumb, se hitrost predvajanja spremeni v treh
korakih.

Gumb  (naslednji), gumb 
(prejšnji)

Preskoči na začetek posnetka ali na
prejšnji/naslednji posnetek.

Gumb  (zaustavitev) Zaustavi predvajanje.
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S pritiskom gumba [Thumbnail] med prikazom zaslona sličic zaprete zaslon sličic in se
vrnete na sliko kamere.

Za podrobnosti o zaslonu sličic si oglejte razdelek "Zaslon sličic".

Gumb [Slot Select]
Preklaplja med ciljnimi mediji za predvajanje.

Dodeljivi gumbi
Prikaže dodeljive gumbe, ki so dodeljeni funkcijam enote.

Za podrobnosti o dodeljivih gumbih si oglejte razdelek "Dodeljivi gumbi".

3.

Nadzorna plošča grafičnega uporabniškega vmesnika
Nadzorno ploščo grafičnega uporabniškega vmesnika uporabljajte za upravljanje menija
kamere, predvajanja posnetkov in drugih funkcij.

Za podrobnosti o delovanju si oglejte razdelka "Upravljanje menija kamere" in
"Predvajanje posnetih posnetkov".

4.
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[18] Pregled Zaslon spletne aplikacije

Struktura zaslona z nastavitvami

Zaslon z nastavitvami uporabljajte za konfiguriranje različnih elementov nastavitev enote,
vključno z začetnimi nastavitvami, omrežnimi nastavitvami, nastavitvami snemanja/predvajanja
z uporabo spletnega menija.

Opomba

V spletnem meniju se nastavitve praviloma ne uporabijo, dokler ne pritisnete gumba [OK]. Če
spremenite nastavitve na strani, na kateri je gumb [OK], obvezno pritisnite gumb [OK].

Za podrobnosti o zaslonu z nastavitvami si oglejte razdelek "Spletni meni in podrobne
nastavitve".

[19] Pregled Zaslon spletne aplikacije

Meni kamere
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Pritisnite gumb [Menu] na nadzorni plošči grafičnega uporabniškega vmesnika na zaslonu
delovanja v živo, da prikažete meni kamere na slikovni plošči kamere.

Z menijem kamere lahko konfigurirate nastavitve, ki so potrebne za snemanje in predvajanje.
Ko je prikazan meni kamere, pritisnite gumb [Menu], da omenjen meni skrijete.
Meni kamere se upravlja z nadzorno ploščo grafičnega uporabniškega vmesnika.

Za podrobnosti o meniju kamere si oglejte razdelek "Meni kamere in podrobne nastavitve".

Opomba

Ko je možnost [Monitoring] > [Output Display] > [HDMI/Stream] v spletnem meniju nastavljena na Off
(onemogoči prekrivanje informacij na prikazu zaslona), meni kamere ni več prikazan na slikovni
plošči kamere. Vendar upoštevajte, da so menijski postopki na nadzorni plošči grafičnega
uporabniškega vmesnika še vedno aktivni. Da preprečite neželeno delovanje, ne izvajajte menijskih
operacij prek nadzorne plošče grafičnega uporabniškega vmesnika, ko je možnost [HDMI/Stream]
nastavljena na Off.

[20] Pregled
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Prikaz zaslona kamere

Prikažete lahko stanje in nastavitve enote, ki prekrivajo izhodno sliko iz kamere. Z možnostjo
[Monitoring] > [Output Display] v spletnem meniju lahko nastavite izhode, za katere je
omogočen prikaz zaslona.
Podatke lahko prikažete/skrijete z gumbom [Display]. Tudi ko je skrit, se bo prikazal, če
izvedete neposredne operacije v meniju.
Z možnostjo [Monitoring] > [Display On/Off] v meniju kamere lahko prikažete/skrijete
posamezne elemente.

Podatki, prikazani na zaslonu med snemanjem

Indikator nalaganja/indikator preostalih datotek

Za podrobnosti o prenosu datotek si oglejte razdelek "O prenosu datotek" in druge teme
v poglavju "Prenos datotek".

1.

Indikator območja ostrenja
Prikaže območje ostrenja samodejnega ostrenja.

Za podrobnosti o samodejnem ostrenju si oglejte razdelek "Samodejno prilagajanje s
spletno aplikacijo" in druge teme v poglavju "Samodejno prilagajanje ostrenja (Auto
Focus)".

2.

Indikator načina snemanja, reže A/B, intervala načina snemanja Interval Rec3.

Prikaz Pomen
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Za podrobnosti o intervalnem snemanju si oglejte razdelek "Video snemanje s
prekinitvami (Interval Rec)".

?Rec Snemanje

Stby Stanje pripravljenosti na snemanje

Indikator globinske ostrine4.

Indikator načina zajemanja slike
Ob neujemanju velikosti kroga slike objektiva in efektivne velikosti slike v nastavljenem
načinu zajemanja slike je prikazana oznaka  (neujemanje).
Ko je način zajemanja slike nastavljen na FF, se v načinih z ožjim zornim kotom prikaže
oznaka "C" (obrezano).
Do obrezovanja pride v naslednjih načinih.

Ko je nastavljen format snemanja 3840×2160 in je hitrost sličic počasnih in hitrih
posnetkov 100 ali 120 sličic na sekundo.
Ko je nastavitev [Codec] nastavljena na RAW ali RAW & XAVC-I in je izhodni format
RAW 3840×2160.
Za podrobnosti o načinu zajemanja slike si oglejte razdelek "Nastavitev načina
zajemanja slike" v poglavju "Konfiguriranje osnovnih funkcij".

5.

Indikator stanja delovanja izhodnega formata RAW
Prikazuje izhodno stanje signala RAW.

Za podrobnosti o RAW si oglejte razdelek "Snemanje videoposnetka RAW".

6.

Indikator hitrosti sličic pri snemanju počasnih in hitrih posnetkov

Za podrobnosti o počasnih in hitrih posnetkih si oglejte razdelek "Počasni in hitri
posnetki".

7.

Indikator položaja ostrenja

Prikaže položaj ostrenja.

8.

Indikator načina ostrenja9.

Prikaz Pomen

Focus Hold Način zadržanja ostrenja
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Samodejno ostrenje z zaznavanjem obrazov/oči

Za podrobnosti o samodejnem ostrenju z zaznavanjem obrazov/oči si oglejte razdelek
"Sledenje z zaznavanjem obrazov in oči (Samodejno ostrenje z zaznavanjem
obrazov/oči)".

MF Način ročnega ostrenja

AF Način samodejnega ostrenja

 (način samodejnega ostrenja s
sledenjem v realnem času)

Način samodejnega ostrenja s
sledenjem v realnem času

Prikaz Pomen

 (samodejno ostrenje z zaznavanjem
obrazov/oči)

Označuje, da je aktivna funkcija
samodejnega ostrenja z zaznavanjem
obrazov/oči.

 (samodejno ostrenje samo
obrazov/oči)

Označuje, da je aktivna funkcija
samodejnega ostrenja samo obrazov/oči.

 (shranjen obraz za sledenje) Označuje, da je bil shranjen obraz za
sledenje.

 (ikona začasne prekinitve
samodejnega ostrenja med samodejnim
ostrenjem z zaznavanjem obrazov/oči)

Označuje, da je bilo samodejno ostrenje
začasno prekinjeno med samodejnim
ostrenjem z zaznavanjem obrazov/oči.*

Prikazana je, ko ni shranjen noben obraz za sledenje in ni zaznan noben obraz ali, ko je prisoten shranjen
obraz za sledenje, a ni zaznan ciljni obraz za sledenje.

*

Indikator položaja zooma
Prikaže položaj zooma v razponu od 0 (široki kot) do 99 (telefoto) (če je nameščen objektiv,
ki podpira prikaz položaja zooma).
Z nastavitvijo [Technical] > [Lens] > [Zoom Position Display] v meniju kamere lahko indikator
spremenite tudi v črtni prikaz ali prikaz goriščne razdalje.
Ko je vklopljen zoom za jasno sliko, so na zaslon dodani naslednji elementi.

10.

Prikaz Pomen

 (vklopljen zoom za jasno sliko) Vklopljen je zoom za jasno sliko.

Magnification value Ko uporabljate zoom za jasno sliko



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Za podrobnosti o zoomu si oglejte razdelek "Nastavitev vrste zooma" in druge teme v
poglavju "Nastavitev zooma".

Indikator načina stabilizacije slike11.

Indikator stanja izhoda SDI/funkcije Rec Control izhoda HDMI
Prikaže izhodno stanje signala REC control.

Za podrobnosti si oglejte razdelek "Povezovanje zunanjih monitorjev in snemalnih
naprav".

12.

Indikator ostrenja

Za podrobnosti si oglejte razdelek "Uporaba enkratnega samodejnega ostrenja (Push
Auto Focus (AF-S))" v poglavju "Prilagajanje ostrenja".

13.

Indikator preostalega prostora na pomnilniškem mediju
Ikona  (zaščita) se prikaže, če je pomnilniška kartica zaščitena pred zapisovanjem.

14.

Indikator načina beline15.

Prikaz Pomen

 (ATW) Samodejni način

 (ATW Hold) Samodejni način je začasno prekinjen.

W:P Prednastavljeni način

W:A Način pomnilnika A

Indikator zunanjega zaklepa časovne kode/prikaz podatkov o času
Ob zaklepu na časovno kodo zunanje naprave prikazuje "EXT-LK".

Za podrobnosti o časovni kodi si oglejte razdelek "Določanje podatkov o času".

16.

Indikator filtra ND17.

Prikaz Pomen

 (A) Samodejni način
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Za podrobnosti o filtrih ND si oglejte razdelek "Prilagajanje količine svetlobe (filter ND)".
Za podrobnosti o upravljanju zameglitve ozadja si oglejte razdelek "Prilagajanje
zameglitve ozadja (funkcija Bokeh Control)".

 (B) Način upravljanja zameglitve ozadja

Indikator scenske datoteke

Za podrobnosti o scenskih datotekah si oglejte razdelek "Pregled videza" in druge teme
v poglavju "Snemanje z želenim videzom".

18.

Indikator zaslonke
Prikaže položaj zaslonke (vrednost F) (če je nameščen objektiv, ki podpira prikaz nastavitve
zaslonke).

Za podrobnosti o zaslonki si oglejte razdelka "Samodejno prilagajanje zaslonke" in
"Ročno prilagajanje zaslonke".

19.

Opozorilni indikator ravni videa20.

Indikator ojačitve
Prikaže vrednost EI, ko ste v načinu Cine EI.

Za podrobnosti o ojačitvi si oglejte razdelka "Samodejno prilagajanje ojačitve" in "Ročno
prilagajanje ojačitve".
Za podrobnosti o načinu Cine EI si oglejte razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij".

21.

Prikaz Pomen

 (A) Samodejni način

L Prednastavljeni način L

 (način začasne prilagoditve) Način začasne prilagoditve

 (B) Način upravljanja zameglitve ozadja

Prikaz imena posnetka
Prikaže ime posnetka, ki se snema ali se bo snemal kot naslednji.

22.

Indikator zaklopa23.
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Za podrobnosti o zaklopu si oglejte razdelka "Samodejno prilagajanje zaklopa" in
"Ročno prilagajanje zaklopa".

Indikator načina samodejne osvetlitve/ravni samodejne osvetlitve

Za podrobnosti o samodejni osvetlitvi (AE) si oglejte razdelek "Nastavitev ciljne ravni za
samodejno prilagajanje svetlosti".

24.

Indikator izravnanosti
Prikaže vodoravno izravnanost do ±15° v korakih po ±1°.

25.

Merilnik ravni zvoka
Prikaže raven zvoka za vsak kanal.

26.

Zaslon video signala
Prikaže valovno obliko, vektorskop in histogram.
Oranžna črta označuje nastavljeno vrednost označevalnika ravni svetlosti.
V načinu Cine EI prikazuje vrsto signala LUT, ki je pod nadzorom.

Za podrobnosti si oglejte razdelek "Nadzor video signala".
Za podrobnosti o načinu Cine EI si oglejte razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij".

27.

Indikator osnovne občutljivosti/indikator osnovne občutljivosti ISO
V načinu po meri prikaže osnovno občutljivost, ki je nastavljena z gumbom [ISO/Gain /
Exposure Index] na plošči za osnovno konfiguracijo kamere ali z možnostjo [Shooting] >
[ISO/Gain/EI] > [Base Sensitivity] v meniju kamere.
V načinu Cine EI prikaže osnovno občutljivost ISO, ki je nastavljena z gumbom [ISO/Gain /
Exposure Index] na plošči za osnovno konfiguracijo kamere ali z možnostjo [Shooting] >
[ISO/Gain/EI] > [Base ISO] v meniju kamere.

Za podrobnosti o osnovni občutljivosti si oglejte razdelek "Izbira osnovne občutljivosti".
Za podrobnosti o načinu Cine EI si oglejte razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij".

28.

Indikator nadzora videza
V načinu Cine EI prikazuje nastavitev nadzora LUT.

Za podrobnosti o nastavitvi LUT si oglejte razdelek "Snemanje s prilagajanjem videza v
postprodukciji" in sorodne teme.
Za podrobnosti o načinu Cine EI si oglejte razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij".

29.
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Podatki, prikazani na zaslonu med predvajanjem

Sledeči podatki so dodani predvajani sliki.

Indikator osnovnega videza/videza za snemanje
Prikazuje nastavitev osnovnega videza.
V načinu Cine EI prikazuje video signal za snemanje na pomnilniške kartice.

Za podrobnosti o osnovnem videzu si oglejte razdelek "Pregled videza" v poglavju
"Snemanje z želenim videzom".
Za podrobnosti o načinu Cine EI si oglejte razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij".

30.

Indikator stanja proxyja31.

Indikator formata snemanja (kodek)
Prikaže ime formata za snemanje na pomnilniške kartice.
Nastavite format snemanja (kodek) z možnostjo [Project] > [Rec Format] > [Codec] v
spletnem meniju ali meniju kamere.

32.

Indikator formata snemanja (hitrost sličic in način zajema)33.

Indikator formata snemanja (velikost slike)
Prikaže velikost slike za snemanje na pomnilniške kartice.
Nastavite format snemanja (velikost slike) z možnostjo [Project] > [Rec Format] > [Codec] v
spletnem meniju ali meniju kamere.

34.

Indikator snemanja v živo
Prikaže rdeči ali zeleni okvir okrog slike, in sicer glede na sprejeti zunanji signal za
snemanje v živo.

35.
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Indikator nalaganja/indikator preostalih datotek1.

Številka posnetka/skupno število posnetkov2.

Indikator stanja predvajanja3.

Indikator formata predvajanja (hitrost sličic in način zajemanja)4.

Indikator formata predvajanja (velikost slike)5.

Indikator formata predvajanja (kodek)6.

Indikator pomnilniškega medija
Ikona  (zaščita) se prikaže, če je pomnilniška kartica zaščitena pred zapisovanjem.

7.

Prikaz podatkov o času8.

Prikaz imena posnetka9.

Indikator izboljšanega prikaza game10.

Merilnik ravni zvoka
Prikaže raven zvoka pri predvajanju.

11.

Indikator osnovnega videza/videza za snemanje12.

Indikator snemanja v živo13.
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[21] Priprava Namestitev enote

Namestitev v pokončnem položaju na fiksnem mestu

Ta tema opisuje namestitev enote na mizo ali stojalo.

Opombe o namestitvi
Za zaščito objektiva in priključnega bloka za objektiv na enoti zagotovite, da bosta pokrova
objektiva in enote nameščena, dokler ne pritrdite objektiva.
Da preprečite okvaro objektiva, med delom ne držite delov objektiva.
Da preprečite okvaro enote, med delom ne držite glave kamere.

Preverite namestitveni prostor.

Pri namestitvi na mizo
Enoto namestite na ravno površino in pri tem upoštevajte prostor, ki je potreben za
obračanje objektiva in kable oz. žice na zadnji strani enote.

Opomba

Enoto namestite na stabilno mesto, ki ni izpostavljeno tresljajem. Mesta, ki so izpostavljena
tresljajem, lahko povzročijo tresljaje na sliki.

Če morate enoto namestiti na nagnjeno površino, naj bo njen odklon od vodoravne lege največ
±15°, prav tako pa zagotovite, da enota ne bo padla.

Pri namestitvi na stojalo
Stojalo namestite v odprtino za pritrditveni vijak stojala, ki je na spodnjem delu.

1
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Nato pritrdite objektiv. Oglejte si razdelek "Namestitev objektiva" ter upoštevajte informacije v
razdelkih "Previdnostni ukrepi pri namestitvi/odstranitvi objektiva", "Preverjanje stikal objektiva"
in "Previdnostni ukrepi pri uporabi objektiva z zoomom".

[22] Priprava Namestitev enote

Namestitev v pokončnem položaju na visokem,
fiksnem mestu

Ta tema opisuje postopek namestitve enote v pokončnem položaju na visokem mestu s
stropnim nosilcem (CIB-PCM1 (izbirno)).

Uporabite pritrditveni vijak stojala z naslednjo mero izbočenosti iz namestitvene površine in
ga zategnite z ročnim izvijačem.

A: Pritrditveni vijaki stojala 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Izbočenost (od 4,5 mm do 5,5 mm)

Ko enoto nameščate na visokem mestu, ne uporabljajte vijakov, namenjenih za
pritrditev na stojalo.

Opomba

Izberite stojalo, ki se ne bo prevrnilo niti pri obračanju objektiva.
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Če želite enoto namestiti na visokem mestu, se obrnite na usposobljenega strokovnjaka.
Pri namestitvi na visokem mestu se prepričajte, da lahko namestitvena površina in material
(brez dodatne opreme) preneseta 200 kg ali več, ter namestite enoto, kot je opisano v tem
vodniku za pomoč. Če namestitev ni dovolj trdna, lahko enota pade in povzroči hude
poškodbe.
Na stropni nosilec CIB-PCM1 (izbirno) pritrdite priloženo jekleno vrv za preprečevanje padca
in tako zaščitite enoto pred padcem.
Ko je enota nameščena na visokem mestu, enkrat na leto preverite, da namestitev ni
zrahljana. Interval med pregledi skrajšajte glede na pogoje uporabe.

Opombe o namestitvi
Za zaščito objektiva in priključnega bloka za objektiv na enoti zagotovite, da bosta pokrova
objektiva in enote nameščena, dokler ne pritrdite objektiva.
Da preprečite okvaro objektiva, med delom ne držite delov objektiva.
Da preprečite okvaro enote, med delom ne držite glave kamere.

Preverite pripomočke in prostor za namestitev na visokem mestu.

Komplet stropnega nosilca CIB-PCM1 (izbirno)
Preden začnete, se prepričajte, da imate naslednje dele.

Nosilec ohišja (1)
Stropni nosilec (1)
Pokrovček gumba za sprostitev objektiva (1)
Jeklena vrv za preprečevanje padca (1)
Vijaki +PSW M3×8 (9)
Vijak +PSW M4x8, izdelan iz nerjavnega jekla in namenjen za jekleno vrv za

1
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preprečevanje padca (1)

Opomba

Jeklena vrv za preprečevanje padca je zasnovana tako, da podpira enoto, ko je obešena. Ne
obremenjujte jo z nobeno drugo težo, razen s težo enote.

Namestitveni prostor
Pri določanju mesta in smeri namestitve upoštevajte naslednjo sliko, upoštevajte pa tudi
prostor, ki je potreben za obračanje objektiva in kable oz. žice na zadnji strani enote.

A: Razpon premikanja glave kamere (npr. SEL70200GM2 (s pritrjenim SEL20TC): Ø340)
B: Stropni nosilec (odprtina na strani namestitvene površine (Ø60))
C: Odprtina za poravnavo namestitve

Opomba

Enoto namestite na stabilno mesto, ki ni izpostavljeno tresljajem. Mesta, ki so izpostavljena
tresljajem, lahko povzročijo tresljaje na sliki.

Če morate enoto namestiti na nagnjeno površino, naj bo njen odklon od vodoravne lege največ
±15°, prav tako pa zagotovite, da enota ne bo padla.

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

2
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Opomba

Če se obračanje/nagibanje glave kamere ne zaklene, ko je ročica za zaklepanje v položaju
LOCK, ročno premaknite glavo kamere, dokler se ne zaklene v položaju.

S šestimi priloženimi vijaki (M3×8) pritrdite nosilec ohišja na spodnji del enote.3
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Uporabite priložene vijake. Če namesto priloženih vijakov uporabite druge vijake, lahko
poškodujete notranjost enote.

Jekleno vrv za preprečevanje padca pritrdite na nosilec ohišja.4
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A: Priložena jeklena vrv
B: Priložen vijak Phillips (M4×8)
C: Kovinsko uho za jekleno vrv

Uporabite priložen vijak. Če namesto priloženega vijaka uporabite drug vijak, lahko
zmanjšate učinkovitost funkcije jeklene vrvi.

Stropni nosilec pritrdite na površino (npr. polico), na katero bo enota nameščena.5
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A: Stena
B: Oznaka ? (smer kamere naprej)
C: Odprtina za priključne kable
D: Polica ali druga namestitvena površina

Jekleno vrv za preprečevanje padca pritrdite na točko blizu namestitvene površine.

Uporabite vijak s šestrobo glavo M5 (3/16-palčni) (izbirno) in ga pritrdite na predmet blizu
police ali površine, na katero je pritrjen stropni nosilec.

6
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A: Jeklena vrv
B: Vijak s šestrobo glavo (M5, 3/16-palčni)

Poravnajte odprtino za vijak ? na sprednji strani nosilca ohišja z odprtino ? na
stropnem nosilcu, vstavite enoto in jo obračajte v smeri urinega kazalca, da začasno
pritrdite nosilec ohišja v stropni nosilec.

7
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A: Odprtina ?
B: Odprtina ?

S tremi priloženimi vijaki za zaklep vrtenja (M3×8) pritrdite nosilec ohišja in stropni
nosilec.

8
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Nato pritrdite objektiv. Oglejte si razdelek "Namestitev objektiva" ter upoštevajte informacije v
razdelkih "Previdnostni ukrepi pri namestitvi/odstranitvi objektiva", "Preverjanje stikal objektiva"
in "Previdnostni ukrepi pri uporabi objektiva z zoomom".

Opomba

Po namestitvi objektiva se prepričajte, da je objektiv varno pritrjen.
Objektiv nima nobene zaščite pred padcem. Družba Sony ne prevzema odgovornosti za padec
objektiva z enote.

Preverite stanje namestitve.

Preverite predvsem naslednje elemente. 

Pritrditveni vijaki so pravilno nameščeni.
Jeklena vrv za preprečevanje padca je pravilno pritrjena in ni zvita.
Enota je nameščena vodoravno (brez nagiba ali nihanja).
Enota se pri obračanju ne vrti prosto.

9
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[23] Priprava Namestitev enote

Namestitev na strop

Ta tema opisuje postopek namestitve enote na strop s stropnim nosilcem (CIB-PCM1 (izbirno)).

Če želite enoto namestiti na strop, se obrnite na usposobljenega strokovnjaka.
Pri namestitvi na strop se prepričajte, da lahko namestitvena površina in material (brez
dodatne opreme) preneseta 200 kg ali več, ter namestite enoto, kot je opisano v tem
vodniku za pomoč. Če namestitev ni dovolj trdna, lahko enota pade in povzroči hude
poškodbe.
Na stropni nosilec CIB-PCM1 (izbirno) pritrdite priloženo jekleno vrv za preprečevanje padca
in tako zaščitite enoto pred padcem.
Ko je enota nameščena na strop, enkrat na leto preverite, da namestitev ni zrahljana.
Interval med pregledi skrajšajte glede na pogoje uporabe.

Opombe o namestitvi
Za zaščito objektiva in priključnega bloka za objektiv na enoti zagotovite, da bosta pokrova
objektiva in enote nameščena, dokler ne pritrdite objektiva.
Da preprečite okvaro objektiva, med delom ne držite delov objektiva.
Da preprečite okvaro enote, med delom ne držite glave kamere.

Preverite pripomočke in prostor za namestitev na strop.1
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Komplet stropnega nosilca CIB-PCM1 (izbirno)
Preden začnete, se prepričajte, da imate naslednje dele.

Nosilec ohišja (1)
Stropni nosilec (1)
Pokrovček gumba za sprostitev objektiva (1)
Jeklena vrv za preprečevanje padca (1)
Vijaki +PSW M3×8 (9)
Vijak +PSW M4×8, izdelan iz nerjavnega jekla in namenjen za jekleno vrv za
preprečevanje padca (1)

Opomba

Jeklena vrv za preprečevanje padca je zasnovana tako, da podpira enoto, ko je obešena. Ne
obremenjujte jo z nobeno drugo težo, razen s težo enote.

Namestitveni prostor
Pri določanju mesta in smeri namestitve upoštevajte naslednjo sliko, upoštevajte pa tudi
prostor, ki je potreben za obračanje objektiva in kable oz. žice na zadnji strani enote.

A: Razpon premikanja glave kamere (npr. SEL70200GM2 (s pritrjenim SEL20TC): Ø340)
B: Stropni nosilec (odprtina na strani stropa (Ø60))
C: Odprtina za poravnavo namestitve

Opomba

Namestite na strop (npr. betonski) z zadostno trdnostjo.
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Če želite enoto namestiti na strop z nezadostno trdnostjo, zagotovite ustrezno ojačitev.

Enoto namestite na stabilno mesto, ki ni izpostavljeno tresljajem. Mesta, ki so izpostavljena
tresljajem, lahko povzročijo tresljaje na sliki.

Če morate enoto namestiti na nagnjeno površino, naj bo njen odklon od vodoravne lege največ
±15°, prav tako pa zagotovite, da enota ne bo padla.

Stran nasproti odprtine ? na stropnem nosilcu je smer snemanja (sprednja stran kamere).

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj UNLOCK, da odklenete
obračanje/nagibanje in obrnete glavo kamere za 180° v smeri nagibanja.

2

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

Za 180° obrnjena glava kamere

Opomba

Če se obračanje/nagibanje glave kamere ne zaklene, ko je ročica za zaklepanje v položaju
LOCK, ročno premaknite glavo kamere, dokler se ne zaklene v položaju.

3

S šestimi priloženimi vijaki (M3×8) pritrdite nosilec ohišja na spodnji del enote.4
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Uporabite priložene vijake. Če namesto priloženih vijakov uporabite druge vijake, lahko
poškodujete notranjost enote.

Pritrdite stropni nosilec na namestitveno ploščo (izbirno), nato pa ploščo pritrdite
na strop.

5



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

A: Stropni nosilec
B: Strop
C: Namestitvena plošča
D: Odprtina ?
Pritrdite nosilec – glede na usmerjenost stropnega nosilca
Upoštevajte, da se v primerjavi z običajno pokončno namestitvijo sprednja stran kamere
pri namestitvi na strop nahaja na nasprotni strani stropnega nosilca. Pravilno namestitev
izvedite v skladu s sliko, ki označuje smer namestitve.

A: Spredaj za pokončno namestitev (usmeritev odprtine ?)
B: Spredaj za namestitev na strop

Opomba

Za material namestitvene površine je odgovorna stranka oz. kupec.

Pritrdite jekleno vrv za preprečevanje padca na strop.6
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A: Stropni nosilec
B: Vijak s šestrobo glavo (M5, 3/16-palčni)
C: Jeklena vrv (priložena)
D: Namestitvena plošča
E: Strop

Jekleno vrv za preprečevanje padca potegnite skozi odprtino na sredini stropnega
nosilca in jo pritrdite na nosilec ohišja.

Jekleno vrv za preprečevanje padca napeljite skozi kovinsko uho za jekleno vrv na nosilcu
ohišja in jo s priloženim vijakom iz nerjavnega jekla (M4×8) varno pritrdite na nosilec.

7
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A: Priložena jeklena vrv
B: Priložen vijak Phillips (M4×8)
C: Kovinsko uho za jekleno vrv

Uporabite priložen vijak. Če namesto priloženega vijaka uporabite drug vijak, lahko
zmanjšate učinkovitost funkcije jeklene vrvi.

Opomba

Priporočamo, da ena oseba drži enoto, kot je prikazano na naslednji sliki, medtem pa druga
oseba namesti enoto.
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Med namestitvijo enote ne držite glave kamere ali podpore za objektiv. V primeru padca enote
obstaja nevarnost nastanka škode ali poškodb.

Ko izvajate ožičenje, pazite, da na električnih priključkih in kablih ne pride do kratkega stika
zaradi jeklene vrvi za preprečevanje padca.

Nosilec lahko vzdrži obešeno obremenitev do 8,8 kg (vključno z objektivom). Pazite, da ne
prekoračite največje pričakovane teže, saj lahko v nasprotnem primeru enota pade.

Odprtino za vijak (A) na nosilcu ohišja poravnajte z odprtino ? (B) na stropnem
nosilcu, vstavite enoto in jo obrnite za pribl. 60 stopinj v smeri urinega kazalca,
dokler nista odprtina za vijak (A) in odprtina za vijak (C) poravnani.

8
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A: Odprtina za vijak na nosilcu ohišja
B: Odprtina za vijak na stropnem nosilcu (odprtina ?)
C: Odprtina za vijak
D: Strop
E: Namestitvena plošča

S tremi priloženimi vijaki za zaklep vrtenja (M3×8) pritrdite nosilec ohišja in stropni
nosilec.

9
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Nato pritrdite objektiv. Oglejte si razdelek "Namestitev objektiva" ter upoštevajte informacije v
razdelkih "Previdnostni ukrepi pri namestitvi/odstranitvi objektiva", "Preverjanje stikal objektiva"
in "Previdnostni ukrepi pri uporabi objektiva z zoomom".

Opomba

Ko je enota nameščena na strop, morate za pravilno upravljanje obračanja/nagibanja nastaviti
možnost [Pan-Tilt] > [Direction] > [Ceiling] v spletnem meniju na [On].

Preverite stanje namestitve.

Preverite predvsem naslednje elemente.

Pritrditveni vijaki so pravilno nameščeni.
Jeklena vrv za preprečevanje padca je pravilno pritrjena in ni zvita.
Enota je nameščena vodoravno (brez nagiba ali nihanja).
Enota se pri obračanju ne vrti prosto.

10
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Po namestitvi objektiva se prepričajte, da je objektiv varno pritrjen.
Objektiv nima nobene zaščite pred padcem. Družba Sony ne prevzema odgovornosti za padec
objektiva z enote.

[24] Priprava Namestitev/odstranitev objektiva

Previdnostni ukrepi pri namestitvi/odstranitvi objektiva

Objektiva ne puščajte obrnjenega proti soncu. Neposredna sončna svetloba lahko vstopi skozi
objektiv, se zbere v točki v enoti in povzroči požar.

Opomba

Objektiv namestite/odstranite, ko je enota izklopljena.

Objektiv je zelo natančen izdelek. Objektiva ne polagajte na površino obrnjenega z nastavkom
navzdol. Namestite priložen pokrovček za objektiv.

Namig

Za podrobnosti o podprtih objektivih se obrnite na servisnega predstavnika družbe Sony.

[25] Priprava Namestitev/odstranitev objektiva

Preverjanje stikal objektiva

Glede na vrsto objektiva so potrebna naslednja preverjanja in nastavitve.

Za objektiv s stikalom za zoom

Stikalo nastavite na SERVO.
Če je stikalo nastavljeno na MANUAL, lahko zoom prilagajate samo z obročem za zoom.
Upravljanje zooma na enoti nima učinka.

Za objektiv s stikalom za način ostrenja

Stikalo nastavite na AF/MF ali AF.
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Če je stikalo nastavljeno na MF, lahko ostrenje prilagajate samo z obročem na objektivu ali pa
ga prilagajate ročno z daljinskim upravljalnikom. Če je stikalo nastavljeno na Full MF, lahko
ostrenje prilagajate samo z obročem na objektivu.

Opomba

Ob uporabi objektiva serije A ročno prilagajanje z daljinskim upravljalnikom morda ne bo na voljo.

Za objektiv s stikalom Auto Iris

Stikalo nastavite na AUTO.
Ko stikalo ni nastavljeno na AUTO, lahko zaslonko prilagajate samo z obročem na objektivu.
Upravljanje zaslonke na enoti nima učinka.

Za objektiv s stikalom za stabilizacijo slike

Stikalo nastavite na OFF.
Če je stikalo nastavljeno na ON, lahko med delovanjem obračanja/nagibanja pride do
nepričakovanega obnašanja.

SELP28135G

A: Nastavite stikalo ZOOM na SERVO.
B: Premaknite obroč za ostrenje v položaj za naprej (način AF/MF).
C: Nastavite stikalo stabilizatorja slike na OFF.

[26] Priprava Namestitev/odstranitev objektiva

Previdnostni ukrepi pri uporabi objektiva z zoomom
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Ko uporabljate objektiv z zoomom, ki ni objektiv z motoriziranim zoomom, se lahko položaj
zooma spremeni glede na okolje namestitve. Obroč za zoom pritrdite s trakom glede na namen
uporabe.

Plastični filmski trak: 471 BLA 50 ali enakovreden

[27] Priprava Namestitev/odstranitev objektiva

Namestitev objektiva

Ta tema opisuje postopek namestitve objektiva serije E ali objektiva serije A.

Opomba

Pri uporabi objektiva serije A se zaslonka nastavlja ročno in ostrenje je nastavljeno na ročno
ostrenje.

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

1



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Opomba

Če se obračanje/nagibanje glave kamere ne zaklene, ko je ročica za zaklepanje v položaju
LOCK, ročno premaknite glavo kamere, dokler se ne zaklene v položaju.

Zavrtite oprijemalno ročico pritrditvenega vijaka podstavka podpore za objektiv v
nasprotni smeri urinega kazalca, da sprostite zaklep, nato premaknite pritrditveni
vijak podstavka podpore za objektiv v položaj, ki ne ovira objektiva.

A: Pravilno
B: Nepravilno

2

Zavrtite ročico za zaklepanje glave kamere v smeri puščice, da odklenete glavo
kamere.

3
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Opomba

Dokler ni glava kamere ponovno zaklenjena, obstaja nevarnost, da se glava kamere premakne
pod lastno težo. Med izvajanjem opravila glavo kamere podprite z roko.

Potisnite glavo kamere v skrajni sprednji položaj.4

Zavrtite ročico za zaklepanje glave kamere v smeri puščice, da zaklenete glavo
kamere.

5
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Snemite pokrova z enote in objektiva.6

Poravnajte (belo) oznako za namestitev objektiva z enoto, previdno vstavite objektiv
v glavo kamere, nato pa obrnite objektiv v smeri urinega kazalca, dokler ne zaskoči
v zaklenjenem položaju.

A: Namestitvene oznake (bele barve)

Opomba

Za uporabo objektiva serije A namestite adapter z nastavkom za objektiv (možnost) na enoto
in nato namestite objektiv serije A.

7

Zavrtite ročico za zaklepanje glave kamere v smeri puščice, da odklenete glavo
kamere.

8
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Opomba

Dokler ni glava kamere ponovno zaklenjena, obstaja nevarnost, da se glava kamere premakne
pod lastno težo. Med izvajanjem opravila glavo kamere podprite z roko.

Ohranite ravnovesje glave kamere naprej/nazaj, tako da je drsni podstavek
vodoraven.

Če uporabljate enega od naslednjih objektivov, lahko enoto in objektiv grobo uravnovesite
s pomočjo merila na drsnem podstavku.

9

Položaj na
merilu Ime objektiva

0,5 SEL70200GM (s pritrjenim SEL20TC)
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Opomba

Za zagotovitev grobega ravnovesja uporabite merilo na drsnem podstavku.

Med nameščanjem objektiva ustrezno prilagodite ravnovesje, da se enota ne bo nagibala
naprej in nazaj.

Prilagodite ravnovesje na vodoravni površini.

1,7 SEL70200GM

2,0 SEL70200GM2 (s pritrjenim SEL20TC)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

5,0 ali višji
SEL1224GM, SEL1635GM, SELP1635G, SELP18105G,
SELP1020G

Zavrtite ročico za zaklepanje glave kamere v smeri puščice, da zaklenete glavo
kamere.

10

Zavrtite oprijemalni ročici podpore za objektiv v nasprotni smeri urinega kazalca, da
sprostite podporo za objektiv.

11
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A: Oprijemalna ročica za podporno palico objektiva (2 mesti)
B: Podpora za objektiv

Premaknite podporo za objektiv, tako da je podstavek podpore za objektiv poravnan
s pritrditvenim vijakom podstavka podpore za objektiv, nato pa zavrtite vijak v smeri
urinega kazalca, da pritrdite podstavek podpore za objektiv.

Opomba

Prepričajte se, da je podstavek podpore za objektiv pravokoten na pritrditveni vijak podstavka
podpore za objektiv, in ga zategnite.

12

Zavrtite oprijemalno ročico pritrditvenega vijaka podstavka podpore za objektiv v
smeri urinega kazalca, da blokirate pritrditveni vijak podstavka podpore za objektiv.

13



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

[28] Priprava Namestitev/odstranitev objektiva

Odstranitev objektiva

A: Pritrditveni vijak podstavka podpore za objektiv
B: Odprtina za pritrditveni vijak
C: Oprijemalna ročica pritrditvenega vijaka podstavka podpore za objektiv

Namig

Če je oprijemalna ročica v položaju, ki otežuje njeno vrtenje, sprostite oprijemalno ročico in jo
zavrtite v položaj, ki bo olajšal upravljanje. Ko ste dosegli želen položaj, zaprite oprijemalno
ročico.

A: Oprijemalna ročica pritrditvenega vijaka podstavka podpore za objektiv
B: Oprijemalna ročica za podporno palico objektiva

Zavrtite oprijemalni ročici za podporni palici objektiva v smeri urinega kazalca, da
blokirate podporo za objektiv.

14

Prepričajte se, da sta obe ročici zategnjeni in ne zrahljani, da je objektiv pravilno
pritrjen in da so stikala objektiva pravilno nastavljena.

Če je ročica zrahljana ali pa objektiv ni pravilno pritrjen, lahko objektiv pade in se
poškoduje.
Če uporabljate objektiv serije E z motoriziranim zoomom, morate ločeno umeriti tudi
objektiv, da natančno obnovite položaje zooma, ki so v kameri shranjeni kot
prednastavljeni položaji. Za podrobnosti si oglejte razdelek "Umerjanje objektiva serije
E".

15
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Za odstranitev objektiva uporabite obratni postopek kot pri namestitvi objektiva.

Opomba

Z roko čvrsto držite objektiv, da preprečite njegov padec.

Če ne boste takoj namestili drugega objektiva, vedno namestite pokrovček ohišja.

[29] Priprava

Priključitev kablov

Ta tema opisuje kabelske priključke.

Prepričajte se, da je obračanje/nagibanje zaklenjeno.1

Zavrtite oprijemalno ročico pritrditvenega vijaka podstavka podpore za objektiv v
nasprotni smeri urinega kazalca, da sprostite zaklep.

2

Odstranite pritrditveni vijak podstavka podpore za objektiv na podpori za objektiv in
ga premaknite v položaj, ki ne ovira objektiva.

3

Odklenite glavo kamere in jo potisnite v skrajni sprednji položaj.

Za podrobnosti si oglejte korake od 3 do 5 v razdelku "Namestitev objektiva".

4

Pritisnite in pridržite gumb za sprostitev objektiva ter zasukajte objektiv v nasprotni
smeri urinega kazalca, medtem ko ga držite.

5

Ko so (bele) namestitvene oznake kamere in objektiva poravnane, izvlecite objektiv
proti sprednji strani.

6

Priključite potrebne kable na priključke na zadnji plošči.

Da bi preprečili odstranitev kabla HDMI, s priključnega bloka odstranite pritrditveni vijak
(M2,6×6, črn) nosilne plošče za kabel HDMI in s pritrditvenim vijakom pritrdite priloženo
nosilno ploščo za kabel HDMI. S kabelsko objemko ali trakom, ki sta dostopna na trgu,

1
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[30] Priprava

Priključitev enote na omrežno napravo prek žične
povezave

Ta tema opisuje priključitev enote na omrežno napravo prek žične povezave.

pritrdite kabel HDMI na nosilno ploščo za kabel HDMI.

A: Pritrditveni vijak (M2,6×6, črn) nosilne plošče za kabel HDMI
B: Na trgu dostopna kabelska objemka ali trak
C: Nosilna plošča za kabel HDMI (priložena)

S kablom LAN, kategorije 5e ali višje, povežite enoto z omrežno napravo (na primer
dostopovno točko Wi-Fi ali komutiranim zvezdiščem).

1
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[31] Priprava Priključitev napajanja

Uporaba omrežnega napajanja

Ta tema opisuje postopek napajanja enote z omrežnim tokom.

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

1

Omrežni napajalnik (priložen) priklopite na priključek DC IN na enoti. Napajalni kabel
(priložen) povežite z električno vtičnico.

A: Priključek DC IN
B: Napajalni kabel

2
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C: Omrežni napajalnik

Kabel omrežnega napajalnika pritrdite s sponko za kabel in tako preprečite, da se
odklopi.

Odklenite sponko za kabel, skozi njo napeljite kabel, kot je prikazano spodaj, nato pa
zaklenite sponko.

A: Sponka za kabel
B: Zaklep sponke za kabel
C: Kabel omrežnega napajalnika

3

Prepričajte se, da se indikator POWER na sprednji strani enote spremeni iz
utripajoče zelene v stalno zeleno in se je zagon končal.

Ko se je enota normalno zagnala in je povezana z omrežjem, indikator NETWORK sveti
zeleno.

Ko uporabljate objektiv, ki ne podpira funkcije obračanja/nagibanja, zaklenite ročico za
zaklepanje obračanja/nagibanja in preskočite naslednje korake. Za podrobnosti o
objektivih, ki podpirajo obračanje/nagibanje, se obrnite na prodajalca izdelkov Sony ali
servisnega predstavnika družbe Sony.

4
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Opomba

Uporabljajte samo omrežni napajalnik ali napajalni kabel, ki je priložen tej enoti. Priključitev drugega
napajalnika ali napajalnega kabla lahko povzroči požar ali okvaro.

Omrežnega napajalnika ne priklopite in ne uporabljajte v omejenem prostoru, na primer med zidom
in pohištvom.

Ne povzročite kratkega stika na kovinskih delih vtiča omrežnega napajalnika. V nasprotnem primeru
lahko povzročite okvaro.

Omrežni napajalnik priklopite v najbližjo električno vtičnico. Če se med delovanjem pojavi težava,
takoj izvlecite napajalni kabel iz električne vtičnice.

Ko omrežni napajalnik odklopite z enote, primite vtič in ga izvlecite naravnost. Če boste vlekli kabel,
lahko pride do okvare.

[32] Priprava Priključitev napajanja

Uporaba napajanja PoE++

Ko je enota priključena na napravo za dovajanje energije, združljivo s PoE++, se enota napaja
prek omrežnega kabla, ki je dostopen na trgu.
Ta metoda omogoča napajanje enote brez potrebe po napajalni napeljavi v okoljih, kjer v bližini
namestitvenega mesta ni napajalne vtičnice.

Opomba

Če se enota napaja s PoE++, funkcij snemanja in predvajanja ne morete uporabljati s snemalnim
medijem, vstavljenim v enoto.

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj UNLOCK, da odklenete
obračanje/nagibanje glave kamere.

5

Ponastavite obračanje/nagibanje.

Za podrobnosti si oglejte razdelek "Ponastavitev obračanja/nagibanja".

6

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

1
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Z omrežnim kablom, ki je dostopen na trgu, povežite enoto in napravo za dovajanje
energije, združljivo s PoE++.

A: Omrežni kabel
B: Naprava za dovajanje energije, združljiva s PoE++

2

Prepričajte se, da se indikator POWER na sprednji strani enote spremeni iz
utripajoče zelene v stalno zeleno in se je zagon končal.

Ko se je enota normalno zagnala in je povezana z omrežjem, indikator NETWORK sveti
zeleno.

Opomba

Če se enota napaja s PoE++, se začetno preverjanje pristnosti izvede v časovnem intervalu do
zaključka zagona.

Ko uporabljate objektiv, ki ne podpira funkcije obračanja/nagibanja, zaklenite ročico za
zaklepanje obračanja/nagibanja in preskočite naslednje korake. Za podrobnosti o objektivih, ki
podpirajo obračanje/nagibanje, se obrnite na prodajalca izdelkov Sony ali servisnega

3
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Opomba

Enota je skladna s standardom IEEE802.3bt (tip 4, razred 8). Za podrobnosti o preverjenih združljivih
napravah za napajanje PoE++ se obrnite na prodajalca izdelkov Sony ali servisnega predstavnika
družbe Sony.

Enota je skladna s šibkim preverjanjem pristnosti (LLDP), vendar bo morda potrebna konfiguracija
omrežnih naprav (skladne s standardom IEEE802.3bt).

Ne priključite omrežnega napajalnika, ko uporabljate napajanje PoE++ z vklopljenim šibkim
preverjanjem pristnosti (LLDP).

Če sta istočasno priključena omrežni napajalnik in naprava za napajanje PoE++, se enota napaja
prek omrežnega napajalnika.

Pri dovajanju energije s PoE++ uporabite omrežni kabel kategorije 5e ali višje.

Po ponovnem vklopu enote, ki se napaja s PoE++, počakajte približno 10 sekund.

Ko uporabljate napajanje PoE++, priključite ozemljitveni priključek na ozemljitev.

Pri povezovanju enote, ki se napaja s PoE++, ne napeljite kablov na prostem.

[33] Priprava

Ponastavitev obračanja/nagibanja

Z naslednjim postopkom lahko ponastavite obračanje/nagibanje, na primer ob zamenjavi
objektiva.

predstavnika družbe Sony.

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj UNLOCK, da odklenete
obračanje/nagibanje glave kamere.

4

Ponastavite obračanje/nagibanje.

Za podrobnosti si oglejte razdelek "Ponastavitev obračanja/nagibanja".

5

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj UNLOCK in preverite,
ali je funkcija obračanja/nagibanja glave kamere odklenjena.

1
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[34] Priprava Konfiguriranje pred snemanjem Inicializacija enote s spletno aplikacijo

Dostopanje do spletne aplikacije iz spletnega
brskalnika

Če enoto povežete s tabličnim računalnikom ali osebnim računalnikom, jo lahko upravljate in
konfigurirate iz spletnega brskalnika.

Izvedite funkcijo ponastavitve obračanja/nagibanja.

Ponastavitev obračanja/nagibanja lahko izvedete z infrardečim daljinskim upravljalnikom,
spletno aplikacijo ali daljinskim upravljalnikom RM-IP500 (izbirno).
Upravljanje z infrardečim daljinskim upravljalnikom: pritisnite gumb P/T RESET.

Upravljanje z infrardečim daljinskim upravljalnikom: pritisnite gumb P/T RESET.
Upravljanje s spletno aplikacijo: pritisnite gumb [Pan-Tilt Reset] na zavihku  (drugo)
na zaslonu delovanja v živo.
Upravljanje z daljinskim upravljalnikom RM-IP500: oglejte si navodila za uporabo
daljinskega upravljalnika RM-IP500.

Opomba

Izvajanje ponastavitve obračanja/nagibanja povzroči obračanje glave kamere in objektiva. Pred
izvajanjem se prepričajte, da objektiv ni oviran.

Enota ima funkcijo, ki omejuje območje obračanja/nagibanja, a je ta funkcija onemogočena ob
vklopu enote ali izvajanju ponastavitve obračanja/nagibanja.

Namig

Ko je ponastavitev obračanja/nagibanja končana, se enota vrne v položaj pred izvedbo.

2

Preverite, ali tablični računalnik ali osebni računalnik podpira delovanje spletne
aplikacije.

1

Element Zahteva

Prikaz

Priporočena ločljivost 1080 × 810
slikovnih pik ali višja 
Velikost zaslona tabličnega
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Opomba

Če zahtevani pogoji za okolje niso izpolnjeni ali pa se tablični računalnik/osebni računalnik
uporablja na določen način, lahko to negativno vpliva na videoprikaz v spletnem brskalniku.

Spletna aplikacija te enote uporablja JavaScript. Če na tabličnem računalniku/osebnem
računalniku uporabljate protivirusno programsko opremo, spletna stran morda ne bo prikazana
pravilno.

računalnika: priporočena velikost 10
palcev ali večja

Podprt operacijski
sistem in spletni
brskalnik

Windows

OS Windows 10 ali novejši

Spletni
brskalnik

Google Chrome

Mac

OS macOS 10.15 ali novejši

Spletni
brskalnik

Google Chrome 
Safari

iPad

OS iPadOS 15 ali novejši

Spletni
brskalnik

Google Chrome 
Safari

Android

OS Android 12 ali novejši

Spletni
brskalnik

Google Chrome

Prepričajte se, da so enota, tablični računalnik ali osebni računalnik in zunanje
naprave vklopljene.

2

Prepričajte se, da sta enota in tablični računalnik ali osebni računalnik povezana
prek brezžične povezave Wi-Fi ali žične povezave LAN.

3

Iz spletnega brskalnika tabličnega računalnika ali osebnega računalnika vzpostavite
povezavo z enoto.

Povezovanje prek kode QR
S kamero v tabličnem računalniku skenirajte kodo QR, ki je natisnjena na pokrovu reže za
pomnilniško kartico na strani enote.

4
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Opomba

Če je bila številka vrat HTTP spremenjena iz vrednosti 80, v naslovno vrstico vnesite "http://naslov IP
enote:številka vrat".

Pri povezovanju prek kode QR ali vnosu spletnega naslova v naslovno vrstico spletnega brskalnika
uporabite napravo, ki podpira mDNS*.

Namig

Naknadno lahko do enote hitro dostopate s funkcijo zaznamkov v spletnem brskalniku.

Odprite prikazano povezavo v tabličnem računalniku.
Zažene se spletni brskalnik in prikaže se zaslon spletne aplikacije enote.

Povezovanje z vnosom spletnega naslova v naslovno vrstico spletnega brskalnika
V tabličnem računalniku ali osebnem računalniku zaženite spletni brskalnik in vnesite
spletni naslov, ki je natisnjen na pokrovu reže za pomnilniško kartico na strani enote.
V spletnem brskalniku mora biti prikazan zaslon spletne aplikacije enote.

Povezovanje z vnosom naslova IP enote v naslovno vrstico spletnega brskalnika
V tabličnem računalniku ali osebnem računalniku zaženite spletni brskalnik in v naslovno
vrstico vnesite "http://naslov IP enote".
V spletnem brskalniku mora biti prikazan zaslon spletne aplikacije enote.

mDNS: komunikacijski protokol, ki se uporablja za določanje naslova IP iz imena gostitelja v lokalnem omrežju.*
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[35] Priprava Konfiguriranje pred snemanjem Inicializacija enote s spletno aplikacijo

Inicializacija enote

Ob prvi uporabi enote jo morate obvezno konfigurirati po naslednjem postopku.

Namig

Če se pomožna baterija popolnoma izprazni, boste morali ponovno konfigurirati začetno nastavitev.

S tabličnim računalnikom ali osebnim računalnikom se povežite z enoto in zaženite
spletno aplikacijo.

Ob prvi uporabi enote boste pozvani, da v spletni brskalnik vnesete uporabniško ime in
geslo. Vnesite naslednje nastavitve.

Uporabniško ime: admin
Geslo: (pustite prazno)

Sledite navodilom na zaslonu, da konfigurirate začetno nastavitev.

1

Vnesite uporabniško ime in geslo skrbnika (Administrator) ter pritisnite gumb [OK].

1: Vnesite uporabniško ime skrbnika.
2: Nastavite geslo skrbnika.

2



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

3: Za potrditev znova vnesite isto geslo.

Opomba

V uporabniškem imenu in geslu lahko uporabite naslednje znake. Geslo mora vsebovati vsaj
eno veliko črko, eno malo črko, eno številko ter biti dolgo med 8 in 64 znakov.

Alfanumerični znaki
Simboli (!$%`*+-./<=>?@[]^_{|}~)

Spletni brskalnik se bo znova naložil in pozvani boste, da vnesete uporabniško ime in
geslo.

Vnesite uporabniško ime in geslo, ki ste ju konfigurirali v koraku 2.

Prikaže se zaslon za nastavitev jezika in ure.

3

Določite naslednje elemente in pritisnite gumb [OK].

[Language]
Izberite jezik, ki se bo uporabljal za spletno aplikacijo in prikaz zaslona kamere. S
spreminjanjem jezika se bo spremenil jezik prikaza spletne aplikacije.
[Date & Time Format]
Med naslednjimi možnostmi izberite obliko prikaza za datum in uro.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
[y] označuje leto, [m] označuje mesec, [d] označuje dan, [h] označuje uro, [m] označuje
minuto in [s] označuje sekundo.

4
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Prikaže se zaslon v živo za operacije snemanja. Nadaljujte s konfiguriranjem osnovnih funkcij
enote v skladu z načinom delovanja.

[36] Priprava Konfiguriranje pred snemanjem

Konfiguriranje osnovnih funkcij

Ta tema opisuje, kako konfigurirati enoto za osnovno delovanje.

Nastavitev snemalnega načina

Izbirate lahko med načinom snemanja "Custom" za fleksibilno ustvarjanje posnetkov med
snemanjem in načinom snemanja "Cine EI", v katerem enoto upravljate podobno kot filmsko
kamero, kjer se razvijanje posnetega materiala izvede v postprodukciji.
Način snemanja preklopite z uporabo možnosti [Project] > [Base Setting] > [Shooting Mode] v
spletnem meniju ali meniju kamere.

Način Custom
V načinu snemanja Custom lahko izberete video standard.
Preklopite z uporabo možnosti [Project] > [Base Setting] > [Target Display] v spletnem meniju
ali meniju kamere.
[SDR(BT.709)]: snemanje v skladu s standardom oddajanja v visoki ločljivosti
[HDR(HLG)]: snemanje v skladu s standardom oddajanja v ločljivosti 4K naslednje generacije

Za podrobnosti si oglejte razdelek "Pregled videza" in druge teme v poglavju "Snemanje z
želenim videzom".

Način Cine EI

[12 h/24 h]
Izberite možnost [12 h] (12-urni način) ali [24 h] (24-urni način) za prikaz časa.
[Time Setting]
Izberite način nastavitve datuma/ure.
[Synchronize with PC]: sinhronizirajte z datumom/uro v osebnem računalniku ali tabličnem
računalniku.
[Manual setting]: nastavite ročno. Ko izberete to metodo, se prikažejo polja za vnos
datuma in ure.
[Time Zone]
Izberite časovni pas.
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Ko je način snemanja nastavljen na način Cine EI, izberite barvni prostor za signal snemanja in
izhodni signal. Tukaj izbran barvni prostor je barvni prostor video izhoda, ko je [MLUT]
nastavljen na [Off].
Preklopite z uporabo možnosti [Project] > [Cine EI Setting] > [Color Gamut] v meniju kamere.
[S-Gamut3.Cine/SLog3]: enostavno nastavljiv barvni obseg za digitalni kino (DCI-P3)
[S-Gamut3/SLog3]: Sonyjeva široka barvna lestvica, ki zajema barvni prostor ITU-R BT.2020

Za podrobnosti si oglejte razdelek "Snemanje s prilagajanjem videza v postprodukciji".

Opomba

V načinu Cine EI naslednjih funkcij ni mogoče samodejno prilagoditi (sledenje).
Nastavitev beline
Ojačitev
Zaklop

V načinu Cine EI ni mogoče spreminjati nastavitev za naslednje funkcije.
Občutljivost ISO/ojačitev (nastavljeno na osnovno občutljivost ISO (fiksno))
Nastavitve menija [Paint/Look] (razen Base Look)
Scenska datoteka (onemogočeno)

Sledeče funkcije so na voljo samo v načinu Cine EI.
Monitor LUT
Indeks osvetlitve

Namig

V načinu Cine EI se snemanje izvaja pri osnovni občutljivosti ISO brez uporabe ojačitve, da se
doseže čim večja zmogljivost slikovnega senzorja. Svetlost se prilagodi z osvetlitvijo in filtrom ND, s
čimer se nastavi količina svetlobe, ki doseže slikovni senzor.

Nastavitev sistemske frekvence

Preklopite z uporabo možnosti [Project] > [Rec Format] > [Frequency] v spletnem meniju ali
meniju kamere. Enota se lahko po preklopu samodejno ponovno zažene, kar je odvisno od
izbrane vrednosti.

Opomba

Sistemske frekvence ne morete spremeniti med snemanjem ali predvajanjem.

Nastavitev načina zajemanja slike

Nastavite lahko efektivno velikost slike in ločljivost slikovnega senzorja.
Preklopite z uporabo možnosti [Project] > [Rec Format] > [Imager Scan Mode] v spletnem
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meniju ali meniju kamere.
[FF]: velikost polnega formata
[S35]: velikost Super 35 mm

Opomba

Načina zajemanja slike ne morete spreminjati med snemanjem ali predvajanjem.

Ko je nastavljen na S35, je video format omejen na ločljivost 1920×1080.

Nastavitev kodeka

Nastavite lahko kodek za snemanje.
Preklopite z uporabo možnosti [Project] > [Rec Format] > [Codec] v spletnem meniju ali meniju
kamere.

Opomba

Kodeka ne morete spreminjati med snemanjem ali predvajanjem.

Nastavitev video formata

Nastavite lahko video format za snemanje in izhodni format za izhod iz kamere.

Video format za snemanje preklopite z uporabo možnosti [Project] > [Rec Format] > [Video
Format] v spletnem meniju ali meniju kamere.
Izhodni format iz priključkov SDI OUT in HDMI OUT preklopite z uporabo možnosti
[Monitoring] > [Output Format] v spletnem meniju ali meniju kamere.

Opomba

Video formata ne morete spreminjati med snemanjem ali predvajanjem.

Pri signalu na priključkih SDI OUT in HDMI OUT lahko obstajajo omejitve, kar je odvisno od
nastavljenega video formata.

[37] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Podprte pomnilniške kartice

Enota snema zvok in video na pomnilniške kartice CFexpress Type A (naprodaj ločeno) ali
pomnilniške kartice SDXC (naprodaj ločeno), ki jih vstavite v reže za kartice. Pomnilniške



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

kartice se uporabljajo tudi za snemanje proxy.

Pomnilniške kartice CFexpress Type A

Uporabljajte pomnilniške kartice Sony CFexpress Type A*, ki so navedene v razdelku
"Priporočeni pomnilniški mediji" v enoti.
Za podrobnosti o delovanju s pomnilniškimi karticami drugih proizvajalcev glejte navodila za
uporabo konkretnega pomnilniškega medija ali poiščite proizvajalčeve podatke.

Pomnilniške kartice SDXC

Uporabljajte pomnilniške kartice SDXC*, ki so navedene v razdelku "Priporočeni pomnilniški
mediji" v enoti.

Priporočeni pomnilniški mediji

Zagotovljeni pogoji delovanja se razlikujejo glede na format snemanja in nastavitev snemanja.

CFexpress Type A
Skladno z VPG400
Podprto za vse formate snemanja enote.

SDXC
Podprto pod pogoji iz naslednje tabele. "Da" označuje, da je bilo delovanje preverjeno, "Ne" pa
označuje, da delovanje ni zagotovljeno.

RAW Out & XAVC-I, 4096×2160 razred 300, običajni način

V tem vodniku za pomoč se imenujejo "kartice CFexpress".*

V tem vodniku za pomoč se imenujejo "kartice SD".*

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

24P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da
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RAW Out & XAVC-I, 3840×2160 razred 300, običajni način

RAW Out & XAVC-I, 3840×2160 razred 300, S&Q (60 sličic na sekundo ali manj)

RAW Out & XAVC-I, 3840×2160 razred 300, S&Q (100 sličic na sekundo, 120 sličic na
sekundo)
Preverjeni mediji niso na voljo.

XAVC-I, 4096×2160 razred 300, običajni način

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da
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XAVC-I, 4096×2160 razred 300, S&Q (60 sličic na sekundo ali manj)

XAVC-I, 3840×2160 razred 300, običajni način

XAVC-I, 3840×2160 razred 300, S&Q (60 sličic na sekundo ali manj)

25P Ne Ne Ne Ne Ne Da Da

24P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

24P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da

50P Ne Ne Ne Ne Ne Ne Da
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XAVC-I, 3840×2160 razred 300, S&Q (100 sličic na sekundo, 120 sličic na sekundo)
Preverjeni mediji niso na voljo.

XAVC-I, 1920×1080 razred 100, običajni način

XAVC-I, 1920×1080 razred 100, S&Q (60 sličic na sekundo ali manj)

XAVC-I, 1920×1080 razred 100, S&Q (100 sličic na sekundo, 120 sličic na sekundo)

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Ne Da
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XAVC-I, 1920×1080 razred 100, S&Q (150 sličic na sekundo, 180 sličic na sekundo)
Preverjeni mediji niso na voljo.

XAVC-I, 1920×1080 razred 100, S&Q (200 sličic na sekundo, 240 sličic na sekundo)
Preverjeni mediji niso na voljo.

XAVC-L, 3840×2160 420, običajni način

XAVC-L, 3840×2160 420, S&Q (60 sličic na sekundo ali manj)

50P Ne Ne Ne Ne Ne Ne Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Ne Da
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XAVC-L, 3840×2160 420, S&Q (100 sličic na sekundo, 120 sličic na sekundo)

XAVC-L, 1920×1080 HD50, običajni način

XAVC-L, 1920×1080 HD50, S&Q (60 sličic na sekundo ali manj)

XAVC-L, 1920×1080 HD50, S&Q (100 sličic na sekundo, 120 sličic na sekundo)

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Ne

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da
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XAVC-L, 1920×1080 HD50, S&Q (150 sličic na sekundo, 180 sličic na sekundo)

XAVC-L, 1920×1080 HD50, S&Q (200 sličic na sekundo, 240 sličic na sekundo)

XAVC-L, 1920×1080 HD35, običajni način

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Ne Ne Ne Da Da

50P Ne Ne Ne Ne Ne Da Da

29,97P Ne Ne Ne Ne Ne Ne Da

25P Ne Ne Ne Ne Ne Ne Da

23,98P Ne Ne Ne Ne Ne Ne Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90
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XAVC-L, 1920×1080 HD35, S&Q (60 sličic na sekundo ali manj)

XAVC-L, 1920×1080 HD35, S&Q (100 sličic na sekundo, 120 sličic na sekundo)

XAVC-L, 1920×1080 HD35, S&Q (150 sličic na sekundo, 180 sličic na sekundo)

59,94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29,97P Da Da Da Da Da Da Da

25P Da Da Da Da Da Da Da

23,98P Da Da Da Da Da Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Da Ne Da Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Da Ne Da Da Da

25P Ne Ne Da Ne Da Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da
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XAVC-L, 1920×1080 HD35, S&Q (200 sličic na sekundo, 240 sličic na sekundo)

[38] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Vstavljanje pomnilniških kartic

Ta tema opisuje previdnostne ukrepe pri vstavljanju pomnilniških kartic.

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Da Da

Sistemska frekvenca Razred 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59,94P Ne Ne Da Ne Da Da Da

50P Ne Ne Da Ne Da Da Da

29,97P Ne Ne Ne Ne Ne Da Da

25P Ne Ne Ne Ne Ne Da Da

23,98P Ne Ne Ne Ne Ne Ne Da

Odprite pokrov reže za pomnilniško kartico.1

Vstavite pomnilniško kartico.

Pri karticah CFexpress mora biti nalepka zgoraj.

2
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Opomba

Pri enoti, nameščeni na strop, mora biti nalepka spodaj.

Pri karticah SD mora biti nalepka spodaj.

Opomba

Pri enoti, nameščeni na strop, mora biti nalepka zgoraj.

Indikator dostopa zasveti v rdeči barvi in če je kartica uporabna, se barva spremeni v
zeleno.

Opomba

Če indikator dostopa neprekinjeno utripa rdeče in ne preklopi na zeleno, začasno izklopite
enoto ter odstranite in ponovno vstavite pomnilniško kartico.

Zaprite pokrov reže za pomnilniško kartico.3
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Opomba

Če poskušate pomnilniško kartico vstaviti v nepravilnem položaju in s silo, se pomnilniška kartica,
reža za pomnilniško kartico in podatki na pomnilniški kartici lahko poškodujejo.

Ko snemate na pomnilniški kartici, vstavljeni v reži A in B za kartice CFexpress Type A/SD, v obe
reži vstavite takšni kartici, kot sta priporočeni za snemanje v izbranem formatu.

[39] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Odstranjevanje pomnilniške kartice

Odprite pokrov reže za pomnilniško kartico in rahlo pritisnite na pomnilniško kartico, da jo
izvržete.

Opomba

Celovitost podatkov na kartici ne bo zagotovljena, če izklopite enoto ali odstranite pomnilniško
kartico, medtem ko je dostop do kartice še v teku. Vsi podatki, zapisani na kartici, bodo lahko
zavrženi. Pred izklopom enote ali odstranitvijo pomnilniške kartice se vedno prepričajte, da je
indikator dostopa zelen ali izklopljen.

Če pomnilniško kartico odstranite takoj po zaključenem snemanju, je pomnilniška kartica lahko še
vroča, kar pa ni znak težav.

[40] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Formatiranje (inicializiranje) pomnilniških kartic

Če vstavite neformatirano pomnilniško kartico ali pomnilniško kartico, ki je bila formatirana z
drugačnimi specifikacijami, se na slikovni plošči kamere prikaže sporočilo "Media Needs to be
Formatted".
Kartico formatirajte po naslednjem postopku.

Izberite možnost [TC/Media] > [Format Media] v meniju kamere.1

Izberite možnost Media(A) (reža A) ali Media(B) (reža B), nato pa izberite način
formatiranja (Full Format ali Quick Format).

2
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Opomba

Formatiranje pomnilniške kartice izbriše vse podatke, vključno z videoposnetki in nastavitvenimi
datotekami.

Med izvajanjem se lahko izpišejo sporočila, kar je odvisno od trajanja postopka formatiranja.

Če formatiranje ne uspe
Pomnilniških kartic, ki jih enota ne podpira, ni mogoče formatirati.
Prikaže se opozorilno sporočilo. Sledite navodilom in zamenjajte kartico s podprto pomnilniško
kartico.

Uporaba kartice, formatirane v enoti, v reži druge naprave
Najprej naredite varnostno kopijo kartice, nato ponovno formatirajte kartico v napravi, v kateri bo
uporabljena.

[41] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Preverjanje preostalega časa snemanja

Med snemanjem (snemanje/stanje pripravljenosti) lahko nadzorujete preostali prostor na
pomnilniški kartici v vsaki reži. To storite z uporabo indikatorja preostalega časa snemanja za
režo A/B na slikovni plošči kamere.
Preostali čas snemanja se izračunava na podlagi preostalega prostora na pomnilniškem mediju
v vsaki reži in trenutnega formata snemanja (bitna hitrost snemanja). Prikazan je v obliki minut.

Kdaj zamenjati pomnilniško kartico
Ko celotni preostali čas snemanja na obeh pomnilniških karticah pade pod 5 minut, se prikaže
sporočilo "Media Near Full" ter začne utripati indikator za snemanje na pomnilniško

Prikaže se potrditveno sporočilo.
[Full Format]: popolna ponastavitev medija, vključno z informacijami o regiji podatkov in
upravljanju podatkov.
[Quick Format]: samo ponastavitev informacij o upravljanju podatkov medija.

Izberite možnost [Execute].

Ko je formatiranje v teku, je prikazano sporočilo. Indikator dostopa sveti rdeče.
Ko je formatiranje zaključeno, se prikaže sporočilo o zaključku.

3
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kartico/snemanje v živo, da vas na to opozori.
Zamenjajte pomnilniški medij s praznim.
Če nadaljujete s snemanjem, dokler celoten preostali čas snemanja ne doseže ničle, se
sporočilo spremeni v "Media Full" in snemanje se ustavi.

Opomba

Na eno pomnilniško kartico je mogoče posneti do približno 600 posnetkov.

[42] Priprava Konfiguriranje pred snemanjem Priprava pomnilniških kartic

Obnovitev pomnilniških kartic

Če pride iz kateregakoli vzroka do napake na pomnilniški kartici, morate kartico pred uporabo
obnoviti.
Ko vstavite pomnilniško kartico, ki potrebuje obnovitev, se na slikovni plošči kamere prikaže
sporočilo, ki vas vpraša, ali jo želite obnoviti.

Obnovitev kartice
S puščičnimi gumbi na nadzorni plošči grafičnega uporabniškega vmesnika izberite možnost
[Execute] in pritisnite gumb [Set].
Ko je formatiranje v teku, sta prikazana sporočilo in stanje napredka (%). Indikator dostopa sveti
rdeče.
Ko je obnovitev zaključena, se prikaže sporočilo o zaključku.

Če obnovitev ne uspe
Pomnilniških kartic, na katerih je prišlo do pomnilniških napak, ni mogoče obnoviti. Prikaže
se opozorilno sporočilo. Sledite navodilom za zamenjavo pomnilniške kartice.
Pomnilniške kartice, na katerih je prišlo do pomnilniških napak, lahko postanejo uporabne,
če jih ponovno formatirate.
V nekaterih primerih je nekatere posnetke mogoče obnoviti, drugih ne. Obnovljene posnetke
je mogoče normalno predvajati.

Opomba

Za obnovitev pomnilniških medijev morate uporabljati enoto, s katero so bili ti posneti.

Pomnilniških medijev, posnetih z drugo napravo ali z enoto drugačne različice (celo istega modela),
morda ne bo mogoče obnoviti s to enoto.

Posnetkov, ki so krajši od 2 sekund, ni mogoče obnoviti.
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[43] Snemanje Osnovne funkcije

Začetek/zaustavitev snemanja

Ta tema opisuje začetek/zaustavitev snemanja.

Opomba

Ko se enota napaja s PoE++, snemanje in predvajanje nista podprta.

Priklopite potrebne naprave in se prepričajte, da je zagotovljeno napajanje enote in
zunanjih naprav.

1

Vstavite pomnilniško kartico.2

V zgornjem levem delu zaslona spletne aplikacije preverite stanje napajanja enote.

Ko je napajanje vklopljeno
Ko je enota vklopljena, je na stikalu za vklop v zgornjem delu zaslona spletne aplikacije
prikazano [Power ON].

Na sprednji strani enote zasveti indikator POWER, na zaslonu delovanja v živo v spletni
aplikaciji pa se prikaže slika kamere.

Opomba

Če geslo skrbnika ni bilo konfigurirano, se prikaže zaslon, ki vas pozove, da konfigurirate
geslo. Oglejte si razdelek "Inicializacija enote".

Ko je napajanje v stanju pripravljenosti
Ko je napajanje enote v stanju pripravljenosti, je na stikalu za vklop v spletni aplikaciji
prikazano [Power Standby].

3
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V tem stanju pritisnite stikalo za vklop in izberite [Power ON]. Enota se vklopi, na njeni
sprednji strani zasveti indikator POWER, na zaslonu delovanja v živo v spletni aplikaciji pa
se prikaže slika kamere.

Namig

Enoto lahko vklopite tudi z gumbom za vklop na priloženem infrardečem daljinskem
upravljalniku.

Pritisnite gumb za snemanje START/STOP.

Začne se snemanje in na enoti zasveti indikator za snemanje na pomnilniško
kartico/snemanje v živo (2 mesti).
Med snemanjem sveti gumb za snemanje START/STOP. Poleg tega sta prikazani ikona
za ciljni snemalni medij in [?Rec].

4
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Preklop napajanja enote v stanje pripravljenosti
Če želite napajanje enote nastaviti v stanje pripravljenosti, pritisnite stikalo za vklop v spletni
aplikaciji in izberite možnost [Power Standby].

Namig

Napajanje lahko v stanje pripravljenosti nastavite tudi z gumbom za vklop na priloženem infrardečem
daljinskem upravljalniku.

Če želite zaustaviti snemanje, znova pritisnite gumb za snemanje START/STOP.

Snemanje se zaustavi, indikator za snemanje na pomnilniško kartico/snemanje v živo (2
mesti), ki se nahaja na enoti, pa se izklopi.
Med stanjem pripravljenosti na snemanje ne sveti gumb za snemanje START/STOP.
Poleg tega sta prikazani ikona za ciljni snemalni medij in [Stby].

Namig

Snemanje lahko začnete/zaustavite tudi z gumbom za snemanje START/STOP na priloženem
infrardečem daljinskem upravljalniku.

5
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[44] Snemanje Osnovne funkcije

Preklapljanje med pomnilniškima karticama

Ko sta vstavljeni dve pomnilniški kartici, lahko med njima preklapljate s pritiskom gumba [Slot
Select] na nadzorni plošči za predvajanje v spletni aplikaciji.

Namig

Med pomnilniškima karticama lahko preklapljate tudi s pritiskom gumba SLOT SEL (izbira reže za
pomnilniško kartico (A)/(B)) na priloženem infrardečem daljinskem upravljalniku.

O preklopnem snemanju

Med snemanjem enota samodejno preklopi na drugo pomnilniško kartico, tik preden se prva
pomnilniška kartica zapolni (preklopno snemanje). Z neprekinjenim snemanjem lahko
nadaljujete z zamenjavo pomnilniške kartice, tako da polno pomnilniško kartico zamenjate z
novo.

Opomba

Med pomnilniškima karticama ne morete preklapljati v načinu predvajanja. Dodatno, neprekinjeno
predvajanje posnetka, ki se delno nahaja na pomnilniški kartici v reži A in delno na pomnilniški kartici
v reži B, ni podprto.

O posnetih podatkih

Ko ustavite snemanje, se video, zvočni in spremljajoči podatki od začetka do konca snemanja
shranijo v en sam "posnetek" na pomnilniški kartici.

Ime posnetka posnetih podatkov

Ime vsakega posnetka, ki ga posname enota, je samodejno dodeljeno z možnostjo [TC/Media]
> [Clip Name Format] v meniju kamere.

Najdaljše trajanje posnetka

Do 6 ur na posnetek.
Najdaljše trajanje neprekinjenega snemanja je enako najdaljšemu trajanju posnetka. Če čas
snemanja preseže najdaljše trajanje posnetka, se samodejno ustvari nov posnetek in snemanje
se nadaljuje. Nov posnetek se na zaslonu sličic prikaže kot ločen posnetek.
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Med preklopnim snemanjem se posname večje število posnetkov, kljub temu pa se bo
snemanje samodejno ustavilo po približno 24 urah.

Opomba

Ne odstranjujte pomnilniške kartice medtem, ko poteka snemanje. Med snemanjem lahko zamenjate
pomnilniške kartice samo v tistih režah, katerih indikator dostopa je izklopljen.

Ko preostala kapaciteta pomnilniške kartice, na katero se trenutno snema, znaša manj kot eno
minuto, in je v drugi reži vstavljena prazna pomnilniška kartica, se prikaže sporočilo "Will Switch
Slots Soon". Sporočilo izgine po preklopu med režama za pomnilniške kartice.

Preklopno snemanje morda ne bo delovalo, če začnete snemati, ko preostala kapaciteta pomnilniške
kartice znaša manj kot minuto. Da bo preklopno snemanje potekalo pravilno, pred začetkom
snemanja preverite, da preostala kapaciteta pomnilniške kartice znaša več kot minuto.

Videoposnetka, ki ga ustvarite s funkcijo preklopnega snemanja v enoti, ni mogoče neprekinjeno
predvajati na enoti.

Za združitev videoposnetkov, ustvarjenih s funkcijo preklopnega snemanja, uporabite programsko
opremo "Catalyst Browse".

[45] Snemanje Osnovne funkcije

Preverjanje zvoka

Zvok se predvaja prek priključkov SDI in HDMI na enoti. Z možnostjo [Audio] > [Audio Output] >
[HDMI/Stream Output CH] v meniju kamere izberite kombinacijo zvočnih kanalov, ki se
predvajajo prek priključka HDMI.
CH1/CH2: kombinacija CH1 in CH2
CH3/CH4: kombinacija CH3 in CH4
Pri spremljanju zvoka v spletni aplikaciji uporabite merilnik ravni zvoka v spodnjem desnem delu
slike kamere.

[46] Snemanje

Določanje podatkov o času

Ta tema opisuje, kako nastaviti podatke o času.

Nastavitev časovne kode
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Z možnostjo [TC/Media] > [Timecode] v meniju kamere nastavite časovno kodo za snemanje.

Nastavitev uporabniških bitov

Posneti sliki lahko dodate 8-mestno šestnajstiško število kot uporabniške bite. Uporabniške
bitne podatke lahko nastavite tudi trenutnemu času. Nastavitev izvedite z možnostjo [TC/Media]
> [Users Bit] v meniju kamere.

Prikaz podatkov o času

Z možnostjo [TC/Media] > [TC Display] > [Display Select] v meniju kamere nastavite časovno
kodo za prikaz.
Če pritisnete dodeljiv gumb z dodeljeno funkcijo [DURATION/TC/U-BIT], preklopite med
prikazom časovne kode, uporabniških bitov in trajanjem v sekvenci.

[47] Snemanje

Ogled posnetka (Rec Review)

Zadnji posneti videoposnetek si lahko ogledate na zaslonu (recording review).

Opomba

Funkcija ogleda posnetka ne deluje, če po snemanju posnetka spremenite video format.

Nastavitev začetnega položaja funkcije Rec Review

Začetni položaj predvajanja lahko nastavite na eno od sledečih možnosti. To storite z
nastavitvijo [Technical] > [Rec Review] v meniju kamere.

Predvajanje zadnjih 3 sekund videoposnetka
Predvajanje zadnjih 10 sekund videoposnetka
Predvajanje od začetka videoposnetka

Namig

Če si želite ogledati točno določen videoposnetek po tem, ko ste posneli več videoposnetkov,
pritisnite gumb [Thumbnail] za prikaz zaslona sličic in izberite videoposnetek za začetek predvajanja.

Za prikaz zaslona sličic lahko pritisnete tudi gumb THUMBNAIL na priloženem infrardečem
daljinskem upravljalniku.
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Način Rec Review

Funkcijo Rec Review predhodno dodelite enemu od dodeljivih gumbov na plošči za nastavitev
osnovne konfiguracije.

Za podrobnosti o dodelitvi si oglejte razdelek "Dodeljivi gumbi" v poglavju "Uporabne
funkcije".

Ustavite snemanje, nato pa za začetek predvajanja predhodno posnetega posnetka pritisnite
dodeljiv gumb, ki mu je dodeljena funkcija Rec Review.

Videoposnetek se predvaja do konca, funkcija Rec Review se zaključi in enota se vrne v način
Stby (stanje pripravljenosti).

Zaustavitev ogleda posnetka
Pritisnite dodeljiv gumb, ki ste mu dodelili funkcijo Rec Review, ali pritisnite gumb
[Cancel/Back].
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Namig

Za zaustavitev funkcije Rec Review lahko pritisnete tudi gumb [Cancel/Back] na priloženem
infrardečem daljinskem upravljalniku.

[48] Snemanje Prilagajanje okvirjanja

Zaslon prilagajanja okvirjanja

Okvirjanje lahko prilagajate z naslednjimi elementi zaslona delovanja v živo.



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Opomba

Glede na smer kamere, goriščno razdaljo objektiva in položaj zooma je lahko viden del enote ali
kablov, priključenih na priključni blok. Pred snemanjem preverite vidno polje za objektiv in goriščno
razdaljo, ki ju uporabljate. Območje obračanja/nagibanja lahko upravljate tudi z možnostjo [Pan-Tilt]
> [P/T Range Limit] v spletnem meniju. Ob vklopu enote ali izvajanju ponastavitve
obračanja/nagibanja se ta nastavitev omejitve območja ne upošteva. Za podrobnosti si oglejte [Pan-
Tilt] > [P/T Range Limit] v spletnem meniju.

Namig

Okvirjanje lahko upravljate tudi s priloženim infrardečim daljinskim upravljalnikom.

[49] Snemanje Prilagajanje okvirjanja Prilagajanje smeri snemanja

Prilagajanje smeri snemanja s spletno aplikacijo

Vodoravno premikanje kamere se imenuje obračanje, navpično premikanje kamere pa

Nadzorna plošča za prednastavljene položaje1.

Zavihek (glavni zaslon) / zavihek (drugo)2.

Nadzorna plošča za okvirjanje3.
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nagibanje.
Smer snemanja lahko prilagajate z upravljanjem obračanja/nagibanja.

Namig

Če je pod kontrolno palico prikazano [Execute Pan-Tilt Reset], je prišlo do nedoslednosti v izvirnih
informacijah o upravljanju obračanja/nagibanja enote. Izvedite funkcijo ponastavitve
obračanja/nagibanja, da posodobite izvirne informacije. Za podrobnosti si oglejte razdelek
"Ponastavitev obračanja/nagibanja".

Obračanje kamere nazaj na sprednjo stran
Pritisnite gumb [Pan-Tilt Home] v zavihku  (drugo) na nadzorni plošči kamere.

Opomba

Glede na smer kamere, goriščno razdaljo objektiva in položaj zooma je lahko viden del enote ali
kablov, priključenih na priključni blok. Pred snemanjem preverite vidno polje za objektiv in goriščno
razdaljo, ki ju uporabljate. Območje obračanja/nagibanja lahko upravljate tudi z možnostjo [Pan-Tilt]
> [P/T Range Limit] v spletnem meniju. Ob vklopu enote ali izvajanju ponastavitve
obračanja/nagibanja se ta nastavitev omejitve območja ne upošteva. Za podrobnosti si oglejte [Pan-
Tilt] > [P/T Range Limit] v spletnem meniju.

Pritisnite zavihek [Pan-Tilt-Zoom] na nadzorni plošči za okvirjanje, da prikažete
kontrolno palico.

1

Povlecite sredino kontrolne palice v smer, ki jo želite prikazati, medtem ko
spremljate slikovno ploščo kamere.

Smer in hitrost kamere se spreminjata glede na smer in raven vlečenja.
Obračanje/nagibanje lahko natančneje prilagajate s pritiskom na obrobna območja
kontrolne palice.

2
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[50] Snemanje Prilagajanje okvirjanja Prilagajanje smeri snemanja

Nastavitev hitrosti obračanja/nagibanja

Hitrost obračanja/nagibanja lahko spreminjate z drsnikom [Pan-Tilt Speed] na nadzorni plošči
kamere, in sicer tako, da upravljate kontrolno palico na nadzorni plošči za okvirjanje.

Opomba

Če se v območju gibanja kamere nahaja zid ali druga ovira, pazite, da med obračanjem/nihanjem ne
zadenete kamere ali objektiva.

Pospeševanje obračanja/nagibanja je odvisno od fizikalnih lastnosti, kot je uravnotežena teža
objektiva. Nastavitev pospeševanja lahko spremenite z možnostjo [Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] v spletnem meniju ali meniju kamere.

Pritisnite zavihek  (glavni zaslon) na nadzorni plošči kamere.1

S seznama izberite drsnik [Pan-Tilt Speed].

Če drsnik [Pan-Tilt Speed] ni prikazan, izberite enega od obeh gumbov za izbiro funkcije
drsnika, da se prikaže drsnik.

2

Premaknite gumb drsnika v levo ali desno.

S premikanjem gumba v levo zmanjšate hitrost upravljanja, s premikanjem gumba v desno
pa to hitrost povečate.

3
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[51] Snemanje Prilagajanje okvirjanja Prilagajanje smeri snemanja

Nastavitev pospeševanja obračanja/nagibanja

Pospeševanje lahko nastavite v devetih stopnjah, in sicer z uporabo možnosti [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] v spletnem meniju ali meniju kamere. Povečajte vrednost za
hitrejše spremembe hitrosti ali zmanjšajte vrednost za bolj postopne spremembe hitrosti.
Za večjo odzivnost pri upravljanju obračanja/nagibanja izberite vrednost v območju od 7 do 9.
Za večjo položajno natančnost na začetku/koncu premikanja v prednastavljen položaj je
priporočljiva vrednost v območju od 1 do 6.

Za podrobnosti o prednastavljenem položaju si oglejte razdelek "Shranjevanje/obnovitev
položaja obračanja/nagibanja in zooma".

Opomba

Ko je vrednost nastavljena visoko, funkcija morda ne bo delovala pravilno, če je nameščen težak
objektiv. Pred dejansko uporabo preverite delovanje.

Razmerje med nastavitvijo [Ramp Curve] in obračanjem/nagibanjem

Ob uporabi obračanja/nagibanja

Ob priklicu prednastavljenega položaja
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[52] Snemanje Prilagajanje okvirjanja Prilagajanje smeri snemanja

Prilagajanje smeri snemanja s priloženim infrardečim
daljinskim upravljalnikom

Smer snemanja lahko prilagajate z gumbi za upravljanje obračanja/nagibanja na priloženem
infrardečem daljinskem upravljalniku.

Pritisnite puščične gumbe za upravljanje obračanja/nagibanja.

Pritisnite puščični gumb smeri, ki jo želite prikazati, medtem ko spremljate sliko kamere.
Za premik na krajšo razdaljo le za trenutek pritisnite puščični gumb.
Za premik na daljšo razdaljo pritisnite in pridržite puščični gumb.
Za diagonalni premik pritisnite in pridržite gumb  (puščica navzgor) ali  (puščica
navzdol) ter pritisnite gumb  (puščica levo) ali  (puščica desno).

1
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Obračanje kamere nazaj na sprednjo stran
Pritisnite gumb HOME.

Opomba

Glede na smer kamere, goriščno razdaljo objektiva in položaj zooma je lahko viden del enote ali
kablov, priključenih na priključni blok. Pred snemanjem preverite vidno polje za objektiv in goriščno
razdaljo, ki ju uporabljate. Območje obračanja/nagibanja lahko upravljate tudi z možnostjo [Pan-Tilt]
> [P/T Range Limit] v spletnem meniju. Ob vklopu enote ali izvajanju ponastavitve
obračanja/nagibanja se ta nastavitev omejitve območja ne upošteva. Za podrobnosti si oglejte [Pan-
Tilt] > [P/T Range Limit] v spletnem meniju.

[53] Snemanje Prilagajanje okvirjanja Nastavitev zooma

Nastavitev vrste zooma

Vrsto zooma nastavite z možnostjo [Technical] > [Zoom] > [Zoom Type] v meniju kamere.
Vrsta zooma bo odvisna od vrste nameščenega objektiva.

Vrsta nameščenega objektiva
Nastavitev [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Objektiv s fiksnim
ostrenjem/objektiv z ročnim

Funkcija zooma ni
podprta.

Funkcija Clear Image Zoom je
podprta.
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Opomba

Funkcija Clear Image Zoom ni na voljo v naslednjih primerih.
Ko je možnost [Shooting] > [S&Q Motion] > [Setting] nastavljena na On in je nastavitev [Frame
Rate] v meniju kamere višja od 60 sličic na sekundo
Ko je možnost [Project] > [Rec Format] > [Codec] v meniju kamere nastavljena na [RAW] ali
možnost, ki vključuje RAW

Z izbirnim stikalom SERVO/MANUAL na objektivu ponastavite povečavo funkcije Clear Image Zoom
na 1×.

Med delovanjem funkcije Clear Image Zoom je območje ostrenja nastavljeno na Wide. Prav tako je
onemogočeno samodejno ostrenje z zaznavanjem obrazov/oči.

Ko je nastavljeno na [On(Clear Image Zoom)], je funkcija prednastavitve obračanja/nagibanja
onemogočena.

Clear Image Zoom

Enota je opremljena s funkcijo zooma, ki uporablja obdelavo signala slike, ki se imenuje Clear
Image Zoom. Ko je vklopljena funkcija Clear Image Zoom, zoom podpirajo tudi objektivi s
fiksnim ostrenjem. Uporablja se lahko tudi za razširitev območja, ki presega optično območje na
objektivu z motoriziranim zoomom.
Največje razmerje zooma pri uporabi funkcije Clear Image Zoom je odvisno od ločljivosti
snemanja.

Za ločljivost snemanja QFHD/4K: 1,5×
Za ločljivost snemanja v visoki ločljivosti: 2×

[54] Snemanje Prilagajanje okvirjanja Nastavitev zooma

Nastavitev zooma s spletno aplikacijo

Zoom enote lahko nastavljate z optičnim zoomom ali funkcijo Clear Image Zoom. Ta tema
opisuje, kako izvesti prilagoditve s spletno aplikacijo. Za podrobnosti o funkciji Clear Image
Zoom si oglejte razdelek "Nastavitev vrste zooma".

zoomom

Objektiv z motoriziranim
zoomom

Funkcija Optical zoom
only je podprta.

Optični zoom in funkcija Clear
Image Zoom sta podprta.

Pritisnite zavihek [Pan-Tilt-Zoom] na nadzorni plošči za okvirjanje, da prikažete1
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Opomba

Glede na smer kamere, goriščno razdaljo objektiva in položaj zooma je lahko viden del enote ali
kablov, priključenih na priključni blok. Pred snemanjem preverite vidno polje za objektiv in goriščno
razdaljo, ki ju uporabljate. Območje obračanja/nagibanja lahko upravljate tudi z možnostjo [Pan-Tilt]
> [P/T Range Limit] v spletnem meniju. Ob vklopu enote ali izvajanju ponastavitve
obračanja/nagibanja se ta nastavitev omejitve območja ne upošteva. Za podrobnosti si oglejte [Pan-
Tilt] > [P/T Range Limit] v spletnem meniju.

[55] Snemanje Prilagajanje okvirjanja Nastavitev zooma

Nastavitev hitrosti delovanja zooma

Hitrost delovanja zooma za drsnik [Zoom] na nadzorni plošči za okvirjanje lahko spreminjate z
drsnikom [Zoom Speed] na nadzorni plošči kamere.

nadzorno ploščo za obračanje/nagibanje.

Potisnite gumb drsnika [Zoom] v smeri [T] (telefoto) ali [W] (široki kot), da nastavite
zoom.

2

Pritisnite zavihek  (glavni zaslon) na nadzorni plošči kamere.1

S seznama izberite drsnik [Zoom Speed].

Če drsnik [Zoom Speed] ni prikazan, izberite enega od obeh gumbov za izbiro funkcije
drsnika, da prikažete drsnik.

2
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[56] Snemanje Prilagajanje okvirjanja Nastavitev zooma

Nastavitev zooma s priloženim infrardečim daljinskim
upravljalnikom

Zoom enote lahko nastavljate z optičnim zoomom ali funkcijo Clear Image Zoom. Ta tema
opisuje, kako izvesti prilagoditve s priloženim infrardečim daljinskim upravljalnikom. Za
podrobnosti o funkciji Clear Image Zoom si oglejte razdelek "Nastavitev vrste zooma".

 

Premaknite gumb drsnika [Zoom Speed] v levo ali desno.

S premikanjem gumba v levo zmanjšate hitrost upravljanja, s premikanjem gumba v desno
pa to hitrost povečate.

3

Pritisnite gumb zoom, da nastavite zoom.

Med spremljanjem zaslona pritisnite gumb T (telefoto) ali W (široki kot), da nastavite zoom.
Za povečavo pritisnite gumb T.
Za pomanjšavo pritisnite gumb W.

1
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Opomba

Glede na smer kamere, goriščno razdaljo objektiva in položaj zooma je lahko viden del enote ali
kablov, priključenih na priključni blok. Pred snemanjem preverite vidno polje za objektiv in goriščno
razdaljo, ki ju uporabljate. Območje obračanja/nagibanja lahko upravljate tudi z možnostjo [Pan-Tilt]
> [P/T Range Limit] v spletnem meniju. Ob vklopu enote ali izvajanju ponastavitve
obračanja/nagibanja se ta nastavitev omejitve območja ne upošteva. Za podrobnosti si oglejte [Pan-
Tilt] > [P/T Range Limit] v spletnem meniju.

[57] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Umerjanje objektiva serije E

Umerjanje popravi razlike v položaju zooma, ki pri uporabi objektiva serije E z motoriziranim
zoomom nastanejo zaradi razlik med posameznimi objektivi.
Za natančen izračun položaja zooma uporabite naslednji postopek, s katerim boste umerili
objektiv in posledično popravili posamezne razlike v objektivu.

Če ima objektiv stikalo SERVO/MANUAL, ga nastavite v položaj SERVO.

Opomba

Če stikalo nastavite na MANUAL, objektiv ne bo mogel prejemati navodil za zoom,
posredovanih z enote.

1

Zaženite umerjanje z uporabo možnosti [Technical] > [Lens] > [Lens Calibration] v
meniju kamere.

2
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Podatki o umerjanju
V enoto lahko shranite podatke o umerjanju za največ pet objektivov. Pri umerjanju šestega
ali vseh naslednjih objektivov bodo najstarejši podatki prepisani.
S pritiskom gumba  (stanje kamere) v skupnem območju zaslona spletne aplikacije in
izbiro možnosti [Lens] > [Calibration Data] lahko preverite, ali so za nameščen objektiv na
voljo podatki o umerjanju.

[58] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Shranjevanje/obnovitev nastavitve
obračanja/nagibanja, zooma in ostrenja z uporabo
spletne aplikacije

Nastavitve obračanja/nagibanja, zooma in ostrenja lahko shranite in jih po potrebi prikličete s
spletno aplikacijo.

Za podrobnosti o elementih, ki jih je mogoče shraniti/obnoviti, si oglejte razdelek
"Prednastavljen položaj shranjenih elementov".

Opomba

Ta funkcija je onemogočena, če je možnost [Technical] > [Zoom] > [Zoom Type] v meniju kamere
nastavljena na [On(Clear Image Zoom)].

Če spremenite nastavitev [Pan-Tilt] > [P/T Direction] [Ceiling] v spletnem meniju, se izbrišejo vsi
shranjeni prednastavljeni položaji.

Med umerjanjem se objektiv z zoomom samodejno premika in meri.

Z upravljanjem obračanja/nagibanja in zooma določite položaj, ki ga želite shraniti.1

Pritisnite gumb [+] na nadzorni plošči za prednastavljene položaje.

Na nadzorni plošči za prednastavljene položaje se prikaže slika s shranjenim položajem.

2
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Namig

Če se nadzorna plošča za prednastavljene položaje ne prikaže, pritisnite gumb  (odpri) in
omogočite njen prikaz.

Položaji so shranjeni v zaporedju od [Preset1].

Če so v zaporedju prednastavitev neuporabljene prednastavitve, bodo položaji shranjeni v
prednastavitvah, ki se začnejo z neuporabljenimi prednastavitvami. Če so na primer
prednastavitve položaja shranjene v možnostih [Preset1] in [Preset3], a ne v [Preset2], bodo
naslednje prednastavitve položaja shranjene v možnosti [Preset2], nato pa v [Preset4].

Shraniti je mogoče do 100 prednastavitev položajev.

Vsako prednastavitev položaja lahko preimenujete. Za podrobnosti si oglejte razdelek
"Preimenovanje prednastavitev položaja s spletno aplikacijo".

Obnovite shranjen položaj.

Za obnovitev ustreznega položaja na nadzorni plošči za prednastavljene položaje dvakrat
pritisnite sličico položaja, ki ga želite obnoviti.

Namig

Položaj lahko obnovite tudi s pritiskom slike, pritiskom gumba  (meni prednastavljenih
položajev), ki se pojavi, in izbiro možnosti [Recall].

Ko je položaj shranjen, je hitrost prehoda v shranjen položaj določena z nastavitvijo [Pan-Tilt] >
[P/T Preset] > [Common Speed] v spletnem meniju. Hitrost prehoda lahko spremenite tudi po
shranjevanju. Za podrobnosti si oglejte razdelek "Spreminjanje hitrosti prehoda prednastavitev
položaja".

Pri premiku v prednastavljen položaj lahko stopnjo spremembe položaja obračanja/nagibanja

3
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[59] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Preimenovanje prednastavitev položaja s spletno
aplikacijo

Prednastavitve položaja lahko preimenujete.

[60] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Zamenjava shranjenega položaja z novim položajem
prek spletne aplikacije

Shranjen položaj lahko zamenjate z novim položajem.

prilagodite z nastavitvami hitrosti prehoda in možnosti [Ramp Curve]. Za podrobnosti si oglejte
razdelka "Spreminjanje hitrosti prehoda prednastavitev položaja" in "Nastavitev pospeševanja
obračanja/nagibanja".

Pritisnite prednastavitev položaja, ki jo želite preimenovati.

V zgornjem desnem kotu slike se prikaže gumb  (meni prednastavljenih položajev).

1

Pritisnite gumb  (meni prednastavljenih položajev) in v prikazanem meniju izberite
možnost [Rename].

2

Vnesite novo ime prednastavitve.3

Z upravljanjem obračanja/nagibanja in zooma določite položaj, ki ga želite shraniti.1

Na nadzorni plošči za prednastavljene položaje pritisnite sliko položaja, ki jo želite
zamenjati.

V zgornjem desnem kotu zaslona se prikaže gumb  (meni prednastavljenih položajev).

2
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[61] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Brisanje shranjenega položaja s spletno aplikacijo

Prednastavitve položaja lahko izbrišete.

[62] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Spreminjanje hitrosti prehoda prednastavitev položaja

Pri obnovitvi shranjenega položaja lahko spremenite hitrost prehoda.

Pritisnite gumb  (meni prednastavljenih položajev) in v prikazanem meniju izberite
možnost [Replace].

Nov položaj zamenja trenutno nastavitev.

3

Na nadzorni plošči za prednastavljene položaje pritisnite sliko položaja, ki jo želite
izbrisati.

V zgornjem desnem kotu slike se prikaže gumb  (meni prednastavljenih položajev).

1

Pritisnite gumb  (meni prednastavljenih položajev) in v prikazanem meniju izberite
možnost [Delete].

Shranjen položaj se izbriše.

2

Nastavite možnost [Pan-Tilt] > [P/T Preset] > [Speed Select] v spletnem meniju na
[Separate].

1

Na nadzorni plošči za prednastavljene položaje pritisnite sliko za položaj, za
katerega želite spremeniti hitrost prehoda.

V zgornjem desnem kotu slike se prikaže gumb  (meni prednastavljenih položajev).

2
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Namig

Ko je možnost [Pan-Tilt] > [P/T Preset] > [Speed Select] nastavljena na [Common], bodo z uporabo
možnosti [Pan-Tilt] > [P/T Preset] > [Common Speed] vsi položaji obnovljeni z nastavljeno hitrostjo.

[63] Snemanje Prilagajanje okvirjanja Shranjevanje/obnovitev položaja kamere za
obračanje/nagibanje in zoom

Shranjevanje/obnovitev položaja za
obračanje/nagibanje in zoom s priloženim infrardečim
daljinskim upravljalnikom

Položaj obračanja/nagibanja in zooma lahko shranite in po potrebi prikličete s priloženim
infrardečim daljinskim upravljalnikom.

Pritisnite gumb  (meni prednastavljenih položajev) in v prikazanem meniju izberite
možnost [Speed].

3

Izberite želeno hitrost prehoda.

Ob naslednji obnovitvi shranjenega položaja se bo kamera premikala s konfigurirano
hitrostjo.

4

Prilagodite obračanje/nagibanje in zoom kamere.1

Pritisnite in pridržite gumb PRESET, nato pa pritisnite enega od gumbov od 1 do 3.

Položaj je shranjen.

2
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[64] Snemanje Prilagajanje ostrenja

Zaslon prilagajanja ostrenja

Ostrenje lahko prilagajate z naslednjimi elementi zaslona delovanja v živo.

Obnovite shranjen položaj.

Pritisnite enega od gumbov od 1 do 3 s shranjenim položajem, da obnovite ta položaj.

Namig

Pri infrardečem daljinskem upravljalniku se slika premakne v shranjeni položaj z največjo
hitrostjo.
Hitrost prehoda lahko spremenite tudi po shranjevanju. Za podrobnosti si oglejte razdelek
"Spreminjanje hitrosti prehoda prednastavitev položaja".

3
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[65] Snemanje Prilagajanje ostrenja Ročno prilagajanje ostrenja (Manual Focus)

Ročno prilagajanje s spletno aplikacijo

Ostrenje lahko ročno nastavite na primer v naslednjih primerih.

Subjekti, ki jih delno zakrivajo vodne kapljice
Subjekti z nizkim kontrastom glede na ozadje
Subjekti, ki so glede na bližnje subjekte bolj oddaljeni

Slikovna plošča kamere
Ostrenje lahko prilagajate z dotikom slike kamere. Upravljanje na dotik lahko onemogočite z
izklopom stikala [Touch Focus] na zavihku  (ostrenje) na nadzorni plošči kamere.

1.

Zavihek  (ostrenje) na nadzorni plošči kamere2.

Nadzorna plošča grafičnega uporabniškega vmesnika3.

Če je objektiv opremljen s stikalom za izbiro načina ostrenja, prestavite stikalo v
položaj "AF/MF" ali "AF".

1
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Namig

Samodejno ostrenje lahko uporabite tudi takrat, ko je ročna nastavitev glavna metoda upravljanja. Za
podrobnosti si oglejte razdelek "Ročna nastavitev cilja samodejnega ostrenja (AF Assist) s spletno
aplikacijo".

[66] Snemanje Prilagajanje ostrenja Ročno prilagajanje ostrenja (Manual Focus)

Ročno prilagajanje s priloženim infrardečim daljinskim
upravljalnikom

S priloženim infrardečim daljinskim upravljalnikom lahko ročno prilagajate ostrenje.

Opomba

Če je stikalo v položaju "Full MF" ali "MF", ostrenja objektiva ni mogoče upravljati z enote.
Oglejte si razdelek "Prilagajanje ostrenja pri objektivih s stikalom ostrenja" v poglavju
"Preverjanje stikal objektiva".

Na nadzorni plošči kamere potisnite stikalo [Auto Focus] v levi položaj, da izklopite
samodejno ostrenje.

Aktiviran je način ročnega ostrenja.

 (MF oz. ročno ostrenje)

2

Prilagodite z drsnikom na dnu zavihka  (ostrenje).3

Pritisnite gumb MF na infrardečem daljinskem upravljalniku.1

Z gumbom F (oddaljeno) in gumbom N (bližnje) ročno prilagodite ostrenje.

Za izostritev oddaljenega subjekta pritisnite gumb F.
Za izostritev bližnjega subjekta pritisnite gumb N.

2
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Namig

Samodejno ostrenje lahko uporabite tudi takrat, ko je ročna nastavitev glavna metoda upravljanja. Za
podrobnosti si oglejte razdelek "Ročno ostrenje med samodejnim ostrenjem s priloženim infrardečim
daljinskim upravljalnikom".

[67] Snemanje Prilagajanje ostrenja Ročno prilagajanje ostrenja (Manual Focus)

Ostrenje z določitvijo položaja ostrenja (Spot Focus)

V načinu ročnega ostrenja lahko na slikovni plošči kamere določite položaj, kjer želite prilagoditi
ostrenje.

V spletnem meniju ali meniju kamere nastavite možnost [Shooting] > [Focus] >
[Touch Function in MF] na [Spot Focus].

1

Potisnite stikalo [Touch Focus] na zavihku  (ostrenje) v desni položaj, da ga
vklopite.

2

Potisnite stikalo [Auto Focus] na zavihku  (ostrenje) v levi položaj, da ga izklopite.3

Določite položaj ostrenja.

Prikaže se označevalnik točkovnega ostrenja in izvede se prilagajanje slike, da je
izostrena na izbranem položaju.

4
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Opomba

Funkcija točkovnega ostrenja ne deluje, če je objektiv nastavljen na ročno ostrenje.

Namig

V načinu točkovnega ostrenja lahko pritisnete dodeljiv gumb, ki mu je dodeljena funkcija [Push
AF/MF], da začasno zaustavite točkovno ostrenje in omogočite samodejno ostrenje, medtem ko je
gumb pritisnjen. Ostrenje se povrne na ročno ostrenje, ko spustite gumb.

[68] Snemanje Prilagajanje ostrenja Ročno prilagajanje ostrenja (Manual Focus)

Začasna uporaba samodejnega ostrenja (Push Auto
Focus (AF))

Ko je omogočen način ročnega ostrenja, lahko ostrenje začasno prilagodite s samodejnim
ostrenjem, in sicer tako, da pritisnete gumb [Push AF/MF] in zagotovite samodejno ostrenje,
medtem ko je gumb pritisnjen.
To je uporabno, kadar želite med ročnim ostrenjem počasi premakniti ostrenje z enega na drug
subjekt.

Primer določitve položaja z upravljanjem na dotik

Nastavite možnost [Shooting] > [Focus] > [Push AF Mode] v meniju kamere na [AF].1

Potisnite stikalo [Auto Focus] na zavihku  (ostrenje) v levi položaj, da ga izklopite.2

Pritisnite gumb [Push AF/MF].3
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Opomba

Funkcija Push Auto Focus ne deluje, če je objektiv nastavljen na ročno ostrenje.

Namig

Enako delovanje omogoča tudi uporaba dodeljivega gumba, ki ste mu dodelili funkcijo [Push AF/MF].

[69] Snemanje Prilagajanje ostrenja Ročno prilagajanje ostrenja (Manual Focus)

Uporaba enkratnega samodejnega ostrenja (Push Auto
Focus (AF-S))

V načinu ročnega ostrenja lahko pritisnete gumb [Push AF/MF] za samodejno hitro izostritev.
Ta funkcija je priročna za izostritev subjekta pred snemanjem.

Samodejno ostrenje je aktivno, dokler je gumb pritisnjen.

Ko spustite gumb, se funkcija Push Auto Focus sprosti, ostrenje pa povrne na ročno
ostrenje.

V spletnem meniju ali meniju kamere nastavite možnost [Shooting] > [Focus] >
[Push AF Mode] na [Single-shot AF(AF-S)].

1

Z možnostjo [Shooting] > [Focus] > [Focus Area (AF-S)] v meniju kamere določite
položaj, za katerega želite prilagoditi ostrenje.

2
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Opomba

Funkcija Push Auto Focus ne deluje, če je objektiv nastavljen na ročno ostrenje.

Okvir območja ostrenja ni skrit, ko uporabljate gumb [Display].

Med delovanjem funkcije Clear Image Zoom ni mogoče nastaviti položaja okvirja [Focus Area (AF-
S)]. Ko je omogočena funkcija Push Auto Focus, samodejno ostrenje tudi daje prednost osrednjemu
delu.

Namig

Namig

Položaj lahko spremenite s pritiskom dodeljivega gumba, ki mu je dodeljena funkcija [Focus
Setting], da se okoli območja ostrenja prikaže oranžni okvir, in z izbiro položaja z upravljanjem
na dotik.

Potisnite stikalo [Auto Focus] na zavihku  (ostrenje) v levi položaj, da ga izklopite.3

Pritisnite gumb [Push AF/MF].

Če spustite gumb, preden se ostrenje konča, se funkcija Push Auto Focus ustavi.

Med delovanjem funkcije Push Auto Focus je stanje ostrenja prikazano z indikatorjem
ostrenja.
Vklopljen: izostritev je fiksirana na mesto ostrenja.
Utripa: ni izostreno. Ker enota ne izostri samodejno, spremenite kompozicijo in nastavitve
ostrenja, da dosežete izostritev.
Ostrenje se povrne na ročno ostrenje, ko spustite gumb.

4
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Enako delovanje omogoča tudi uporaba dodeljivega gumba, ki ste mu dodelili funkcijo [Push AF/MF].

Funkcijo [Push AF Mode] lahko dodelite tudi dodeljivemu gumbu.

Funkcijo [Focus Area (AF-S)] lahko dodelite tudi dodeljivemu gumbu.

Okvir območja ostrenja lahko prikažete/skrijete z uporabo možnosti [Monitoring] > [Display On/Off] >
[Focus Area Ind.(AF-S)] v meniju kamere.

[70] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Samodejno prilagajanje s spletno aplikacijo

Enota uporablja samodejno ostrenje s faznim zaznavanjem za hitro ostrenje ter samodejno
ostrenje z zaznavanjem kontrasta za visoko natančnost ostrenja.
Kombinacija teh dveh načinov omogoča samodejno ostrenje, ki je hitro in zelo natančno.

Opomba

Zahtevan je objektiv, ki podpira samodejno ostrenje.

Glede na razmere snemanja morda ne bo dosežena želena natančnost ostrenja.

Ostrenja ni mogoče prilagajati samodejno na objektivih serije A.

Če je objektiv opremljen s stikalom za izbiro načina ostrenja, prestavite stikalo v
položaj "AF/MF" ali "AF".

Opomba

Če je stikalo v položaju "Full MF" ali "MF", ostrenja objektiva ni mogoče upravljati z enote.
Oglejte si razdelek "Prilagajanje ostrenja pri objektivih s stikalom ostrenja" v poglavju
"Preverjanje stikal objektiva".

1

Na nadzorni plošči kamere potisnite stikalo [Auto Focus] v desni položaj, da ga
vklopite.

Aktiviran je način samodejnega ostrenja.

 (AF oz. samodejno ostrenje)

2
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Namig

Ko je omogočen način samodejnega ostrenja, lahko ostrenje prilagajate z drsnikom za ostrenje na
nadzorni plošči kamere. Za podrobnosti si oglejte razdelek "Ročna nastavitev cilja samodejnega
ostrenja (AF Assist) s spletno aplikacijo".

[71] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Samodejno prilagajanje s priloženim infrardečim
daljinskim upravljalnikom

S priloženim infrardečim daljinskim upravljalnikom lahko samodejno prilagajate ostrenje.

Opomba

Samodejno ostrenje lahko uporabite tudi takrat, ko je ročna nastavitev glavna metoda upravljanja. Za
podrobnosti si oglejte razdelek "Ročno ostrenje med samodejnim ostrenjem s priloženim infrardečim
daljinskim upravljalnikom".

[72] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Nastavitev območja/mesta samodejnega ostrenja

Pritisnite gumb AF na infrardečem daljinskem upravljalniku.

Izostritev subjekta se prilagodi samodejno.

1
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(Focus Area)

Nastavite lahko ciljno območje za samodejno ostrenje in prilagodite ostrenje za to območje.

Pritisnite gumb [Menu] na nadzorni plošči grafičnega uporabniškega vmesnika, da
odprete meni kamere.

1

Z možnostjo [Shooting] > [Focus] > [Focus Area] v meniju kamere nastavite ciljno
območje za samodejno ostrenje.

[Wide]:
Med ostrenjem išče subjekt na širokem območju slike. Okvir ni prikazan.

[Zone]:
Samodejno išče mesto ostrenja znotraj določenega območja.
Po izbiri določite mesto ostrenja z uporabo puščičnih gumbov na nadzorni plošči
grafičnega uporabniškega vmesnika.

2
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Opomba

Okvir območja ostrenja ni skrit, ko uporabljate gumb [Display] na slikovni plošči kamere.

Ko je omogočena funkcija Clear Image Zoom, je območje ostrenja nastavljeno na [Wide] (fiksno).

Namig

Okvir območja ostrenja lahko prikažete/skrijete z uporabo možnosti [Monitoring] > [Display On/Off] >
[Focus Area Indicator] v meniju kamere.

[73] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Hitra sprememba območja ostrenja (Focus Setting)

Na osrednji položaj se lahko vrnete tako, da pritisnete in pridržite gumb [Set].
[Flexible Spot]:
Izostri določeno mesto v sliki.
Po izbiri določite mesto ostrenja z uporabo puščičnih gumbov na nadzorni plošči
grafičnega uporabniškega vmesnika.

Na osrednji položaj se lahko vrnete tako, da pritisnete in pridržite gumb [Set].
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Položaj in velikost območja samodejnega ostrenja lahko hitro spremenite med samim
snemanjem, če dodeljivemu gumbu dodelite funkcijo [Focus Setting].

Za podrobnosti o dodeljivih gumbih si oglejte razdelek "Dodeljivi gumbi".

Delovanje je odvisno od nastavitve območja ostrenja.

Ko je možnost [Shooting] > [Focus] > [Focus Area] v meniju kamere
nastavljena na [Flexible Spot] ali [Zone]

Mesto območja ostrenja lahko spremenite tako, da pritisnete dodeljiv gumb, ki ste mu
dodelili funkcijo [Focus Setting], in uporabite puščične gumbe na nadzorni plošči grafičnega
uporabniškega vmesnika. Medtem ko prilagajate mesto območja ostrenja, lahko tega vrnete
v središče tako, da pritisnete gumb [Set].
Velikost območja ostrenja lahko spremenite tako, da pritisnete in pridržite dodeljiv gumb, ki
ste mu dodelili funkcijo [Focus Setting]. Po spreminjanju velikosti lahko spremenite mesto
območja ostrenja tako, da pritisnete gumb [Set]. Ko ste zaključili, pritisnite dodeljiv gumb, ki
ste mu dodelili funkcijo [Focus Setting], da se vrnete na izvorni zaslon.

Ko je možnost [Shooting] > [Focus] > [Focus Area] v meniju kamere
nastavljena na [Wide]

Spremenite lahko samo velikost območja ostrenja, tako da pritisnete in pridržite dodeljiv gumb,
ki ste mu dodelili funkcijo [Focus Setting]. Mesto ostrenja lahko spremenite, če najprej
spremenite tip ostrenja na [Flexible Spot] ali [Zone].

Namig

Ko je možnost [Shooting] > [Focus] > [Push AF Mode] v meniju kamere nastavljena na [Single-shot
AF(AF-S)] in stikalo [Auto Focus] nastavljeno v položaj OFF oz. izklop (način ročnega ostrenja),
lahko spremenite mesto območja ostrenja [Focus Area (AF-S)].

Okvir območja ostrenja je oranžne barve, ko je mesto območja ostrenja mogoče spreminjati.

[74] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Premikanje okvirja območja ostrenja z upravljanjem na
dotik (Touch Focus Area)

Mesto območja ostrenja lahko spremenite tako, da pritisnete dodeljiv gumb, ki ste mu dodelili
funkcijo [Focus Setting], in tako spremenite prikaz območja ostrenja v oranžno barvo, nato pa z
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upravljanjem na dotik premaknete okvir območja ostrenja na slikovni plošči kamere.
Tapnite zaslon, da premaknete območje ostrenja, pri čemer mora biti območje ostrenja na
sredini mesta, ki ste ga tapnili. Povlecite po zaslonu, da premaknete območje ostrenja na
mesto, kamor povlečete prst.

Namig

Funkcijo območja ostrenja z upravljanjem na dotik lahko vklopite/izklopite na zaslonu za snemanje z
uporabo dodeljivega gumba, ki ste mu dodelili funkcijo [Focus Setting].

Tapnite poljubno mesto.

Mesto, ki ste ga tapnili, postane središče območja ostrenja.

1

Povlecite po zaslonu, da premaknete območje ostrenja na mesto, kamor povlečete
prst.

2
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Opomba

Če tapnete mesto ali povlečete območje ostrenja na mesto zunaj območja nastavitve, bo območje
ostrenja nastavljeno na vrhu/dnu/levem robu/desnem robu območja nastavitve.

Ta funkcija ni na voljo v naslednjih okoliščinah.
Ko je stikalo [Auto Focus] izklopljeno na nadzorni plošči kamere.
Ko je stikalo [Touch Focus] izklopljeno na nadzorni plošči kamere.
Ko je okvir območja ostrenja prikazan s sivo barvo ali pa sploh ni prikazan.

[75] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Prilagajanje delovanja samodejnega ostrenja (AF
Transition Speed, AF Subject Shift Sensitivity)

Delovanje samodejnega ostrenja lahko prilagodite s spreminjanjem hitrosti prehoda in
občutljivosti pri prehodu med subjekti.

Nastavitev hitrosti prehoda samodejnega ostrenja

Nastavite lahko hitrost pogona ostrenja za primere, ko se subjekt spremeni. To storite z
uporabo možnosti [AF Transition Speed] na nadzorni plošči kamere.
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Izberite hitrost od [Speed 1] (počasi) do [Speed 7] (hitro) v korakih po 1. Pritisnite gumb < za
zmanjšanje vrednosti (počasneje) ali gumb > za povečanje vrednosti (hitreje).
Ko je izbrana nizka hitrost, se ostrenje pri spremembi subjekta, ki ga želite izostriti, premika
počasi in vam omogoča snemanje z impresivnim izrazom slike.
Ko je izbrana visoka hitrost, ostrenje hitro preklopi med subjektoma. V spodnjem primeru
ostrenje hitro preklopi s stavbe v ozadju na osebo, ki se sprehaja v ospredju. Subjekt, ki vstopi v
sliko, je takoj izostren. S tem je ta nastavitev idealna za dokumentarno snemanje, ki zahteva
hitro ostrenje.

Občutljivost samodejnega ostrenja pri prehodu med subjekti

Občutljivost za prehajanje med subjekti lahko nastavite z uporabo gumba [AF Subj. Shift Sens.]
na nadzorni plošči kamere.
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Izberite občutljivost od [Sens 1] (zaklenjeno na) do [Sens 5] (odzivno) v korakih po 1. Pritisnite
gumb < za zmanjšanje vrednosti (počasna sprememba) ali gumb > za povečanje vrednosti
(hitra sprememba).
Ko je izbrana nizka občutljivost, ostrenje ne preide takoj na drug subjekt, tudi če se drug subjekt
giblje pred izostrenim subjektom.

Ko je izbrana visoka občutljivost, ostrenje preide na subjekt, ki se giblje v ospredju.

Namig

Če je funkcija [AF Speed/Sens.] dodeljena dodeljivemu gumbu, so vrstice ravni za prilagajanje
vrednosti ob vsakem pritisku gumba prikazane na slikovni plošči kamere, in sicer v spodaj
zapisanem vrstnem redu. Tako lahko spremenite nastavitev hitrosti prehoda samodejnega ostrenja
in nastavitev občutljivosti samodejnega ostrenja pri prehodu med subjekti.
Hitrost prehoda samodejnega ostrenja › Občutljivost samodejnega ostrenja pri prehodu med subjekti
› Brez prikaza…

[76] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)
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Ročna nastavitev cilja samodejnega ostrenja (AF
Assist) s spletno aplikacijo

Po ročnem premikanju in prilagajanju ostrenja lahko upravljanje ostrenja preklopite na
samodejno ostrenje in tako zagotovite fino nastavitev ostrenja.

Opomba

V stanju AF assist je premikanje ostrenja oteženo, ne glede na nastavitev [Shooting] > [Focus] > [AF
Subj. Shift Sens.] v meniju kamere.

Nastavite možnost [Shooting] > [Focus] > [AF Assist] v meniju kamere na [On].1

Nastavite možnost [Shooting] > [Focus] > [AF Assist Control] v spletnem meniju na
[On].

2

Na nadzorni plošči kamere potisnite stikalo [Auto Focus] v desni položaj, da ga
vklopite.

Aktiviran je način samodejnega ostrenja.

3

Z drsnikom [Focus] na nadzorni plošči kamere nastavite cilj ostrenja.

[Near]: izostritev bližnjega subjekta
[Far]: izostritev oddaljenega subjekta

V stanju AF assist bo subjekt na razdalji, ki ste jo nastavili z drsnikom [Focus], samodejno
izostren.

4
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Stanje AF assist se izklopi na naslednje načine.
Ko subjekt, ki ste ga izostrili z drsnikom [Focus], ni več viden.
Ko preklopite na ročno ostrenje.
Ko sistem registrira obraz.

Namig

Stanje AF assist lahko hitro izklopite z dodeljivim gumbom, ki ste mu dodelili funkcijo [Push AF/MF].

Z uporabo drsnika [Focus] počistite izbiro registriranih obrazov.

V načinu Face/Eye Only AF funkcija samodejnega ostrenja izostri obraz, ki je najbližje mestu
ostrenja, ki ste ga nastavili z drsnikom [Focus].

[77] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Ročno ostrenje med samodejnim ostrenjem s
priloženim infrardečim daljinskim upravljalnikom

Ko je možnost [Shooting] > [Focus] > [AF Assist] v meniju kamere nastavljena na [On], lahko
gumba F (oddaljeno) in N (bližnje) na priloženem infrardečem daljinskem upravljalniku uporabite
celo med samodejnim ostrenjem in z njima prilagodite izostritev subjekta.

[78] Snemanje Prilagajanje ostrenja Samodejno prilagajanje ostrenja (Auto Focus)

Začasna uporaba ročnega ostrenja med samodejnim
ostrenjem (Push Manual Focus)

V načinu samodejnega ostrenja pritisnite gumb [Push AF/MF], da izvedete ročno ostrenje,
medtem ko držite pritisnjen gumb. Ostrenje se povrne na samodejno ostrenje, ko spustite
gumb.
To vam omogoča, da začasno ustavite samodejno ostrenje in ročno ostrite, kar je uporabno v
primerih, ko nekaj, kar ni subjekt snemanja, prečka sliko pred subjektom.
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Namig

Enako delovanje omogoča tudi uporaba dodeljivega gumba, ki ste mu dodelili funkcijo [Push AF/MF].

[79] Snemanje Prilagajanje ostrenja

Sledenje z zaznavanjem obrazov in oči (Face/Eye
Detection AF)

Enota lahko zazna obraze in oči ljudi kot cilj za sledenje ter prilagodi izostritev obrazov in oči v
območju ostrenja.
Ko kamera zazna obraze, se prikažejo sivi okvirji zaznavanja obrazov/oči. Ko je mogoče
samodejno ostrenje, okvirji postanejo beli in sledenje se začne. Ko kamera zazna oči in
prilagodi izostritev, se okvir zaznavanja obrazov/oči prikaže na očeh. Ko kamera zazna več
oseb, samodejno določi glavni subjekt.
Ta funkcija je na voljo le v načinu samodejnega ostrenja ali pri uporabi funkcije Push Auto
Focus.

Namig

Ko je območje ostrenja nastavljeno na [Zone] ali [Flexible Spot] in obrazi ali oči prekrivajo izbrano
območje ostrenja, se barva okvirjev zaznavanja obrazov/oči spremeni v belo, enota pa samodejno
izostri te obraze/oči.

Ob uporabi funkcije Push Auto Focus (AF-S) se barva okvirjev zaznavanja obrazov/oči, ki so
izostreni, spremeni v zeleno.

Nastavitev z uporabo gumba [Face/Eye Detection AF] na nadzorni plošči
kamere
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Pritisnite gumb [Face/Eye Detection AF] in nastavite delovanje samodejnega ostrenja z
zaznavanjem obrazov/oči.

[Face/Eye Only AF]: kamera zazna obraze/oči subjektov (oseb) ter izostri in sledi samo
njihovim obrazom/očem. Če kamera ne zazna obraza/oči, se samodejno ostrenje začasno
ustavi in prikaže se ikona  (način samodejnega ostrenja Face/Eye Only AF je začasno
ustavljen). Ta način je koristen takrat, ko želite samodejno izostriti in slediti samo
obrazom/očem.
[Face/Eye Priority AF]: kamera zaznava obraze/oči subjektov (oseb) in prednostno izostri/sledi
obrazom/očem. Če kamera ne zazna obraza ali oči, izvaja ostrenje v načinu samodejnega
ostrenja (privzeta nastavitev).
[AF]: funkcija samodejnega ostrenja z zaznavanjem obrazov/oči je onemogočena.

Opomba

Med uporabo funkcije Push Auto Focus je način [Face/Eye Priority AF] aktiviran tudi, če je trenutno
izbrana možnost [Face/Eye Only AF].

Ko je stikalo [Auto Focus] izklopljeno, je samodejno ostrenje z zaznavanjem obrazov/oči
onemogočeno (razen med uporabo funkcije Push Auto Focus).

Če izklopite kamero, ko je izbran način [Face/Eye Only AF], bo kamera ob naslednjem vklopu
samodejno preklopila v način [Face/Eye Priority AF].

Namig

Samodejno ostrenje z zaznavanjem obrazov/oči lahko nastavite z možnostjo [Shooting] > [Focus] >
[Face/Eye Detection AF] v meniju kamere.

Skrivanje okvirjev za zaznavanje obrazov/oči
Okvirje za zaznavanje obrazov/oči lahko prikažete/skrijete z možnostjo [Monitoring] > [Display
On/Off] > [Face/Eye Detection Frame] v meniju kamere.
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Opomba

Zeleni okvirji za zaznavanje obrazov/oči so prikazani za obraze in oči, ki so izostreni z uporabo
funkcije Push Auto Focus (AF-S), in niso skriti z uporabo gumba [Display] ali kadar je možnost
[Face/Eye Detection Frame] nastavljena na [Off].

Preklapljanje samodejnega ostrenja z zaznavanjem obrazov/oči z uporabo
dodeljivega gumba
Dodelite funkcijo [Face/Eye Detection AF] dodeljivemu gumbu. Zdaj lahko z vsakim pritiskom
gumba preklapljate med načini delovanja samodejnega ostrenja z zaznavanjem obrazov/oči v
naslednjem vrstnem redu: [Face/Eye Priority AF], [Face/Eye Only AF] in [AF].

Nastavitev z uporabo neposrednega menija

Delovanje samodejnega ostrenja z zaznavanjem obrazov/oči lahko nastavite tudi z
neposrednim menijem.

Za podrobnosti o neposrednem meniju si oglejte razdelek "Upravljanje z neposrednim
menijem".

[80] Snemanje Prilagajanje ostrenja

Sledenje določenemu subjektu (Realtime Tracking AF)

Izostritev subjekta lahko ohranite tako, da z upravljanjem na dotik določite subjekt ali pa na
nadzorni plošči kamere izberete okvir za zaznavanje obrazov.
Ko ste izbrali subjekt, se prikaže bel okvir sledenja in sledenje se začne.

Namig

Sledenje se izvaja na celotnem območju slike, ne glede na nastavitev območja ostrenja.

Ko je možnost [Shooting] > [Focus] > [Touch Function in MF] v spletnem meniju ali meniju kamere
nastavljena na [Tracking AF], je funkcija samodejnega ostrenja s sledenjem v realnem času podprta
tudi v načinu ročnega ostrenja.

Glede na nastavitev načina delovanja samodejnega ostrenja z zaznavanjem obrazov/oči se za
cilj sledenja zgodi sledeče.
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[Face/Eye Only AF] ali [Face/Eye Priority AF]: ostrenje in sledenje določenemu subjektu.
Če je cilj sledenja oseba in je zaznan obraz/oči, kamera izostri ta obraz/oči.
Ko je zaznan obraz/oči cilja sledenja, se shrani obraz cilja sledenja. Ko je shranjen, se prikaže
ikona  (ikona shranjenega obraza za sledenje).

Opomba

Če se samodejno ostrenje s sledenjem začne med ročnim ostrenjem, se obraz cilja sledenja ne
shrani.

[AF]: ostrenje in sledenje določenemu subjektu. Zaznavanje obraza/oči se ne izvede, tudi če je
cilj sledenja oseba.

Opomba

Funkcija samodejnega ostrenja s sledenjem v realnem času ne deluje, če je objektiv nastavljen na
ročno ostrenje.

Zagon samodejnega ostrenja s sledenjem v realnem času

Ko je določen subjekt opredeljen kot cilj sledenja, se začne sledenje tega cilja.

Določitev z upravljanjem na dotik
Potisnite stikalo [Touch Focus] na zavihku  (ostrenje) na nadzorni plošči kamere v desni
položaj, da ga vklopite, nato pa tapnite ciljni subjekt za sledenje v katerem koli od sledečih
stanj.

Med ročnim ostrenjem ali med omogočeno funkcijo Push Manual Focus in ko je možnost
[Shooting] > [Focus] > [Touch Function in MF] v spletnem meniju ali meniju kamere
nastavljena na [Tracking AF]
Med samodejnim ostrenjem ali med omogočeno funkcijo Push Auto Focus (AF)
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Določitev z izbiro okvirja za zaznavanje obrazov
S puščičnimi gumbi na nadzorni plošči grafičnega uporabniškega vmesnika premaknite kazalec
za izbiro obraza (oranžno podčrtan) na ciljni subjekt, ki mu želite slediti, nato pa pritisnite gumb
[Set].

A: Okvirji za zaznavanje obrazov (sivi)
B: Okvir sledenja
C: Kazalec za izbiro obraza (oranžen)

Opomba

Med ročnim ostrenjem sledenja ni mogoče začeti z izbiro okvirja za zaznavanje obrazov.

Namig

Cilj za sledenje lahko spremenite tudi med samodejnim ostrenjem s sledenjem v realnem času.

Ustavitev samodejnega ostrenja s sledenjem v realnem času

Pritisnite gumb  (ustavitev samodejnega ostrenja s sledenjem v realnem času).

Namig
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Samodejno ostrenje s sledenjem v realnem času se bo ustavilo v naslednjih primerih:
Ko je stikalo [Auto Focus] ali upravljalnik AUTO/MANUAL na objektivu preklopljen.
Ko je spremenjen način ostrenja.
Ko je izvedena funkcija AF assist.
Ko je spremenjena nastavitev območja ostrenja ali delovanje samodejnega ostrenja z
zaznavanjem obrazov/oči.
Ko je pritisnjen dodeljiv gumb, ki ste mu dodelili funkcijo [Push AF/MF].
Ko cilj sledenja ni znotraj zaslona za snemanje ali ko subjekt nekaj sekund ni izostren.

Ko je shranjen obraz za sledenje (prikazana je ikona  (ikona shranjenega obraza za sledenje)), se
samodejno ostrenje s sledenjem v realnem času nadaljuje, ko shranjeni obraz za sledenje vstopi v
območje slike. Če želite izbrisati obraz za sledenje, ustavite samodejno ostrenje s sledenjem v
realnem času, kot je opisano zgoraj.

[81] Snemanje Prilagajanje svetlosti

Zaslon prilagajanja svetlosti

Svetlost lahko prilagodite s prilagajanjem zaslonke, ojačitve, hitrosti zaklopa in s prilagajanjem
ravni svetlobe z uporabo filtrov ND na naslednjih nadzornih ploščah zaslona delovanja v živo v
spletni aplikaciji. Svetlost lahko prilagodite tudi samodejno.
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Opomba

Ojačitve ni mogoče prilagajati, ko je možnost [Shooting Mode] nastavljena na [Cine EI]. Svetlosti ni
mogoče samodejno prilagajati z uporabo hitrosti zaklopa. Podprta je samodejna prilagoditev svetlosti
z uporabo zaslonke in filtra ND.

Namig

Način Cine EI je način za snemanje pri osnovni občutljivosti brez uporabe ojačitve, da se doseže čim
večja zmogljivost slikovnega senzorja. Svetlost se prilagodi z osvetlitvijo in filtrom ND, s čimer se
nastavi količina svetlobe, ki doseže slikovni senzor. Za podrobnosti o indeksu osvetlitve si oglejte
razdelek "Spreminjanje porazdelitve temnih in svetlih območij v posneti sliki".

Nadzorna plošča kamere – zavihek  (glavni zaslon)1.

Plošča za osnovno konfiguracijo kamere
Prikaže stanje nastavitev osnovnih funkcij, ki so potrebne za snemanje z gumbi. Pritisnite
gumb, da se na spodnji plošči za nastavitev osnovne konfiguracije kamere prikaže ustrezen
zaslon nastavitev za vsako funkcijo.

2.

Plošča za nastavitev osnovne konfiguracije kamere
Prikaže ploščo za prilagajanje elementa nastavitve, ki ste ga izbrali na plošči osnovne
konfiguracije kamere.

3.
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[82] Snemanje Prilagajanje svetlosti

Nastavitev osnovne občutljivosti

Osnovno občutljivost lahko nastavite pred začetkom prilagajanja svetlosti.

Ko je možnost [Shooting Mode] nastavljena na [Custom]

Pritisnite gumb [ISO/Gain] na plošči za osnovno konfiguracijo kamere in nastavite možnost
[Base Sensitivity] na plošči za nastavitev ISO/ojačitve na [High] ali [Low].
Izberite možnost [Low] v normalnih svetlobnih pogojih in izberite možnost [High] v slabših
svetlobnih pogojih.
Zaslon ob izključeni funkciji [AGC]

Zaslon ob vključeni funkciji [AGC]

Ko je možnost [Shooting Mode] nastavljena na [Cine EI]

Pritisnite gumb [Base ISO/Exposure Index] na plošči za osnovno konfiguracijo kamere in
nastavite možnost [Base ISO] na plošči za nastavitev osnovne občutljivosti ISO/indeksa
osvetlitve na [ISO 12800] ali [ISO 800].
Izberite možnost [ISO 800] v normalnih svetlobnih pogojih in izberite možnost [ISO 12800] v
slabših svetlobnih pogojih.



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Namig

To lahko nastavite tudi na zavihku  (glavni zaslon) na nadzorni plošči kamere.

Nastavitev lahko izvedete tudi z uporabo možnosti [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] ali
[Base ISO] v meniju kamere.

Funkcijo [Base ISO/Sensitivity] lahko dodelite tudi dodeljivemu gumbu.

[83] Snemanje Prilagajanje svetlosti

Nastavitev ciljne ravni za samodejno prilagajanje
svetlosti

Ciljno raven za samodejno prilagajanje svetlosti nastavite z drsnikom [AE Level] na nadzorni
plošči kamere.

Pritisnite zavihek  (glavni zaslon) na nadzorni plošči kamere.

Če drsnik [AE Level] ni prikazan, izberite enega od obeh gumbov za izbiro funkcije drsnika
in s seznama izberite drsnik [AE Level].

1
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[84] Snemanje Prilagajanje svetlosti Prilagajanje zaslonke

Samodejno prilagajanje zaslonke

Svetlost lahko prilagajate samodejno glede na subjekt. Potreben je združljiv objektiv.

Prikaže se drsnik [AE Level].

Z drsnikom nastavite ciljno raven.

Premaknite gumb drsnika v levo, da bo slika temnejša. Premaknite gumb drsnika v desno,
da bo slika svetlejša.

Namig

Nastavitev lahko izvedete tudi z uporabo možnosti [Shooting] > [Auto Exposure] > [Level] v
meniju kamere.

2

Če je nameščen objektiv s stikalom Auto Iris, preklopite stikalo v položaj AUTO.1

Pritisnite gumb [Iris] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Iris] se obarva oranžno.

2
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Opomba

Zaslonke ni mogoče samodejno prilagajati na objektivih serije A.

Namig

Funkcijo [Auto Iris] lahko dodelite tudi dodeljivemu gumbu.

[85] Snemanje Prilagajanje svetlosti Prilagajanje zaslonke

Ročno prilagajanje zaslonke

Svetlost lahko prilagodite ročno.

Prikaže se plošča za nastavitev zaslonke.

Potisnite stikalo [Auto] v desni položaj, da ga vklopite.

Zaslonka preklopi v način samodejnega prilagajanja. Na desni strani stikala se prikaže
samodejno prilagojena vrednost zaslonke.

3

Če je nameščen objektiv s stikalom Auto Iris, preklopite stikalo v položaj AUTO.

Opomba

Ko je stikalo Auto Iris na objektivu nastavljeno na MANUAL, funkciji [Auto Iris] in [Push Auto
Iris] na enoti nimata učinka. Prav tako nima učinka ročno prilagajanje zaslonke na enoti.

1

Pritisnite gumb [Iris] na plošči za osnovno konfiguracijo kamere.2
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Začasna samodejna prilagoditev zaslonke
Pritisnete lahko tudi gumb [Push Auto] na plošči za nastavitev zaslonke, da se zaslonka
samodejno prilagodi, medtem ko je gumb pritisnjen.

Namig

Pritisnite dodeljiv gumb, ki ste mu dodelili funkcijo [Push Auto Iris], da samodejno prilagodite

Okvir gumba [Iris] se obarva oranžno.

Prikaže se plošča za nastavitev zaslonke.

Potisnite stikalo [Auto] v levi položaj, da ga izklopite.

Zaslonka preklopi v način ročnega prilagajanja.

3

Prilagodite zaslonko z uporabo drsnika [Iris] ali gumbov za prilagoditev možnosti
[Iris].

Namig

Nastavitve drsnika in gumbov za prilagoditev so povezane.

Zaslonko lahko dodelite tudi drsniku na zavihku  (glavni zaslon) na nadzorni plošči kamere.

4
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zaslonko, medtem ko je gumb pritisnjen.
Zaslonka se vrne v ročni način, ko spustite gumb.

[86] Snemanje Prilagajanje svetlosti Prilagajanje ojačitve

Samodejno prilagajanje ojačitve

Svetlost lahko samodejno prilagodite z nastavitvijo ojačitve, ko je možnost [Shooting Mode]
nastavljena na [Custom].

Nastavite možnost [Project] > [Shooting Mode] v spletnem meniju ali meniju kamere
na [Custom].

1

Pritisnite gumb [ISO/Gain] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [ISO/Gain] se obarva oranžno.

Prikaže se plošča za nastavitev možnosti ISO/Gain.

2

Potisnite stikalo [AGC] v desni položaj, da ga vklopite.

Ojačitev preklopi v način samodejnega prilagajanja. Na desni strani stikala se prikaže
samodejno prilagojena vrednost ojačitve.

Namig

Isto lahko dosežete tako, da nastavite možnost [Shooting] > [Auto Exposure] > [AGC] v meniju
kamere na [On].

Funkcijo [AGC] lahko dodelite tudi dodeljivemu gumbu.

3
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[87] Snemanje Prilagajanje svetlosti Prilagajanje ojačitve

Ročno prilagajanje ojačitve

Svetlost lahko ročno prilagodite z nastavitvijo ojačitve, ko je možnost [Shooting Mode]
nastavljena na [Custom].
Ojačitev lahko nadzorujete, kadar želite prilagoditi osvetlitev med uporabo fiksne nastavitve
zaslonke ali kadar želite preprečiti povečanje ojačitve zaradi funkcije AGC.

Nastavite možnost [Project] > [Shooting Mode] v spletnem meniju ali meniju kamere
na [Custom].

1

Pritisnite gumb [ISO/Gain] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [ISO/Gain] se obarva oranžno.

Prikaže se plošča za nastavitev možnosti ISO/Gain.

2

Potisnite stikalo [AGC] v levi položaj, da ga izklopite.

Ojačitev preklopi v način ročnega prilagajanja.

3

Prilagodite ojačitev z uporabo drsnika [ISO/Gain] ali gumbov za prilagoditev
možnosti [ISO/Gain].

Namig

Nastavitve drsnika in gumbov za prilagoditev so povezane.

4
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Začasna ročna prilagoditev ojačitve
Ojačitev lahko začasno prilagodite tudi tako, da funkcijo [ISO/Gain] dodelite gumbu za izbiro
funkcije drsnika na zavihku  (glavni zaslon) na nadzorni plošči kamere in uporabite drsnik.
To je uporabno, kadar želite prilagoditi osvetlitev za eno stopnjo brez spreminjanja globinske
ostrine.
Rezultat prilagoditve se vrne na prednastavljeno vrednost, konfigurirano s funkcijo
[ISO/Gain<L>], po izvedbi kateregakoli od sledečih opravil.

Spreminjanje elementov za nastavitev možnosti ISO/Gain
Preklapljanje osnovne občutljivosti
Prestavljanje stikala AGC v položaj za vklop
Preklapljanje napajanja enote v stanje pripravljenosti

Začasna samodejna prilagoditev ojačitve z dodeljivim gumbom
Pritisnite dodeljiv gumb, ki ste mu dodelili funkcijo [Push AGC], da samodejno prilagodite
ojačitev, medtem ko je gumb pritisnjen.
Ojačitev se vrne v ročni način, ko spustite gumb.
Rezultat prilagoditve se vrne na prednastavljeno vrednost, konfigurirano s funkcijo
[ISO/Gain<L>], po izvedbi kateregakoli od sledečih opravil.

Spreminjanje elementov za nastavitev možnosti ISO/Gain
Preklapljanje osnovne občutljivosti
Prestavljanje stikala AGC v položaj za vklop
Preklapljanje napajanja enote v stanje pripravljenosti

Opomba

Te funkcije ni mogoče izvesti, ko je možnost [Shooting] > [Iris] > [Bokeh Control] v meniju kamere
nastavljena na [On].

[88] Snemanje Prilagajanje svetlosti Prilagajanje zaklopa

Samodejno prilagajanje zaklopa

Zaklop lahko samodejno prilagodite glede na svetlost slike.

Pritisnite gumb [Shutter] na plošči za osnovno konfiguracijo kamere.1
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[89] Snemanje Prilagajanje svetlosti Prilagajanje zaklopa

Ročno prilagajanje zaklopa

Zaklop lahko prilagodite ročno.

Okvir gumba [Shutter] se obarva oranžno.

Prikaže se plošča za nastavitev zaklopa.

Pritisnite gumb [Shutter Type] in s seznama izberite možnost [Auto].

Namig

Isto lahko dosežete tako, da nastavite možnost [Shooting] > [Auto Exposure] > [Auto Shutter] v
meniju kamere na [On].

Funkcijo [Auto Shutter] lahko dodelite tudi dodeljivemu gumbu.

2

Pritisnite gumb [Shutter] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Shutter] se obarva oranžno.

Prikaže se plošča za nastavitev zaklopa.

1

Pritisnite gumb [Shutter Type] in s seznama izberite možnost [Speed].2



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

[90] Snemanje Prilagajanje svetlosti Prilagajanje količine svetlobe (filter ND)

O filtru ND

V razmerah, ko je svetlobe preveč, lahko primerno svetlost nastavite z uporabo filtra ND.
Pri snemanju močno osvetljenih subjektov lahko preveliko zapiranje zaslonke privede do
difrakcije in s tem zamegljenosti slike, kar ustvarja vtis slabe izostritve (tipičen pojav pri
videokamerah). Ta učinek lahko zmanjšate in dobite boljše rezultate snemanja z uporabo filtra
ND.
Enota ima naslednje načine filtra ND.

Prilagodite zaklop z uporabo drsnika [Speed] ali gumbov za prilagoditev možnosti
[Speed].

Za nastavitev časa osvetlitve, ki se ujema z intervalom sličice, v koraku 2 izberite možnost
[Off]. Fiksno vrednost lahko nastavite tudi z uporabo možnosti [ECS] (frekvenca) ali pa jo
samodejno prilagodite z možnostjo [Auto].
Primer: Nastavitev z uporabo možnosti [ECS] (frekvenca)

Namig

Nastavitve drsnika in gumbov za prilagoditev so povezane.

Za uporabo možnosti [Angle] namesto možnosti [Speed] ali [Off] nastavite možnost [Shooting]
> [Shutter] > [Mode] v meniju kamere na [Angle].

3
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Prednastavljeni način

Oglejte si razdelek "Prilagajanje v prednastavljenem načinu".

Variabilni način (samodejno prilagajanje)

Oglejte si razdelek "Samodejno prilagajanje v variabilnem načinu".

Variabilni način (ročno prilagajanje)

Oglejte si razdelek "Ročno prilagajanje v variabilnem načinu".

[91] Snemanje Prilagajanje svetlosti Prilagajanje količine svetlobe (filter ND)

Prilagajanje v prednastavljenem načinu

Predhodno lahko izberete tri vrednosti prepustnosti svetlobe za filter ND in med snemanjem
hitro preklapljate med njimi.

Nastavite možnost [Shooting] > [ND Filter] > [Mode] v meniju kamere na [Preset].1

Pritisnite gumb [ND Filter] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [ND Filter] se obarva oranžno.

Prikaže se plošča za nastavitev filtra ND.

2

Pritisnite gumb [ND Filter] in s seznama izberite eno od naslednjih možnosti.

[Clear]: Brez filtra ND.
[Preset1]: Prepustnost svetlobe nastavljena z možnostjo [Shooting] > [ND Filter] >
[Preset1] v meniju kamere.
[Preset2]: Prepustnost svetlobe nastavljena z možnostjo [Shooting] > [ND Filter] >
[Preset2] v meniju kamere.
[Preset3]: Prepustnost svetlobe nastavljena z možnostjo [Shooting] > [ND Filter] >
[Preset3] v meniju kamere.

3
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Namig

Ko pritisnete dodeljiv gumb, ki ste mu dodelili funkcijo [ND Filter Position], se filter ND spremeni v
naslednjem zaporedju: [Clear] › [Preset1] › [Preset2] › [Preset3] › [Clear].

[92] Snemanje Prilagajanje svetlosti Prilagajanje količine svetlobe (filter ND)

Samodejno prilagajanje v variabilnem načinu

S filtrom ND lahko omogočite samodejno prilagajanje osvetlitve.

Ko je za filter ND izbrana ena od možnosti od [Preset1] do [Preset3], je ob imenu filtra ND
prikazana vrednost prepustnosti svetlobe.

Nastavite možnost [Shooting] > [ND Filter] > [Mode] v meniju kamere na [Variable].1

Pritisnite gumb [ND Filter] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [ND Filter] se obarva oranžno.

Prikaže se plošča za nastavitev filtra ND.

2

Pritisnite gumb [ND Filter] in s seznama izberite možnost [Auto].

Ob gumbu [ND Filter] se prikaže samodejno prilagojena vrednost prepustnosti svetlobe za
filter ND.

3
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Opomba

Če filter ND med snemanjem preklopite v položaj [Clear] ali iz njega, se na sliki prikaže okvir filtra ND
in oglasi se zvok delovanja.

Namig

Funkcijo [Auto ND Filter] lahko dodelite tudi dodeljivemu gumbu in s pritiskom nanj preklapljate med
možnostma [Auto] in [Manual].

[93] Snemanje Prilagajanje svetlosti Prilagajanje količine svetlobe (filter ND)

Ročno prilagajanje v variabilnem načinu

S filtrom ND lahko izvedete ročno prilagajanje osvetlitve.

Nastavite možnost [Shooting] > [ND Filter] > [Mode] v meniju kamere na [Variable].1

Pritisnite gumb [ND Filter] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [ND Filter] se obarva oranžno.

Prikaže se plošča za nastavitev filtra ND.

2

Pritisnite gumb [ND Filter] in s seznama izberite možnost [Manual].3

Z uporabo drsnika [ND Filter] ali gumbov za prilagoditev možnosti [ND Filter]
prilagodite prepustnost svetlobe za filter ND.

4
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Začasno samodejno prilagajanje
Funkcijo [Push Auto ND] lahko dodelite dodeljivemu gumbu in začasno vklopite samodejni filter
ND, medtem ko je gumb pritisnjen. Ko spustite gumb, se samodejni filter ND izklopi.
Nastavite filter ND na [Manual].

Opomba

Če filter ND med snemanjem preklopite v položaj [Clear] ali iz njega, se na sliki prikaže okvir filtra ND
in oglasi se zvok delovanja.

Namig

Funkcijo [ND Filter Position] lahko dodelite dodeljivemu gumbu in s pritiskom nanj preklapljate med
možnostma [Manual] in [Clear].

Medtem ko je gumb pritisnjen, lahko za vklop samodejnega filtra ND pritisnete tudi gumb [Push Auto]
na plošči za nastavitev filtra ND.

[94] Snemanje Prilagajanje za naravne barve (White Balance)

Zaslon za nastavitev beline

Belino lahko prilagodite z uporabo zaslona delovanja v živo v spletni aplikaciji in tako dosežete
belino, ki omogoča bolj naraven videz slike.

Namig

Nastavitve drsnika in gumbov za prilagoditev so povezane.

Filter ND lahko prilagodite tudi na zavihku  (glavni zaslon) na nadzorni plošči kamere.
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[95] Snemanje Prilagajanje za naravne barve (White Balance)

Samodejno prilagajanje beline

S funkcijo ATW (samodejno sledenje izravnavi beline) lahko vedno zagotovite ustrezno
prilagojeno belino.
Pri omogočeni funkciji ATW se belina samodejno prilagodi, ko se temperatura barve
svetlobnega vira spremeni.

Plošča za osnovno konfiguracijo kamere1.

Plošča za nastavitev osnovne konfiguracije kamere
Prikaže ploščo za prilagajanje elementa nastavitve, ki ste ga izbrali na plošči osnovne
konfiguracije kamere.

2.

Pritisnite gumb [White Balance] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [White Balance] se obarva oranžno.

1
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Opomba

Funkcije ATW ni mogoče uporabljati, ko je možnost [Shooting Mode] nastavljena na [Cine EI].

Glede na osvetlitev in razmere subjekta s funkcijo ATW morda ne bo mogoče nastaviti primerne
barve.
Primeri:

Kadar prevladuje ena barva subjekta, kot na primer pri nebu, morju, zemlji ali rožah.
Kadar je temperatura barve izjemno visoka ali izjemno nizka.

Če je hitrost samodejnega sledenja ATW počasna ali pa ni mogoče zagotoviti ustreznega učinka,
pritisnite gumb [WB SET], da zaženete samodejno izravnavo beline.

Namig

Ko je omogočen način ATW, lahko hitrost odziva izberete v petih stopnjah (1, 2, 3, 4, 5), in sicer z
uporabo možnosti [Shooting] > [White Setting] > [ATW Speed] v meniju kamere. Nižja kot je številka,
hitrejši je odziv.

Trenutno nastavitev beline lahko zamrznete tako, da funkcijo [ATW Hold] dodelite dodeljivemu
gumbu in pritisnete nanj za začasno prekinitev funkcije ATW v načinu ATW.

[96] Snemanje Prilagajanje za naravne barve (White Balance)

Ročno prilagajanje beline

Prikaže se plošča za nastavitev beline.

Pritisnite gumb [White Mode] in s seznama izberite možnost [ATW].2
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Belino lahko prilagodite ročno.

Pritisnite gumb [White Balance] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [White Balance] se obarva oranžno.

Prikaže se plošča za nastavitev beline.

1

Pritisnite gumb [White Mode] in s seznama izberite eno od naslednjih možnosti.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Z uporabo drsnikov ali gumbov za prilagoditev nastavite belino.

Namig

Nastavitve drsnika in gumbov za prilagoditev so povezane.

Razlika med možnostjo [Memory A(T/T)] in [Memory A(R/B)] je v tem, da je os prilagoditve
drugačna, rezultati prilagoditve pa so povezani.

Za način [Memory A(T/T)]
V tem načinu se belina, ki je shranjena v pomnilniku A, prilagodi z nastavljanjem

3
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[97] Snemanje Prilagajanje za naravne barve (White Balance)

Nastavitev beline z belim listom

V načinu pomnilnika A se belina, ki jo želite shraniti, prilagodi samodejno.

temperature (Temp) in odtenka (Tint) barve.
Temperaturo barve lahko nastavljate v korakih po 20 K v razponu od 2000 K do 5600 K.
Vrednosti nad 5600 K lahko nastavite v intervalih, ki ustrezajo količini barvne spremembe
(mired) od 5580 K do 5600 K.
S pritiskom gumba [Reset] obnovite nastavitev [Temp] (temperatura barve) ali [Tint] na
privzeto vrednost.
Za način [Memory A(R/B)]
V tem načinu se belina, ki je shranjena v pomnilniku A, prilagodi z nastavljanjem ojačitve R
in ojačitve B.
S pritiskom gumba [Reset] obnovite ustrezno nastavitev ojačitve na privzeto vrednost.
Za način [Preset]
Ta način prilagodi temperaturo barve na prednastavljeno vrednost.
Vrednost lahko nastavljate v korakih po 100 K.
V prednastavljenem načinu lahko funkcijo [Preset White Select] dodelite tudi dodeljivemu
gumbu, nato pa s pritiskom nanj spreminjate na prednastavljeno vrednost.
Način [Custom]: 3200 K › 4300 K › 5600 K › 6300 K › 3200 K…
Način [Cine EI]: 3200 K › 4300 K › 5500 K › 3200 K…

Pritisnite gumb [White Balance] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [White Balance] se obarva oranžno.

Prikaže se plošča za nastavitev beline.

1

Pritisnite gumb [White Mode] in s seznama izberite možnost [Memory A(T/T)] ali
[Memory A(R/B)].

[Memory A(T/T)]

2
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Opomba

Če prilagoditev ni uspešna, se na zaslonu za približno tri sekunde prikaže sporočilo o napaki. Če se

[Memory A(R/B)]

Položite bel list papirja (ali drug bel predmet) na mesto z enakim virom svetlobe in
enakimi svetlobnimi razmerami, kot veljajo za subjekt. Nato z objektivom približajte
papir, tako da zapolnjuje sliko na zaslonu.

3

Prilagodite svetlost.

Prilagodite zaslonko z uporabo postopka, opisanega v razdelku "Ročno prilagajanje
zaslonke".

4

Pritisnite gumb [WB SET] na plošči za nastavitev beline.

[Memory A(T/T)]

[Memory A(R/B)]

Če je samodejna izravnava beline zagnana v načinu pomnilnika, se rezultat samodejne
prilagoditve shrani v pomnilnik A.

5
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sporočilo o napaki prikaže vsakokrat tudi po več ponovljenih poskusih nastavitve beline, stopite v stik
s servisnim predstavnikom podjetja Sony.

Namig

Prilagoditev lahko zaženete tudi v načinu ATW. Uporabite jo lahko, ko želite hitro prilagoditev beline
med delovanjem funkcije ATW. Po prilagoditvi se način vrne v običajno delovanje ATW.

[98] Snemanje Konfiguriranje zvoka za snemanje

Zaslon za konfiguriranje zvoka

Raven zvoka, ki ga bo posnela enota, lahko prilagajate na zaslonu delovanja v živo v spletni
aplikaciji. Prek spletnega menija konfigurirajte stikala na priključnem bloku enote in
konfigurirajte zvok.
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[99] Snemanje Konfiguriranje zvoka za snemanje

Izbira vhodne zvočne naprave

Nastavite naslednja stikala glede na napravo, priključeno na priključek AUDIO IN.

Nadzorna plošča kamere – zavihek  (zvok)1.

Ko je priključen mikrofon, nastavite stikalo SETUP 2 na priključnem bloku na zadnji
strani enote.

CH-1 in CH-2 imata skupne nastavitve.

1

Nastavitev Opis

OFF
(privzeto)

Izberite, ko uporabljate dinamični mikrofon ali baterijski mikrofon. Ta način
izklopi fantomsko napajanje +48 V ter nastavi vhod LINE ali MIC kot vir
zvoka CH-1 in CH-2.

Izberite, ko uporabljate mikrofon, ki je združljiv s fantomskim napajanjem



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Opomba

Zvok se ne snema v načinu Interval Rec ali v načinu Slow & Quick Motion.

[100] Snemanje Konfiguriranje zvoka za snemanje

Samodejno prilagajanje ravni zvoka pri snemanju

Nastavite kanal, za katerega želite samodejno prilagoditi raven zvoka pri snemanju, na [Auto]
na strani [Audio] v spletnem meniju ali z uporabo možnosti [Audio] > [Audio Input] > [CH1 Level
Control] do [CH4 Level Control] v meniju kamere.
Kanali, ki so določeni za samodejno prilagajanje, so označeni z ikono  (samodejno) ob
ustreznih kanalih na zavihku  (zvok) na zaslonu delovanja v živo.

[101] Snemanje Konfiguriranje zvoka za snemanje

Ročno prilagajanje ravni zvoka pri snemanju

Raven zvoka pri snemanju lahko prilagajate ročno.

ON +48 V. Ta način vklopi fantomsko napajanje +48 V ter nastavi mikrofon, ki
je združljiv s fantomskim napajanjem, kot vir zvoka CH-1 in CH-2.

Nastavite vrsto priključene naprave z uporabo možnosti [Audio] > [Audio Input] >
[AUDIO IN Select] v meniju kamere.

2

Izberite zvočni vhod z uporabo možnosti [Audio] > [Audio Input] > [CH1 Input Select]
do [CH4 Input Select] v spletnem meniju ali meniju kamere.

3

Nastavite kanal, za katerega želite ročno prilagoditi raven zvoka pri snemanju, na
[Manual] na strani [Audio] v spletnem meniju ali z uporabo možnosti [Audio] >
[Audio Input] > [CH1 Level Control] do [CH4 Level Control] v meniju kamere.

1

Pritisnite zavihek  (zvok) na nadzorni plošči kamere.2
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[102] Uporabne funkcije

Upravljanje z neposrednim menijem

Preverite lahko stanje in nastavitve enote, ki so prikazane na sliki kamere, ter izberete in
spremenite nastavitve z gumbi za upravljanje grafičnega uporabniškega vmesnika na
infrardečem daljinskem upravljalniku.
Nastavite lahko naslednje elemente.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]

Na zaslonu [Audio] nadzorne plošče kamere z drsnikom ali gumbi za prilagoditev
ročno nastavite raven zvoka pri snemanju za kanal.

Opomba

Kanali, za katere je prikazana ikona  (samodejno), se prilagodijo samodejno. Spremembe
vrednosti, ki so bile izvedene z drsniki ali gumbi, se ne prenesejo na posneti zvok.

Namig

Nastavitve drsnikov in prilagoditvenih gumbov v vsaki vrstici so povezane.

Na zaslonu za snemanje lahko z uporabo prikaza merilnika ravni zvoka preverite raven
zvočnega vhoda v realnem času.

3
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[ND Filter Position]
[Auto ND Filter]
Vrednost [ND Filter]
[Auto Iris]
Vrednost [Iris]
[AGC]
Vrednost [Gain]
Vrednost [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] in [Frame Rate]

Namig

Isto funkcijo lahko izvajate tudi z dodeljivim gumbom in nadzorno ploščo grafičnega uporabniškega
vmesnika v spletni aplikaciji.

[103] Uporabne funkcije

Na infrardečem daljinskem upravljalniku pritisnite dodeljiv gumb, ki ste mu dodelili
funkcijo [Direct Menu].

Tovarniško privzeto je gumb [Direct Menu] dodeljen dodeljivemu gumbu 1.
Z oranžnim kazalcem lahko izberete samo tiste možnosti, ki jih je mogoče nastavljati z
uporabo neposrednega menija.

1

S puščičnimi gumbi na nadzorni plošči grafičnega uporabniškega vmesnika
premaknite kazalec na možnost, ki jo želite nastaviti, in pritisnite gumb [Set].

Prikaže se meni ali izbrana možnost na belem ozadju.

2

S puščičnimi gumbi izberite nastavitev in pritisnite gumb [Set].

Meni ali belo ozadje izgine in nova nastavitev se prikaže z oranžnim kazalcem.
Za izhod iz neposrednega menija ponovno pritisnite dodeljiv gumb, ki ste mu dodelili
funkcijo [Direct Menu], ali počakajte 3 sekunde, ne da bi izvedli kakršno koli dejanje.

3
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Dodeljivi gumbi

V spletni aplikaciji enote je deset dodeljivih gumbov, ki jim lahko dodelite funkcije.
Dodeljivi gumbi so prikazani na zaslonu delovanja v živo in zaslonu za upravljanje predvajanja.

Opomba

Seznam dodeljivih gumbov ni prikazan, ko konfigurirate nastavitve na plošči za osnovno delovanje
kamere na zaslonu delovanja v živo. Da končate postopek, pritisnite gumb [X] v zgornjem desnem
kotu plošče za nastavitev.

Tovarniško privzeto so gumbom dodeljene naslednje funkcije.
Gumb 1: [Direct Menu]
Gumb 2: [Focus Setting]
Gumb 3: [Rec Review]

Gumbi od 1 do 3 so enakovredni gumbom z enakim številom na priloženem infrardečem
daljinskem upravljalniku.

Gumb 4: [Push Auto ND]
Gumb 5: [Crop Select]
Gumb 6: [Marker]
Gumb 7: [Video Signal Monitor]
Gumb 8: [Clip Flag OK]
Gumb 9: [Color Bars]
Gumb za zaklep ostrenja: [Focus Hold]

Gumb Focus Hold je enakovreden gumbu Focus Hold na objektivu serije E.

Spreminjanje funkcije gumba
Uporabite možnost [Project] > [Assignable Button] v meniju kamere.
Ko spremenite dodelitev, se spremeni prikaz seznama dodeljivih gumbov.
Za podrobnosti o dodeljivih funkcijah si oglejte razdelek "Dodeljivi gumbi" v poglavju "Meni
kamere in podrobne nastavitve".
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[104] Uporabne funkcije

Počasni in hitri posnetki

Ko je format snemanja nastavljen na sledeče vrednosti, lahko določite drugačne vrednosti za
hitrost sličic pri snemanju in hitrost sličic pri predvajanju.
V naslednji tabeli so prikazane nastavljive hitrosti sličic.

Sistemska frekvenca: 59,94/50/29,97/25/23,98, način zajemanja slike: FF

Sistemska frekvenca: 59,94/50/29,97/25/23,98, način zajemanja slike: S35

Sistemska frekvenca: 24, način zajemanja slike: FF

Kodek Video format Nastavljive hitrosti sličic

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1-60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Kodek Video format Nastavljive hitrosti sličic

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Kodek Video format Nastavljive hitrosti sličic

XAVC-I 4096×2160P 1-60
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Opomba

Hitrega in počasnega snemanja ne morete nastaviti med snemanjem, predvajanjem ali kadar je
prikazan zaslon sličic.

V načinu hitrih in počasnih posnetkov ni podprto snemanje zvoka.

V načinu hitrih in počasnih posnetkov so onemogočene funkcije samodejnega ostrenja, samodejne
zaslonke in samodejnega zaklopa. Funkcijo samodejnega ostrenja lahko uporabite, ko je hitrost sličic
nastavljena na naslednje vrednosti.

Hitrost sličic, ko je sistemska frekvenca nastavljena na 59,94/29,97/23,98: 30, 60, 120, 240
Hitrost sličic, ko je sistemska frekvenca nastavljena na 50/25: 25, 50, 100, 200

Za podrobnosti o uporabi izhoda RAW si oglejte razdelek "Snemanje videoposnetka RAW".

[105] Uporabne funkcije

Video snemanje s prekinitvami (Interval Rec)

Funkcija Interval Rec oz. funkcija intervalnega snemanja vam omogoča, da v notranji pomnilnik
enote zajamete videoposnetke s prekinitvami. Ta funkcija predstavlja učinkovit način za
snemanje počasi premikajočih se subjektov.
Ko začnete snemati, enota samodejno posname določeno število sličic (Number of Frames) na
določen čas intervala (Interval Time).

A: Interval snemanja (Interval Time)
B: Število sličic v enem posnetku (Number of Frames)
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Opomba

Naenkrat lahko uporabljate samo eno funkcijo posebnega načina snemanja, kot je intervalno
snemanje.

Če med intervalnim snemanjem vklopite drugo funkcijo posebnega načina snemanja, se intervalno
snemanje samodejno izklopi.

Način intervalnega snemanja se samodejno izklopi, če spremenite sistemske nastavitve, kot je na
primer video format.

Intervalnega snemanja ne morete nastaviti med snemanjem, predvajanjem ali kadar je prikazan
zaslon sličic.

Omejitve med snemanjem
Zvok se ne posname.
Ogled posnetka (Rec Review) ni mogoč.

Če med snemanjem izklopite enoto
Če stikalo za vklop enote prestavite v stanje pripravljenosti, enota še nekaj sekund dostopa
do pomnilniškega medija, da nanj zapiše posnetke, ki so se do tistega trenutka shranili v
notranji pomnilnik. Nato enota samodejno preklopi v stanje pripravljenosti.
Če odklopite napajalni kabel za enosmerni tok, izklopite napajanje iz omrežnega napajalnika
ali prekinete napajanje PoE++, se posnetki, narejeni do tega trenutka, lahko izgubijo (največ
10 sekund). Potrebno je previdno ravnanje.

Nastavitev števila sličic in intervala med snemanjem

Nastavite možnost [Project] > [Interval Rec] > [Setting] v spletnem meniju na [On] ter nastavite
možnosti [Number of Frames] in [Interval Time].
Ko enoto izklopite, se način intervalnega snemanja izklopi, nastavitvi [Number of Frames] in
[Interval Time] pa ostaneta shranjeni. Tako vam jih naslednjič, ko snemate v intervalnem načinu
snemanja, ni treba ponovno nastavljati.

Namig

Nastavitev lahko izvedete tudi z uporabo možnosti [Project] > [Interval Rec] v meniju kamere.

Začetek snemanja

Za začetek snemanja pritisnite gumb za snemanje START/STOP. "Int?Rec" in "Int?Stby" se
prikažeta izmenično.

Zaustavitev snemanja
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Ustavite snemanje.
Ko je snemanje zaključeno, se video posnetki, ki so se do tega trenutka shranili v pomnilnik,
zapišejo na pomnilniški medij.
Za izhod iz načina intervalnega snemanja izvedite eno od naslednjih dejanj.

Preklopite napajanje enote v stanje pripravljenosti.
V stanju pripravljenosti na snemanje nastavite možnost [Project] > [Interval Rec] > [Setting]
na [Off].

Način intervalnega snemanja ostane izklopljen tudi, ko ponovno zaženete enoto.

[106] Uporabne funkcije

Snemanje slik iz predpomnilnika (Picture Cache Rec)

Funkcija Picture Cache Rec vam omogoča, da retroaktivno posnamete video, ko začnete
snemati, kamera pa pri tem video v določeni dolžini shranjuje v notranji predpomnilnik.

Nastavitev velikosti predpomnilnika

Nastavite možnost [Project] > [Picture Cache Rec] > [Setting] v spletnem meniju na [On] in
nastavite velikost predpomnilnika z uporabo možnosti [Cache Size].

Opomba

Funkcije Picture Cache Rec ni mogoče uporabljati v kombinaciji s funkcijo Interval Rec, funkcijo
sočasnega snemanja na 2 pomnilniški kartici ali funkcijo snemanja proxy. Ko je funkcija Picture
Cache Rec vklopljena, se ti ostali posebni načini snemanja prisilno izklopijo.

Funkcije Picture Cache Rec ne morete izbrati med snemanjem, ki je v teku, ali med pregledom
videoposnetkov.

Ko je funkcija Picture Cache Rec vklopljena, se časovna koda snema v načinu [Free Run], tudi če je

Nastavitev [Cache Size] Čas predpomnilnika (približno)

[Short] 5 sekund

[Medium] 10 sekund

[Long] 20 sekund

[Max] Največja vrednost za vsak format snemanja
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nastavljena na [Regen] ali [Rec Run].

V načinu Picture Cache Rec morda ne bo mogoče konfigurirati nastavitve [Output Format]. Če se to
zgodi, začasno izklopite funkcijo Picture Cache Rec in nato spremenite nastavitev.

Namig

Glede na format snemanja je lahko čas predpomnilnika krajši. Preverite čas, ki je prikazan v
možnosti [Project] > [Picture Cache Rec] > [Cache Rec Time] v spletnem meniju.

Nastavitev lahko izvedete tudi z uporabo možnosti [Project] > [Picture Cache Rec] v meniju kamere.

Med vklopom in izklopom funkcije [Picture Cache Rec] lahko preklapljate tudi z dodeljivim gumbom.

Zagon funkcije Picture Cache Rec

Ko je funkcija [Picture Cache Rec] vklopljena, se prikaže "?Cache" (? je zelene barve).
Ko pritisnete gumb za snemanje START/STOP, se zažene snemanje in videoposnetek se
zapisuje na pomnilniško kartico; najprej se shrani videoposnetek, ki je shranjen v
predpomnilniku.

Opomba

Sprememba formata snemanja ali osnovnega videza izbriše videoposnetek, ki je do tistega trenutka
shranjen v predpomnilniku, in zažene predpomnjenje novega videoposnetka. Posledično ni mogoče
posneti slikovnega predpomnilnika pred spremembo formata, tudi če začnete s snemanjem takoj po
spremembi formata.

Če funkcijo Picture Cache Rec vklopite ali izklopite takoj po vstavitvi pomnilniške kartice, se podatki
iz predpomnilnika morda ne bodo posneli na kartico.

Videoposnetek se shranjuje v predpomnilnik, ko je funkcija Picture Cache Rec vklopljena. Pred
vklopom funkcije se video ne shranjuje v predpomnilnik.

Videoposnetek se ne shranjuje v predpomnilnik v času, ko poteka branje s pomnilniške kartice, kot
na primer med predvajanjem, ogledom posnetka ali prikazom zaslona sličic. Snemanje
videoposnetka iz slikovnega predpomnilnika v tem času ni mogoče.

Preklic funkcije Picture Cache Rec

Nastavite možnost [Project] > [Picture Cache Rec] > [Setting] v spletnem meniju na [Off] ali
pritisnite dodeljiv gumb, ki ste mu dodelili funkcijo [Picture Cache Rec].

[107] Uporabne funkcije

Sočasno snemanje na pomnilniški kartici A in B (2-slot
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Simul Rec)

Na obe pomnilniški kartici (A in B) lahko snemate sočasno, in sicer tako, da možnost [Project] >
[Simul Rec] > [Setting] v spletnem meniju ali meniju kamere nastavite na [On].

Ločeno snemanje na pomnilniško kartico A in pomnilniško kartico B

Snemanje na vsako pomnilniško kartico lahko ločeno začnete/ustavite z gumbom za snemanje
START/STOP ali gumbom [2nd Rec START/STOP] na zavihku  (drugo).
Tovarniško privzeta nastavitev je, da oba gumba zaženeta/ustavita sočasno snemanje na obe
pomnilniški kartici - kartico A in kartico B.
Če gumba nastavite, da upravljata snemanje za različni pomnilniški kartici, upravljanje
začetka/zaustavitve snemanja [SDI/HDMI Rec Control] sledi stanju snemanja reže A.

Spreminjanje nastavitve

Z uporabo možnosti [Project] > [Simul Rec] > [Rec Button Set] v meniju kamere izvedite
naslednjo nastavitev.

Nastavitev
[Rec

Button
Set]

Gumbi in pomnilniške kartice

Rec
Button:
[SlotA
SlotB] 
2nd Rec
Button:
[SlotA
SlotB]

Zažene/zaustavi sočasno snemanje na pomnilniški kartici A in B z uporabo
kateregakoli gumba.

Rec
Button:
[SlotA] 
2nd Rec
Button:
[SlotB]

Gumb za snemanje START/STOP zažene/zaustavi snemanje na pomnilniško
kartico A. Gumb [2nd Rec START/STOP] na zavihku  (drugo)
zažene/zaustavi snemanje na pomnilniško kartico B.

Rec
Button:
[SlotB] 

Gumb za snemanje START/STOP zažene/zaustavi snemanje na pomnilniško
kartico B. Gumb [2nd Rec START/STOP] na zavihku  (drugo)
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[108] Uporabne funkcije

Zaslon video signala

Nastavite lahko tip video signala za prikaz na slikovni plošči kamere – valovna oblika,
vektorskop ali histogram. To storite z uporabo možnosti [Monitoring] > [Video Signal Monitor] >
[Setting] v meniju kamere.
Oranžna črta označuje nastavljene vrednosti za možnosti [Level Marker 1] in [Level Marker 2].
Funkcijo [Video Signal Monitor] lahko dodelite tudi dodeljivemu gumbu.

Nadzorovanje ciljnega zaslona
V načinu Cine EI je podatek o nastavitvi barvnega prostora ali nastavitvi LUT prikazan v
zgornjem desnem kotu zaslona video signala, s čimer je označen cilj nadzorovanja.

[109] Uporabne funkcije

Zastavice posnetkov

Posnetku lahko dodate zastavico posnetka [OK], če pritisnete dodeljiv gumb, ki ste mu dodelili
funkcijo [Clip Flag OK], in izberete možnost [Add OK].
Zastavico posnetka [OK] lahko izbrišete tako, da dvakrat pritisnete gumb in izberete možnost
[Delete Clip Flag].

Namig

Zastavico posnetka lahko dodate tudi z uporabo možnosti [Thumbnail] > [Set Clip Flag] v meniju
kamere.

2nd Rec
Button:
[SlotA]

zažene/zaustavi snemanje na pomnilniško kartico A.
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Zaslon sličic je mogoče prikazati razvrščen po vrsti zastavice posnetka (zaslon sličic filtriranih
posnetkov). Za podrobnosti si oglejte razdelek "Upravljanje posnetih posnetkov" v poglavju "Zaslon
sličic".

[110] Uporabne funkcije

Izravnava zaradi dihanja

Z uporabo možnosti [Technical] > [Lens] > [Breathing Compensation] v meniju kamere lahko
nastavite, ali želite za objektiv izvesti izravnavo zaradi dihanja.
Ta funkcija popravi pojav, pri katerem pride do sprememb vidnega kota, ko se spreminja mesto
ostrenja.
Ko je izvedena izravnava zaradi dihanja, se del slike elektronsko obreže, da se ohrani
konstanten vidni kot in se pojav dihanja ne pojavi.

Opomba

Ko je omogočena izravnava zaradi dihanja, se lahko vidni kot in kakovost slike rahlo spremenita.

Pri omogočeni izravnavi zaradi dihanja morda ne bo mogoče popraviti spremembe vidnega kota, kar
pa je odvisno od objektiva.

Izravnava ni mogoča, če je nameščen objektiv, ki ne podpira izravnave zaradi dihanja.

Ta funkcija je nastavljena na Off (fiksno) v naslednjih primerih.
Če je možnost [Technical] > [Lens] > [Distortion Comp.] v meniju kamere nastavljena na [Off].
Če je možnost [Shooting] > [S&Q Motion] > [Setting] v spletnem meniju ali meniju kamere
nastavljena na [On].
Če je možnost [Project] > [Rec Format] > [Codec] v spletnem meniju ali meniju kamere nastavljena
na [RAW] ali [RAW & XAVC-I].

[111] Uporabne funkcije Snemanje proxy

Pregled snemanja proxy

Ta funkcija vam omogoča, da hkrati posnamete podatke proxy z nizko ločljivostjo in
videoposnetek z izvornimi podatki v visoki ločljivosti.

Za podrobnosti o podprtih pomnilniških karticah, formatiranju pomnilniških kartic in
preverjanju preostale kapacitete glejte razdelek "Podprte pomnilniške kartice" v poglavju
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"Priprava pomnilniških kartic".

O posneti datoteki
Končnica imena datoteke je ".mp4".
Sočasno se posname tudi časovna koda.

Mesto shranjevanja posnete datoteke
Posneta datoteka se shrani v naslednji imenik.

O imenu datoteke
Ime datoteke je sestavljeno iz imena posnetka, shranjenega na pomnilniško kartico, in
pripone "S03".
Za imena posnetkov si oglejte možnost [TC/Media] > [Clip Name Format] v meniju kamere.

[112] Uporabne funkcije Snemanje proxy

Snemanje posnetka proxy

Snemanje lahko začnete, ko je omogočeno snemanje proxy.

Snemalni medij Pot mape

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Nastavite možnost [Project] > [Proxy Rec] > [Setting] v spletnem meniju ali meniju
kamere na [On].

1

Vstavite pomnilniško kartico v režo za kartice CFexpress Type A/SD.

Kartice CFexpress vstavite tako, da je nalepka zgoraj.
Kartice SD vstavite tako, da je nalepka obrnjena navzdol s poševnim vogalom na spodnji
strani.

Opomba

Funkcije Proxy Rec ne morete vklopiti hkrati s funkcijo S&Q Motion ali Interval Rec. Ko je
snemanje proxy vklopljeno, se ti načini snemanja prisilno izklopijo.

2



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Zaustavitev snemanja
Ustavite snemanje.

Nastavitev zvočnega kanala za snemanje proxy
Nastavite zvočni kanal za snemanje podatkov proxy z uporabo možnosti [Project] > [Proxy Rec]
> [Audio Channel] v meniju kamere.

[113] Uporabne funkcije Snemanje z želenim videzom

Pregled videza

Ko je enota v načinu Custom, lahko dodate prilagoditve parametrom Black, Matrix in drugim ter
tako ustvarite "videz", ki temelji na osnovnem videzu.

Hitro lahko tudi izberete drugačen videz, in sicer s shranjevanjem različnih kombinacij
nastavitev v scenskih datotekah.
V enoti je na voljo šest prednastavljenih videzov.

Pritisnite gumb za snemanje START/STOP.

Začne se snemanje proxy.

Opomba

Celovitost podatkov na kartici ne bo zagotovljena, če izklopite enoto ali odstranite pomnilniško
kartico, medtem ko je dostop do kartice še v teku.
Vsi podatki, zapisani na kartici, se lahko zavržejo. Pred izklopom enote ali odstranitvijo
pomnilniške kartice se vedno prepričajte, da je indikator dostopa do pomnilniške kartice
izklopljen.

Pazite, da pomnilniška kartica ne izskoči, ko jo vstavite ali odstranite.

3



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

[114] Uporabne funkcije Snemanje z želenim videzom

Izbiranje videza

V tej temi je opisano, kako izbrati videz.

Prepričajte se, da je možnost [Project] > [Base Setting] > [Shooting Mode] v
spletnem meniju ali meniju kamere nastavljena na [Custom].

Namig

V načinu [Custom] sta gumba [ISO/Gain] in [Scene File] prikazana na plošči za osnovno
konfiguracijo kamere.

1

Pritisnite gumb [Scene File] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Scene File] se obarva oranžno.

Prikaže se plošča za nastavitev scenske datoteke.

2

Pritisnite gumb [Scene File] na plošči za nastavitev in s seznama izberite scensko
datoteko z želenim videzom.

Naslednje prednastavitve so tovarniško privzeto nastavljene.

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scene file 1 [S-Cinetone] [HLG Live]

Scene file 2 [Standard] [HLG Natural]

Scene file 3 [Still] (Not registered)
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[115] Uporabne funkcije Snemanje z želenim videzom

Uvoz želenega osnovnega videza

Kot osnovni videz lahko uvozite datoteko 3D LUT, ki ste jo ustvarili v računalniku ali drugi
napravi. Uvozite lahko največ 16 datotek.
Oblika zapisa datoteke: datoteka CUBE (*.cube) za 17-točkovno ali 33-točkovno datoteko 3D
LUT, ki ste jo ustvarili z možnostjo Catalyst Browse, RAW Viewer ali DaVinci Resolve* (avtorjev
Blackmagic Design Pty. Ltd.).

Vhodni barvni prostor/gama: [S-Gamut3.Cine/S-Log3] ali [S-Gamut3/S-Log3]

Namig

Videz lahko izberete tudi z možnostjo [Paint/Look] > [Scene File] > [Recall] v meniju kamere.
Prednastavljen videz lahko prikličete tudi z možnostjo [Scene File] > [Preset Recall].

Scene file 4 [ITU709] (Not registered)

Scene files 5 to 16 (Not registered) (Not registered)

Preverjeno z Resolve V9.0, V10.0 in V11.0.*

Shranite datoteko 3D LUT v napravo, v kateri je nameščena spletna aplikacija.1

Odprite možnost [Paint/Look] > [Base Look] v spletnem meniju.

Prikaže se seznam registriranih osnovnih videzov.

2
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Prilagajanje prešibki osvetlitvi
V primeru nagibanja k prešibki osvetlitvi, ko izberete samodejno osvetlitev ob uporabi
uvoženega osnovnega videza, prilagodite videz z uporabo možnosti [Paint/Look] > [Base Look]
> [AE Level Offset] v spletnem meniju.

Opomba

Sam uvoz datoteke 3D LUT ne vpliva na sliko. Naložite uvoženo datoteko 3D LUT z možnostjo
[Paint/Look] > [Base Look] > [Select] v meniju kamere.

Če možnost [Input] ni pravilno nastavljena, ne boste dobili ustreznega videza.

Nastavitve elementov menijev [Input], [Output] in [AE Level Offset] se uporabijo pri osnovnem

Pritisnite gumb [Import] v vrstici, v kateri želite uvoziti datoteko.

Prikaže se pogovorno okno za izbiro datoteke.

3

Izberite pripravljeno datoteko 3D LUT.

Uvožena datoteka 3D LUT postane osnovni videz enote.

4

Izberite uvoženo datoteko 3D LUT z možnostjo [Paint/Look] > [Base Look] > [Select]
v meniju kamere.

5

Konfigurirajte možnosti [Paint/Look] > [Base Look] > [Input] in [Output] v meniju
kamere, da se bosta ujemali z lastnostmi uvožene datoteke 3D LUT.

6
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videzu, ki ste ga izbrali z možnostjo [Select]. Če uvozite več datotek 3D LUT, izberite vsako datoteko
3D LUT z možnostjo [Select] ter konfigurirajte možnosti [Input], [Output] in [AE Level Offset]
posamezno za vsako datoteko.

Konfigurirane nastavitve [Input], [Output] in [AE Level Offset] se shranijo za vsako datoteko 3D LUT.

Izbirne možnosti osnovnega videza/datoteke LUT za uvožene datoteke 3D LUT so skupne načinom
[SDR(BT.709)], [HDR(HLG)] in Cine EI, toda barvni prostor in pretvorba v gamo nista izvedena v
skladu s temi načini.

Datoteke 3D LUT se ne izbrišejo, ko izvedete možnost [Maintenance] > [Reset] > [All Reset (except
for Network Settings)] v spletnem meniju.

[116] Uporabne funkcije Snemanje z želenim videzom

Prilagajanje videza

Videz lahko prilagajate glede na osnovni videz z uporabo drsnikov [Master Black], [R Black] in
[B Black] na plošči za nastavitev scenske datoteke na plošči za osnovno konfiguracijo kamere
ter možnosti [Paint/Look] > [Matrix] in drugih nastavitvenih elementov v meniju kamere.
Enoto priključite na televizor ali zaslon, nato pa med opazovanjem slike na televizorju ali
zaslonu prilagodite kakovost slike.

1: Drsnik/gumba za prilagoditev [R Black]
2: Drsnik/gumba za prilagoditev [B Black]
3: Drsnik/gumba za prilagoditev [Master Black]

Opomba

Ko uvozite datoteko 3D LUT in jo uporabite na sliki, ne boste dosegli želenega videza, ki je določen v
datoteki 3D LUT, če spremenite možnost [Paint/Look] > [Matrix] in nastavitve, ki ne sodijo med
nastavitve osnovnega videza v meniju kamere.

Vse prilagojene nastavitve lahko ponastavite z možnostjo [Paint/Look] > [Reset Paint Settings] >
[Reset without Base Look] v meniju kamere.
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[117] Uporabne funkcije Snemanje z želenim videzom

Shranjevanje videza

Trenutni videz lahko shranite v notranji pomnilnik kot scensko datoteko z možnostjo [Paint/Look]
> [Scene File] > [Store] v meniju kamere.
Shranjen videz lahko hitro prikličete z uporabo plošče za nastavitev scenske datoteke ali z
upravljanjem neposrednega menija.

Opomba

Če izberete drug videz, ne da bi shranili trenutni videz, bo trenutni videz zavržen.

Namig

Prednastavljene scenske datoteke lahko prepišete. Če želite obnoviti prednastavljeno scensko
datoteko, naložite videz, ki ga želite obnoviti, z možnostjo [Paint/Look] > [Scene File] > [Preset
Recall] v meniju kamere, nato pa shranite scensko datoteko z možnostjo [Scene File] > [Store].

Brisanje shranjenega videza
Scensko datoteko, ki je shranjena v notranjem pomnilniku, lahko izbrišete z možnostjo
[Paint/Look] > [Scene File] > [Delete] v meniju kamere.

Namig

Ko je izbrisana, ni več prikazana na plošči za nastavitev scenske datoteke ali v neposrednem meniju.

[118] Uporabne funkcije Snemanje z želenim videzom

Brisanje osnovnega videza

Uvožene datoteke 3D LUT lahko izbrišete posamično z uporabo možnosti [Paint/Look] > [Base
Look] > [Delete] v meniju kamere.
Vse uvožene datoteke 3D LUT lahko izbrišete z uporabo možnosti [Paint/Look] > [Base Look] >
[Delete All] v meniju kamere.

Opomba
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Pred izbrisom preverite, da osnovni videz ni uporabljen v kateri koli scenski datoteki. Če izbrišete
osnovni videz, ki je v uporabi, bo videz ustreznih scenskih datotek nepravilen.

Uvožene datoteke 3D LUT se ne izbrišejo, ko izvedete možnost [Maintenance] > [Reset] > [All Reset
(except for Network Settings)] v spletnem meniju.

Izbrisanega osnovnega videza ne morete več uporabiti kot datoteko LUT v načinu Cine EI.

[119] Uporabne funkcije Snemanje s prilagajanjem videza v postprodukciji

Snemanje s prilagajanjem videza v postprodukciji

Če uporabite enoto v načinu Cine EI in snemate enakomerne prehode iz temnih območij v
svetla območja, lahko opravite natančne popravke, na primer lokalno obnovite prehode temnih
in svetlih območij v postprodukciji.
Če posnete slike gledate na običajnem monitorju, bo skupni kontrast šibek, zato bodo popravki
ostrenja in osvetlitve težavni.
Datoteko LUT lahko uporabite na cilju monitorja v enoti, kar vam bo v pomoč pri različnih
popravkih med snemanjem. Datoteko LUT lahko uporabite tudi pri predvajanju videoposnetkov,
ko želite pregledati končni izdelek.
Datoteke LUT uporabljajo naslednji sistemi. Uporabiti je mogoče samo eno datoteko LUT.

Izhod SDI
Izhod HDMI in pretočno predvajanje
Posnetek proxy, posnet na snemalnem mediju
(Glavni) posnetek z visoko ločljivostjo, posnet na snemalnem mediju

[120] Uporabne funkcije Snemanje s prilagajanjem videza v postprodukciji

Uporaba datoteke LUT za izhod HDMI in pretočno
predvajanje

Datoteko LUT lahko uporabite za izhod HDMI in pretočno predvajanje.

Prepričajte se, da je možnost [Project] > [Base Setting] > [Shooting Mode] v
spletnem meniju ali meniju kamere nastavljena na [Cine EI].

Namig

V načinu [Cine EI] sta gumba [Base ISO/Exposure Index] in [Base Look/LUT] prikazana na

1



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Opomba

V pretočno sliko je vključena tudi slika na slikovni plošči kamere v spletni aplikaciji.

Namig

To nastavitev lahko izvedete tudi z možnostjo [Shooting] > [LUT On/Off] > [HDMI/Stream] v meniju
kamere.

Izhod SDI lahko nastavite na enak način.

Za videoposnetek na snemalnem mediju lahko to nastavite z možnostma [Shooting] > [LUT On/Off] >
[Internal Rec] in [Proxy] v meniju kamere.

[121] Uporabne funkcije Snemanje s prilagajanjem videza v postprodukciji

Spreminjanje datoteke LUT

Datoteko LUT, ki jo želite uporabiti, lahko spremenite.

plošči za osnovno konfiguracijo kamere.

Pritisnite gumb [Base Look/LUT] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Base Look/LUT] se obarva oranžno.

Prikaže se plošča za nastavitev osnovnega videza/datoteke LUT.

2

Izberite možnost [HDMI/Stream] > [MLUT].3
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Namig

Kot prednastavljene datoteke LUT enota ponuja [s709], [709(800%)] in [S-Log3].

Uvozite in uporabite lahko tudi datoteko 3D LUT. Za podrobnosti si oglejte razdelka "Uvoz želenega
osnovnega videza" in "Brisanje osnovnega videza".

To nastavitev lahko izvedete tudi z možnostjo [Paint/Look] > [Base Look] > [Select] v meniju kamere.

[122] Uporabne funkcije Snemanje s prilagajanjem videza v postprodukciji

Spreminjanje porazdelitve temnih in svetlih območij v
posneti sliki

Porazdelitev temnih in svetlih območij lahko spreminjate, če želite na primer dati prednost
odtenku temnih območij, in sicer tako, da spremenite nastavitev Exposure Index v osnovni
občutljivosti.

Pritisnite gumb [Base Look/LUT] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Base Look/LUT] se obarva oranžno.

Prikaže se plošča za nastavitev osnovnega videza/datoteke LUT.

1

Pritisnite gumb [Base Look/LUT] in izberite osnovni videz, ki ga želite uporabiti.2

Pritisnite gumb [Base Look/LUT] na plošči za osnovno konfiguracijo kamere.

Okvir gumba [Base Look/LUT] se obarva oranžno.

1
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Namig

To nastavitev lahko izvedete tudi z možnostjo [Shooting] > [ISO/Gain/EI] > [Exposure Index] v meniju
kamere.

Prikaže se plošča za nastavitev osnovnega videza/datoteke LUT.

Izberite možnost [HDMI/Stream] > [MLUT].

Datoteka LUT se uporablja za izhod HDMI in pretočno predvajanje.

2

Pritisnite gumb [Base ISO/Exposure Index] na plošči za osnovno konfiguracijo
kamere.

Okvir gumba [Base ISO/Exposure Index] se obarva oranžno.

Prikaže se plošča za nastavitev osnovne občutljivosti ISO/indeksa osvetlitve.

3

Z drsnikom [Exposure Index] ali gumboma za prilagoditev [Exposure Index]
prilagodite indeks osvetlitve glede na želeno porazdelitev temnih in svetlih območij.

4

Prilagodite osvetlitev in/ali filter ND tako, da bo izhodna slika kamere iz
[HDMI/Stream] ustrezno osvetljena.

5
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Izhod SDI lahko uporabite na enak način.

Druga številska vrednost nastavitve označuje, koliko korakov informacij o svetlobi je dodeljenih
svetlim območjem (svetlost, večja kot pri 18 % sivini). Območja, ki so svetlejša od teh, so
presvetljena.
Primer: V "400EI/5.0E" je dodeljenih 5,0 koraka na svetli strani.

S tem si lahko med snemanjem tudi pomagate pri preverjanju odtenka temnih in svetlih območij. Po
preverjanju osvetlitve se ne pozabite vrniti v prvotno vrednost EI.

[123] Uporabne funkcije Snemanje v RAW

Snemanje videoposnetka RAW

Posnamete lahko video signal RAW, ki gre iz priključka SDI OUT na enoti v podprt zunanji
snemalnik.
Podprti izhodni formati RAW so prikazani spodaj.

Sistemska frekvenca [Codec] [RAW Output Format]

59,94 / 50 / 29,97 / 25 / 23,98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Priključite zunanji snemalnik RAW v priključek SDI OUT na enoti.1

Nastavite možnost [Project] > [Base Setting] > [Shooting Mode] v spletnem meniju
ali meniju kamere na [Cine EI].

2

Nastavite vidni kot (samo FF) z možnostjo [Project] > [Rec Format] > [Imager Scan
Mode] v spletnem meniju ali meniju kamere.

3
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Opomba

Ko se snemanje z zunanjim snemalnikom začne, ne da bi uporabili gumb za snemanje
START/STOP na zaslonu delovanja v živo, videoposnetki morda ne bodo ustrezno posneti.

[124] Uporabne funkcije Snemanje v RAW

Snemanje videoposnetka RAW v načinu počasnih in

Nastavite možnost [Project] > [Rec Format] > [Codec] v spletnem meniju ali meniju
kamere na [RAW].

Če izberete možnost [RAW&XAVC-I], boste sočasno posneli videoposnetek na zunanji
snemalnik RAW in na pomnilniške kartice v enoti.

4

Nastavite ločljivost z možnostjo [Project] > [Rec Format] > [RAW Output Format] v
spletnem meniju ali meniju kamere.

5

Preverite, ali je zunanji snemalnik vklopljen, nato pa pritisnite gumb za snemanje
START/STOP na zaslonu delovanja v živo.

Stanje snemanja videoposnetka RAW označuje ikona, ki je prikazana na slikovni plošči
kamere.

Opomba

Nadzorni signal snemanja se oddaja iz priključka SDI OUT na enoti, stanja zunanjega
snemalnika pa ni mogoče pridobiti. Zato lahko enota označuje, da snemanje videoposnetka
RAW poteka, čeprav zunanji snemalnik v resnici ne snema. Pravilno stanje delovanja si oglejte
prek indikatorja na zunanjem snemalniku.

6
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hitrih posnetkov

Videoposnetke RAW lahko snemate v načinu počasnih in hitrih posnetkov.

Za podrobnosti o podprtih hitrostih sličic za snemanje si oglejte razdelek "Počasni in hitri
posnetki".

[125] Uporabne funkcije Prilagajanje zameglitve ozadja (funkcija Bokeh Control)

Vklop/izklop funkcije upravljanja zameglitve ozadja

Stopnjo zameglitve ozadja lahko preprosto prilagodite tako, da filter ND in ojačitev povežete z
upravljanjem zaslonke.

Vklop/izklop funkcije upravljanja zameglitve ozadja oz. funkcije Bokeh
Control

To funkcijo lahko omogočite samo med ročnim prilagajanjem osvetlitve. Nastavite filter ND v
variabilni način, nato pa nastavite zaslonko, ojačitev, zaklop in filter ND na ročno prilagajanje.
Funkcijo upravljanja zameglitve ozadja lahko vklopite/izklopite z možnostjo [Shooting] > [Iris] >
[Bokeh Control] v meniju kamere.
Če je funkcija upravljanja zameglitve ozadja vklopljena, je na indikatorjih filtra ND in ojačitve
prikazana ikona  (B).

Opomba

Ta funkcija je omogočena samo pri objektivih serije E, ki lahko komunicirajo z enoto.

Največji učinek te funkcije lahko dosežete s Sonyjevim objektivom serije E.

Funkcijo [Bokeh Control] lahko dodelite tudi dodeljivemu gumbu ter s pritiskom nanj vklapljate in
izklapljate funkcijo upravljanja zameglitve ozadja.

Funkcija upravljanja zameglitve ozadja je izklopljena, ko je izvedeno katero koli od naslednjih opravil.
Ko je enota izklopljena.
Ko je katera koli od možnosti – zaslonka, ojačitev, zaklop ali filter ND – nastavljena na Auto.
Ko je način snemanja preklopljen.
Ko je filter ND nastavljen na način brisanja ali prednastavljen način.
Ko je objektiv odstranjen.
Ko se enota ponovno zažene, na primer po preklopu frekvence.
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[126] Uporabne funkcije Prilagajanje zameglitve ozadja (funkcija Bokeh Control)

Prilagajanje stopnje zameglitve ozadja

Opomba

Videz se lahko razlikuje glede na hitrost delovanja, objektiv, nastavitve snemanja in subjekt,
spremeni pa se lahko tudi svetlost. Pred snemanjem je močno priporočljivo, da opravite preizkus
kamere.

Pri spremembi smeri delovanja zaslonke se lahko spremeni tudi svetlost – na primer pri odpiranju
zaslonke po njenem zaprtju ali pri zapiranju zaslonke po njenem odprtju. V tem primeru predhodno
nastavite nekoliko več, kot je potrebno, potem pa za malenkost zmanjšajte, preverite svetlost in
začnite snemati. Če želite na primer odpreti zaslonko na vrednost F8 in zamegliti ozadje, najprej
zaprite zaslonko prek vrednosti F8, nato pa se vrnite na vrednost F8, preverite svetlost in začnite
snemati.

Postopke upravljanja zameglitve ozadja izvajajte počasi. Če morate postopek pospešiti, poskusite
prilagajati postopoma, medtem ko preverjate spremembe na sliki.

Namig

Ko je funkcija upravljanja zameglitve ozadja vklopljena, filter ND in ojačitev delujeta skupaj, da
izravnata spremembe osvetlitve zaradi prilagoditve zaslonke, kar vam omogoča spreminjanje stopnje
zameglitve ozadja.

Upravljanje zameglitve ozadja je najprej povezano s filtrom ND kot odziv na delovanje zaslonke. Ko
spreminjanje filtra ND ni več mogoče, se poveže ojačitev.

V načinu ročnega ostrenja je priporočljivo, da najprej odprete zaslonko in nato prilagodite ostrenje.

Če namesto funkcije upravljanja zameglitve ozadja uporabite samodejni filter ND, filter ND sledi
spremembi svetlosti subjekta.

Prikaz med delovanjem povezave ojačitve

Vklopite funkcijo upravljanja zameglitve ozadja.1

Prilagodite filter ND in ojačitev, da določite osvetlitev.2

Prilagodi zaslonko.

Stopnja zameglitve ozadja se spremeni.

3
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Ko je funkcija upravljanja zameglitve ozadja vklopljena, se lahko pri prilagajanju zaslonke
spremeni ojačitev.
Ko je povezava ojačitve aktivna in se ojačitev spremeni, se na vrhu zaslona prikaže sporočilo,
ikona  (B) na indikatorju ojačitve pa utripa.

[127] Uporabne funkcije Shranjevanje in nalaganje konfiguracijskih podatkov

Pregled shranjevanja in nalaganja konfiguracijskih
podatkov

S spletno aplikacijo lahko nastavitve enote shranite kot konfiguracijske podatke. To vam
omogoča, da hitro prikličete primerne nastavitve menija za trenutno situacijo.
Z izjemo naslednje opombe lahko s to enoto skoraj vse nastavitve, povezane s funkcijami
kamere, shranite kot datoteko ALL (datoteka z vsemi nastavitvami).

Opomba

Nastavitve omrežnih funkcij in podatki za preverjanje pristnosti se ne shranijo. Za podrobnosti o
shranjenih elementih si oglejte razdelek "Seznam elementov menija".

[128] Uporabne funkcije Shranjevanje in nalaganje konfiguracijskih podatkov

Shranjevanje datoteke ALL

V tej temi je opisano, kako shraniti datoteko ALL.

Odprite možnost [Project] > [All File] v spletnem meniju.1

Pritisnite gumb [Save All File] > [Save].

Spletni brskalnik bo za trenutek prenesel datoteko z imenom all-file.ALL.

2

Določite lokacijo in ime datoteke za preneseno datoteko all-file.ALL, nato pa
datoteko shranite.

Za podrobnosti o upravljanju datoteke si oglejte navodila za uporabo naprave.

3
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[129] Uporabne funkcije Shranjevanje in nalaganje konfiguracijskih podatkov

Nalaganje datoteke ALL

V tej temi je opisano, kako naložiti datoteko ALL.

Opomba

Enota se po nalaganju konfiguracijskih podatkov samodejno znova zažene. Po ponovnem zagonu
znova naložite stran v spletnem brskalniku.

[130] Omrežne funkcije Prenos datotek

O prenosu datotek

Datoteko proxy ali originalno datoteko, ki je posneta v enoti, lahko naložite v strežnik na
internetu ali v strežnik v lokalnem omrežju.

Opomba

Odprite možnost [Project] > [All File] v spletnem meniju.1

Pritisnite gumb [Load All File] > [Load].

V napravi, v kateri je nameščena spletna aplikacija, se prikaže pogovorno okno za
odpiranje datoteke.

2

Odprite datoteko, ki jo želite naložiti.

Za podrobnosti o upravljanju datoteke si oglejte navodila za uporabo naprave.

3

Ko se prikaže zaslon za potrditev imena naložene datoteke, pritisnite gumb [OK].4

Ko se prikaže zaslon z rezultati izvedbe, pritisnite gumb [OK].5

Počakajte, da se enota ponovno zažene, nato pa znova povežite spletno aplikacijo.6
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Ko je napajanje nastavljeno na stanje pripravljenosti, se prenosi datotek zadržijo, čeprav se enota še
vedno napaja.

[131] Omrežne funkcije Prenos datotek

Registriranje cilja za prenos datoteke

Pred začetkom prenosa datoteke lahko registrirate ciljni strežnik za prenos.

Izberite možnost [Network] > [File Transfer] > [Default Upload Server] > [Server
Settings1] (ali [Server Settings2], [Server Settings3]) v spletnem meniju.

Namig

Ime možnosti izbire se bo spremenilo glede na nastavitev [Display Name], konfigurirano v
naslednjem koraku.

1

Konfigurirajte naslednje elemente za možnosti [Network] > [FTP Server 1] do [FTP
Server 3] v spletnem meniju.

[Display Name]
Vnesite ime strežnika, ki bo prikazano na seznamu opravil prenosa, ko izberete ciljni
strežnik za prenos.
[Service]
Prikaže tip strežnika.
[FTP]: strežnik FTP
[Host Name]
Vnesite naslov ali ime gostitelja strežnika.
[Port]
Vnesite številko vrat strežnika, s katerim želite vzpostaviti povezavo.
[User Name]
Vnesite uporabniško ime.
[Password]
Vnesite geslo.
[Passive Mode]
Vklopite/izklopite pasivni način.
[Destination Directory]
Vnesite ime mape na ciljnem strežniku.

Opomba

2
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[132] Omrežne funkcije Prenos datotek Izbira datoteke in nalaganje

Nalaganje datoteke proxy na pomnilniški kartici z
zaslona sličic

Datoteke proxy lahko na pomnilniški kartici posamično nalagate z zaslona sličic.

Če so znaki, ki so neveljavni na ciljnem strežniku, vneseni v mapo [Destination Directory],
bodo datoteke prenesene v uporabnikovo domačo mapo. Neveljavni znaki se razlikujejo glede
na strežnik.

[Using Secure Protocol]
Nastavite, ali naj se izvede varen prenos FTP.
[Root Certificate]
Naložite/izbrišite potrdilo.
[Load]: Nalaganje potrdila CA. Naloži potrdila v obliki PEM.
[Clear]: Brisanje potrdila CA.
[None]: Potrdilo se ne naloži in ne izbriše.

Opomba

Pred nalaganjem potrdila CA nastavite uro enote na pravilen čas.

Ko snemate v formatu XAVC-I 4096×2160P/3840×2160P 59,94/50P, ni mogoče izbrati
možnosti [Load].

[Root Certificate Status]: Prikaže stanje nalaganja potrdila.
[Reset]: Ponastavi nastavitve Server Settings na privzete vrednosti.

Pritisnite gumb [Thumbnail] na zaslonu delovanja v živo v spletni aplikaciji.

Na zaslonu se namesto slike kamere prikaže zaslon sličic.

1

Izberite možnost [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] v meniju
kamere.

Za istočasen prenos vseh datotek proxy izberite možnost [Transfer Clip (Proxy)] > [All
Clips].
Posnetke lahko prenesete z zaslona sličic ali zaslona sličic filtriranih posnetkov.

2
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Opomba

Registrirati je mogoče do 200 opravil prenosa.

[133] Omrežne funkcije Prenos datotek Izbira datoteke in nalaganje

Nalaganje originalne datoteke na pomnilniški kartici z
zaslona sličic

Originalno datoteko lahko na pomnilniški kartici naložite z zaslona sličic.

Z gumbom [Set] izberite posnetek, ki ga želite prenesti, nato pa pritisnite gumb
[Menu].

Prikaže se potrditveni zaslon prenosa.

3

Izberite možnost [Execute].

Datoteka proxy, ki ustreza izbranemu posnetku, se registrira za opravilo prenosa in
nalaganje se začne.
Ko se opravilo prenosa uspešno registrira, se prikaže zaslon z rezultatom prenosa.

4

Pritisnite gumb [OK].5

Pritisnite gumb [Thumbnail] na zaslonu delovanja v živo v spletni aplikaciji.

Na zaslonu se namesto slike kamere prikaže zaslon sličic.

1

Izberite možnost [Thumbnail] > [Transfer Clip] > [Select Clip] v meniju kamere.

Za istočasen prenos vseh originalnih datotek izberite možnost [Transfer Clip] > [All Clips].
Posnetke lahko prenesete z zaslona sličic ali zaslona sličic filtriranih posnetkov.

2

Z gumbom [Set] izberite posnetek, ki ga želite prenesti, nato pa pritisnite gumb
[Menu].

Prikaže se potrditveni zaslon prenosa.

3
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Opomba

Registrirati je mogoče do 200 opravil prenosa.

[134] Omrežne funkcije Prenos datotek Izbira datoteke in nalaganje

Preverjanje stanja prenosa datotek

Stanje prenosa datotek lahko preverite tako, da izberete možnost [Network] > [File Transfer] >
[View Job List] v meniju kamere.

Opomba

Registrirati je mogoče do 200 opravil prenosa.

Ko enota preklopi v stanje pripravljenosti, se opravila prenosa ohranijo. Če je napajanje prekinjeno
na kakršen koli drug način, se lahko izgubi do 10 minut najnovejših informacij o napredku.

Če pride med prenosom datotek do napake, se prenos posnetka z enakim imenom, kot ga ima
preneseni posnetek, morda ne bo začel znova. To je odvisno od nastavitev in stanja ciljnega
strežnika za prenos. V tem primeru preverite nastavitve in stanje ciljnega strežnika za prenos.

Namig

Če je možnost [Network] > [File Transfer] > [Auto Upload (Proxy)] v meniju kamere nastavljena na
[On] in je vzpostavljena omrežna povezava, se datoteke proxy po zaključku snemanja samodejno
naložijo na strežnik, določen z uporabo možnosti [Default Upload Server].

[135] Omrežne funkcije Prenos datotek

Nalaganje z varnim protokolom FTP

Izberite možnost [Execute].

Originalna datoteka izbranega posnetka se registrira za opravilo prenosa in nalaganje se
začne.
Ko se opravilo prenosa uspešno registrira, se prikaže zaslon z rezultatom prenosa.

4

Pritisnite gumb [OK].5
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Datoteke naložite prek šifrirane povezave s ciljnim strežnikom, tako da uporabite FTPS v načinu
Explicit (FTPES).
Da zagotovite varen prenos FTP, v nastavitvah ciljnega strežnika nastavite možnost [Using
Secure Protocol] na [On] in naložite potrdilo.

Za podrobnosti o konfiguraciji si oglejte razdelek "Registriranje cilja za prenos datoteke".

[136] Omrežne funkcije Konfiguriranje pretočnega predvajanja

O pretočnem predvajanju

Enota lahko istočasno pretočno predvaja video in zvok, ki se oddajata iz priključka HDMI.

Opomba

Če želite pretočno predvajanje uporabljati kot glavni video, v spletnem meniju nastavite možnost
[Monitoring] > [Output Display] > [SDI] na [On] in možnost [HDMI/Stream] na [Off] ter spremljajte
stanje kamere na monitorju SDI.

Če monitor, ki je priključen na priključek HDMI, ne podpira izhodnega formata HDMI, nastavljenega z
uporabo menija [Monitoring] v spletnem meniju ali meniju kamere, se slika kamere ne bo predvajala
v spletni aplikaciji. Prav tako ni mogoče oddajati pretočno predvajanega videa.

Ločljivosti pretočnega predvajanja ni mogoče nastaviti višje od ločljivosti izhodnega signala HDMI.

Če sliko gleda več uporabnikov, se lahko slika glede na nastavitve kodekov popači.

Enota podpira naslednje metode pretočnega predvajanja. Video kodeki, ki so na voljo za izbiro,
so prikazani v oklepajih.

RTSP (H.264, H.265)
SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Nastavitev formata pretočnega predvajanja, nastavitev video kodeka in nastavitev zvočnega
kodeka konfigurirajte v tem vrstnem redu.

Format pretočnega
predvajanja

Nastavitev kodeka

Video
Stream 1

Video
Stream 2

Video
Stream 3

Audio
Stream
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?: Omogočeno, –: Onemogočeno

Namig

Tudi slika na slikovni plošči kamere v spletni aplikaciji je sistem pretočnega predvajanja.

[137] Omrežne funkcije Konfiguriranje pretočnega predvajanja

Nastavitev formata pretočnega predvajanja

Nastavite format pretočnega predvajanja z uporabo možnosti [Stream] > [Stream] > [Stream
Setting] > [Setting] v spletnem meniju.

Ko je možnost [Setting] nastavljena na [RTSP]

Pri pretočnem predvajanju RTSP si lahko sliko iz ene kamere istočasno ogleda do pet
uporabnikov.
Nastavite lahko do dva načina video kodekov.
[Port Number]
Nastavi številko vrat, ki se uporablja za pretočno predvajanje RTSP. Privzeta vrednost je 554.
Če spremenite nastavitev, se ponovno zažene strežnik RTSP.
[Time Out]
Določa časovno omejitev ukaza ohranjanja povezave za pretočno predvajanje RTSP. Časovno
omejitev lahko nastavite v razponu od 0 do 600 sekund. Privzeta vrednost je 60 sekund.
Če je nastavljena na 0 sekund, se časovna omejitev zaradi ukaza ohranjanja povezave ne
pojavi.
[Authentication]
Določa, ali je potrebno preverjanje pristnosti.
[Video Port Number 1], [Video Port Number 2]
Določa številko vrat za podatkovno komunikacijo slike, ki se uporablja za enovrstno pretočno
predvajanje RTSP. Privzeta tovarniška vrednost za možnost Video Port Number 1 je 51000.

RTSP
? 
video 1

? 
video 2

– ?

SRT ? – – ?

NDI|HX
? 
Main

? 
Sub

– ?

Spletna aplikacija – – ? –
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Privzeta tovarniška nastavitev za možnost Video Port Number 2 je 53000. Navedite sodo
številko v razponu od 1024 do 65534. Tukaj nastavljena številka in naslednja liha številka,
pridobljena z dodajanjem 1, sta dve številki vrat, ki se uporabljata za podatkovno komunikacijo
slike in nadzor.
Možnosti [Video Port Number 1] in [Video Port Number 2] ustrezata možnostma [Stream] >
[Video Stream] > [Video Stream 1] in [Video Stream 2].
[Audio Port Number]
Določa številko vrat za podatkovno komunikacijo zvoka, ki se uporablja za enovrstno pretočno
predvajanje RTSP. Privzeta vrednost je 57000. Navedite sodo številko v razponu od 1024 do
65534. Tukaj nastavljena številka in naslednja liha številka, pridobljena z dodajanjem 1, sta dve
številki vrat, ki se uporabljata za podatkovno komunikacijo zvoka in nadzor.

Ko je možnost [Setting] nastavljena na [SRT-Caller] ali [SRT-Listener]

Način video kodeka je samo H.264.
[Destination]
Prikaže se, ko je način pretočnega predvajanja nastavljen na [SRT-Caller]. Nastavi ciljni spletni
naslov povezave.
[Port Number]
Prikaže se, ko je način pretočnega predvajanja nastavljen na [SRT-Listener]. Nastavi številko
vrat, na katerih se naj posluša. Privzeta vrednost je 4201.
[Latency]
Nastavi zakasnitev v razponu od 20 do 8000 ms. Privzeta vrednost je 120.
[TTL]
Nastavi vrednost TTL v razponu od 1 do 255. Privzeta vrednost je 64.
[Encryption]
Izbere način šifriranja. Izberite Off, AES128 ali AES256. Privzeta vrednost je Off.
[Passphrase]
Nastavi geslo, ki se uporablja za šifriranje. S pritiskom gumba [Reset] ponastavite nastavljeno
geslo.
[ARC]
Če želite omogočiti funkcijo Adaptive Rate Control, nastavite to možnost na On.
Pri omogočeni funkciji Adaptive Rate Control je mogoče zmanjšati prekinitve v sliki, ki jih
povzroča preobremenitev komunikacijske linije.

Ko je možnost [Setting] nastavljena na [NDI|HX]

Enota je skladna z gonilnikom NDI|HX različice 2 podjetja NewTek.
Za uporabo gonilnika NDI|HX morate kupiti licenčni ključ.
Nakup licenčnega ključa
Kupite na tem spletnem naslovu podjetja NewTek.
http://new.tk/ndi_sony

Opomba
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Prenesite najnovejši gonilnik NDI|HX in ga namestite v izdelku podjetja NewTek.

Za podrobnosti o registraciji in delovanju gonilnika NDI|HX si oglejte navodila za uporabo izdelka
podjetja NewTek.

[License]
Prikaže informacije o licenci za omogočeno licenco.
[Source Name]
Prikaže ime vira.
[Group]
Če želite omogočiti funkcijo združevanja v skupine NDI, nastavite to možnost na On.
[Group Name]: Nastavi ime skupine NDI. Konfigurirate lahko več nastavitev, ki so ločene z
vejico.
[Discovery Server 1], [Discovery Server 2]
Nastavi NDI strežnik za odkrivanje 1 in NDI strežnik za odkrivanje 2.
[Reliable UDP Mode]
Če želite omogočiti način Reliable UDP, nastavite to možnost na On.
[Multicast Mode]
Če želite omogočiti večvrstno pretočno predvajanje, nastavite to možnost na On.
[Multicast Prefix]: Nastavi predpono, ki se uporablja za večvrstno pretočno predvajanje.
[Multicast Netmask]: Nastavi masko omrežja, ki določa območje naslovov za večvrstno
pretočno predvajanje.
[Multicast TTL]: Nastavi vrednost TTL za večvrstno pretočno predvajanje v razponu od 1 do
256. Privzeta vrednost je 3.
[Multi-TCP Mode]
Če želite omogočiti način Multi-TCP, nastavite to možnost na On.
[Unicast UDP Mode]
Če želite omogočiti način Unicast UDP, nastavite to možnost na On.

O storitvah in programski opremi tretjih oseb
Veljajo lahko drugačni pogoji uporabe.

Zagotavljanje storitev in posodobitev programske opreme se lahko prekine ali zaključi brez
predhodnega obvestila.
Opis storitev in programske opreme se lahko spremeni brez predhodnega obvestila.
Morda bo potrebna ločena registracija in naročnina.

Družba Sony ne odgovarja za morebitne zahtevke uporabnikov ali tretjih oseb zaradi uporabe
storitev in programske opreme drugih podjetij.

[138] Omrežne funkcije Konfiguriranje pretočnega predvajanja
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Nastavitev video kodeka za pretočno predvajanje

Nastavite video kodek z možnostjo [Stream] > [Video Stream] v spletnem meniju.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Nastavite lahko do tri načine slikovnega kodeka. Za vsak način slike ločeno konfigurirajte
naslednje nastavitve.
Možnost [Video Stream 3] se uporablja za prikaz slikovne plošče kamere v spletni aplikaciji.

Opomba

Če je možnost [Stream] > [Stream Setting] > [Setting] nastavljena na [SRT-Caller] ali [SRT-Listener],
imajo nekatere nastavitve [Video Stream 1], [Video Stream 2] in [Video Stream 3] ([Codec], [Size],
[Frame Rate], [Bit Rate Compression Mode]) privzete vrednosti.

[Codec 1], [Codec 2], [Codec 3]
Izberite možnost [H.264], [H.265] ali [Off]. Upoštevajte, da možnosti [Codec 1] ni mogoče
nastaviti na [Off]. Poleg tega je možnost [Codec 3] nastavljena na [JPEG] (fiksno).

Opomba

Glede na kombinacijo različnih nastavitev, kot so velikost slike, hitrost sličic in bitna hitrost pri
možnostih [Codec 1], [Codec 2] in [Codec 3], lahko pride do naslednjih pojavov.

Povečana zakasnitev videoposnetkov.
Preskakovanje sličic med predvajanjem videoposnetkov.
Prekinjen zvok.
Počasen odziv kamere na različne ukaze.
Počasen odziv kamere na upravljanje z daljinskim upravljalnikom.
Počasen prikaz zaslona monitorja in postopki konfiguracije.

Če se pojavijo ti simptomi, zmanjšajte vrednosti parametrov za velikost slike, hitrost sličic in bitno
hitrost ali spremenite vrednosti drugih parametrov nastavitev, da odpravite težavo.

Ko je možnost [Stream] > [Stream Setting] > [Setting] nastavljena na [SRT-Caller] ali [SRT-Listener],
je možnost [Codec 1] nastavljena na [H.264] (fiksno). Možnost [Codec 2] je nastavljena na [Off]
(fiksno).

Ko je spremenjena velikost slike ali sistemska frekvenca izhoda HDMI, je možnost [Codec 2]
nastavljena na [Off].

[Size 1], [Size 2], [Size 3]
Izbere velikost slike, ki se pretočno predvaja iz kamere.
Razpoložljive možnosti velikosti slike se razlikujejo glede na velikost slike na izhodu HDMI.
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Opomba

V primeru spremembe velikosti slike ali sistemske frekvence izhoda HDMI bo izbrana največja
velikost slike.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Nastavi hitrost sličic za sliko.
Enote "sličice na sekundo" označujejo število pretočno predvajanih sličic na sekundo.
Razpoložljive možnosti hitrosti sličic se razlikujejo glede na velikost slike na izhodu HDMI.

Opomba

V primeru spremembe velikosti slike ali sistemske frekvence izhoda HDMI bo izbrana največja hitrost
sličic.

[I-Picture Mode 1], [I-Picture Mode 2]
Nastavi metodo določanja intervala vstavljanja I-slike za H.264 in H.265 na [Time] ali [Frame].
Nastavitve ni mogoče določiti za možnost [Codec 3].
[Time]: Nastavi interval vstavljanja I-slike kot čas.
[Frame]: Nastavi interval vstavljanja I-slike kot število sličic.
[I-Picture Interval 1], [I-Picture Interval 2]
Nastavi interval vstavljanja I-slike v enotah sekund. Nastavi vrednost v razponu od 1 do 5
sekund. Privzeta vrednost je 1 sekunda.
Nastavitve ni mogoče določiti za možnost [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Nastavi interval vstavljanja I-slike za H.264 in H.265 kot število sličic v razponu od 15 do 300.
Privzeta vrednost je 300 sličic.
Nastavitve ni mogoče določiti za možnost [Codec 3].
[Profile 1], [Profile 2]
Nastavi profil slikovnega kodeka H.264 ali H.265.
[H.264]: Izberite profil [high], [main] ali [baseline].
[H.265]: Izberite profil [main] ali [main10]. Ko sta omogočena dva video kodeka, je na voljo
samo možnost izbire profila [main].
Zmogljivost stiskanja slik se povečuje v zaporedju [high], [main] in [baseline]. Izberite profil, ki
ga podpira vaš sistem.
Ko je možnost [H.265] nastavljena na [main10], je delovanje v načinu [main10], ko je izhod
HDMI YCrCb ali [main], ko je izhod HDMI RGB.
Nastavitve ni mogoče določiti za možnost [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Izberite možnost [CBR] ali [VBR].
Za ohranjanje konstantne bitne hitrosti izberite možnost [CBR]. Za ohranjanje kakovosti slike
izberite možnost [VBR].
Nastavitve ni mogoče določiti za možnost [Codec 3].
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Opomba

Hitrost sličic in bitna hitrost, ki se dejansko pretočno predvajata, se lahko glede na velikost slike,
prizor snemanja, omrežno okolje in druge dejavnike razlikujeta od nastavljenih vrednosti.

Ko je možnost [Stream] > [Stream Setting] > [Setting] nastavljena na [SRT-Caller] ali [SRT-Listener],
je možnost [Bit Rate Compression Mode 1] nastavljena na [CBR] (fiksno).

[Bit Rate 1], [Bit Rate 2]
Ko je možnost [Bit Rate Compression Mode] nastavljena na [CBR], lahko nastavite bitno hitrost
na tok videoposnetka. Z nastavitvijo visoke bitne hitrosti omogočite pretočno predvajanje
visokokakovostne video slike.
Nastavitve ni mogoče določiti za možnost [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Nastavi kakovost slike v razponu od 1 do 10. Vrednost 10 določa najvišjo kakovost slike.
Privzeta vrednost je 6.
Za možnosti [Quality 1] in [Quality 2] lahko nastavite kakovost slike H.264, in sicer tako, da
nastavite možnost [Bit Rate Compression Mode] na [VBR] in možnost [Codec] na [H.264].
Kakovost slike H.265 lahko nastavite z določitvijo možnosti [Bit Rate Compression Mode] na
[VBR] in možnosti [Codec] na [H.265].

[139] Omrežne funkcije Konfiguriranje pretočnega predvajanja

Nastavitev zvočnega kodeka za pretočno predvajanje

Nastavite zvočni kodek z uporabo možnosti [Stream] > [Audio Stream] v spletnem meniju.
[Setting]
Če želite omogočiti pretočno predvajanje zvoka, nastavite to možnost na On.
[Codec]
Izbere vrsto kodeka, ki se uporablja za pretočno predvajanje zvoka.
[AAC (256kbps)]: Izberite, da podelite prednost kakovosti zvoka.
[AAC (128kbps)]: Izberite, da podelite prednost podatkovni zmogljivosti.
Ta nastavitev ne vpliva na posnetek, ki ga posname enota, ali zvočni signal, dodan v signal
HDMI/SDI.

[140] Omrežne funkcije Konfiguriranje pretočnega predvajanja

Začetek/zaustavitev pretočnega predvajanja

Za možnosti [RTSP], [SRT-Listener] in [NDI|HX]
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Enota čaka na zahtevo za pretočno predvajanje.
Zaženite odjemalsko aplikacijo za ogled pretočnega predvajanja in dostopajte do spletnega
naslova, prikazanega v naslednji tabeli.
Vnesite vrednosti za uporabniško ime in geslo, ki sta konfigurirana v enoti.

<camera_address>: naslov IP enote
<Port>: vrata poslušalca, konfigurirana z možnostjo [Port Number]

Primer pretočnega predvajanja RTSP
V enoti lahko omogočite do dva toka. Spletni naslov vsakega toka je prikazan spodaj.
rtsp://<camera_address>:<Port>/video1 ([Video Stream 1])
rtsp://<camera_address>:<Port>/video2 ([Video Stream 2])

Opomba

Predvajanje ni zagotovljeno v vseh aplikacijah ali napravah.

Za možnost [SRT-Caller]

Za začetek pretočnega predvajanja pritisnite gumb [Stream now] na zavihku  (Stream) na
zaslonu delovanja v živo. Oznaka gumba se spremeni v [Stop stream], na vrhu slikovne plošče
kamere pa se prikaže ikona [Stream].
Da zaustavite pretočno predvajanje, pritisnite gumb [Stop stream] med pretočnim predvajanjem.
Oznaka gumba se spremeni nazaj v [Stream now], na vrhu slikovne plošče kamere pa izgine
ikona [Stream].

Primer pretočnega predvajanja SRT-Listener
Spletni naslov pretoka je prikazan spodaj.
srt://<camera_address>:<Port>
<camera_address>: naslov IP enote

Format pretočnega
predvajanja Spletni naslov

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX
Oglejte si navodila za uporabo odjemalske naprave, združljive z
gonilnikom NDI|HX.
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<Port>: vrata poslušalca, konfigurirana z možnostjo [Port Number]

Opomba

Predvajanje ni zagotovljeno v vseh aplikacijah ali napravah.

[141] Zaslon sličic

Zaslon sličic

Če pritisnete gumb [Thumbnail] na zaslonu za upravljanje predvajanja ali gumb THUMBNAIL na
infrardečem daljinskem upravljalniku, se na slikovni plošči kamere prikažejo posnetki, ki so
posneti na pomnilniško kartico. Ta prikaz na slikovni plošči kamere se imenuje zaslon sličic.
Na zaslonu sličic lahko izberete posnetek in zaženete njegovo predvajanje.
S pritiskom na gumb [Thumbnail] med prikazom zaslona sličic zaprete zaslon sličic in se vrnete
na prikaz slike snemanja.

Opomba

Na zaslonu sličic so prikazani samo posnetki, posneti v trenutno izbranem formatu snemanja. Če
posnetek, ki ste ga pričakovali, ni prikazan, preverite format snemanja. Na to bodite posebej pozorni
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pred formatiranjem (inicializiranjem) pomnilniških medijev.

Postavitev zaslona

Sličica izbranega posnetka je prikazana z oranžnim ozadjem.
Podatki o izbranem posnetku so prikazani na dnu zaslona.

Izbrana pomnilniška kartica
Če je pomnilniška kartica zaščitena pred zapisovanjem, se na desni strani pojavi ikona
ključavnice.

1.

Številka posnetka/skupno število posnetkov2.

Sličica (slika kazala)
Prikaže sliko kazala posnetka. Ko je posnetek posnet, se njegova prva sličica samodejno
nastavi kot slika kazala.
Podatki o posnetku/sličici so prikazani pod sličico. Prikazane podatke lahko spremenite z
uporabo možnosti [Thumbnail] > [Customize View] > [Thumbnail Caption] v meniju kamere.

3.

Ime posnetka
Prikaže ime izbranega posnetka.

4.

Format snemanja
Prikaže datotečni format izbranega posnetka.

5.

Posebni podatki o snemanju
Prikaže način snemanja, a samo, če je bil posnetek posnet s posebnim načinom snemanja.
Hitrost sličic počasnih in hitrih posnetkov je prikazana na desni strani.

6.
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[142] Zaslon sličic Predvajanje posnetkov in druge funkcije s posnetki

Predvajanje posnetih posnetkov

Posnete posnetke lahko predvajate, ko je enota v načinu stanja pripravljenosti za snemanje
(Stby).
V tej temi je opisano, kako predvajati posnete posnetke z uporabo nadzorne plošče grafičnega
uporabniškega vmesnika.

Trajanje posnetka7.

Datum, ko je bil posnetek ustvarjen8.

Vstavite pomnilniško kartico, ki jo želite predvajati.1

Pritisnite gumb [Thumbnail].

Prikažejo se sličice posnetka.

2

Uporabite puščične gumbe na nadzorni plošči grafičnega uporabniškega vmesnika,
da premaknete kazalec na sličico posnetka, ki ga želite predvajati.

3
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Opomba

Posnetkov ni mogoče izbrati z upravljanjem na dotik.

Pritisnite gumb [Set] na nadzorni plošči grafičnega uporabniškega vmesnika.

Predvajanje se začne od začetka izbranega posnetka.

4

Upravljajte nadzorno ploščo za predvajanje, kot vam ustreza.

Namig

Delovanje lahko upravljate tudi z nadzorno ploščo grafičnega uporabniškega vmesnika.
Predvajanje: Pritisnite gumb [Set].

5

Gumb Funkcija

Gumb  (predvajanje/začasna
zaustavitev)

Predvaja posnetek. Med predvajanjem začasno
ustavi posnetek.

Gumb  (hitro pomikanje
naprej), gumb  (hitro
pomikanje nazaj)

Predvaja posnetek z veliko hitrostjo. Ko pritisnete
gumb, se hitrost predvajanja spremeni v treh
korakih.

Gumb  (prejšnji), gumb 
(naslednji)

Preskoči na začetek posnetka ali na
prejšnji/naslednji posnetek.

Gumb  (zaustavitev) Zaustavi predvajanje.
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Opomba

Na ločnici med posnetkoma se lahko pojavi začasna prekinitev slike ali ustavljena slika. Med tem
časom ne morete uporabljati enote.

Ko izberete posnetek s seznama sličic in ga začnete predvajati, se lahko na začetku posnetka pojavi
začasna prekinitev slike. Če si želite ogledati začetek posnetka brez prekinitve, preklopite enoto v
način predvajanja, prekinite predvajanje, pritisnite gumb  (prejšnji), da se vrnete na začetek
posnetka, in znova začnite s predvajanjem.

[143] Zaslon sličic Predvajanje posnetkov in druge funkcije s posnetki

Upravljanje posnetih posnetkov

Na zaslonu sličic lahko z uporabo menija [Thumbnail] v meniju kamere upravljate posnetke ali si
ogledate lastnosti posnetkov.
Pritisnite gumb [Menu] na zaslonu za upravljanje predvajanja, da prikažete meni kamere na
slikovni plošči kamere.
Z uporabo menija [Thumbnail] v meniju kamere lahko izvajate naslednje postopke.

Začasna zaustavitev med predvajanjem: Pritisnite gumb [Set] med predvajanjem. Pritisnite
ponovno za vrnitev v običajno predvajanje.
Preskok na začetek posnetka/začetek naslednjega posnetka: Pritisnite gumb v levo/gumb v
desno.
Hitro pomikanje naprej/nazaj: Pritisnite in pridržite gumb v desno/gumb v levo. Predvajanje
se vrne na normalno hitrost, ko spustite gumb.
Zaustavitev predvajanja: Pritisnite gumb [Cancel/Back].
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Namig
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Za prikaz menija kamere lahko pritisnete tudi gumb [Menu] na zaslonu delovanja v živo.

Upravljanje z uporabo menija [Thumbnail] v meniju kamere

S puščičnimi gumbi na nadzorni plošči grafičnega uporabniškega vmesnika izberite funkcijo za
upravljanje in pritisnite gumb [Set].
Za vrnitev na prejšnji zaslon pritisnite gumb [Cancel/Back].

Opomba

Nekaterih elementov ni mogoče izbrati, kar je odvisno od stanja, ko je bil meni prikazan.

Elementi menija za upravljanje posnetkov

Meni [Thumbnail] v meniju kamere vsebuje naslednje elemente menija, ki so povezani z
upravljanjem posnetkov.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Za podrobnosti o vsakem elementu menija si oglejte "meni [Thumbnail]".

Prikaz zaslona z lastnostmi posnetka
Izberite možnost [Thumbnail] > [Display Clip Properties] v meniju kamere, da prikažete zaslon z
lastnostmi posnetka.
Pritisnite gumb  (prejšnji) ali gumb  (naslednji), da skočite na prejšnji/naslednji
posnetek.

Dodajanje zastavic posnetkov
Posnetkom lahko dodate zastavice (oznake OK, NG ali KP), če želite filtrirati prikaz posnetkov
glede na zastavice posnetkov.
Izberite sličico za posnetek, ki mu želite dodati zastavico posnetka, nato pa izberite zastavico
posnetka z možnostjo [Thumbnail]] > [Set Clip Flag] v meniju kamere.

Nastavitev Dodana zastavica posnetka

[Add OK] OK
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Namig

Za dodajanje zastavic posnetkov lahko uporabite tudi dodeljiv gumb, ki ste mu dodelili funkcijo
zastavice posnetka.

Prikaz zaslona sličic filtriranih posnetkov
Izberite možnost [Thumbnail] > [Filter Clips] v meniju kamere in izberite tip zastavice za prikaz
samo tistih posnetkov, ki imajo določeno zastavico.
Za prikaz vseh posnetkov izberite možnost [All].
Pritisnete lahko tudi gumb [Display], da razvrstite prikaz sličic po zastavicah.

Brisanje posnetkov
Izbrišete lahko posnetke s pomnilniških kartic.
Izberite možnost [Thumbnail] > [Delete Clip] > [Select Clip] ali [All Clips] v meniju kamere.
[Select Clip]: Izbriše izbrani posnetek. Izberete lahko več posnetkov.
[All Clips]: Izbriše vse prikazane posnetke.

Spreminjanje podatkov, prikazanih na zaslonu sličic
Spremenite lahko podatke o posnetku/sličici, ki so prikazani pod sličico.
Izberite možnost [Thumbnail] > [Customize View] > [Thumbnail Caption] v meniju kamere in
izberite podatke za prikaz.
[Date Time]: Prikaže datum in čas, ko je bil posnetek ustvarjen in nazadnje spremenjen.
[Time Code]: Prikaže časovno kodo.
[Duration]: Prikaže trajanje posnetka.
[Sequential Number]: Prikaže sekvenčno številko vsake sličice.

[144] Meni kamere in podrobne nastavitve

Konfiguracija menija kamere 

Ko pritisnete gumb [Menu] na nadzorni plošči grafičnega uporabniškega vmesnika ali gumb
MENU na infrardečem daljinskem upravljalniku, se na slikovni plošči kamere prikaže meni
kamere za konfiguracijo različnih nastavitev, ki so potrebne za snemanje in predvajanje.

[Add NG] NG

[Add KEEP] KP
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Meni sestavljajo naslednji meniji.

Konfiguracija menijev

Meni [User]
Vsebuje elemente menija, ki jih konfigurira uporabnik.
Urejanje je mogoče z možnostjo [Edit User Menu].
Meni [Edit User]
Vsebuje elemente menija za urejanje menija [User].
Meni [Shooting]
Vsebuje nastavitve, povezane s snemanjem.
Meni [Project]
Vsebuje osnovne nastavitve projekta.
Meni [Paint/Look]
Vsebuje nastavitve, povezane s kakovostjo slike.
Meni [Pan-Tilt]
Vsebuje nastavitve, povezane z obračanjem/nagibanjem.
Meni [TC/Media]
Vsebuje nastavitve, povezane s časovnimi kodami in pomnilniškimi mediji.
Meni [Monitoring]
Vsebuje nastavitve, povezane z video izhodom in prikazom zaslona.
Meni [Audio]
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Vsebuje nastavitve, povezane z zvokom.
Meni [Thumbnail]
Vsebuje nastavitve, povezane s prikazom sličic.
Meni [Technical]
Vsebuje nastavitve za tehnične elemente.
Meni [Network]
Vsebuje nastavitve, povezane z omrežji.
Meni [Maintenance]
Vsebuje nastavitve naprave, kot sta ura in jezik.

Konfiguracija in hierarhija menija kamere

Raven 1 Raven 2

User
(tovarniške nastavitve)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Lens

Edit User Menu

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button
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Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Display Clip Properties

Set Clip Flag
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[145] Meni kamere in podrobne nastavitve Upravljanje menija kamere

Upravljanje menija kamere

Ko pritisnete gumb [Menu] na nadzorni plošči grafičnega uporabniškega vmesnika ali gumb
MENU na infrardečem daljinskem upravljalniku, se na slikovni plošči kamere prikaže meni
kamere za konfiguracijo različnih nastavitev, ki so potrebne za snemanje in predvajanje.
Meni se upravlja z gumbi na nadzorni plošči grafičnega uporabniškega vmesnika.

Thumbnail

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Gumb [Menu]: Pritisnite za prikaz menija kamere. Ko je meni kamere prikazan, znova pritisnite
ta gumb, da skrijete meni.
Puščični gumbi: Pritisnite puščične gumbe, da premaknete kazalec v meniju kamere
gor/dol/levo/desno, da izberete elemente menija ali nastavitve.
Gumb [Set]: Pritisnite za potrditev izbranega elementa.
Gumb [Cancel/Back]: Pritisnite za vrnitev na prejšnji meni. Nedokončana sprememba je
preklicana.

Opomba

Nekaterih elementov ni mogoče izbrati, kar je odvisno od stanja, ko je bil meni prikazan.

Nastavljanje elementov menija

S puščičnimi gumbi na nadzorni plošči grafičnega uporabniškega vmesnika premaknite kazalec
na element, ki ga želite nastaviti, in pritisnite gumb [Set], da uporabite nastavitev.

Območje za izbor elementov menija prikaže do osem vrstic. Če vseh razpoložljivih možnosti
za element ni mogoče prikazati hkrati, se s kazalcem pomaknite po zaslonu
navzgor/navzdol.
Območje nastavitev se ne prikaže pri podelementih z velikim razponom nastavitev (na
primer –99 do +99). Trenutna nastavitev je poudarjena, s čimer je označena vrednost, ki jo
lahko spremenite.
Izbira možnosti [Execute] za funkcijo bo izvršila ustrezno funkcijo.
Izbira elementa, ki zahteva potrditev pred izvršitvijo, bo začasno skrila meni in prikazala
potrditveno sporočilo. Preverite sporočilo in izberite ali želite izvršiti ali preklicati funkcijo.

[146] Meni kamere in podrobne nastavitve Upravljanje menija kamere

Vnos niza znakov

Ko izberete element, kot je ime datoteke, ki zahteva vnos znakov, se pojavi zaslon za vnos
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znakov.

[147] Meni kamere in podrobne nastavitve Meni User

User

Ta tema opisuje funkcije in nastavitve vsakega elementa menija.

Pritisnite puščične gumbe na nadzorni plošči grafičnega uporabniškega vmesnika,
da izberete tip znakov in uporabite nastavitev.

[ABC]: veliki abecedni znaki
[abc]: mali abecedni znaki
[123]: številčni znaki
[!#$]: posebni znaki

1

Izberite znak in pritisnite gumb [Set], da uporabite nastavitev.

Kazalec se premakne na naslednje polje.
[Space]: Vstavi presledek na položaju kazalca.
[‹] [›]: Spremeni položaj kazalca.
[BS]: Izbriše znak na levi strani kazalca (funkcija backspace).

2

Ko ste zaključili, pritisnite gumb [Done], da uporabite nastavitev.

Niz znakov je potrjen in zaslon za vnos znakov izgine.

3

Element Opis
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Opomba

Elemente menija lahko dodajate in odstranjujete z uporabo menija [Edit User] v meniju [User].
Nastaviti je mogoče do 20 elementov.

[148] Meni kamere in podrobne nastavitve Meni Edit User

Base Setting Project > element Base Setting

Focus Shooting > element Focus

S&Q Motion Shooting > element S&Q Motion

LUT On/Off Shooting > element LUT On/Off

Simul Rec Project > element Simul Rec

Proxy Rec Project > element Proxy Rec

Interval Rec Project > element Interval Rec

Picture Cache Rec Project > element Picture Cache Rec

Assignable Button Project > element Assignable Button

Scene File Project > element Scene File

Base Look Paint/Look > element Base Look

P/T Acceleration Pan-Tilt > element P/T Acceleration

Clip Name Format TC/Media > element Clip Name Format

Format Media TC/Media > element Format Media

Video Signal Monitor Monitoring > element Video Signal Monitor

Marker Monitoring > element Marker

Zoom Technical > element Zoom

Lens Technical > element Lens

Edit User Menu Prikaže meni Edit User.
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Edit User

Meni [Edit User] je prikazan na vrhnji ravni, ko je možnost [Edit User Menu] izbrana v meniju
[User].

[149] Meni kamere in podrobne nastavitve Meni Shooting

ISO/Gain/EI

Določi nastavitve ojačitve.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Add Item
Doda element meniju
[User].

– –
Meniju [User] doda element menija
ravni 2.

Customize Reset
Ponastavi elemente v
meniju [User].

– –
Elemente menija, registrirane v
meniju [User], ponastavi na privzete
tovarniške vrednosti.

Element menija ravni
2, ki je izbran med
urejanjem

Delete –
Izbriše registriran element menija
ravni 2 iz menija [User].

Move –
Prerazporedi registrirane elemente
menija v meniju [User].

Edit Sub Item –
Uredi (registracija/brisanje) registriran
podelement menija ravni 3 v meniju
[User].

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Mode ISO/dB dB
Izbere način
nastavitve
ojačitve.
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ISO/Gain<L>

Za podrobnosti o
nastavitvah si oglejte
razdelek "Nastavitve
ISO/Gain in privzete
vrednosti".

–
Nastavi privzeto
vrednost
ojačitve <L>.

Exposure
Index<L>

Ko je možnost Base ISO
nastavljena na ISO 800: 
200EI / 4.0E 
250EI / 4.3E 
320EI / 4.7E 
400EI / 5.0E 
500EI / 5.3E 
640EI / 5.7E 
800EI / 6.0E 
1000EI / 6.3E 
1250EI / 6.7E 
1600EI / 7.0E 
2000EI / 7.3E 
2500EI / 7.7E 
3200EI / 8.0E
Ko je možnost Base ISO
nastavljena na ISO 12800: 
3200EI / 4.0E 
4000EI / 4.3E 
5000EI / 4.7E 
6400EI / 5.0E 
8000EI / 5.3E 
10000EI / 5.7E 
12800EI / 6.0E 
16000EI / 6.3E 
20000EI / 6.7E 
25600EI / 7.0E 
32000EI / 7.3E 
40000EI / 7.7E 
51200EI / 8.0E

Ko je možnost Base
ISO nastavljena na
ISO 800: 800EI / 6.0E 
Ko je možnost Base
ISO nastavljena na
ISO 12800: 12800EI /
6.0E

Nastavi
indeksno
vrednost
osvetlitve <L>.

Shockless
Gain

On / Off Off
Vklopi/izklopi
funkcijo ojačitve
brez sunkov.

Base
Sensitivity

High / Low Low
Nastavi osnovno
občutljivost za
način Custom.
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[150] Meni kamere in podrobne nastavitve Meni Shooting

ND Filter

Nastavi prednastavljene vrednosti za filter ND.

[151] Meni kamere in podrobne nastavitve Meni Shooting

Shutter

Nastavi delovanje elektronskega zaklopa.

Base ISO ISO 12800 / ISO 800 ISO 800

Nastavi osnovno
občutljivost ISO
za način Cine
EI.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Mode Preset / Variable Variable Izbere način filtra ND.

Preset1
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Nastavi prednastavljeno
vrednost 1 za filter ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/16
Nastavi prednastavljeno
vrednost 2 za filter ND.

Preset3
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64
Nastavi prednastavljeno
vrednost 3 za filter ND.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Izbere način
delovanja
elektronskega
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Mode Speed / Angle Speed

zaklopa.
Speed: način za
nastavitev hitrosti
zaklopa v enotah
sekund. Izberite za
jasno snemanje
hitro premikajočih
se subjektov.
Angle: način za
nastavitev hitrosti
zaklopa v obliki
kota zaklopa.

Shutter
Speed
On/Off

On / Off Off

Nastavi, ali naj čas
osvetlitve ob
izbranem načinu
Speed sledi
vrednosti [Shutter
Speed], ali pa je
nastavljen za polno
osvetlitev.

Shutter
Speed

64F do 1/8000 
Razpoložljive nastavitve se lahko
razlikujejo glede na frekvenco sličic
izbranega video formata.
59,94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
29,97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 / 1/4000 / 1/8000
24P/23,98P: 64F / 32F / 16F / 8F / 7F / 6F
/ 5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50

59,94P: 
1/60
50P: 1/50
29,97P:
1/30
25P: 1/25
24P/23,98P:
1/24

Nastavi hitrost
zaklopa, ko je
izbran način
Speed.
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[152] Meni kamere in podrobne nastavitve Meni Shooting

Iris

Določi nastavitve zaslonke.

[153] Meni kamere in podrobne nastavitve Meni Shooting

Auto Exposure

/ 1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250
/ 1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F
/ 2F / 360,0° / 300,0° / 270,0° / 240,0° /
216,0° / 210,0° / 180,0° / 172,8° / 150,0° /
144,0° / 120,0° / 90,0° / 86,4° / 72,0° /
45,0° / 30,0° / 22,5° / 11,25° / 5,6°

180,0°
Nastavi kot
zaklopa, ko je
izbran način Angle.

ECS
On/Off

On / Off Off
Vklopi/izklopi
funkcijo Extended
Clear Scan.

ECS
Frequency

23,99 do 8000 
Razpoložljive nastavitve se lahko
razlikujejo glede na frekvenco sličic
izbranega formata snemanja.

59,94P:
60,00
50P: 50,00
29,97P:
30,00
23,98P:
23,99
25P: 25,02
24P: 24,02

Nastavi frekvenco
ECS, ko je možnost
Mode nastavljena
na ECS.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Bokeh
Control

On / Off Off
Vklopi/izklopi funkcijo upravljanja
zameglitve ozadja.
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Nastavi prilagoditev samodejne osvetlitve.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Level

+3,0 / +2,75 / +2,5 / +2,25 / +2,0 /
+1,75 / +1,5 / +1,25 / +1,0 / +0,75 /
+0,5 / +0,25 / ±0 / -0,25 / -0,5 / -0,75 /
-1,0 / -1,25 / -1,5 / -1,75 / -2,0 / -2,25 /
-2,5 / -2,75 / -3,0

±0
Nastavi raven svetlosti za
samodejno zaznano
osvetlitev.

Mode Backlight / Standard / Spotlight Standard

Nastavi način delovanja
prilagoditve samodejne
osvetlitve.
Backlight: način
Backlight (način za
zmanjšano temnost
subjekta, ko je osvetljen iz
ozadja)
Standard: način
Standard
Spotlight: način Spotlight
(način za zmanjšano
prežganost bele barve, ko
je subjekt osvetljen s
točkovnim virom svetlobe)

Speed od –99 do +99 ±0

Nastavi hitrost
prilagoditve za
prilagoditev samodejne
osvetlitve.

AGC On / Off Off
Vklopi/izklopi funkcijo
AGC (auto gain control).

AGC
Limit

Za podrobnosti o nastavitvah si
oglejte razdelek "Nastavitve AGC
Limit in privzete vrednosti".

–
Nastavi največjo ojačitev
funkcije AGC.

AGC
Point

F2.8 / F4 / F5.6 F2.8

Nastavi vrednost
zaslonke, kjer se začne
delovanje AGC, ko je
vklopljena funkcija AGC.
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Auto
Shutter

On / Off Off
Vklopi/izklopi kontrolno
funkcijo samodejnega
zaklopa.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Nastavi najkrajši čas
zaklopa pri funkciji
samodejnega zaklopa.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11

Nastavi vrednost
zaslonke, kjer se začne
delovanje samodejnega
zaklopa.

Clip High
light

On / Off Off

Vklopi/izklopi funkcijo, ki
ignorira najsvetlejše dele,
da omogoči manj izrazito
reakcijo na visoko
osvetljenost.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Nastavi razpon merjenja
za samodejno prilagajanje
osvetlitve glede na
svetlost subjekta. (Ni na
voljo pri ročnem
prilagajanju osvetlitve)

Detect
Window
Indication

On / Off Off
Vklopi/izklopi indikacijo
merjenja ravni
osvetljenosti.

Custom
Width

od 40 do 999 500
Nastavi širino razpona
merjenja svetlobe.

Custom
Height

od 70 do 999 500
Nastavi višino razpona
merjenja svetlobe.

Custom
H
Position

od –479 do +479 ±0
Nastavi vodoravni položaj
razpona merjenja
svetlobe.

Custom
V
Position

od –464 do +464 ±0
Nastavi navpični položaj
razpona merjenja
svetlobe.
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[154] Meni kamere in podrobne nastavitve Meni Shooting

White

Prilagodi nastavitve beline.

[155] Meni kamere in podrobne nastavitve Meni Shooting

White Setting

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Preset
White

od 2000K do
15000K

3200K Nastavi privzeto vrednost beline.

Color
Temp
<A>

od 2000K do
15000K

3200K

Nastavi temperaturo barve za belino, shranjeno v
pomnilniku A.

Opomba

Ker je temperatura barve med delovanjem R
Gain/B Gain pri 2000 K in 15000 K prežgana,
morda ne bo mogoče prikazati pravilne vrednosti
temperature barve za vrednost R Gain/B Gain.

Tint<A>
od –99 do
+99

±0

Nastavi odtenek za belino, shranjeno v pomnilniku
A.

Opomba

Ker je odtenek med delovanjem R Gain/B Gain pri
vrednosti ±99 prežgan, morda ne bo mogoče
prikazati pravilne vrednosti odtenka za vrednost R
Gain/B Gain.

R Gain
<A>

od –99,0 do
+99,0

±0,0
Nastavi vrednost ojačitve R za belino, shranjeno v
pomnilniku A.

B Gain
<A>

od –99,0 do
+99,0

±0,0
Nastavi vrednost ojačitve B za belino, shranjeno v
pomnilniku A.
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Prilagodi nastavitve beline.

[156] Meni kamere in podrobne nastavitve Meni Shooting

Offset White

Prilagodi nastavitve odmika beline.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Shockless
White

Off / 1 / 2 / 3 2

Nastavi hitrost odziva beline pri
preklapljanju med načini beline.
Off: Preklop se zgodi takoj.
Od 1 do 3: Višja kot je številka,
počasnejši je preklop.

ATW
Speed

1 / 2 / 3 / 4 / 5 3
Nastavi hitrost odziva v načinu ATW. 
Najvišja hitrost odziva je 1, najnižja
hitrost odziva pa 5.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Offset White
<A>

On / Off Off
Nastavi, ali naj se doda (On) ali ne doda (Off)
vrednost odmika belini v pomnilniku A.

Offset Color
Temp<A>

od –99 do
+99

±0
Nastavi odmik temperature barve, ki bo dodan
belini v pomnilniku A, ko je možnost [Offset
White <A>] nastavljena na On.

Offset
Tint<A>

od –99 do
+99

±0
Nastavi odmik vrednosti odtenka, ki bo dodan
belini v pomnilniku A, ko je možnost [Offset
White <A>] nastavljena na On.

Offset
White<ATW>

On / Off On
Nastavi, ali naj se doda (On) ali ne doda (Off)
vrednost odmika belini ATW.
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[157] Meni kamere in podrobne nastavitve Meni Shooting

Focus

Prilagodi nastavitve ostrenja.

Offset Color
Temp<ATW>

od –99 do
+99

±0
Nastavi odmik temperature barve, ki bo dodan
belini ATW, ko je možnost [Offset
White<ATW>] nastavljena na On.

Offset
Tint<ATW>

od –99 do
+99

±0
Nastavi odmik vrednosti odtenka, ki bo dodan
belini ATW, ko je možnost [Offset
White<ATW>] nastavljena na On.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

AF
Transition
Speed

1(Slow) / 2 / 3
/ 4 / 5 / 6 /
7(Fast)

5
Nastavi hitrost pogona ostrenja za primere, ko
se med samodejnim ostrenjem spremeni
subjekt.

AF Subj.
Shift
Sens.

1(Locked On)
/ 2 / 3 / 4 /
5(Responsive)

5(Responsive)
Nastavi občutljivost za spreminjanje ostrine
subjekta med samodejnim ostrenjem.

Focus
Area

Wide / Zone /
Flexible Spot

Wide

Nastavi ciljno območje za samodejno ostrenje
in samodejno ostrenje s pritiskom (AF).

Oglejte si razdelka "Samodejno
prilagajanje ostrenja (Auto Focus)" in
"Nastavitev območja/mesta samodejnega
ostrenja (Focus Area)".

Wide: Med ostrenjem išče subjekt na širokem
območju slike.
Zone: Samodejno išče točko ostrenja znotraj
določenega območja.
Flexible Spot: Izostri določeno mesto v sliki.

Focus
Area (AF-
S)

Flexible Spot Flexible Spot
Nastavi ciljno območje ostrenja za samodejno
ostrenje s pritiskom (AF-S).
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[158] Meni kamere in podrobne nastavitve Meni Shooting

S&Q Motion

Prilagodi nastavitve načina za počasne in hitre posnetke (oglejte si razdelek "Počasni in hitri
posnetki").

Face/Eye
Detection
AF

Face/Eye
Only AF / 
Face/Eye
Priority AF /
Off

Face/Eye
Priority AF

Omogoči/onemogoči samodejno ostrenje z
zaznavanjem obrazov.

Oglejte si razdelek "Sledenje z
zaznavanjem obrazov in oči (Face/Eye
Detection AF)".

Push AF
Mode

AF / Single-
shot AF(AF-S)

AF Nastavi način pritiska za samodejno ostrenje.

Touch
Function
in MF

Tracking AF /
Spot Focus

Tracking AF
Nastavi delovanje, ko se v načinu ročnega
ostrenja dotaknete zaslona slike kamere.

AF Assist On / Off On

Ko je možnost nastavljena na On, vam
omogoča, da začasno preglasite samodejno
ostrenje in ostrite ročno.

Oglejte si razdelka "Ročna nastavitev cilja
samodejnega ostrenja (AF Assist) s
spletno aplikacijo" in "Ročno ostrenje med
samodejnim ostrenjem s priloženim
infrardečim daljinskim upravljalnikom".

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Setting On / Off Off
Vklopi/izklopi način za počasne in
hitre posnetke.

Nastavi hitrost sličic za počasne in
hitre posnetke.
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[159] Meni kamere in podrobne nastavitve Meni Shooting

LUT On/Off

Prilagodi nastavitve LUT.

[160] Meni kamere in podrobne nastavitve Meni Shooting

Noise Suppression

Frame
Rate

od 1fps do 60fps / 100fps /
120fps / 150fps / 180fps /
200fps / 240fps

–
Opomba

Razpoložljive nastavitve se lahko
razlikujejo glede na sistemsko
frekvenco, kodek in video format.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

SDI
MLUT On / MLUT
Off

MLUT Off
Izbere, ali dodati LUT monitorja video
izhodu SDI.

HDMI/Stream
MLUT On / MLUT
Off

MLUT Off
Izbere, ali dodati LUT monitorja video
izhodu HDMI in video izhodu za
pretočno predvajanje.

Proxy
MLUT On / MLUT
Off

MLUT Off
Izbere, ali dodati LUT monitorja videu
proxy.

Internal Rec
MLUT On / MLUT
Off

MLUT Off
Izbere, ali dodati LUT monitorja
glavnemu videu.

LUT On/Off
Button Target

SDI /
HDMI/Stream /
SDI &
HDMI/Stream

HDMI/Stream
Nastavi ciljni izhod, s katerim upravlja
dodeljiv gumb, ki ste mu dodelili funkcijo
LUT On/Off.
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Prilagodi nastavitve zmanjševanja šuma.

Namig

Nastavitvi [Setting(Custom)] in [Level(Custom)] sta vidni v nastavitvi [Target Display].

[161] Meni kamere in podrobne nastavitve Meni Shooting

Flicker Reduce

Prilagodi nastavitve popravljanja migetanja.

[162] Meni kamere in podrobne nastavitve Meni Shooting

SteadyShot

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting(Custom) On / Off On
Vklopi/izklopi funkcijo zmanjševanja
šuma v načinu Custom.

Level(Custom)
Low / Mid /
High

Mid
Nastavi raven zmanjševanja šuma v
načinu Custom.

Setting(Cine EI) On / Off Off
Vklopi/izklopi funkcijo zmanjševanja
šuma v načinu Cine EI.

Level(Cine EI)
Low / Mid /
High

Mid
Nastavi raven zmanjševanja šuma v
načinu Cine EI.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Mode Auto / On / Off Off Nastavi način popravljanja migetanja.

Frekvenca 50Hz / 60Hz 60Hz
Nastavi frekvenco vira napajanja
razsvetljave, ki povzroča migetanje.
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Prilagodi nastavitve stabilizacije slike.

[163] Meni kamere in podrobne nastavitve Meni Project

Base Setting

Prilagodi osnovne nastavitve.

[164] Meni kamere in podrobne nastavitve Meni Project

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting
Active /
Standard /
Off

Off

Nastavi funkcijo stabilizacije slike.

Opomba

Možnost je omogočena, ko je nameščen združljiv
objektiv.

Če je izbrana nastavitev Active ali Standard,
lahko med delovanjem obračanja/nagibanja pride
do nepričakovanega obnašanja.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Shooting
Mode

Custom /
Cine EI

Custom

S to funkcijo nastavite način snemanja.
Oglejte si razdelek "Nastavitev snemalnega
načina" v poglavju "Konfiguriranje osnovnih
funkcij".

Target
Display

SDR(BT.709)
/ HDR(HLG)

SDR(BT.709)
Nastavi barvni prostor posnetka/izhoda v načinu
Custom.
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Rec Format

Prilagodi nastavitve formata snemanja.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Frequency
59,94 / 50 / 29,97 / 25 / 24 /
23,98

59,94 Izbere sistemsko frekvenco.

Imager
Scan
Mode

FF / S35 FF Izbere velikost zajemanja slike.

Codec
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Nastavi kodek za
snemanje/predvajanje posnetka.

Opomba

Ko je možnost [Imager Scan
Mode] nastavljena na [S35],
ne morete izbrati možnosti
[RAW] in [RAW & XAVC-I].

RAW
Output
Format

Razpoložljive nastavitve se
razlikujejo glede na nastavitev
za [Frequency].

Oglejte si spodnji razdelek
"Nastavitve [RAW Output
Format]".

–

Nastavi velikost slike RAW za
oddajanje zunanjemu snemalniku
RAW.

Opomba

Ko je možnost [Codec]
nastavljena na [RAW &
XAVC-I], se nastavitev [Video
Format] preklopi v povezavi z
nastavitvijo [RAW Output
Format].

Video
Format

Razpoložljive nastavitve se
razlikujejo glede na nastavitve
za [Frequency], [Imager Scan
Mode] in [Codec].

Oglejte si spodnji razdelek
"Nastavitve [Video

–
Nastavi velikost slike in bitno
hitrost.
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Nastavitve [RAW Output Format]

Privzete vrednosti so prikazane v krepki pisavi.
Pogoji, pod katerimi ni mogoče nastaviti možnosti [RAW Output Format], so bili izpuščeni.

Nastavitve [Video Format]

Format]".

Frequency Imager Scan Mode Codec Nastavitev

59,94 / 50 / 29,97 / 25 / 23,98 FF RAW / RAW & XAVC-I
4096×2160 
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan
Mode Codec Nastavitev

59,94 / 50 / 29,97 / 25 /
23,98

FF

RAW –

RAW & XAVC-I
4096×2160P 
3840×2160P

XAVC-I
4096×2160P 
3840×2160P 
1920×1080P

XAVC-L

3840×2160P 
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
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Privzete vrednosti so prikazane v krepki pisavi.

[165] Meni kamere in podrobne nastavitve Meni Project

Cine EI Setting

Prilagodi nastavitve načina Cine EI (oglejte si razdelek "Nastavitev snemalnega načina" v
poglavju "Konfiguriranje osnovnih funkcij").

[166] Meni kamere in podrobne nastavitve Meni Project

Simul Rec

Prilagodi nastavitve načina za sočasno snemanje na 2 pomnilniški kartici (oglejte si razdelek
"Sočasno snemanje na pomnilniški kartici A in B (2-slot Simul Rec)").

XAVC-I
4096×2160P

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Nastavi barvni prostor v
načinu Cine EI.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Setting On / Off Off
Vklopi/izklopi način
sočasnega snemanja na
2 pomnilniški kartici.

Rec
Button
Set

Rec Button: [SlotA SlotB] 2nd Rec
Button: [SlotA SlotB] / Rec Button:
[SlotA] 2nd Rec Button: [SlotB] / Rec
Button: [SlotB] 2nd Rec Button:
[SlotA]

Rec Button:
[SlotA SlotB]
2nd Rec
Button:
[SlotA SlotB]

Dodeli gumbe za
snemanje, ki se
uporabljajo za
upravljanje
posameznega
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[167] Meni kamere in podrobne nastavitve Meni Project

Proxy Rec

Prilagodi nastavitve načina za snemanje proxy (oglejte si razdelek "Snemanje proxy").

[168] Meni kamere in podrobne nastavitve Meni Project

Interval Rec

Prilagodi nastavitve načina intervalnega snemanja (oglejte si razdelek "Video snemanje s
prekinitvami (Interval Rec)").

pomnilniškega medija.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Setting On / Off Off
Vklopi/izklopi način snemanja
proxy.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
Izbere zvočni kanal za snemanje
podatkov proxy.

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Setting On / Off Off

Vklopi/izklopi način
intervalnega snemanja.
(Vklop tega načina bo
izklopil vse ostale
posebne načine.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 /
10 / 15 / 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 /
10 / 15 / 20 / 30 / 40 / 50
(min) 

1

Nastavi interval med
snemanji v načinu
snemanja Interval Rec
(ko je možnost Interval
Rec nastavljena na On).
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[169] Meni kamere in podrobne nastavitve Meni Project

Picture Cache Rec

Prilagodi nastavitve načina snemanja slikovnega predpomnilnika (oglejte si razdelek "Snemanje
slik iz predpomnilnika (Picture Cache Rec)”).

[170] Meni kamere in podrobne nastavitve Meni Project

SDI/HDMI Rec Control

1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Number
of
Frames

1frame / 2frames / 3frames
/ 
6frames / 9frames /
12frames 
Razpoložljive nastavitve se
lahko razlikujejo glede na
frekvenco sličic izbranega
video formata. 
59.94P/50P: 2frames /
6frames / 12frames 
29.97P/25P/24P/23.98P:
1frame / 3frames / 6frames
/ 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavi število sličic, ki
se posnamejo v enem
posnetku v načinu
snemanja Interval Rec
(ko je možnost Interval
Rec nastavljena na On).

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off Off Vklopi/izklopi funkcijo slikovnega predpomnilnika.

Cache
Size

Short /
Medium /
Long / Max

Max
Nastavi čas akumulacije slik v slikovnem
predpomnilniku (čas snemanja slikovnega
predpomnilnika).

Cache
Rec
Time

– –
Prikaže čas akumulacije slik v slikovnem
predpomnilniku (čas snemanja slikovnega
predpomnilnika).
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Prilagodi nastavitve upravljanja snemanja SDI/HDMI.

[171] Meni kamere in podrobne nastavitve Meni Project

Assignable Button

Dodeljivim gumbom (od <1> do <9>) in gumbu [Focus Hold Button] nastavi dodeljive funkcije.
Dodeliti je mogoče naslednje funkcije.
[Off]: Ni dodelitve funkcije.
[Base ISO/Sensitivity]: Preklopi osnovno občutljivost slikovnega senzorja.
[AGC]: Vklopi/izklopi funkcijo AGC.
[Push AGC]: Omogoči funkcijo AGC med pritiskom gumba.
[ND Filter]

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting

Off /
SDI/HDMI
Remote I/F /
Parallel Rec

Off

Nastavi upravljanje začetka/zaustavitve snemanja
na povezani zunanji napravi prek izhodnega signala
SDI/HDMI.
Off: Ne uporabljajte daljinskega upravljalnika.
SDI/HDMI Remote I/F: Upravljanje
začetka/zaustavitve snemanja na povezani zunanji
napravi, ko v enoti ni vstavljenega pomnilniškega
medija. S pomnilniškim medijem v enoti ni
sinhronizirano na sličico natančno.
Parallel Rec: Upravljanje začetka/zaustavitve
snemanja na povezani zunanji napravi, ko je v enoti
vstavljen pomnilniški medij. S pomnilniškim
medijem v enoti je sinhronizirano na sličico
natančno.

Opomba

Za upravljanje z izhodnim signalom HDMI
nastavite možnost [TC/Media] > [HDMI TC Out] >
[Setting] v meniju kamere na [On].
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V variabilnem načinu: Prilagodi prepustnost svetlobe za filter ND. Pritisnite in pridržite, da
preklopite med možnostmi Clear/Manual/Auto.
V prednastavljenem načinu: Pritisnite in pridržite, da preklopite prednastavitve.

[ND Filter Position]: Preklopi filtre ND.
[Auto ND Filter]: Vklopi/izklopi funkcijo samodejnega filtra ND.
[Push Auto ND]: Omogoči funkcijo samodejnega filtra ND med pritiskom gumba.
[Auto Iris]: Vklopi/izklopi funkcijo zaslonke.
[Push Auto Iris]: Omogoči funkcijo samodejne zaslonke med pritiskom gumba.
[Bokeh Control]: Vklopi/izklopi način upravljanja zameglitve ozadja.
[Auto Shutter]: Vklopi/izklopi funkcijo samodejnega zaklopa.
[AE Level/Mode]: Prilagodi raven samodejne osvetlitve. Pritisnite in pridržite, da preklopite
način samodejne osvetlitve.
[Backlight]: Preklopi med možnostma Backlight in Standard.
[Spotlight]: Preklopi med možnostma Spotlight in Standard.
[Preset White Select]: Preklopi privzeto vrednost beline.
[ATW]: Vklopi/izklopi funkcijo ATW.
[ATW Hold]: Začasno ustavi delovanje funkcije ATW.
[AF Speed/Sens.]: Preklopi nastavitev hitrosti prehoda samodejnega ostrenja in nastavitev
občutljivosti samodejnega ostrenja pri prehodu med subjekti.
[Focus Setting]: Nastavi območje ostrenja.
[Face/Eye Detection AF]: Preklopi med nastavitvami samodejnega ostrenja z zaznavanjem
obrazov.
[Push AF Mode]: Preklopi nastavitev načina Push AF.
[Push AF/MF]: V načinu ročnega ostrenja med pritiskom gumba aktivira samodejno ostrenje. V
načinu samodejnega ostrenja med pritiskom gumba aktivira ročno ostrenje.
[Focus Hold]: V načinu samodejnega ostrenja se med pritiskom gumba izostritev ne spreminja.
[S&Q Motion]: Vklopi/izklopi funkcijo počasnih in hitrih posnetkov. Ob pritisku in pridržanju
nastavi hitrost sličic pri snemanju.
[LUT On/Off] Vklopi/izklopi funkcijo LUT. Cilj preklopa nastavite z uporabo možnosti [Shooting]
> [LUT On/Off] > [LUT On/Off Button Target].
[SteadyShot]: Preklopi med možnostmi Active, Standard in Off.
[Crop Select]: Preklopi možnost Imager Scan Mode. Preklapljanje je omogočeno znotraj
območja brez spreminjanja formata snemanja.
[Rec] Začne/zaustavi snemanje.
[Picture Cache Rec]: Vklopi/izklopi način snemanja slikovnega predpomnilnika.
[Rec Review]: Vklopi/izklopi funkcijo ogleda posnetka.
[Clip Flag OK]: Izvede funkcijo Add OK. Pritisnite dvakrat za izvedbo ukaza Delete Clip Flag.
[Clip Flag NG]: Izvede funkcijo Add NG. Pritisnite dvakrat za izvedbo ukaza Delete Clip Flag.
[Clip Flag Keep]: Izvede funkcijo Add KEEP. Pritisnite dvakrat za izvedbo ukaza Delete Clip
Flag.
[Slot Select] Preklopi med režama za pomnilniški kartici (A) in (B).
[Color Bars]: Vklopi/izklopi barvne vrstice.
[DURATION/TC/U-BIT]: Preklopi med možnostmi Time Code, User Bit in Duration.
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[Display]: Vklopi/izklopi indikatorje na zaslonu.
[Lens Info]: Preklopi indikator globinske ostrine.
[Video Signal Monitor]: Preklopi monitor video signala (kot je monitor valovne oblike).
[Marker]: Vklopi/izklopi funkcijo označbe.
[Thumbnail]: Prikaže/zapusti zaslon sličic.
[Auto Upload (Proxy)]: Vklopi/izklopi samodejni prenos datoteke proxy.
[Direct Menu]: Prikaže/zapusti neposredni meni.
[User Menu]: Prikaže/zapusti meni User.

[172] Meni kamere in podrobne nastavitve Meni Paint/Look

Scene File

Prilagodi nastavitve, povezane s scenskimi datotekami (oglejte si razdelek "Snemanje z želenim
videzom").

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Recall – –

Naloži scensko datoteko,
ki je shranjena v
notranjem pomnilniku, in
uporabi nastavitve kot
nastavitve kakovosti
trenutne slike.

Store – –

Shrani stanje kakovosti
trenutne slike kot scensko
datoteko v notranji
pomnilnik.

Delete – –
Izbriše scensko datoteko
iz notranjega pomnilnika.

Preset
Recall

Ko je možnost Shooting Mode
nastavljena na Custom in je možnost
Target Display nastavljena na
SDR(BT.709): S-Cinetone / Standard /
Still / ITU709
Ko je možnost Shooting Mode
nastavljena na Custom in je možnost

–

Uporabi nastavitve
kakovosti prednastavljene
slike (zapisljive) kot
nastavitve kakovosti
trenutne slike.
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[173] Meni kamere in podrobne nastavitve Meni Paint/Look

Base Look

Prilagodi nastavitve, ki so povezane z osnovnim videzom.

Target Display nastavljena na
HDR(HLG): HLG Live / HLG Natural

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Select

Ko je možnost Shooting Mode
nastavljena na Custom in je
možnost Target Display
nastavljena na SDR(BT.709): S-
Cinetone / Standard / Still /
ITU709 / User1 do User16
Ko je možnost Shooting Mode
nastavljena na Custom in je
možnost Target Display
nastavljena na HDR(HLG): HLG
Live / HLG Natural / User1 do
User16
Ko je možnost Shooting Mode
nastavljena na Cine EI: s709 /
709(800) / S-Log3 / User1 do
User16

Ko je možnost
Shooting Mode
nastavljena na Custom
in je možnost Target
Display nastavljena na
SDR(BT.709): S-
Cinetone
Ko je možnost
Shooting Mode
nastavljena na Custom
in je možnost Target
Display nastavljena na
HDR(HLG): HLG Live
Ko je možnost
Shooting Mode
nastavljena na Cine EI:
s709

Izbere osnovni
videz.

Delete – –
Izbriše izbrani
osnovni videz.

Delete
All

– –
Izbriše vse
osnovne videze.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Nastavi vhodno
barvno lestvico
za izbrani
osnovni videz z
uporabo
možnosti
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[174] Meni kamere in podrobne nastavitve Meni Paint/Look

Reset Paint Settings

Ponastavi nastavitve menija [Paint/Look] z izjemo osnovnega videza.

[175] Meni kamere in podrobne nastavitve Meni Paint/Look

Black

[Select].

Output BT.709 / HLG BT.709

Nastavi izhodno
barvno lestvico
za izbrani
osnovni videz z
uporabo
možnosti
[Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV
/ 5/3EV / 2EV

0EV

Nastavi
referenčno
vrednost
osvetlitve za
izbrani osnovni
videz z uporabo
možnosti
[Select].

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Reset without
Base Look

Execute/Cancel –

Ponastavi nastavitve menija
[Paint/Look] z izjemo osnovnega
videza.
Execute: Izvedite funkcijo.
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Prilagodi nastavitve črnine.

[176] Meni kamere in podrobne nastavitve Meni Paint/Look

Knee

Prilagodi nastavitve popravkov kolena.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Master
Black

od –99,0 do +99,0 ±0,0
Nastavi raven master
črnine.

R Black od –99,0 do +99,0 ±0,0 Nastavi raven črnine R.

B Black od –99,0 do +99,0 ±0,0 Nastavi raven črnine B.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting

Ko je možnost
Target Display
nastavljena na
SDR(BT.709): On /
Off / ---
Ko je možnost
Target Display
nastavljena na
HDR(HLG): On / Off /
---

Ko je možnost
Target Display
nastavljena na
SDR(BT.709):Off
Ko je možnost
Target Display
nastavljena na
HDR(HLG):Off

Vklopi/izklopi funkcijo popravkov
kolena.

Opomba

Omogočeno le, ko je možnost
[Base Look] > [Select]
nastavljena na [Standard],
[ITU709], [HLG Live] ali [HLG
Natural].

Auto
Knee

Ko je možnost
Target Display
nastavljena na
SDR(BT.709): On /
Off / ---
Ko je možnost
Target Display
nastavljena na
HDR(HLG): On / Off /

Ko je možnost
Target Display
nastavljena na
SDR(BT.709):On
Ko je možnost
Target Display
nastavljena na
HDR(HLG):Off

Vklopi/izklopi funkcijo samodejnih
popravkov kolena.

Opomba

Omogočeno le, ko je možnost
[Base Look] > [Select]
nastavljena na [Standard] ali
[ITU709].
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[177] Meni kamere in podrobne nastavitve Meni Paint/Look

Detail

Določi nastavitve prilagajanja podrobnosti.

---

Point 75% do 109% 90% Nastavi točko kolena.

Slope od –99 do +99 ±0 Nastavi naklon kolena.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off On Vklopi/izklopi funkcijo podrobnosti.

Level -7 do +7 ±0 Nastavi raven podrobnosti.

Manual
Setting

On / Off / --- Off
Vklopi/izklopi funkcijo ročne nastavitve
podrobnosti.

V/H
Balance

-2 do +2 ±0
Nastavi razmerje med navpičnimi (V) in
vodoravnimi (H) podrobnostmi za ročno
nastavitev podrobnosti.

B/W
Balance

Type1 /
Type2 /
Type3 /
Type4 /
Type5

Type3

Nastavi razmerje med črnimi (B) podrobnostmi za
slabo osvetljena območja in belimi (W)
podrobnosti za močno osvetljena območja za
ročno nastavitev podrobnosti.

Limit 0 do 7 7
Nastavi raven omejitve podrobnosti za ročno
nastavitev podrobnosti.

Crispening 0 do 7 0
Nastavi raven izrazitosti barve za ročno
nastavitev podrobnosti.

High Light
Detail

0 do 4 0
Nastavi raven podrobnosti močno osvetljenih
območij za ročno nastavitev podrobnosti.
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[178] Meni kamere in podrobne nastavitve Meni Paint/Look

Matrix

Prilagodi nastavitve popravkov matrice.

[179] Meni kamere in podrobne nastavitve Meni Paint/Look

Multi Matrix

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

User Matrix On / Off Off
Vklopi/izklopi funkcijo popravkov
uporabniške matrice.

User Matrix
Level

od –99 do +99 ±0
Prilagodi nasičenost barv celotne
slike.

User Matrix
Phase

od –99 do +99 ±0 Prilagodi ton barv (fazo) celotne slike.

User Matrix
R-G

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico R-G.

User Matrix
R-B

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico R-B.

User Matrix
G-R

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico G-R.

User Matrix
G-B

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico G-B.

User Matrix
B-R

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico B-R.

User Matrix
B-G

od –99 do +99 ±0
Nastavi uporabniško določeno
uporabniško matrico B-G.
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Prilagodi nastavitve popravkov multi matrice.

[180] Meni kamere in podrobne nastavitve Meni Pan-Tilt

P/T Acceleration

Prilagodi nastavitve, ki so povezane s pospeševanjem obračanja/nagibanja.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Setting On / Off Off
Vklopi/izklopi funkcijo
popravkov multi matrice.

Reset Execute/Cancel –
Ponastavi odtenek in
nasičenost za vsako osno
barvo na privzete vrednosti.

Axis
B / B+ / MG- / MG / MG+ / R /
R+ / YL- / YL / YL+ / G- / G / G+
/ CY / CY+ / B-

B Izbere os.

Hue od –99 do +99 ±0
Nastavi odtenek barve,
uporabljene za popravke multi
matrice.

Saturation od –99 do +99 ±0
Nastavi nasičenost barve,
uporabljene za popravke multi
matrice.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Ramp
Curve

1 do 9 8
Izbere pospeševanje/upočasnjevanje za delovanje
obračanja/nagibanja. Večja kot je vrednost, večji
je pospešek.
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[181] Meni kamere in podrobne nastavitve Meni TC/Media

Timecode

Prilagodi nastavitve časovne kode.

[182] Meni kamere in podrobne nastavitve Meni TC/Media

TC Display

Prilagodi nastavitve prikaza podatkov o času.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Mode
Preset / Regen
/ Clock

Preset

Nastavi način, kako teče časovna koda.
Preset: Teči začne od prednastavljene
vrednosti.
Regen: Teči začne od časovne kode na
zaključku prejšnjega posnetka.
Clock: Kot časovno kodo uporabi notranjo
uro.

Run
Rec Run / Free
Run

Rec Run
Rec Run: Teče samo med snemanjem.
Free Run: Teče vedno, ne glede na
delovanje snemanja.

Setting – –
Časovno kodo nastavi na poljubno
vrednost.
Set: Nastavite vrednost.

Reset Execute/Cancel –
Ponastavi časovno kodo na 00:00:00:00.
Execute: Izvedite funkcijo.

TC
Format

DF / NDF DF
Nastavi format časovne kode.
DF: Izpuščanje sličic
NDF: Neizpuščanje sličic

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis
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[183] Meni kamere in podrobne nastavitve Meni TC/Media

Users Bit

Prilagodi nastavitve povezane z uporabniškimi biti.

[184] Meni kamere in podrobne nastavitve Meni TC/Media

HDMI TC Out

Prilagodi nastavitve povezane z izhodom časovne kode ob uporabi izhoda HDMI.

Display
Select

Timecode / Users Bit /
Duration

Timecode
Preklopi prikaz podatkov
o času.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Mode Fix / Time Fix

Nastavi način uporabniških bitov.
Fix: V uporabniških bitih uporabi poljubno
fiksno vrednost.
Time: V uporabniških bitih uporabi
trenutno uro, minuto in sekundo.

Setting – –
Uporabniške bite nastavi na poljubno
vrednost.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off Off
Nastavi, ali naj se pošilja časovna koda na
naprave za druge namene z uporabo izhoda
HDMI.
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[185] Meni kamere in podrobne nastavitve Meni TC/Media

Clip Name Format

Prilagodi nastavitve, ki so povezane s poimenovanjem in brisanjem posnetkov.

Nastavitev naslova

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Title
Prefix

nnn_ (nnn so
zadnje 3
številke
serijske
številke)
(največ 7-
mestni zaslon)

nnn

Nastavi naslovni del (4 do 46 znakov) imena
posnetka. 
Odpre zaslon za vnos niza znakov.

Za podrobnosti o nastavljanju naslovov in
zaslonu za vnos znakov si oglejte spodnja
razdelka "Nastavitev naslova" in "Struktura
zaslona za vnos niza znakov".

Number
Set

0001 do 9999 0001
Imenu posnetka nastavi 4-mestno številčno
pripono.

V območju za izbiro znakov z uporabo puščičnih gumbov na nadzorni plošči
grafičnega uporabniškega vmesnika izberite znak, ki ga želite vstaviti na mesto
kazalca v območju [Title Prefix] (znak je poudarjen). Nato pritisnite gumb [Set] na
nadzorni plošči grafičnega uporabniškega vmesnika.

Vstavi se izbrani znak in kazalec se premakne v desno.

1

Za nastavitev naslova ponovite korak 1.

Uporabite [BS], kot je zahtevano.

2

Ko ste nastavili naslov, izberite možnost [Done], da zaprete zaslon za vnos znakov.

Za podrobnosti o upravljanju zaslona za vnos znakov si oglejte razdelek "Vnos niza
znakov".

Izberete lahko naslednje znake.
!#$%()+,-.;=@[ ]^_~ presledek 

3
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[186] Meni kamere in podrobne nastavitve Meni TC/Media

Update Media

Posodobi datoteko za upravljanje na pomnilniških karticah (oglejte si razdelek "Obnovitev
pomnilniških kartic").

[187] Meni kamere in podrobne nastavitve Meni TC/Media

Format Media

Formatira (inicializira) pomnilniške kartice (oglejte si razdelek "Formatiranje (inicializiranje)
pomnilniških kartic").

0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Media(A) Execute/Cancel –
Posodobi datoteko za upravljanje na
pomnilniški kartici v reži A.
Execute: Izvedite funkcijo.

Media(B) Execute/Cancel –
Posodobi datoteko za upravljanje na
pomnilniški kartici v reži B.
Execute: Izvedite funkcijo.

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Media(A)
Full Format / Quick
Format / Cancel

–
Formatira pomnilniško
kartico v reži A.

Media(B)
Full Format / Quick
Format / Cancel

–
Formatira pomnilniško
kartico v reži B.
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[188] Meni kamere in podrobne nastavitve Meni TC/Media

Media Life

Prikaže preostalo življenjsko dobo pomnilniških kartic.

Opomba

Zahteva pomnilniške kartice, ki podpirajo prikaz preostale življenjske dobe medija.

[189] Meni kamere in podrobne nastavitve Meni Monitoring

Output Format

Prilagodi nastavitve izhodnega formata.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Media(A) – –
Prikaže preostalo življenjsko dobo
pomnilniške kartice v reži A.

Media(B) – –
Prikaže preostalo življenjsko dobo
pomnilniške kartice v reži B.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

SDI Za podrobnosti o nastavitvah si oglejte
razdelek "Izhodni formati in omejitve".

– Nastavi izhodno
ločljivost izhodov SDI
in HDMI.HDMI –



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

[190] Meni kamere in podrobne nastavitve Meni Monitoring

Display On/Off

Prilagodi nastavitve elementov zaslona.
Če želite prikazati element zaslona, izberite možnost On. Če želite skriti element zaslona,
izberite možnost Off.

Element Nastavitev podelementa Privzeta tovarniška vrednost

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On
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[191] Meni kamere in podrobne nastavitve Meni Monitoring

Video Signal Monitor

Prilagodi nastavitve nadzora video signala.

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On

Element Nastavitev
podelementa

Privzeta
tovarniška Opis
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[192] Meni kamere in podrobne nastavitve Meni Monitoring

Marker

Prilagodi nastavitve prikaza označb.

vrednost

Setting
Off / Waveform / Vector
/ Histogram

Off
Nastavi vrsto nadzora video
signala.

Level
Marker 1

0% do 109% 70%
Nastavi raven označevalnika
ravni svetilnosti 1.

Level
Marker 2

0% do 109% 100%
Nastavi raven označevalnika
ravni svetilnosti 2.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Setting On / Off On Vklopi/izklopi prikaz vseh označb.

Color
White / Yellow / Cyan /
Green / Magenta / Red /
Blue

White Izbere označevalno barvo označbe.

Center
Marker

1 / 2 / 3 / 4 / Off Off Izbere osrednjo označbo.

Safety
Zone

On / Off Off
Vklopi/izklopi označbo varnega
območja.

Safety
Area

80% / 90% / 92.5% / 95% 90%
Izbere velikost označbe varnega
območja (kot odstotek velikosti
celotne slike).

Aspect
Marker

Line / Mask / Off Off Izbere tip označbe razmerja.

Aspect
Mask

0 do 15 12
Nastavi raven video signala izven
označbe.
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Aspect
Safety
Zone

On / Off Off
Vklopi/izklopi označbo razmerja
varnega območja.

Aspect
Safety
Area

80% / 90% / 92.5% / 95% 90%
Izbere velikost označbe razmerja
varnega območja (kot odstotek
velikosti celotne slike).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 /
16:9 / 17:9 / 1.66:1 / 1.85:1 /
2.35:1 / 2.39:1 / Custom

2.39:1
Nastavi način pri prikazu označbe
razmerja.

Custom
Aspect
Ratio

Vnesite poljubno vrednost. 01.00:01.00

Nastavi razmerje med stranicami na
poljubno vrednost.

Opomba

Omogočeno, ko je možnost
[Aspect Select] nastavljena na
[Custom].

Guide
Frame

On / Off Off
Vklopi/izklopi prikaz vodilnega
okvirja.

100%
Marker

On / Off Off Vklopi/izklopi 100 % označbo.

User
Box

On / Off Off
Vklopi/izklopi prikaz označbe
uporabniškega pravokotnika.

User
Box
Width

3 do 479 240

Nastavi širino označbe
uporabniškega pravokotnika
(razdaljo od sredine do levega in
desnega roba).

User
Box
Height

3 do 269 135

Nastavi višino označbe
uporabniškega pravokotnika
(razdaljo od sredine do zgornjega in
spodnjega roba).

User
Box H
Position

–476 do +476 0
Nastavi vodoravni položaj središča
označbe uporabniškega
pravokotnika.

User
Box V –266 do +266 0

Nastavi navpični položaj središča
označbe uporabniškega
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[193] Meni kamere in podrobne nastavitve Meni Audio

Audio Input

Prilagodi nastavitve zvočnega vhoda.

Position pravokotnika.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

AUDIO IN
Select

MIC / LINE MIC
Izbere vrsto naprave, priključene na priključek
AUDIO IN.

Phantom
Power
+48V

On / Off Off Prikaže stanje fantomskega napajanja +48 V.

CH1 Input
Select

AUDIO IN
CH1

AUDIO IN
CH1

Prikaže vhodni vir za snemanje na kanalu 1.

CH2 Input
Select

AUDIO IN
CH1 / AUDIO
IN CH2

AUDIO IN
CH2

Preklopi vhodni vir za snemanje na kanalu 2.

CH3 Input
Select

Off / AUDIO
IN CH1

AUDIO IN
CH1

Preklopi vhodni vir za snemanje na kanalu 3.

CH4 Input
Select

Off / AUDIO
IN CH1 /
AUDIO IN
CH2

AUDIO IN
CH2

Preklopi vhodni vir za snemanje na kanalu 4.

AUDIO IN
CH1 MIC
Ref.

-80dB / -70dB
/ -60dB /
-50dB / -40dB
/ -30dB

-50dB
Nastavi referenčno raven snemanja za vhodni
signal mikrofona XLR na vhodu AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

-80dB / -70dB
/ -60dB /
-50dB / -40dB
/ -30dB

–50dB
Nastavi referenčno raven snemanja za vhodni
signal mikrofona XLR na vhodu AUDIO IN CH2.
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Line Input
Reference

+4dB / 0dB /
-3dB / EBUL

+4dB
Nastavi referenčno raven vhoda, ko je možnost
[AUDIO IN Select] nastavljena na LINE.

Reference
Level

-20dB / -18dB
/ -16dB /
-12dB / EBUL

–20dB
Nastavi raven snemanja 1 kHz referenčnega
tonskega signala.

CH1 Wind
Filter

On / Off Off
Omogoči/onemogoči zmanjševanje šuma vetra na
kanalu 1.

CH2 Wind
Filter

On / Off Off
Omogoči/onemogoči zmanjševanje šuma vetra na
kanalu 2.

CH3 Wind
Filter

On / Off Off
Omogoči/onemogoči zmanjševanje šuma vetra na
kanalu 3.

CH4 Wind
Filter

On / Off Off
Omogoči/onemogoči zmanjševanje šuma vetra na
kanalu 4.

CH1
Level
Control

Auto / Manual Auto
Nastavi samodejno ali ročno prilagajanje ravni
zvočnega vhoda na kanalu 1.

CH2
Level
Control

Auto / Manual Auto
Nastavi samodejno ali ročno prilagajanje ravni
zvočnega vhoda na kanalu 2.

CH3
Level
Control

Auto / Manual Auto
Nastavi samodejno ali ročno prilagajanje ravni
zvočnega vhoda na kanalu 3.

CH4
Level
Control

Auto / Manual Auto
Nastavi samodejno ali ročno prilagajanje ravni
zvočnega vhoda na kanalu 4.

CH1 Input
Level

0 do 99 49 Nastavi vhodno raven za snemanje na kanalu 1.

CH2 Input
Level

0 do 99 49 Nastavi vhodno raven za snemanje na kanalu 2.

CH3 Input
Level

0 do 99 49 Nastavi vhodno raven za snemanje na kanalu 3.

CH4 Input
Level

0 do 99 49 Nastavi vhodno raven za snemanje na kanalu 4.
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[194] Meni kamere in podrobne nastavitve Meni Audio

Audio Output

Prilagodi nastavitve zvočnega izhoda.

Glavna
vhodna
raven

0 do 99 99 Nastavi vhodno raven glavnega zvoka.

Limiter
Mode

Off / -6dB /
-9dB / -12dB /
-15dB / -17dB

Off
Izbere lastnosti omejevalnika za velike vhodne
signale, ko ročno nastavljate raven zvočnega
vhoda.

CH1&2
AGC
Mode

Mono /
Stereo

Stereo
Nastavi samodejni način prilagajanja ravni za
kanal 1 in kanal 2. Pri nastavitvi Stereo je AGC
povezan med kanaloma.

CH3&4
AGC
Mode

Mono /
Stereo

Stereo
Nastavi samodejni način prilagajanja ravni za
kanal 3 in kanal 4. Pri nastavitvi Stereo je AGC
povezan med kanaloma.

AGC
Spec

-6dB / -9dB /
-12dB / -15dB
/ -17dB

–6dB Izbere lastnosti AGC-ja.

1kHz
Tone on
Color
Bars

On / Off Off

Vklopi/izklopi 1 kHz referenčni tonski signal ob
prikazu barvnih vrstic.

Opomba

Ko je možnost nastavljena na [On], je 1 kHz
referenčni tonski signal nastavljen za snemanje
na kanalu 3 in kanalu 4, tudi če sta možnosti
[CH3 Input Select] in [CH4 Input Select]
nastavljeni na [Off].

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

HDMI/Stream CH1/CH2 / Nastavi kombinacijo zvočnih kanalov za
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[195] Meni kamere in podrobne nastavitve Meni Thumbnail

Display Clip Properties

Prikaže zaslon z lastnostmi posnetka.

[196] Meni kamere in podrobne nastavitve Meni Thumbnail

Set Clip Flag

Prilagodi nastavitve zastavice posnetka.

[197] Meni kamere in podrobne nastavitve Meni Thumbnail

Lock/Unlock Clip

Output CH CH3/CH4
CH1/CH2

izhod HDMI/pretočno predvajanje.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Display Clip
Properties

– –
Prikaže zaslon z lastnostmi
posnetka.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Add OK – – Doda zastavico OK.

Add NG – – Doda zastavico NG.

Add KEEP – –
Doda zastavico
KEEP.

Delete Clip
Flag

– –
Izbriše vse
zastavice.
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Prilagodi nastavitve zaščite posnetka.

[198] Meni kamere in podrobne nastavitve Meni Thumbnail

Delete Clip

Izbriše posnetke.

[199] Meni kamere in podrobne nastavitve Meni Thumbnail

Transfer Clip

Prenese posnetke.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Select Clip – –
Izbere in zaklene/odklene
posnetek.

Lock All
Clips

– – Zaklene vse posnetke.

Unlock All
Clips

– – Odklene vse posnetke.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Select
Clip

– –
Izbriše izbrani
posnetek.

All Clips – – Izbriše vse posnetke.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis
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[200] Meni kamere in podrobne nastavitve Meni Thumbnail

Transfer Clip (Proxy)

Prenese posnetke proxy.

[201] Meni kamere in podrobne nastavitve Meni Thumbnail

Filter Clips

Prilagodi nastavitve posnetkov za prikaz.

Select
Clip

– – Prenese izbrane posnetke.

All Clips – –

Prenese vse posnetke.

Opomba

Registrirati je mogoče do 200
opravil prenosa.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Select
Clip

– –
Prenese posnetke proxy, ki ustrezajo
izbranim posnetkom.

All Clips – –

Prenese posnetke proxy, ki ustrezajo
vsem posnetkom.

Opomba

Registrirati je mogoče do 200 opravil
prenosa.

Nastavitev Privzeta tovarniška
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[202] Meni kamere in podrobne nastavitve Meni Thumbnail

Customize View

Preklopi pogled zaslona sličic.

[203] Meni kamere in podrobne nastavitve Meni Technical

Color Bars

Prilagodi nastavitve barvnih vrstic.

Element podelementa vrednost Opis

OK – –
Prikaže samo posnetke, ki imajo
zastavico OK.

NG – –
Prikaže samo posnetke, ki imajo
zastavico NG.

KEEP – –
Prikaže samo posnetke, ki imajo
zastavico KEEP.

Brez – –
Prikaže samo posnetke, ki nimajo
zastavice.

All – –
Prikaže vse posnetke ne glede na
zastavice.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Thumbnail
Caption

Date Time / Time Code /
Duration / Sequential Number

Time Code
Preklopi podatke,
prikazane pod sličicami.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis
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[204] Meni kamere in podrobne nastavitve Meni Technical

Genlock

Konfigurira prikaz stanja funkcije genlock (oglejte si razdelek "Sinhronizacija faze video signalov
(Genlock))".

[205] Meni kamere in podrobne nastavitve Meni Technical

Tally

Prilagodi nastavitve indikatorja za snemanje na pomnilniško kartico/snemanje v živo (oglejte si
razdelek "Priključitev signala za snemanje v živo").

Setting On / Off Off
Vklopi/izklopi barvne
vrstice.

Type
ARIB / 100% / 75% /
SMPTE

ARIB Izbere tip barvne vrstice.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Reference
Internal / External(HD)
/ External(SD)

–
Prikaže vrsto referenčnega
signala funkcije genlock.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Tally
Lamp
Brightness

High / Low /
Off

High
Nastavi svetlost indikatorja za snemanje na
pomnilniško kartico/snemanje v živo.

G Tally
Lamp

Enable /
Disable

Enable
Omogoči/onemogoči indikator za snemanje v živo
G.
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[206] Meni kamere in podrobne nastavitve Meni Technical

Rec Review

Prilagodi nastavitve za ogled posnetka (oglejte si razdelek "Ogled posnetka (Rec Review)").

[207] Meni kamere in podrobne nastavitve Meni Technical

Zoom

Prilagodi nastavitve zooma ("Nastavitev zooma").

[208] Meni kamere in podrobne nastavitve Meni Technical

Lens

Tally
Control

External /
Internal

Internal

Izbere cilj za sprejemanje upravljalnih informacij
indikatorja za snemanje na pomnilniško
kartico/snemanje v živo na enoti.
External: Upravljanje indikatorja za snemanje v
živo iz zunanjosti kamere.
Internal: Upravljanje prek snemanja s kamero.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting 3s / 10s / Clip 3s
Nastavi čas predvajanja pravkar posnetih
posnetkov za funkcijo ogleda posnetka.

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Zoom
Type

Optical Zoom Only / On(Clear
Image Zoom)

Optical Zoom Only
Nastavi vrsto
zooma.
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Prilagodi nastavitve, ki so povezane z objektivi.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Lens
Calibration

Execute/Cancel –

Izvede funkcijo, ki popravi razlike v
položaju zooma, ki pri uporabi
objektivov z motoriziranim zoomom
nastanejo zaradi razlik med
posameznimi objektivi.

Zoom Ring
Direction

Left(W)/Right(T)
/
Right(W)/Left(T)

Left(W)/Right(T)

Nastavi smer delovanja obroča za
zoom.

Opomba

Omogočeno samo pri uporabi
objektiva serije E, ki podpira
preklop smeri obroča za zoom.

Shading
Compensation

Auto / Off Auto
Nastavi samodejno kompenzacijo
senčenja.

Chroma
Aberration
Comp.

Auto / Off Auto
Nastavi samodejno kompenzacijo
kromatske aberacije.

Distortion
Comp.

Auto / Off Auto
Nastavi samodejno kompenzacijo
popačenja.

Breathing
Compensation

Auto / Off Off

Nastavi izravnavo objektiva zaradi
dihanja.

Oglejte si razdelek "Izravnava
zaradi dihanja".

Distance
Display

Meter / Feet Meter
Nastavi mersko enoto za prikaz
podatkov o objektivu in položaju
ostrenja.

Zoom Position
Display

Focal Length /
Number / Bar

Number
Nastavi format prikaza položaja
zooma.
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[209] Meni kamere in podrobne nastavitve Meni Technical

APR

Izvede funkcijo APR.

[210] Meni kamere in podrobne nastavitve Meni Network

Wired LAN

Prilagodi nastavitve, ki so povezane z žično povezavo LAN.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

APR Execute/Cancel –

Zažene APR (Automatic Pixel Restoration) za
samodejno prilagoditev slikovnega senzorja.
Execute: Izvedite funkcijo.

Opomba

Pred zagonom funkcije APR vedno
namestite pokrovček objektiva.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

HTTP
Port

– 80 Prikaže vrata za dostop do HTTP.

– – Prikaže lastnosti žične povezave LAN.

DHCP 
On / Off

On
Prikaže, ali je DHCP omogočen (On) ali
onemogočen (Off).

IP Address –
Prikaže naslov IP enote, ko je možnost
[DHCP] nastavljena na [Off].
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[211] Meni kamere in podrobne nastavitve Meni Network

File Transfer

Prilagodi nastavitve, ki so povezane s prenosi datotek (oglejte si razdelek "O prenosu datotek").

Detail
Settings Subnet Mask –

Prikaže masko podomrežja enote, ko je
možnost [DHCP] nastavljena na [Off].

Gateway –
Prikaže privzeti prehod, ko je možnost
[DHCP] nastavljena na [Off].

DNS Auto
On / Off

On
Prikaže nastavitev za samodejno
pridobivanje DNS.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Auto
Upload
(Proxy)

On / Off Off
Vklopi/izklopi samodejno nalaganje datotek
proxy.

Default
Upload
Server

Server
Settings1 do 3
> Display
Name

–

Izbere strežnik za nalaganje datotek. Tukaj
izbran strežnik postane cilj za samodejno
nalaganje datotek proxy in cilj za nalaganje
datotek z zaslona sličic. 
Prikaže nastavitve [Display Name], ki so
konfigurirane v možnostih [Server Settings1 do
3].

Clear
Completed
Jobs

Execute/Cancel –
S seznama izbriše zaključene prenose.
Execute: Izvedite funkcijo.

Clear All
Jobs

Execute/Cancel –
S seznama izbriše vse prenose.
Execute: Izvedite funkcijo.

View Job
List

– – Prikaže seznam prenosov.
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[212] Meni kamere in podrobne nastavitve Meni Maintenance

Language

Nastavi jezik prikaza.

[213] Meni kamere in podrobne nastavitve Meni Maintenance

Clock Set

Prilagodi nastavitve notranje ure.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Select – –
Nastavi jezik prikaza.
Set: Nastavite
vrednost.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Time
Zone

UTC - 12:00 do UTC
+ 14:00

–
Nastavi razliko do časa UTC v
korakih po 30 minut.

Date
Mode

YYMMDD / MMDDYY
/ DDMMYY

YYMMDD

Izbere format prikaza datuma.
YYMMDD: leto, mesec, dan
MMDDYY: mesec, dan, leto
DDMMYY: dan, mesec, leto

12H/24H 12H / 24H 24H
Izbere format prikaza ure.
12H: 12-urni način
24H: 24-urni način

Date – –
Nastavi trenutni datum.
Set: Nastavite vrednost.

Time – –
Nastavi trenutni čas.
Set: Nastavite vrednost.
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[214] Meni kamere in podrobne nastavitve Meni Maintenance

Hours Meter

Prikaže akumulirani čas delovanja.

[215] Meni kamere in podrobne nastavitve Nastavitve menija Shooting in privzete vrednosti

Nastavitve ISO/Gain in privzete vrednosti

Razpon nastavitev [ISO/Gain<L>] in privzetih vrednosti se razlikuje glede na nastavitve [Mode],
[Base Look] > [Select] in [Base Sensitivity].
Privzete vrednosti v tabelah so prikazane v krepki pisavi.

Ko je možnost [Mode] nastavljena na [ISO]

Ko je možnost [Base Look] > [Select] nastavljena na [S-Cinetone], [Standard],
[ITU709] ali [Still]

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Hours
(System)

– –
Prikaže akumulirane ure uporabe
(ponastavitev ni mogoča).

Hours
(Reset)

– –
Prikaže akumulirane ure uporabe
(ponastavitev je mogoča).

Reset Execute/Cancel –
Ponastavi akumulirani čas delovanja na
0.
Execute: Izvedite funkcijo.

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]

ISO 320 
ISO 400 

ISO 5000 
ISO 6400 
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Ko je možnost [Base Look] > [Select] nastavljena na [HLG Live] ali [HLG
Natural]

Ko je možnost [Base Look] > [Select] nastavljena na [User1] do [User16]

ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 128000 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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Ko je možnost [Mode] nastavljena na [dB]

Nastavite lahko vrednost v razponu od –3dB do +30dB v korakih po 1dB.
Privzeta vrednost je 0dB.

[216] Meni kamere in podrobne nastavitve Nastavitve menija Shooting in privzete vrednosti

Nastavitve AGC Limit in privzete vrednosti

Razpon nastavitev menija [AGC Limit] in privzetih vrednosti se razlikuje glede na nastavitve
[Mode], [Base Look] > [Select] in [Base Sensitivity].
Privzete vrednosti v tabelah so prikazane v krepki pisavi.

Ko je možnost [Mode] nastavljena na [ISO]

Ko je možnost [Base Look] > [Select] nastavljena na [S-Cinetone], [Standard],
[ITU709] ali [Still]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]

ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]
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Ko je možnost [Base Look] > [Select] nastavljena na [HLG Live] ali [HLG
Natural]

ISO 400 
ISO 500 
ISO 640 
ISO 800 
ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Ko je možnost [Base Look] > [Select] nastavljena na [User1] do [User16]

Ko je možnost [Mode] nastavljena na [dB]

Izbirate lahko med 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Privzeta vrednost je 15dB.

[217] Meni kamere in podrobne nastavitve

Nastavitve kakovosti slike, shranjene za vsak način
snemanja

Trenutna stanja elementov konfiguracije, ki so povezani s kakovostjo slike, se shranijo za
vsakega od naslednjih načinov snemanja. Ko spremenite način snemanja, se uporabijo
ustrezne nastavitve, ki so shranjene za ciljni način snemanja.

Način Custom z možnostjo Target Display, nastavljeno na SDR(BT.709)
Način Custom z možnostjo Target Display, nastavljeno na HDR(HLG)
Način Cine EI

Elementi konfiguracije, ki so povezani s kakovostjo slike in so shranjeni za vsak način
snemanja, so prikazani v naslednjih tabelah.

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [Low]

Ko je možnost [ISO/Gain/EI] > [Base
Sensitivity] nastavljena na [High]

ISO 1000 
ISO 1250 
ISO 1600 
ISO 2000 
ISO 2500 
ISO 3200 
ISO 4000 
ISO 5000 
ISO 6400 
ISO 8000 
ISO 10000 
ISO 12800 
ISO 16000 
ISO 20000 
ISO 25600

ISO 16000 
ISO 20000 
ISO 25600 
ISO 32000 
ISO 40000 
ISO 51200 
ISO 64000 
ISO 80000 
ISO 102400 
ISO 128000 
ISO 160000 
ISO 204800 
ISO 256000 
ISO 320000 
ISO 409600
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"Da" označuje, da je nastavitev shranjena, "Ne" pa označuje, da nastavitev ni shranjena. "Da" v
več stolpcih pomeni skupne nastavitve.

Element

Način Shooting

Način Custom Način
Cine EISDR(BT.709) HDR(HLG)

Meni
Shooting

ISO/Gain/EI

ISO/Gain Da1) Ne

Exposure Index Ne Da

Base Sensitivity Da Ne

Base ISO Ne Da

White
Preset White Da Da

Drugo Da

White Setting Da

Offset White Da Ne

LUT On/Off Ne Da

Noise
Suppression

Setting(Custom) Da Da Ne

Level(Custom) Da Da Ne

Setting(Cine EI) Ne Da

Level(Cine EI) Ne Da

Meni
Paint/Look

Base Look

Select Da Da Da

Input2) Da

Output2) Da

AE Level
Offset2) Da

Black Da Da Ne

Knee
Auto Knee Da Ne Ne
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[218] Spletni meni in podrobne nastavitve

Konfiguracija spletnega menija

Pritisnite zavihek [Settings] za preklapljanje zaslonov za upravljanje, da prikažete zaslon z
nastavitvami.
Zaslon z nastavitvami uporabljajte za konfiguriranje različnih elementov nastavitev enote,
vključno z začetnimi nastavitvami, omrežnimi nastavitvami, nastavitvami snemanja/predvajanja
z uporabo spletnega menija.

Drugo Da Da Ne

Detail Da Da Ne

Matrix Da Da Ne

Multi Matrix Da Da Ne

Ločene nastavitve občutljivosti ISO so shranjene za način Custom [SDR(BT.709)] in[HDR(HLG)].1)
Nastavitve se shranijo za vsako možnost [Base Look] in niso odvisne od načina snemanja.2)
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Meni sestavljajo naslednji meniji.

Konfiguracija in hierarhija menija

Raven 1 Opis ravni 1 Raven 2

Shooting Vsebuje nastavitve, povezane s snemanjem. Focus

Project Vsebuje osnovne nastavitve projekta.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Vsebuje nastavitve, povezane s kakovostjo slike. Base Look

Pan-Tilt
Vsebuje nastavitve, povezane z
obračanjem/nagibanjem.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Vsebuje nastavitve, povezane z video izhodom in
prikazom zaslona.

Output Format

Output Display

Audio Vsebuje nastavitve, povezane z zvokom. Audio

Technical Vsebuje nastavitve za tehnične elemente.
Tally

IR Remote

Camera Name

User
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Opomba

Možnost [Accessibility] je na voljo samo pri modelih za Severno Ameriko.

Network Vsebuje nastavitve, povezane z omrežji.

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection

Stream
Vsebuje nastavitve, povezane s pretočnim
predvajanjem.

Stream

Video Stream

Audio Stream

Maintenance Vsebuje nastavitve naprave, kot sta ura in jezik.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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[219] Spletni meni in podrobne nastavitve

Upravljanje spletnega menija

Pritisnite zavihek [Settings] za preklapljanje zaslonov za upravljanje, da prikažete zaslon z
nastavitvami, v katerem lahko konfigurirate različne elemente nastavitev enote, vključno z
začetnimi nastavitvami, omrežnimi nastavitvami, nastavitvami snemanja/predvajanja z uporabo
spletnega menija.
Nastavitve v spletnem meniju lahko konfigurirate v tabličnem računalniku z upravljanjem na
dotik ali v osebnem računalniku s pomočjo miške.
Pritisnite meni za elemente, ki jih želite konfigurirati, da prikažete elemente nastavitev in njihove
nastavitve v tem meniju.

Meni (raven 1)1.

Meni (raven 2)2.

Settings3.
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Način konfiguracije

Izbira vrednosti

Pritisnite izbirni gumb za element. Izbirni gumb za izbrani element je prikazan v oranžni barvi.

Vklop/izklop elementa

Pritisnite stikalo, da vklopite/izklopite element. Stikalo je obarvano oranžno, ko je element
vklopljen, in belo, ko je element izklopljen.

Izbira vrednosti s seznama

Pritisnite spustni gumb in izberite element s prikazanega seznama.

Izbira številčne vrednosti

Pritisnite < ali >, da spremenite številčno vrednost. Če je številčna vrednost podčrtana, lahko
številčno vrednost vnesete tudi neposredno.

Vnos znaka/številke

Konfiguracija na ločenem zaslonu
Pritisnite gumb, da izvedete postopek nastavitve na ločenem zaslonu.
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Sporočilo o usmeritvi

Prikazane so informacije, ki vam pomagajo konfigurirati nekatere lastnosti, in sporočila, ki
opozarjajo uporabnika.

Shranjevanje nastavitve

Ko ste zaključili s konfiguracijo nastavitve, pritisnite gumb [OK], da shranite nastavitev.
Če želite zavreči spremembe nastavitve in se vrniti na prejšnjo nastavitev, pritisnite gumb
[Cancel].
Če želite posodobiti prikaz zaslona, pritisnite gumb [Reload].

Opomba

Če pred shranjevanjem nastavitve pritisnete gumb [Reload], se spremembe nastavitve zavržejo.

Če se pred shranjevanjem nastavitve premaknete na drugo stran, se spremembe nastavitve
zavržejo.

[220] Spletni meni in podrobne nastavitve Meni Shooting

Focus

Prilagodi nastavitve ostrenja.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Push AF
Mode

AF / Single-
shot AF(AF-
S)

AF Nastavi način pritiska za samodejno ostrenje.

Touch
Function
in MF

Tracking AF /
Spot Focus

Tracking
AF

Nastavi delovanje, ko se v načinu ročnega ostrenja
dotaknete zaslona slike kamere.

Ko je možnost nastavljena na [On], lahko med
samodejnim ostrenjem z drsnikom ostrenja v spletni
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[221] Spletni meni in podrobne nastavitve Meni Project

Base Setting

Prilagodi osnovne nastavitve.

[222] Spletni meni in podrobne nastavitve Meni Project

Rec Format

Prilagodi nastavitve formata snemanja.

AF
Assist
Control

On / Off On

aplikaciji prilagodite mesto ostrenja.
Za podrobnosti si oglejte razdelek "Ročna
nastavitev cilja samodejnega ostrenja (AF
Assist) s spletno aplikacijo".

Opomba

Ta element je omogočen le, ko je možnost [AF
Assist] v meniju kamere nastavljena na [On].

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Shooting
Mode

Custom /
Cine EI

Custom

S to funkcijo nastavite način snemanja.
Oglejte si razdelek "Snemalni način" v
poglavju "Konfiguriranje osnovnih funkcij".

Target
Display

SDR(BT.709)
/ HDR(HLG)

SDR(BT.709)
Nastavi barvni prostor posnetka/izhoda v
načinu Custom.

Element Nastavitev podelementa
Privzeta

tovarniška Opis
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vrednost

Frequency
59.94 / 50 / 29.97 / 25 / 24 /
23.98

59.94

Izbere sistemsko frekvenco.

Opomba

Če spremenite frekvenco, se
kamera ponovno zažene. Po
ponovnem zagonu znova
naložite stran v spletnem
brskalniku.

Imager
Scan
Mode

FF / S35 FF Izbere velikost zajemanja slike.

Codec
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Nastavi kodek za
snemanje/predvajanje posnetka.

Opomba

Ko je možnost [Imager Scan
Mode] nastavljena na [S35],
ne morete izbrati možnosti
[RAW] in [RAW & XAVC-I].

RAW
Output
Format

Razpoložljive nastavitve se
razlikujejo glede na nastavitev
za [Frequency].

Oglejte si spodnji razdelek
"Nastavitve [RAW Output
Format]".

–

Nastavi velikost slike RAW za
oddajanje zunanjemu snemalniku
RAW.

Opomba

Ko je možnost [Codec]
nastavljena na [RAW &
XAVC-I], se nastavitev [Video
Format] preklopi v povezavi z
nastavitvijo [RAW Output
Format].

Video
Format

Razpoložljive nastavitve se
razlikujejo glede na nastavitve
za [Frequency], [Imager Scan
Mode] in [Codec].

Oglejte si spodnji razdelek
"Nastavitve [Video
Format]".

–
Nastavi velikost slike in bitno
hitrost.
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Nastavitve [RAW Output Format]

Privzete vrednosti so prikazane v krepki pisavi.
Pogoji, pod katerimi ni mogoče nastaviti možnosti [RAW Output Format], so bili izpuščeni.

Nastavitve [Video Format]

Frequency Imager Scan Mode Codec Nastavitev

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160

Frequency Imager Scan
Mode Codec Nastavitev

59.94 / 50 / 29.97 / 25 /
23.98

FF

RAW –

RAW & XAVC-I
4096×2160P 
3840×2160P

XAVC-I
4096×2160P 
3840×2160P 
1920×1080P

XAVC-L

3840×2160P 
1920×1080P
50 
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50 
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P
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Privzete vrednosti so prikazane v krepki pisavi.

[223] Spletni meni in podrobne nastavitve Meni Project

Simul Rec

Prilagodi nastavitve načina za sočasno snemanje na 2 pomnilniški kartici (oglejte si razdelek
"Sočasno snemanje na pomnilniški kartici A in B (2-slot Simul Rec)").

[224] Spletni meni in podrobne nastavitve Meni Project

Proxy Rec

Prilagodi nastavitve načina za snemanje proxy (oglejte si razdelek "Snemanje proxy").

[225] Spletni meni in podrobne nastavitve Meni Project

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off Off
Vklopi/izklopi funkcijo sočasnega snemanja in
nastavi ciljni pomnilniški medij za snemanje.

Rec
Button

SlotA / SlotB /
SlotA/SlotB

SlotA/SlotB Prikaže dodelitev gumba za snemanje za vsak
snemalni medij. 
Nastavite možnost [Project] > [Simul Rec] >
[Rec Button Set] v meniju kamere.

2nd Rec
Button

SlotA / SlotB /
SlotA/SlotB

SlotA/SlotB

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Setting On / Off Off
Vklopi/izklopi način snemanja
proxy.
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Interval Rec

Prilagodi nastavitve načina intervalnega snemanja (oglejte si razdelek "Video snemanje s
prekinitvami (Interval Rec)").

[226] Spletni meni in podrobne nastavitve Meni Project

Picture Cache Rec

Prilagodi nastavitve načina snemanja slikovnega predpomnilnika (oglejte si razdelek "Snemanje
slik iz predpomnilnika (Picture Cache Rec)”).

Element Nastavitev podelementa Privzeta tovarniška
vrednost Opis

Setting On / Off Off

Vklopi/izklopi način
intervalnega snemanja.
(Vklop tega načina bo
izklopil vse ostale
posebne načine.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 /
10 / 15 / 20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 /
10 / 15 / 20 / 30 / 40 / 50
(min) 
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

1

Nastavi interval med
snemanji v načinu
snemanja Interval Rec
(ko je možnost Interval
Rec nastavljena na On).

Number
of
Frames

1frame / 2frames / 3frames
/ 6frames / 9frames /
12frames 
Razpoložljive nastavitve se
lahko razlikujejo glede na
frekvenco sličic izbranega
video formata.
59.94P/50P: 2frames /
6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames / 6frames
/ 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Nastavi število sličic, ki
se posnamejo v enem
posnetku v načinu
snemanja Interval Rec
(ko je možnost Interval
Rec nastavljena na On).
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[227] Spletni meni in podrobne nastavitve Meni Project

All File

Izvaja postopke z datoteko ALL (oglejte si razdelek "Shranjevanje in nalaganje konfiguracijskih
podatkov").

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off Off Vklopi/izklopi funkcijo slikovnega predpomnilnika.

Cache
Size

Short /
Medium /
Long / Max

Max
Nastavi čas akumulacije slik v slikovnem
predpomnilniku (čas snemanja slikovnega
predpomnilnika).

Cache
Rec
Time

– –
Prikaže čas akumulacije slik v slikovnem
predpomnilniku (čas snemanja slikovnega
predpomnilnika).

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Load All
File

– –

V enoto naloži datoteko ALL iz naprave, v kateri je
nameščena spletna aplikacija.

Opomba

Ko v enoto naložite datoteko ALL, se enota
znova zažene. Po ponovnem zagonu znova
naložite stran v spletnem brskalniku.

Save All
File

– –
V napravo, v kateri je nameščena spletna
aplikacija, shrani nastavitve enote kot datoteko
ALL.
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[228] Spletni meni in podrobne nastavitve Meni Paint/Look

Base Look

V enoto lahko naložite osnovni videz.
Na zaslonu se prikaže seznam razpoložljivih osnovnih videzov. Osnovni videz, ki se trenutno
uporablja, je označen z oznako ? na levi strani številke osnovnega videza.

[No.]: številka osnovnega videza
[Base Look Name]: ime osnovnega videza
[Input]: vhodni signal osnovnega videza
[Output]: izhodni signal osnovnega videza
[AE Level Offset]: referenčna vrednost osvetlitve za osnovni videz

Dodajanje osnovnega videza
Za uvoz novega osnovnega videza pritisnite gumb [Import]. Upoštevajte navodila na zaslonu.
Po uvozu nastavite ustrezne vrednosti za možnosti [Input], [Output] in [AE Level Offset]. Za
podrobnosti si oglejte razdelek "Uvoz želenega osnovnega videza".

[229] Spletni meni in podrobne nastavitve Meni Pan-Tilt

P/T Speed
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Prilagodi nastavitve, povezane s hitrostjo obračanja/nagibanja.

[230] Spletni meni in podrobne nastavitve Meni Pan-Tilt

P/T Acceleration

Prilagodi nastavitve, povezane s hitrostjo obračanja/nagibanja.

[231] Spletni meni in podrobne nastavitve Meni Pan-Tilt

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Speed
Step

Normal /
Extended

Extended

Nastavi število korakov hitrosti pogona za
obračanje/nagibanje.
Normal: Hitrost lahko določite v 24 korakih. To
nastavitev uporabite za združljivost z obstoječimi
Sonyjevimi daljinskimi kamerami.
Extended: Hitrost lahko določite v 50 korakih.

Speed
Mode

Normal /
Slow

Normal

Nastavi način hitrosti pogona za
obračanje/nagibanje. 
Omogočeno le, ko je možnost [Speed Step]
nastavljena na [Normal].
Normal: Deluje v območju normalne hitrosti (od
najnižje do najvišje (60 stopinj/sekundo)).
Slow: Deluje v območju nizke hitrosti (od najnižje
do najvišje (40 stopinj/sekundo)).

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Acceleration 1 do 9 8
Izbere pospeševanje/upočasnjevanje za
delovanje obračanja/nagibanja. Večja kot je
vrednost, večji je pospešek.
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P/T Range Limit

Prilagodi nastavitve, ki so povezane z omejevanjem območja delovanja obračanja/nagibanja.
Nastavite meje območja delovanja obračanja/nagibanja z uporabo naslednjega zaslona.

Opomba

Ob vklopu enote ali izvajanju ponastavitve obračanja/nagibanja se ta nastavitev omejitve območja ne
upošteva. Te funkcije ni mogoče uporabiti za izogibanje oviram v bližini enote.

Preklopite stikalo [Setting] v položaj za vklop.

Omogoči se funkcija omejitve območja delovanja obračanja/nagibanja.

1

Z upravljalnimi elementi za obračanje/nagibanje kamere preverite sliko.2

Da nastavite položaje za omejitev delovanja, na teh položajih pritisnite gumb [Left],
[Right], [Up], [Down] > [Set Current Value].

3
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Opomba

Položajev kamere, ki se nahajajo izven mejnih položajev, ni mogoče shraniti kot prednastavitev.

Če spremenite nastavitev [Pan-Tilt] > [P/T Direction] > [Ceiling], se konfigurirane nastavitve mejnih
položajev povrnejo na privzete tovarniške vrednosti.

Nastavitve ni mogoče spremeniti med predvajanjem, med prikazom sličic, ko pride do napake pri
obračanju/nagibanju, ko obračanje/nagibanje ni inicializirano in ko je obračanje/nagibanje
zaklenjeno.

[232] Spletni meni in podrobne nastavitve Meni Pan-Tilt

P/T Direction

Prilagodi nastavitve, povezane s smerjo obračanja/nagibanja.

[Left]: leva stran kamere
[Right]: desna stran kamere
[Up]: zgornja stran kamere
[Down]: spodnja stran kamere

Mejni položaji so nastavljeni in prikazani kot številčne vrednosti (kot).
Če želite preklicati omejitev, pritisnite gumb [Reset] za posamezne položaje.

Pritisnite gumb [OK].

Delovanje obračanja/nagibanja je omejeno tako, da ostane znotraj nastavljenih mejnih
položajev.

4

Element Nastavitev
podelementa

Privzeta
tovarniška Opis
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Opomba

Ob uporabi spremenjene nastavitve [Ceiling] se izbrišejo vsi prednastavljeni položaji, saj bi se
koordinate obračanja/nagibanja obrnile.

Območje pogona za obračanje/nagibanje se glede na nastavitev [Ceiling] spremeni, kot je
prikazano na naslednjih slikah.

A: Ko je možnost [Ceiling] nastavljena na [Off]
B: Ko je možnost [Ceiling] nastavljena na [On]

[233] Spletni meni in podrobne nastavitve Meni Pan-Tilt

P/T Preset

vrednost

Ceiling On / Off Off

Ko je enota nameščena na mizo, nastavite na [Off].
Ko je enota nameščena na strop, nastavite na [On].
Ko je možnost [Ceiling] nastavljena na [On], se
možnost [Pan Direction] samodejno nastavi na
[Opposite].

Pan
Direction

Normal /
Opposite

Normal
Nastavi smer pogona za obračanje. Če spremenite
nastavitev, se smer pogona obrne.

Tilt
Direction

Normal /
Opposite

Normal
Nastavi smer pogona za nagibanje. Če spremenite
nastavitev, se smer pogona obrne.
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Prilagodi nastavitve, povezane s prednastavitvami kamere.

[234] Spletni meni in podrobne nastavitve Meni Monitoring

Output Format

Prilagodi nastavitve izhodnega formata.

[235] Spletni meni in podrobne nastavitve Meni Monitoring

Output Display

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Speed
Select

Separate /
Common

Separate
Določa, ali so prednastavljene hitrosti konfigurirane
ločeno ali pa se uporablja skupna nastavitev.

Common
Speed

1 do 50 50

Nastavi skupno hitrost za prednastavitve.

Opomba

Največja hitrost pogona 24 se uporabi, če
nastavite vrednost 25 ali več, ko je možnost [Pan-
Tilt] > [P/T Speed] > [Speed Step] nastavljena na
[Normal]

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

SDI Za podrobnosti o nastavitvah si oglejte
razdelek "Izhodni formati in omejitve".

– Nastavi izhodno
ločljivost izhodov SDI
in HDMI.HDMI –
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Prilagodi nastavitve, povezane z izhodnimi signali.

Opomba

Ta nastavitev se uporablja tudi za sliko izhodnega signala HDMI, izhodno sliko pretočnega
predvajanja in sliko na slikovni plošči kamere v spletni aplikaciji.

[236] Spletni meni in podrobne nastavitve Meni Audio

Audio Input

Prilagodi nastavitve, povezane z zvočnim vhodom od CH1 do CH4.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

SDI On / Off Off
Določa, ali so meni in podatki o stanju
dodani izhodnemu signalu SDI.

HDMI/Stream On / Off On
Določa, ali so meni in podatki o stanju
dodani izhodnemu signalu HDMI.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Level
Control

Auto / Manual Auto
Nastavi samodejno ali ročno
prilagajanje ravni vhodnega zvoka.

Level 0 do 99 49 Nastavi raven vhoda.

Input
Select

AUDIO IN CH1 /
AUDIO IN CH2 / Off

CH1 in CH3:
AUDIO IN CH1 
CH2 in CH4:
AUDIO IN CH2

Nastavi vir vhodnega zvoka.

Opomba

CH1 je [AUDIO IN CH1] (fiksno).

Wind
Filter

On / Off Off
Vklopi/izklopi filter za zmanjševanje
zvoka vetra.
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Nastavi vhodno raven glavnega zvoka. Glavna raven vhodnega zvoka se uporablja za vse
kanale od 1 do 4.

[237] Spletni meni in podrobne nastavitve Meni Audio

Audio Output

Prilagodi nastavitve, povezane z zvočnim izhodom.

Opomba

Ta nastavitev se uporablja tudi za izhodni zvok pretočnega predvajanja.

[238] Spletni meni in podrobne nastavitve Meni Technical

Tally

Prilagodi nastavitve indikatorja za snemanje na pomnilniško kartico/snemanje v živo (oglejte si
razdelek "Priključitev signala za snemanje v živo").

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Master 0 do 99 99
Nastavi glavno raven
vhoda.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Nastavi kombinacijo zvočnih kanalov za
izhod HDMI/pretočno predvajanje.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis
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[239] Spletni meni in podrobne nastavitve Meni Technical

IR Remote

Prilagodi nastavitve, ki so povezane z infrardečim daljinskim upravljalnikom.

[240] Spletni meni in podrobne nastavitve Meni Network

Camera Name

Prilagodi nastavitve, ki so povezane z imenom kamere (ime enote).

Za ime kamere lahko vnesete največ osem (0 do 8) naslednjih znakov.

Tally
Lamp
Brightness

High / Low /
Off

High
Nastavi svetlost indikatorja za snemanje na
pomnilniško kartico/snemanje v živo.

G Tally
Lamp

Enable /
Disable

Enable
Omogoči/onemogoči indikator za snemanje v živo
G.

Tally
Control

External /
Internal

Internal
Izbere cilj za sprejemanje upravljalnih informacij
indikatorja za snemanje na pomnilniško
kartico/snemanje v živo na enoti.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off On
Omogoči/onemogoči upravljanje enote z
infrardečim daljinskim upravljalnikom.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Camera
Name

– FR7
Nastavi ime
kamere.
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Alfanumerični znaki
Simboli (presledek !#$`*+-./;<=>?@[\]^_`{|})

[241] Spletni meni in podrobne nastavitve Meni Network

User

Prilagodi nastavitve, povezane z uporabniškim dostopom do enote.

Nastavitve, povezane s skrbniškimi uporabniki (Administrator) (obvezno)

Nastavitve, povezane s splošnimi uporabniki (User 1 do User 9) (izbirno)

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

User Name – admin Nastavi uporabniško ime.

Current
Password

– –
Ko spreminjate geslo, vnesite
trenutno geslo.

New
Password

– – Vnesite novo geslo.

Re-Type
Password

– –
Za potrditev znova vnesite novo
geslo.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

User Name – – Nastavi uporabniško ime.

Current
Password

– –
Ko spreminjate geslo, vnesite
trenutno geslo.

New
Password

– – Vnesite novo geslo.

Re-Type
Password

– –
Za potrditev znova vnesite novo
geslo.
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[242] Spletni meni in podrobne nastavitve Meni Network

Wired LAN

Status
Prikaže stanje omrežja.

IPv4
Prilagodi nastavitve, ki so povezane z omrežjem IPv4.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Host Name – – Prikaže ime gostitelja.

MAC Address – – Prikaže naslov MAC enote.

Ethernet Status – –
Prikaže trenutno hitrost
komunikacije.

IP Address – – Prikaže naslov IP enote.

Subnet Mask – –
Prikaže masko podomrežja
enote.

Gateway – –
Prikaže privzeti prehod IPv4
enote.

Primary DNS
Server

– –
Prikaže primarni strežnik DNS
enote.

Secondary DNS
Server

– –
Prikaže sekundarni strežnik
DNS enote.

IPv6 Address 1 – – Prikaže IPv6 naslov 1 enote.

IPv6 Address 2 – – Prikaže IPv6 naslov 2 enote.

IPv6 Gateway – –
Prikaže privzeti prehod IPv6
enote.

Link-local IPv6
Address

– –
Prikaže lokalni naslov
povezave IPv6 enote.
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IPv6
Prilagodi nastavitve, ki so povezane z omrežjem IPv6.

Common
Prilagodi nastavitve, ki so skupne omrežjem IPv4/IPv6.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

DHCP On / Off On Vklopi/izklopi funkcijo [DHCP].

IP
Address

– –
Nastavi naslov IPv4, ko je možnost [DHCP]
nastavljena na Off.

Subnet
Mask

– –
Nastavi masko podomrežja, ko je možnost
[DHCP] nastavljena na Off.

Gateway – –
Nastavi privzeti prehod IPv4, ko je možnost
[DHCP] nastavljena na Off.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Obtain an IP
Address
Automatically

On / Off On
Vklopi/izklopi samodejno pridobivanje
naslova IPv6.

IP Address – –
Nastavi naslov IPv6, ko je možnost [Obtain
an IP Address Automatically] nastavljena na
Off.

Prefix Length – –
Nastavi predpono, ko je možnost [Obtain an
IP Address Automatically] nastavljena na
Off.

Gateway – –
Nastavi privzeti prehod IPv6, ko je možnost
[Obtain an IP Address Automatically]
nastavljena na Off.

Element Nastavitev Privzeta
tovarniška Opis
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[243] Spletni meni in podrobne nastavitve Meni Network

File Transfer

Prilagodi nastavitve, povezane s prenosi datotek.

[244] Spletni meni in podrobne nastavitve Meni Network

FTP Server 1 do 3

podelementa vrednost

HTTP Port
80, 1024 do
65534

80 Nastavi številko vrat HTTP.

DNS Auto On / Off On
Določi, ali naj se naslovi DNS pridobijo iz
strežnika DHCP.

Primary
DNS Server

IPv4/IPv6
address

–
Nastavi primarni strežnik DNS, ko je
možnost [DNS Auto] nastavljena na Off.

Secondary
DNS Server

IPv4/IPv6
address

–
Nastavi sekundarni strežnik DNS, ko je
možnost [DNS Auto] nastavljena na Off.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Auto
Upload
(Proxy)

On / Off Off Vklopi/izklopi samodejno nalaganje datotek proxy.

Default
Upload
Server

Server
Settings1 do
3 > Display
Name

Server
Settings1

Izbere strežnik za nalaganje datotek. Tukaj izbran
strežnik postane cilj za samodejno nalaganje
datotek proxy in cilj za nalaganje datotek z zaslona
sličic. 
Prikaže nastavitve [Display Name], ki so
konfigurirane v možnostih [Server Settings1 do 3].
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Prilagodi nastavitve, povezane s prenosi datotek prek FTP.
Nastavitve so skupne za strežnike FTP 1 do 3.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Display
Name

– –
Nastavi prikazno ime, prikazano v meniju za
nastavitev cilja prenosa.

Service – – Prikaže tip strežnika.

Host Name – –
Nastavi ime gostitelja ciljnega strežnika za
prenos.

Port
21, 990, 1024
do 65534

21
Nastavi številko vrat ciljnega strežnika za
prenos.

User Name – –
Nastavi uporabniško ime za avtentikacijo
povezave ciljnega strežnika za prenos.

Password – –
Nastavi avtentikacijsko geslo povezave
ciljnega strežnika za prenos.

Passive
Mode

On / Off Off Vklopi/izklopi pasivni način.

Destination
Directory

– – Nastavi ime ciljne mape za prenos.

Using
Secure
Protocol

On / Off Off
Nastavi, ali naj se uporabi (On) ali ne
uporabi (Off) varen prenos FTP.

Root
Certificate

– –

Naloži korensko potrdilo za varen prenos
FTP. 
Pritisnite gumb [Load] in na prikazanem
zaslonu izberite korensko potrdilo. 
Če želite izbrisati naloženo korensko
potrdilo, pritisnite gumb [Delete].

Root
Certificate
Status

– –
Prikaže stanje nalaganja korenskega
potrdila.

Reset – –
Ponastavi nastavitve [Server Settings] na
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[245] Spletni meni in podrobne nastavitve Meni Network

SSL

Prilagodi nastavitve, ki so povezane s SSL.

SSL
Omogoči/onemogoči funkcijo SSL.

SSL Server Authentication
Prilagodi nastavitve, ki so povezane s preverjanjem pristnosti strežnika SSL.

privzete vrednosti.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Function
Disable / Enable / Enable (Allow HTTP
connection for some clients)

Disable
Omogoči/onemogoči
funkcijo SSL.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Certificate
Options

Use a self-signed
certificate (For test
use) / Use an
external certificate

–
Nastavi način namestitve potrdila strežnika
SSL.

Status – –

Prikaže veljavnost potrdila strežnika SSL,
ko je možnost [Certificate Options]
nastavljena na [Use a self-signed certificate
(For test use)].

Issuer DN – –

Prikaže razlikovalno ime izdajatelja potrdila
strežnika SSL, ko je možnost [Certificate
Options] nastavljena na [Use a self-signed
certificate (For test use)].
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[246] Spletni meni in podrobne nastavitve Meni Network

Referer Check

Prilagodi nastavitve, ki so povezane s preverjanji posrednika.

Subject
DN

– –

Prikaže razlikovalno ime zadeve potrdila
strežnika SSL, ko je možnost [Certificate
Options] nastavljena na [Use a self-signed
certificate (For test use)].

Available
Period

– –

Prikaže obdobje veljavnosti potrdila
strežnika SSL, ko je možnost [Certificate
Options] nastavljena na [Use a self-signed
certificate (For test use)].

Extended
Key Usage

– –

Prikaže način razširjene uporabe ključa, ko
je možnost [Certificate Options] nastavljena
na [Use a self-signed certificate (For test
use)].

Delete – –

Ta gumb je prikazan, ko je možnost
[Certificate Options] nastavljena na [Use a
self-signed certificate (For test use)]. 
Izbriše nameščeno potrdilo strežnika SSL.

Import – –

Namesti zunanje potrdilo strežnika SSL s
seznama, ko je možnost [Certificate
Options] nastavljena na [Use an external
certificate].

Private
Key
Password

– –

Nastavi geslo za podatke o zasebnem
ključu potrdila strežnika SSL, ko je možnost
[Certificate Options] nastavljena na [Use an
external certificate].

Reset – –
Ta gumb izbriše prikaz gesla zasebnega
ključa za vnos novega gesla.

Self-
Signed
Certificate
Generation

– –

Pritisnite gumb [Generate], da ustvarite
samopodpisano potrdilo, ko je možnost
[Certificate Options] nastavljena na [Use a
self-signed certificate (For test use)].
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Exception List
Prilagodi nastavitve, ki so povezane s seznamom izjem za preverjanje posrednika.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Setting On / Off On
Omogoči/onemogoči funkcijo
preverjanja posrednika.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

No. 1 do 10 – Nastavi številko izjeme s seznama.

Host
Name

– – Nastavi ime gostitelja izjeme.

Port
Number

– – Nastavi številko vrat izjeme.

Set – –
Pritisnite, če želite konfigurirano izjemo
registrirati na seznamu izjem.

Izberite izjemo, ki jo želite izbrisati, in pritisnite
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[247] Spletni meni in podrobne nastavitve Meni Network

Brute Force Attack Protection

Prilagodi nastavitve, ki so povezane s preprečevanjem napada z grobo silo.

Ko je zaznan napadalec, se prikažejo informacije s seznama napadalcev.

[248] Spletni meni in podrobne nastavitve Meni Stream

Delete – – gumb, da registrirano izjemo izbrišete s seznama
izjem.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off On
Vklopi/izklopi funkcijo [Brute Force Attack
Protection].

Count 3 do 100 8
Nastavi število poskusov, ki se bodo šteli za napad.
Omogočeno, ko je možnost [Setting] nastavljena
na On.

Release
Mode

Always /
Timer

Timer

Nastavi pogoj za sprostitev. 
Omogočeno, ko je možnost [Setting] nastavljena
na On.
Always: Ne izbriše s seznama napadalcev.
Timer: Izbriše s seznama napadalcev po preteku
časa sprostitve, nastavljenega s funkcijo [Release
Time].

Release
Time

30 do 86400
s

60

Nastavi čas sprostitve. 
Omogočeno, ko je možnost [Setting] nastavljena
na On. 
Ko je možnost Release Mode: nastavljena na
[Timer], se vnosi s seznama napadalcev izbrišejo
po preteku časa sprostitve.
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Stream

Prilagodi nastavitve pretočnega predvajanja (oglejte si razdelek "O pretočnem predvajanju").

Stream Setting
Prilagodi nastavitve, ki so povezane s protokolom pretočnega predvajanja.

RTSP
Ko je možnost [Stream Setting] nastavljena na [RTSP], so prikazani naslednji elementi.
Prilagodi nastavitve, ki so povezane s pretočnim predvajanjem RTSP.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Setting
RTSP / SRT-Caller / SRT-
Listener / NDI|HX / Off

RTSP
Izbere protokol
pretočnega predvajanja.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Port Number
554, 1024 do
65534

554 Nastavi številko vrat RTSP.

Time Out 0 do 600 60
Nastavi časovno omejitev ukaza [Keep
Alive] za pretočno predvajanje RTSP.

Authentication On / Off On
Vklopi/izklopi funkcijo preverjanja pristnosti
RTSP.

Video Port
Number 1

1024 do
65534

51000
Nastavi številko vrat za pošiljanje
videoposnetka 1 za enovrstno pretočno
predvajanje RTSP.

Video Port
Number 2

1024 do
65534

53000
Nastavi številko vrat za pošiljanje
videoposnetka 2 za enovrstno pretočno
predvajanje RTSP.

Audio Port
Number

1024 do
65534

57000
Nastavi številko vrat za pošiljanje zvoka za
enovrstno pretočno predvajanje RTSP.
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SRT
Ko je možnost [Stream Setting] nastavljena na [SRT-Caller] ali [SRT-Listener], so prikazani
naslednji elementi.
Prilagodi nastavitve, ki so povezane s pretočnim predvajanjem SRT.

NDI|HX
Ko je možnost [Stream Setting] nastavljena na [NDI|HX], so prikazani naslednji elementi.
Prilagodi nastavitve, ki so povezane z NDI|HX.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Destination – –
Nastavi ciljni spletni naslov povezave,
ko enota deluje kot klicatelj.

Port
Number

1024 do 65534 4201
Nastavi številko vrat za poslušanje, ko
enota deluje kot poslušalec.

Latency 20 do 8000 ms 120 Nastavi zakasnitev.

TTL 1 do 255 64 Nastavi vrednost TTL.

Encryption
Off / AES128 /
AES256

Off
Omogoči/onemogoči šifriranje in nastavi
način šifriranja.

Passphrase
0 ali niz od 10
do 79 znakov

0

Nastavi geslo, ki se uporablja za
šifriranje. 
Pritisnite gumb Reset, da izbrišete
vneseno geslo.

ARC On / Off On
Vklopi/izklopi funkcijo [Adaptive Rate
Control].

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

License – –
Prikaže stanje namestitve licenčnega ključa za
NDI.

Source
Name

– – Prikaže ime vira za NDI.
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[249] Spletni meni in podrobne nastavitve Meni Stream

Group On / Off Off
Vklopi/izklopi funkcijo združevanja v skupine
NDI.

Group
Name

– –
Prikaže se, ko je funkcija združevanja v
skupine NDI nastavljena na On. 
Nastavi ime skupine.

Discovery
Server 1

– – Nastavi NDI strežnik za odkrivanje 1.

Discovery
Server 2

– – Nastavi NDI strežnik za odkrivanje 2.

Reliable
UDP
Mode

On / Off On Vklopi/izklopi način Reliable UDP.

Multicast
Mode

On / Off Off Vklopi/izklopi večvrstno pretočno predvajanje.

Multicast
Prefix

239.255.0.0 239.255.0.0

Prikaže se, ko je možnost [Multicast Mode]
nastavljena na On. 
Nastavi predpono, ki se uporablja za
večvrstno pretočno predvajanje.

Multicast
Netmask

255.255.0.0 255.255.0.0

Prikaže se, ko je možnost [Multicast Mode]
nastavljena na On. 
Nastavi masko omrežja, ki določa območje
naslovov za večvrstno pretočno predvajanje.

Multicast
TTL

1 do 256 3

Prikaže se, ko je možnost [Multicast Mode]
nastavljena na On. 
Nastavi vrednost TTL za večvrstno pretočno
predvajanje.

Multi-
TCP
Mode

On / Off Off Vklopi/izklopi način Multi-TCP.

Unicast
UDP
Mode

On / Off On Vklopi/izklopi način Unicast UDP.
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Video Stream

Prilagodi nastavitve, ki so povezane z video kodeki za pretočno predvajanje.

Video Stream 1
Prilagodi nastavitve, ki so povezane z video kodekom 1.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Codec 1 H.264 / H.265 H.264 Nastavi kodek slike 1.

Size 1
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 / 1280×720
/ 640×360

1920×1080 Nastavi velikost slike 1.

Frame Rate
1

Za podrobnosti o podprtih
hitrostih sličic si oglejte razdelek
"Nastavitev video kodeka za
pretočno predvajanje".

–
Nastavi hitrost sličic za
sliko 1.

I-Picture
Mode 1

Time / Frame Time

Nastavi interval
vstavljanja [IDR-Frame]
za sliko 1 kot čas ali
število sličic.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 s 1

Prikaže se, ko je
možnost [I-Picture
Mode 1] nastavljena na
Time. 
Nastavi interval
vstavljanja IDR-Frame
za H.264 in H.265 kot
čas.

I-Picture
Ratio 1

15 do 300 frames 30

Prikaže se, ko je
možnost [I-Picture
Mode 1] nastavljena na
Frame. 
Nastavi interval
vstavljanja IDR-Frame
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Video Stream 2
Prilagodi nastavitve, ki so povezane z video kodekom 2.

za H.264 in H.265 kot
število sličic.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264:
high

Nastavi profil H.264 ali
H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Nastavi način stiskanja
bitne hitrosti za sliko 1.

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 /
4000 / 5000 / 6000 / 7000 / 8000 /
16000 / 24000 / 32000 / 50000 /
64000 / 80000 kbps

16000

Prikaže se, ko je
možnost [Bit Rate
Compression Mode 1]
nastavljena na On. 
Nastavi ciljno vrednost
bitne hitrosti, ko je način
stiskanja bitne hitrosti
nastavljen na CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 10 6
Nastavi kakovost slike
H.264 ali H.265.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Codec 2 H.264 / H.265 / Off Off Nastavi kodek slike 2.

Size 2
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360 / 512×270

1920×1080 Nastavi velikost slike 2.

Frame Rate
2

Za podrobnosti o podprtih
hitrostih sličic si oglejte
razdelek "Nastavitev video
kodeka za pretočno
predvajanje".

–

Prikazano, ko možnost
[Codec 2] ni nastavljena na
Off. 
Nastavi hitrost sličic za sliko
2.

Prikazano, ko možnost
[Codec 2] ni nastavljena na
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I-Picture
Mode 2

Time / Frame Time
Off. 
Nastavi interval vstavljanja
IDR-Frame za sliko 2 kot čas
ali število sličic.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 s 1

Prikazano, ko možnost
[Codec 2] ni nastavljena na
Off, možnost [I-Picture Mode
2] pa je nastavljena na
[Time]. 
Nastavi interval vstavljanja
IDR-Frame za H.264 in
H.265 kot čas.

I-Picture
Ratio 2

15 do 300 frames 30

Prikazano, ko možnost
[Codec 2] ni nastavljena na
Off, možnost [I-Picture Mode
2] pa je nastavljena na
[Frame]. 
Nastavi interval vstavljanja
IDR-Frame za H.264 in
H.265 kot število sličic.

Profile 2
H.264: high / main / baseline
H.265: main

–
Nastavi profil H.264 ali
H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Prikazano, ko možnost
[Codec 2] ni nastavljena na
Off. 
Nastavi način stiskanja bitne
hitrosti za sliko 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 /
4000 / 5000 / 6000 / 7000 /
8000 / 16000 / 24000 / 32000 /
50000 / 64000 / 80000 kbps

8000

Prikazano, ko možnost
[Codec 2] ni nastavljena na
Off, možnost [Bit Rate
Compression Mode 2] pa je
nastavljena na [On]. 
Nastavi ciljno vrednost bitne
hitrosti, ko je način stiskanja
bitne hitrosti nastavljen na
CBR.

Prikaže se, ko je možnost
[Codec 2] nastavljena na
H.264, možnost [Bit Rate
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Video Stream 3
Prilagodi nastavitve, ki so povezane z video kodekom 3.

[250] Spletni meni in podrobne nastavitve Meni Stream

Audio Stream

Prilagodi nastavitve, ki so povezane z zvočnimi kodeki za pretočno predvajanje.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Compression Mode 2] pa
nastavljena na Off. 
Nastavi kakovost slike H.264
ali H.265.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Codec 3 JPEG JPEG
Nastavi
kodek slike
3.

Size 3 1280×720 / 1024×540 / 640×360 1280 x 720
Nastavi
velikost slike
3.

Frame
Rate 3

Za podrobnosti o podprtih hitrostih sličic si
oglejte razdelek "Nastavitev video kodeka za
pretočno predvajanje".

–
Nastavi
hitrost sličic
za sliko 3.

Quality
3

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Nastavi
kakovost.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Setting On / Off Off
Vklopi/izklopi izhodno pretočno
predvajanje zvoka.
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[251] Spletni meni in podrobne nastavitve Meni Maintenance

Language

Nastavi jezik prikaza.

Opomba

Razpoložljivi jeziki se lahko razlikujejo glede na državo ali regijo.

[252] Spletni meni in podrobne nastavitve Meni Maintenance

Accessibility

Prilagodi nastavitve, ki so povezane z branjem zvoka (pretvorba besedila v govor).

Codec
AAC (128kbps) /
AAC (256kbps)

AAC (128kbps)

Prikaže se, ko je možnost [Setting]
nastavljena na On. 
Nastavi zvočni kodek za pretočno
predvajanje.

Element Nastavitev
podelementa

Privzeta tovarniška
vrednost Opis

Language – –
Nastavi jezik
prikaza.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Screen
Reader

On / Off Off 
Vklopi/izklopi funkcijo bralnika zaslona
na slikovni plošči kamere v spletni
aplikaciji.

Speech
Slow2 / Slow1 / Normal /
Fast1 / Fast2 / Fast3 / Normal

Nastavi hitrost funkcije bralnika
zaslona. 
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Opomba

Ta funkcija je na voljo samo na modelih, ki se prodajajo v Severni Ameriki. Funkcijo bralnika zaslona
je mogoče uporabljati le, če je jezik nastavljen na angleščino (od datuma izdaje).

Funkcijo bralnika zaslona spletnega brskalnika omogočite v napravi, v kateri je nameščena spletna
aplikacija.

[253] Spletni meni in podrobne nastavitve Meni Maintenance

Clock Set

Prilagodi nastavitve notranje ure.

Rate
Fast4

Vzorec besedila se glasno prebere z
nastavljeno hitrostjo.

Speech
Volume

1 do 15 7

Nastavi glasnost funkcije bralnika
zaslona v spletni aplikaciji. 
Vzorec besedila se glasno prebere z
nastavljeno glasnostjo.

Element Nastavitev podelementa
Privzeta

tovarniška
vrednost

Opis

Current
Date &
Time

– –
Prikaže trenutni čas, ki je konfiguriran
v enoti.

PC Clock – –
Prikaže trenutni čas tabličnega
računalnika ali osebnega računalnika,
ki se uporablja za konfiguracijo.

Date &
Time
Format

yyyy-mm-dd hh:mm:ss /
mm-dd-yyyy hh:mm:ss /
dd-mm-yyyy hh:mm:ss

yyyy-mm-
dd

Nastavi obliko prikaza za datum in
čas.

12 h / 24
h

12 h / 24 h 24 h
Nastavi 12-urno ali 24-urno obliko
prikaza časa.

Keep current setting /
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[254] Spletni meni in podrobne nastavitve Meni Maintenance

Reset

Inicializira enoto.

Reboot
Znova zažene enoto.

Time
Setting

Synchronize with PC /
Manual setting /
Synchronize with NTP

–
Nastavi način konfiguracije za datum
in čas.

yy-mm-
dd
hh:mm:ss

yy: 19 do 37 
mm: 01 do 12 
dd: 01 do 31 
hh: 00 do 23 
mm: 00 do 59 
ss: 00 do 59 (seconds)

–

Prikaže se, ko je možnost [Time
Setting] nastavljena na Manual
setting. 
Ročno nastavi datum in čas.

NTP Auto On / Off Off

Prikaže se, ko je možnost [Time
Setting] nastavljena na Synchronize
with NTP. 
Določi, ali naj se naslov IP strežnika
NTP pridobi iz strežnika DHCP.

NTP
Server

Naslov IPv4/IPv6 ali ime
gostitelja

–

Prikaže se, ko je možnost [Time
Setting] nastavljena na [Synchronize
with NTP], možnost [NTP Auto] pa
nastavljena na Off. 
Določa strežnik NTP, ki se uporablja
za sinhronizacijo časa.

Time
Zone

UTC - 12:00 do UTC +
14:00

– Izbere časovni pas.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Znova zažene enoto.
Execute: Izvedite funkcijo.
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Reset
Ponastavi nastavitve enote.

Reboot Execute –
Opomba

Po ponovnem zagonu znova naložite
stran v spletnem brskalniku.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

All Reset
(except for
Network
Settings)

Execute –

Ponastavi nastavitve enote (razen omrežnih
nastavitev).
Execute: Izvedite funkcijo.

Opomba

Uvoženi osnovni videzi in datoteke LUT se
ne izbrišejo.

Network Reset Execute –

Ponastavi omrežne nastavitve enote.
Execute: Izvedite funkcijo.

Opomba

Po izvedbi funkcije Network Reset se enota
ponovno zažene. Po ponovnem zagonu
znova naložite stran v spletnem brskalniku.

Factory
Default

Execute –

Vrne nastavitve enote v privzeto tovarniško
stanje.
Execute: Izvedite funkcijo.

Opomba

Po izvedbi funkcije Factory Default se
enota ponovno zažene. Po ponovnem
zagonu znova naložite stran v spletnem
brskalniku.
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[255] Spletni meni in podrobne nastavitve Meni Maintenance

Information

Prikaže informacije o kameri in objektivu. Uporablja se tudi za posodabljanje programske
opreme.

Camera
Prikaže informacije o kameri in posodobi programsko opremo.

Lens
Prikaže informacije o objektivu in posodobi programsko opremo.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Model
Name

– – Prikaže ime modela kamere.

Serial
Number

– – Prikaže serijsko številko kamere.

Version
Number

– – Prikaže različico programske opreme kamere.

Version
Up

– –

Pritisnite gumb [Choose File] in sledite navodilom
na zaslonu, da posodobite programsko opremo
kamere.

Opomba

Po posodobitvi se enota ponovno zažene. Po
ponovnem zagonu znova naložite stran v
spletnem brskalniku.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Model
– – Prikaže ime modela objektiva.
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[256] Spletni meni in podrobne nastavitve Meni Maintenance

System Log

Prilagodi nastavitve, ki so povezane s sistemskim dnevnikom.

Name

Serial
Number

– – Prikaže serijsko številko objektiva.

Version
Number

– – Prikaže različico programske opreme objektiva.

Version
Up

– –

Pritisnite gumb [Choose File] in sledite navodilom
na zaslonu, da posodobite programsko opremo
objektiva.

Za podrobnosti si oglejte razdelek
"Posodabljanje programske opreme objektiva
serije E".

Opomba

Po posodobitvi objektiva se enota ponovno
zažene. Po ponovnem zagonu znova naložite
stran v spletnem brskalniku.

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Log Level
Critical, Warning &
Info / Critical &
Warning / Critical

Critical,
Warning &
Info

Nastavi raven za dodajanje zapisa v
sistemski dnevnik.

Log Size 200 do 1024 1024
Nastavi velikost dnevnika, ki se shrani v
sistemski dnevnik.

Download
as File

– –
Pritisnite gumb [Download] in s prikazanega
zaslona shranite sistemski dnevnik v tablični
računalnik ali osebni računalnik.
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Pridobljeni dnevnik je prikazan kot na spodnji sliki.

[257] Spletni meni in podrobne nastavitve Meni Maintenance

HTTP Access Log

Prilagodi nastavitve, ki so povezane z dnevnikom dostopa HTTP.

[258] Spletni meni in podrobne nastavitve Meni Maintenance

Service

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

Log Level
Critical, Warning
& Info / Critical &
Warning / Critical

Critical,
Warning &
Info

Nastavi raven za dodajanje zapisa v dnevnik
dostopa HTTP.

Log Size 200 do 1024 1024
Nastavi velikost dnevnika, ki se shrani v
dnevnik dostopa HTTP.

Download
as File

– –
Pritisnite gumb [Download] in s prikazanega
zaslona shranite dnevnik dostopa HTTP v
tablični računalnik ali osebni računalnik.
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Pridobi informacije naprave o enoti. Uporabite, ko stopite v stik s servisnim predstavnikom
podjetja Sony.

[259] Spletni meni in podrobne nastavitve Meni Maintenance

EULA

Prikaže licenčno pogodbo za končnega uporabnika (EULA).

[260] Spletni meni in podrobne nastavitve Meni Maintenance

Software

Prikaže licenco za programsko opremo.

[261] Povezovanje zunanjih naprav

Povezovanje zunanjih monitorjev in snemalnih naprav

Element Nastavitev
podelementa

Privzeta
tovarniška
vrednost

Opis

I agree to
download
device
information.

– –

Tukaj postavite kljukico, da se strinjate s
pridobivanjem informacij naprave, in pritisnite
gumb [OK]. 
Pritisnite prikazan gumb [Download]. Spletni
brskalnik bo za trenutek prenesel datoteko z
imenom deviceinformation.dat.

Opomba

Po prenosu se enota ponovno zažene. Po
ponovnem zagonu znova naložite stran v
spletnem brskalniku.



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Za prikaz snemane/predvajane slike na zunanjem monitorju nastavite vrsto video izhoda za
zunanji monitor in uporabite primeren kabel za monitor, ki ga želite priklopiti.
Priklopite lahko tudi zunanji snemalnik in posnamete izhodni signal iz enote.
Iste podatke, ki so vidni na slikovni plošči kamere, kot so podatki o stanju in meniji, lahko
prikažete na zunanjem monitorju. Z možnostjo [Monitoring] > [Output Display] v spletnem
meniju nastavite želeno vrsto sistema za prikaz zaslona na On.

Opomba

Če monitor, ki je priključen na priključek HDMI, ne podpira izhodnega formata HDMI, nastavljenega z
uporabo menija [Monitoring] v spletnem meniju ali meniju kamere, se slika kamere ne bo predvajala
v spletni aplikaciji. Prav tako ni mogoče oddajati pretočno predvajanega videa.

Obe možnosti [Output Display] > [SDI] in [HDMI/Stream] lahko nastavite na [Off], vendar bo to
preprečilo uporabo menijev in funkcij kamere, ki so odvisni od prikaza zaslona. Poleg tega bodo
obvestila o napakah enote omejena na (prižgane ali utripajoče) indikatorje enote in prikaz oznake za
obvestila v zgornjem desnem kotu spletne aplikacije. Za ogled podrobnega stanja nastavite možnost
[Output Display] na [On].

Namig

Možnost [Output Display] > [SDI] je tovarniško nastavljena na [Off], možnost [HDMI/Stream] pa na
[On]. Če želite pretočno predvajanje uporabljati kot glavni video, nastavite možnost [SDI] na [On] in
možnost [HDMI/Stream] na [Off ter spremljajte stanje kamere na monitorju SDI.

Priključek SDI OUT (tip BNC)

Nastavite izhodni format z uporabo menija [Monitoring] v spletnem meniju ali meniju kamere.
Za povezavo uporabite komercialno dostopen koaksialni kabel z upornostjo 75 ?.

Opomba

Preverite, da je povezava med enoto in zunanjo napravo ozemljena, preden napravi vklopite.

Priporočljivo je, da enoto in zunanjo napravo vklopite po tem, ko ste ju povezali s
koaksialnim kablom z upornostjo 75 ?.
Če morate zunanjo napravo priklopiti na enoto, ko je enota vklopljena, priklopite koaksialni
kabel z upornostjo 75 ? najprej na zunanjo napravo in nato na enoto.

Sočasen začetek snemanja na enoti in zunanji napravi
Ob omogočenem izhodu signala SDI nastavite možnost [Project] > [SDI/HDMI Rec Control] >
[Setting] v meniju kamere na [SDI/HDMI Remote I/F] ali [Parallel Rec]. S tem boste omogočili
prenos sprožilnega signala REC na zunanjo napravo, povezano na priključek SDI OUT. Tako
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boste snemanje na zunanji napravi sinhronizirali z enoto.

Opomba

Če povezana zunanja naprava ne podpira sprožilnega signala REC, je na ta način ne morete
upravljati.

Če je možnost [Project] > [SDI/HDMI Rec Control] > [Setting] v meniju kamere nastavljena na
[SDI/HDMI Remote I/F], se oddaja samo sprožilni signal REC, kadar trenutno ni vstavljen noben
snemalni medij in je pritisnjen gumb za snemanje START/STOP.

Priključek HDMI OUT (priključek tipa A)

V meniju [Monitoring] v meniju kamere izberite nastavitev On/Off izhoda in izhodni format.

Sočasen začetek snemanja na enoti in zunanji napravi
Ob omogočenem izhodu signala HDMI nastavite možnost [TC/Media] > [HDMI TC Out] >
[Setting] v meniju kamere na [On] ter možnost [Project] > [SDI/HDMI Rec Control] > [Setting] na
[SDI/HDMI Remote I/F] ali [Parallel Rec]. S tem boste omogočili prenos sprožilnega signala
REC na zunanjo napravo, povezano na priključek HDMI OUT. Tako boste snemanje na zunanji
napravi sinhronizirali z enoto.

Opomba

Če povezana zunanja naprava ne podpira sprožilnega signala REC, je na ta način ne morete
upravljati.

Če je možnost [Project] > [SDI/HDMI Rec Control] > [Setting] v meniju kamere nastavljena na
[SDI/HDMI Remote I/F], se oddaja samo sprožilni signal REC, kadar trenutno ni vstavljen noben
snemalni medij in je pritisnjen gumb za snemanje START/STOP.

[262] Povezovanje zunanjih naprav Upravljanje z daljinskim upravljalnikom RM-IP500
(izbirno)

O upravljanju z daljinskim upravljalnikom RM-IP500
(izbirno)

Enoto lahko upravljate z daljinskim upravljalnikom Sony RM-IP500 z različico programske
opreme 2.2 ali novejšo. Naprave komunicirajo s protokolom VISCA prek IP (LAN).
Glede na ciljni element, ki ga želite upravljati, si boste morda morali ogledati prikaz zaslona
enote. Pripravite monitor, ki se lahko uporablja za preverjanje prikaza zaslona.
Z daljinskim upravljalnikom RM-IP500 so podprti naslednji postopki.
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Izbira ciljne kamere
Prilagajanje okvirjanja (obračanje, nagibanje, zoom)
Prilagajanje ostrenja (ne velja za upravljanje na dotik)
Registriranje in priklic prednastavljenih položajev
Upravljanje menija enote (razen spletnega menija)
Prilagajanje svetlosti
Prilagajanje beline
Prilagajanje ravnovesja črnine
Prilagajanje ravni vhodnega zvoka
Začetek/zaustavitev snemanja
Izvajanje funkcij enote, ki so dodeljene dodeljivim gumbom

Za podrobnosti o delovanju upravljalnika RM-IP500 si oglejte njegova navodila za uporabo.

Namig

Če uporabljate RM-IP500, uporabite list plošče za to enoto, ki je priložen RM-IP500.

RM-IP500 (uporaba lista plošče za to enoto)

[263] Povezovanje zunanjih naprav Upravljanje z daljinskim upravljalnikom RM-IP500
(izbirno)

Povezovanje daljinskega upravljalnika RM-IP500
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Za podrobnosti o dodeljevanju funkcij si oglejte navodila za uporabo RM-IP500.

[264] Povezovanje zunanjih naprav Sinhronizacija z zunanjo napravo

O sinhronizaciji z zunanjo napravo

Ko snemate z več enotami, lahko enote sinhronizirate na določen referenčni signal ali časovno
kodo, kar storite prek priključka GENLOCK na enotah.

Za podrobnosti o funkciji genlock si oglejte razdelek "Sinhronizacija faze video signalov

Preklopite stikalo SETUP 3 na enoti v položaj ON, da omogočite komunikacijo
VISCA prek IP.

Opomba

Nastavitev stikala se uporabi ob naslednjem vklopu enote.

1

Povežite RM-IP500 z istim omrežjem, kot ste povezali enoto.2

Sledite postopku iz navodil za uporabo RM-IP500, da konfigurirate povezavo VISCA
prek IP (LAN) na upravljalniku RM-IP500.

Dodelite to enoto z uporabo menija RM > AUTO IP SETUP > ASSIGN CAM.

3

Funkcije te enote ustrezno dodelite gumbom, tako da uporabite naslednje elemente
menija RM upravljalnika RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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(Genlock)".
Za podrobnosti o sinhronizaciji časovnih kod si oglejte razdelek "Zaklepanje časovne kode
na druge naprave".

[265] Povezovanje zunanjih naprav Sinhronizacija z zunanjo napravo

Sinhronizacija faze video signalov (Genlock)

Na priključek GENLOCK lahko dovajate referenčni signal, da omogočite funkcijo genlock.
Vhodni referenčni signali, ki jih lahko uporabite, so odvisni od sistemske frekvence izbranega
formata snemanja.

Z možnostjo [Technical] > [Genlock] > [Reference] v meniju kamere lahko preverite stanje
sinhronizacije z zunanjo napravo.

Opomba

Delovanja funkcije genlock ni mogoče doseči, če je referenčni signal nestabilen.

Sistemska frekvenca formata snemanja Podprti vhodni referenčni signali

59,94P
1920×1080 59,94i 
720×486 59,94i

50P
1920×1080 50i 
720×576 50i

29,97P
1920×1080 59,94i 
720×486 59,94i

25P
1920×1080 50i 
720×576 50i

24P 1920×1080 24PsF

23,98P 1920×1080 23,98PsF

59,94i
1920×1080 59,94i 
720×486 59,94i

50i
1920×1080 50i 
720×576 50i
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Podnosilec ni sinhroniziran.

[266] Povezovanje zunanjih naprav Sinhronizacija z zunanjo napravo

Zaklepanje časovne kode na druge naprave

Enoto, ki dovaja časovno kodo, nastavite tako, da časovna koda na izhodu neprestano teče (kot
na primer Free Run ali Clock).

Opomba

Preverite, da sta dovedena referenčna časovna koda in referenčni video signal v faznem razmerju, ki
je skladen s standardom za časovno kodo SMPTE.

Ob uporabi zaklepa na zunanjo časovno kodo se časovna koda kamere takoj zaklene na zunanjo
časovno kodo. Na območju za prikaz časovnih podatkov se pojavi vrednost zunanje časovne kode.
Kljub temu ne začnite takoj snemati. Počakajte nekaj sekund, da se generator časovne kode pred
snemanjem stabilizira.

Če frekvenca referenčnega video signala in frekvenca sličic na enoti nista enaki, ne more priti do
zaklepa in enota ne bo delovala pravilno. Če pride do tega, se časovna koda ne bo uspešno
zaklenila na zunanjo časovno kodo.

Z uporabo možnosti [TC/Media] > [Timecode] v meniju kamere izvedite naslednjo
nastavitev.

Nastavite možnost [Mode] na [Preset].
Nastavite možnost [Run] na [Free Run].

1

Pritisnite dodeljiv gumb z dodeljeno funkcijo [DURATION/TC/U-BIT], da se na
zaslonu prikaže časovna koda.

2

Dovajajte referenčni video signal HD ali SD na priključek GENLOCK in referenčno
časovno kodo na priključek TC IN.

Generator časovne kode v enoti se zaklene z referenčno časovno kodo in na zaslonu se
pojavi "EXT-LK".
Ko mine približno deset sekund od zaklepa časovne kode, ostane časovna koda
zaklenjena na zunanjo časovno kodo tudi, če odklopite vir zunanje referenčne časovne
kode.

3
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Če odklopite vir zunanje časovne kode, se lahko časovna koda v primerjavi z referenčno časovno
kodo zamakne za eno sličico na uro.

Za sprostitev zunanjega zaklepa
Spremenite nastavitev [TC/Media] > [Timecode] v meniju kamere.
Zunanja sinhronizacija se sprosti tudi v primeru, če spremenite sistemsko frekvenco ali če
začnete snemati v posebnem načinu snemanja (počasni in hitri posnetki ali intervalno
snemanje).

[267] Povezovanje zunanjih naprav

Povezovanje zunanjega mikrofona ali zunanje zvočne
naprave

Signal lahko vnesete iz zunanjega mikrofona ali zunanje zvočne naprave ter zvok dodate v
posneti videoposnetek ali izhodni videoposnetek enote.

S kablom XLR priključite zunanji mikrofon ali zunanjo zvočno napravo.

Ko je zvok nastavljen na [LINE] z uporabo možnosti [Audio] > [Audio Input] > [AUDIO IN
Select] v meniju kamere, priključek AUDIO IN deluje kot priključek AUDIO IN CH-1 in
priključek AUDIO IN CH-2.

1

Število nožic Funkcija

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1- (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2- (COLD)
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[268] Povezovanje zunanjih naprav

Upravljanje/urejanje posnetkov z računalnikom

Posnetke lahko upravljate/urejate z računalnikom.

Uvoz posnetkov z bralnikom kartic (izbirna možnost)

Izklopite enoto in priključite kabel XLR na priključek AUDIO IN.2

Stikalo SETUP 2 nastavite tako, da po potrebi omogočite fantomsko napajanje.

Preklopite napajanje +48 V (fantomsko napajanje), kot je opisano spodaj.
Stikalo 2
Določa, ali se vklopi/izklopi napajanje +48 V (fantomsko napajanje), ko je priključena
vhodna zvočna naprava.

Opomba

Z nastavitvijo tega stikala v položaj ON in priklopom mikrofona, ki ni združljiv z napetostjo +48
V, lahko poškodujete priključeno napravo. Pred priklopom naprave preverite nastavitev.

3

Nastavitev Opis

OFF
(privzeto)

Ta način izklopi fantomsko napajanje +48 V ter nastavi vhod LINE ali MIC
kot vir zvoka CH-1 in CH-2.

ON
Ta način vklopi fantomsko napajanje +48 V ter nastavi mikrofon, ki je
združljiv s fantomskim napajanjem, kot vir zvoka CH-1 in CH-2.

Vklopite enoto in nastavite vrsto priključene naprave z uporabo možnosti [Audio] >
[Audio Input] > [AUDIO IN Select] v meniju kamere.

4



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Na računalnik priključite bralnik kartic CFexpress Type A ali bralnik kartic SD ter za uvoz
posnetkov uporabite programsko opremo, ki podpira format snemanja te enote, kot je na primer
Catalyst Browse.

Uporaba nelinearnega sistema za urejanje

Pri nelinearnem sistemu za urejanje mora programska oprema za urejanje (izbirna možnost)
podpirati formate, v katerih snema enota.

[269] Povezovanje zunanjih naprav

Oddajanje signala prek optičnih vlaken

Signal SDI, ki je pretvorjen v optični signal, lahko oddajate tako, da modul SFP+ (izbirna
možnost) priključite na priključek OPTICAL na enoti. Uporabite modul SFP+, ki se ujema s
pasovnim območjem signalov posameznega formata.
Pasovno območje signalov

4K (59,94p, 50p): 12G
4K (razen 59,94p, 50p): 6G
HD (59,94p, 50p): 3G
HD (razen 59,94p, 50p): 1,5G

Opomba

Uporabite modul, ki je skladen z naslednjimi standardi.
Standardi SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Standardi SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Modulu SFP+ se pošilja enak signal kot na izhodnem priključku SDI.

Enota ne podpira vhoda signalov, ki se prenašajo prek optičnih vlaken.

Za izhod signalov, ki se prenašajo prek optičnih vlaken, uporabite modul SFP+. Za podrobnosti o
preverjenih modulih SFP+ se obrnite na prodajalca izdelkov Sony ali servisnega predstavnika družbe
Sony.

* Raven moči I (1,0 W)
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[270] Povezovanje zunanjih naprav

Priključitev signala za snemanje v živo

Ta tema opisuje upravljanje signala za snemanje v živo.

Prižiganje indikatorja za snemanje v živo z uporabo signala iz daljinskega
upravljalnika

Indikator za snemanje v živo lahko prižgete z ukazom komunikacije VISCA prek IP iz zunanje
naprave, kot je daljinski upravljalnik RM-IP500.
Nastavite možnost [Technical] > [Tally] > [Tally Control] v spletnem meniju ali meniju kamere na
[External].

Prižiganje indikatorja za snemanje v živo iz zunanje naprave

Indikator za snemanje v živo lahko iz zunanje naprave, kot je daljinski upravljalnik RM-IP500 ali
preklopnik, prižgete rdeče ali zeleno. Signal za snemanje v živo lahko upravljate z ukazi, ki se
prenašajo prek omrežja, ali z vhodom signala za snemanje v živo na priključku OPTION na
enoti.
Nastavite možnost [Technical] > [Tally] > [Tally Control] v spletnem meniju ali meniju kamere na
[External].
Ko na priključku OPTION dovajate signal za snemanje v živo, izvedite kratkostično povezavo
nožice 7 z GND (nožica 4 ali 5), da indikator za snemanje v živo zasveti zeleno, ali nožice 8 z
GND (nožica 4 ali 5), da indikator za snemanje v živo zasveti rdeče.

Opomba

Ko je možnost [Tally Control] nastavljena na [External], indikator za snemanje v živo ne označuje
stanja snemanja enote.

Če se hkrati dovajata signala za snemanje v živo za rdeče in zeleno prižiganje indikatorja, indikator
za snemanje v živo zasveti rdeče.

Specifikacije nožic priključka OPTION
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Prižiganje indikatorja za snemanje v živo na zunanji napravi z uporabo
signala iz enote

Indikator za snemanje v živo na zunanji napravi lahko prižgete s signalom iz enote tako, da
povežete nožici 3 in 6 priključka OPTION, kot je prikazano spodaj.
Primer povezave nožic 3 in 6 priključka OPTION

Število
nožic

Smer
signala Specifikacije signala

1 – Rezerviran

2 – Rezerviran

3 OUT

Izhod zelenega indikatorja za snemanje v živo
Nizkonivojski izhod, ko zeleni indikator za snemanje v živo sveti.
Hi-Z (odprti kolektor izhod), ko zeleni indikator za snemanje v živo
ne sveti.

4 – GND (ozemljitev)

5 – GND (ozemljitev)

6 OUT

Izhod rdečega indikatorja za snemanje v živo
Nizkonivojski izhod, ko rdeči indikator za snemanje v živo sveti.
Hi-Z (odprti kolektor izhod), ko rdeči indikator za snemanje v živo
ne sveti.

7 IN
Vhod zunanjega upravljanja za zeleni indikator za snemanje v živo 
Kratek stik z ozemljitvijo (nožica 4 ali 5) povzroči, da indikator za
snemanje v živo na enoti zasveti zeleno.

8 IN
Vhod zunanjega upravljanja za rdeči indikator za snemanje v živo 
Kratek stik z ozemljitvijo (nožica 4 ali 5) povzroči, da indikator za
snemanje v živo na enoti zasveti rdeče.
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Opomba

Ne dovajajte napetosti nožicam 7 in 8.

Ne priključite zunanje naprave, ki bi lahko dovajala napetost na priključek OPTION.

Če se na nožico 3 ali 6 dovaja vklopna ali povratna napetost, ki presega nazivno vrednost, lahko
pride do okvare, dima ali požara.

Nastavite izhodni signal z uporabo možnosti [Technical] > [Tally] > [Tally Control] v spletnem meniju
ali meniju kamere.
[Internal]: Stanje delovanja snemanja enote
[External]: Logični IN rdečih/zelenih signalov za snemanje v živo, ki jih enota prejme prek signalov IN
in daljinskih upravljalnikov.

[271] Dodatek

Previdnostni ukrepi

Kondenzacija
Če enoto prenesete s hladnega na toplo mesto ali če se temperatura okolice nenadoma zviša,
se lahko na zunanji površini enote in/ali znotraj enote ustvari vlaga. Temu pravimo
kondenzacija. Če pride do kondenzacije, izklopite enoto in pred ponovno uporabo počakajte, da
se kondenzacija posuši. Ko je prisotna kondenzacija, lahko uporaba enote poškoduje enoto.

Pojavi slikovnega senzorja CMOS kamere

Opomba

Sledeči pojavi, ki se lahko pojavijo na slikah, so značilni za slikovne senzorje. V teh primerih ne gre
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za okvaro.

Beli madeži
Čeprav so slikovni senzorji izdelani z visoko natančnimi tehnologijami, se lahko v redkih
primerih na zaslonu pojavijo beli madeži, ki jih povzročijo kozmični žarki ipd.
To je povezano z načinom delovanja slikovnih senzorjev in ne predstavlja okvare.
Bele madeže je mogoče opaziti predvsem v naslednjih primerih:

Pri delovanju pri visoki delovni temperaturi
Kadar povečate ojačitev (občutljivost)

Migetanje
Pri snemanju s svetlobo fluorescenčnih luči, natrijevih svetilk, živosrebrnih svetilk ali svetilk LED
se lahko pojavi utripanje zaslona ali nepravilne barve.

Pogonske enote objektiva in mehanizma za obračanje/nagibanje
Če objektiva in pogonskega mehanizma za obračanje/nagibanje dalj časa ne uporabljate, se
lahko viskoznost v notranjosti nanesenega maziva poveča in preprečuje premikanje
mehanizma. Redno uporabljajte objektiv in mehanizem za obračanje/nagibanje.

Deli, ki so potrošni material
Ventilator in vgrajena akumulatorska baterija sta potrošni material, ki zahteva občasno
zamenjavo.
Pri uporabi pri sobni temperaturi bo običajen cikel zamenjave znašal približno 5 let. Cikel
zamenjave predstavlja splošno vodilo in ne pomeni, da je takšna tudi zagotovljena
življenjska doba teh delov.
Za podrobnosti o menjavi delov se obrnite na prodajalca.

Pričakovana življenjska doba omrežnega napajalnika in elektrolitskega kondenzatorja znaša
približno 5 let pri normalnih temperaturah in normalnem času uporabe (8 ur na dan; 25 dni
na mesec). Če uporaba presega zgoraj navedeno normalno uporabo, se lahko pričakovana
življenjska doba ustrezno zmanjša.

Priporočamo vam periodične preglede enote, da zagotovite njeno pravilno delovanje in
podaljšajte njeno življenjsko dobo. Za več informacij o pregledih se obrnite na servisnega
predstavnika družbe Sony.

Vgrajena akumulatorska baterija
Enota ima vgrajeno akumulatorsko baterijo za shranjevanje datuma, časa in ostalih nastavitev,
tudi ko je enota izklopljena. Vgrajena akumulatorska baterija se napolni, ko preteče 24 ur od
priklopa enote na omrežno napajanje ali priklopa na napajanje PoE++, ne glede na to, ali je
enota vklopljena ali izklopljena. Akumulatorska baterija se popolnoma izprazni v približno 2
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mesecih, če enota v tem času ni priklopljena na omrežno napajanje. Enoto uporabljajte po tem,
ko ste napolnili baterijo. Tudi če akumulatorska baterija ni napolnjena, to ne vpliva na delovanje
enote, razen če boste potrebovali snemanje datuma.

Lokacije uporabe in shranjevanja
Shranjujte na ravnem, prezračevanem mestu.
Izogibajte se uporabi in shranjevanju enote na sledečih mestih.

Na lokacijah, ki so izpostavljene dežju ali vodi (tudi pod strešnimi žlebovi)
Na prostem in na lokacijah, kjer temperatura presega 40 °C 
Ne pozabite, da lahko poleti v toplejših podnebnih pasovih temperatura v avtomobilu z
zaprtimi okni zlahka preseže 50 °C.
Na lokacijah, ki so hladnejše od 0 °C
Na vlažnih ali prašnih lokacijah Na lokacijah, kjer bi bila enota lahko izpostavljena dežju
Na lokacijah, ki so izpostavljene vibracijam ali udarcem
Na lokacijah, kjer nastajajo sevanje, rentgenski žarki in močna magnetna polja.
Blizu radijskih ali TV oddajnikov, ki ustvarjajo močna elektromagnetna polja.
Dalj časa na neposredni sončni svetlobi ali blizu grelnih teles

Opomba glede laserskih žarkov
Laserski žarki lahko poškodujejo slikovni senzor CMOS. Če snemate prizor, ki vključuje laserski
žarek, bodite pozorni, da laserski žarek ni usmerjen v objektiv enote. Poleg tega lahko laserski
žarki visoke moči na medicinskih ali drugih napravah povzročijo poškodbe z odbito ali razpršeno
svetlobo.

Za preprečitev elektromagnetnih motenj s strani prenosnih komunikacijskih
naprav
Uporaba prenosnih telefonov in drugih komunikacijskih naprav v bližini te enote lahko povzroči
nepravilno delovanje ter motnje zvočnih in video signalov. Priporočljivo je, da so prenosne
komunikacijske naprave v bližini te enote izklopljene.

Izdelka ne puščajte v bližini medicinskih pripomočkov.
Izdelek (vključno z dodatno opremo) vsebuje magnete, ki lahko povzročijo motnje srčnih
spodbujevalnikov, programljivih ventilov za zdravljenje hidrocefalusa in drugih medicinskih
pripomočkov. Izdelka ne puščajte v bližini oseb, ki uporabljajo te medicinske pripomočke. Pred
uporabo izdelka se posvetujte z zdravnikom, če ste uporabnik katerega od omenjenih
medicinskih pripomočkov.

Varnostni ukrepi
DRUŽBA SONY NI ODGOVORNA ZA NIKAKRŠNO ŠKODO, KI JE POSLEDICA
NEUPOŠTEVANJA USTREZNIH VARNOSTNIH UKREPOV NA PRENOSNIH NAPRAVAH,
ZA NEIZOGIBNO RAZKRITJE PODATKOV, KI JE POSLEDICA SPECIFIKACIJ PRENOSA,
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ALI ZA KAKRŠNEKOLI VARNOSTNE TEŽAVE.
Odvisno od okolja uporabe bodo morda nepooblaščene tretje osebe v omrežju lahko
dostopale do enote. Pri povezovanju enote v omrežje se prepričajte, da je omrežje ustrezno
zavarovano.
Vsebino komunikacij lahko nevede prestrežejo neavtorizirane tretje osebe, ki se nahajajo v
bližini signalov. Pri komunikacijah prek brezžičnega omrežja LAN uporabite ustrezne
varnostne ukrepe, da zaščitite vsebino komunikacij.
Ko ta izdelek povežete z omrežjem, ga povežite prek sistema z zaščitno funkcijo, kot je na
primer usmerjevalnik ali požarni zid. Če ga povežete brez zaščite, lahko pride do težav z
varnostjo.

Napajanje
Enota ni opremljena s stikalom za vklop. Za izklop enote se prepričajte, da so vsi postopki
končani in je enota v stanju pripravljenosti za napajanje, nato pa odklopite omrežni
napajalnik. Če uporabljate napajanje PoE++, odklopite kabel LAN.
Če je mogoče, uporabljajte vir napajanja na mestu, kjer lahko enostavno vstavite in izvlečete
napajalni vtič.
Če uporabljate vtičnico v prašnem prostoru, redno čistite območje okoli vtičnice, da
preprečite nastanek sledi.

Previdnostni ukrepi za premične dele
Zagotovite, da v premične dele ne prodrejo tujki.
Ko dele premikate z roko, ne uporabljajte prevelike obremenitve. V nasprotnem primeru
lahko povzročite okvaro.
Ne posegajte v delovanje premičnih delov, ko se ti premikajo. Če ne upoštevate tega
opozorila, lahko povzročite poškodbo ali okvaro.
Če enote ne boste uporabljali dlje časa, premični deli morda ne bodo delovali normalno.
Redno uporabljajte funkcije obračanja/nagibanja enote.

Previdnostni ukrepi za funkcijo snemanja
Vedno naredite testni posnetek in se prepričajte, da je bil uspešno posnet. DRUŽBA SONY
NI ODGOVORNA ZA NIKAKRŠNO ŠKODO, MED DRUGIM ZA NADOMESTILO ALI
POVRAČILO IZGUBE SEDANJEGA ALI PRIČAKOVANEGA DOBIČKA ZARADI NAPAKE
TE ENOTE ALI SNEMALNEGA MEDIJA ALI KATEREGAKOLI MEDIJA ALI
POMNILNIŠKEGA SISTEMA KATEREKOLI VRSTE ZA SNEMANJE KAKRŠNE KOLI
VSEBINE.
Pred uporabo enote vedno preverite, ali deluje pravilno. DRUŽBA SONY NI ODGOVORNA
ZA NIKAKRŠNO ŠKODO, MED DRUGIM ZA NADOMESTILO ALI POVRAČILO IZGUBE
SEDANJEGA ALI PRIČAKOVANEGA DOBIČKA ZARADI NAPAKE TE ENOTE, TAKO V
GARANCIJSKEM ROKU KOT PO POTEKU GARANCIJE ALI ZARADI KAKRŠNEGA KOLI
DRUGEGA RAZLOGA.
DRUŽBA SONY NI ODGOVORNA ZA KAKRŠNEKOLI ZAHTEVKE UPORABNIKOV TE
ENOTE ALI TRETJIH OSEB.
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DRUŽBA SONY NI ODGOVORNA ZA IZGUBO, POPRAVILO ALI REPRODUKCIJO
PODATKOV, POSNETIH NA NOTRANJI POMNILNIŠKI SISTEM, SNEMALNE MEDIJE ALI
KATEREKOLI DRUGE MEDIJE ALI POMNILNIŠKE SISTEME.
DRUŽBA SONY NI ODGOVORNA ZA PREKINITEV ALI KONČANJE KATERIHKOLI
STORITEV, VEZANIH NA TO ENOTO, KI BI BILE POSLEDICA KAKRŠNIHKOLI
OKOLIŠČIN.

[272] Dodatek

Izhodni formati in omejitve

Ta tema opisuje izhodne formate in omejitve.

Opomba

Ločljivost izhodnega formata je omejena z nastavitvami [Project] > [Rec Format] > [Frequency],
[Codec] in [Video Format] v spletnem meniju ali meniju kamere.

Ločljivost izhodnega formata je omejena tudi s kombinacijo hitrosti sličic pri počasnih in hitrih
posnetkih. Poleg spodnje tabele izhodnih formatov priključkov SDI OUT/HDMI OUT se izhod HDMI
spremeni v Full HD ali nižji, če sta izpolnjena oba naslednja pogoja.

Možnost [Shooting] > [S&Q Motion] > [Setting] je nastavljena na [On].
Nastavitev [Shooting] > [S&Q Motion] > [Frame Rate] je višja od 60 sličic na sekundo.

Če sta izpolnjena zgornja pogoja, sta možnosti izbire izhoda HDMI 4096×2160P in 3840×2160P za
nastavitev [Monitoring] > [Output Format] > [SDI/HDMI] zatemnjeni in ju ni mogoče izbrati.

Slika se ne predvaja, če je nastavljena višja ločljivost od ločljivosti slike za predvajanje.

Izhodni formati priključkov SDI OUT/HDMI OUT

Ko je sistemska frekvenca 50/59,94 Hz

Nastavitev Izbirni izhodni format

Način
snemanja/predvajanja

Izhodna ločljivost
RAW/

notranja ločljivost
snemanja

SDI HDMI

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P
(privzeto) 
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RAW 
RAW & XAVC-I

1920×1080i

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P
(privzeto) 
1920×1080i

XAVC-I 
XAVC-L

4096×2160

4096 × 2160 (2SI)
4096×2160P 
1920×1080P 
1920×1080i

3840 × 2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (Level A)
(privzeto)

1920×1080P
(privzeto) 
1920×1080i

1920×1080P (Level B)
1920×1080P 
1920×1080i

3840×2160

3840 × 2160 (2SI)
3840×2160P 
1920×1080P 
1920×1080i

1920×1080P (Level A)
(privzeto)

1920×1080P
(privzeto) 
1920×1080i

1920×1080P (Level B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(privzeto)

1920×1080P
(privzeto) 
1920×1080i

1920×1080P (Level B)
1920×1080P 
1920×1080i

1920×1080i 1920×1080i

(izhod je ustavljen)
720×480P1) 
720×576P2)
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Ko je sistemska frekvenca 25/29,97 Hz

Ko je sistemska frekvenca 23,98 Hz

Ko je sistemska frekvenca 59,941)
Ko je sistemska frekvenca 502)

Nastavitev Izhodni format (izhodna ločljivost)

Način
snemanja/predvajanja

Izhodna ločljivost
RAW/

notranja ločljivost
snemanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160 RAW)

4096×2160P 
3840×2160P 
1920×1080P 
1920×1080i
(privzeto)

3840×2160 
(RAW)

(3840×2160 RAW)

3840×2160P 
1920×1080P 
1920×1080i
(privzeto)

XAVC-I 
XAVC-L

4096×2160

4096 × 2160 (2SI)
4096×2160P 
1920×1080P

3840 × 2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(privzeto)

1920×1080i
(privzeto)

3840×2160

3840 × 2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(privzeto)

1920×1080i
(privzeto)

1920×1080
1920×1080P 
1920×1080PsF

1920×1080P 
1920×1080i
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Ko je sistemska frekvenca 24 Hz

Nastavitev Izhodni format (izhodna ločljivost)

Način
snemanja/predvajanja

Izhodna ločljivost
RAW/

notranja ločljivost
snemanja

SDI HDMI

RAW 
RAW & XAVC-I

4096×2160 
(RAW)

(4096×2160
RAW)

4096×2160P 
3840×2160P 
1920×1080P
(privzeto)

3840×2160 
(RAW)

(3840×2160
RAW)

3840×2160P 
1920×1080P
(privzeto)

XAVC-I 
XAVC-L

4096×2160

4096 × 2160 (2SI)
4096×2160P 
1920×1080P

3840 × 2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(privzeto)

1920×1080P
(privzeto)

3840×2160

3840 × 2160 (2SI)
3840×2160P 
1920×1080P

1920×1080P
(privzeto)

1920×1080P
(privzeto)

1920×1080
1920×1080P
(privzeto)

1920×1080P
(privzeto)

Nastavitev Izhodni format (izhodna ločljivost)

Način
snemanja/predvajanja

Izhodna ločljivost
RAW/

notranja ločljivost
snemanja

SDI HDMI

RAW 4096×2160 (4096×2160
4096×2160P 
1920×1080P
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[273] Dodatek

Odpravljanje težav

Napajanje

RAW & XAVC-I (RAW) RAW)
(privzeto)

XAVC-I 4096×2160
4096×2160 (2SI) 
1920×1080P
(privzeto)

4096×2160P 
1920×1080P
(privzeto)

Težava Vzrok Rešitev

Enota
se ne
vklopi.

Omrežni napajalnik ni čvrsto priključen na
priključek DC IN.

Napajalni kabel čvrsto vstavite vse do
konca.

Napajalni kabel ni čvrsto vstavljen v
omrežni napajalnik ali omrežno vtičnico.

Napajalni kabel čvrsto vstavite vse do
konca.

Kabel LAN ni čvrsto povezan med
napravo za dovajanje energije PoE++ in
enoto.

Prepričajte se, da je kabel vstavljen,
dokler se ne zaskoči.

Kabel LAN je priključen na priključek
OPTION in ne na priključek LAN.

Kabel LAN pravilno priključite na
priključek LAN.

Enota je priključena na napravo za
dovajanje energije, ki ne podpira PoE++
(skladno s standardom IEEE802.3bt, tip 4,
razred 8).

Priključite na napravo za dovajanje
energije, ki podpira PoE++ (skladno s
standardom IEEE802.3bt, tip 4,
razred 8).

Skupna poraba energije presega največjo
nazivno vrednost naprave za dovajanje
energije PoE++.

Oglejte si navodila za uporabo
naprave za dovajanje energije
PoE++.

Priključen je omrežni kabel s kategorijo, ki
ne podpira dovajanja energije PoE++.

Za priključitev na priključek LAN
uporabite omrežni kabel kategorije 5e
ali višje.

Kamera, naprava za dovajanje energije
PoE++ in zunanje naprave niso

Zagotovite ozemljitev kamere,
naprave za dovajanje energije PoE++
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Predvajanje slike

ozemljene. in zunanjih naprav.

Težava Vzrok Rešitev

Slika se ne
predvaja.

Povezane naprave niso pravilno priključene.
Pravilno priključite
povezane naprave.

Začetna nastavitev ni bila dokončana.
Dokončajte začetno
nastavitev s spletno
aplikacijo.

Prek priključka
HDMI se ne
predvaja nobena
slika.

Oddaja se signal, ki ga ciljna naprava z izhodom
HDMI ne podpira.

Spremenite
nastavitev izhodnega
formata HDMI ali pa
uporabite napravo, ki
podpira izhodni
signal.

Uporablja se kabel, ki ne podpira izhodnega
standarda HDMI.

Uporabite kabel, ki
podpira uporabljen
izhodni standard
HDMI.

Prek priključka
SDI se ne
predvaja nobena
slika.

Uporablja se kabel, ki ne podpira izhodnega
standarda SDI.

Uporabite kabel, ki
podpira uporabljen
izhodni standard SDI.

Monitor, ki je priključen na priključek SDI, ne
podpira izhodnega signala.

Uporabite monitor, ki
podpira izhodni
standard SDI.

Format snemanja je nastavljen na izhod RAW.

Spremenite format
snemanja na
nastavitev, ki ni izhod
RAW.

Izhod HDMI je nastavljen na ločljivost SD.
Nastavite izhod
HDMI na ločljivost, ki
ni SD.

Prek optičnih
vlaken se ne
predvaja nobena

Modul, ki se uporablja, ni skladen s standardi
SFF ali SMPTE ali pa ne ustreza ravni moči I

Oglejte si razdelek
"Oddajanje signala
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Daljinski upravljalnik

Infrardeči daljinski upravljalnik

slika ali pa je
slika popačena.

(1,0 W). prek optičnih vlaken".

Pri uporabi
sinhronizacije z
zunanjo napravo
se slika ne
predvaja ali pa je
popačena.

Ne dovaja se zunanji sinhronizacijski signal,
primeren za konfigurirani format video signala.

Dovajajte zunanji
sinhronizacijski
signal, primeren za
konfigurirani format
video signala.

V zvoku se
pojavlja šum.

Kamera, naprava za dovajanje energije PoE++
in zunanje naprave niso ozemljene.

Zagotovite ozemljitev
kamere, naprave za
dovajanje energije
PoE++ in zunanjih
naprav.

Enota se uporablja v okolju z napravami, ki
ustvarjajo močna električna in magnetna polja
(kot so antene televizijskih/radijskih oddajnikov,
radioamaterski oddajniki, motorji klimatskih
naprav, napajalni transformatorji).

Zagotovite, da v
bližini enote ne bo
naprav, ki ustvarjajo
močna električna in
magnetna polja.

Objektiv, podpora za objektiv in pogonska enota
so v stiku z enoto ali predmetom v okolici, pri
čemer se oddajajo neobičajni zvoki.

Pravilno pritrdite
objektiv.

Prepričajte se, da
v bližini kamere
ni nobenih ovir.

Težava Vzrok Rešitev

Infrardeči daljinski
upravljalnik ob
pritisku ne deluje.

Delovanje infrardečega
daljinskega upravljalnika je
onemogočeno.

Nastavite možnost [Technical] > [IR
Remote] > [Setting] v spletnem meniju
na [On].

Baterija je izpraznjena ali pa
je polarnost baterije
napačna.

Infrardeči daljinski upravljalnik
uporabljajte v bližini infrardečega
senzorja ne enoti. Če LED-indikator
POWER utripa, zamenjajte baterijo.
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RM-IP500

Začetna nastavitev ni bila
dokončana.

Dokončajte začetno nastavitev s
spletno aplikacijo.

Hitrost delovanja
obračanja/nagibanja
je počasna.

Hitrost obračanja/nagibanja
z infrardečega daljinskega
upravljalnika je nastavljena
na običajni način.

Preklopite stikalo SETUP 4 na zadnji
plošči v položaj ON.

Upravljanje je
usmerjeno na drugo
kamero in ne na
predvideno.

Infrardeči signal je prejela
kamera, ki ni predvidena.

V spletnem meniju kamere, ki je ne
želite upravljati, nastavite možnost
[Technical] > [IR Remote] > [Setting] na
[Off].

Težava Vzrok Rešitev

Kamere ni mogoče upravljati z
daljinskim upravljalnikom RM-
IP500.

Napajanje
kamere ni
priključeno.

Preverite, ali indikator POWER na
kameri sveti zeleno ali oranžno.

Kamera ali
daljinski
upravljalnik ni
povezan z
omrežjem.

Preverite povezave kamere in
daljinskega upravljalnika.

Začetna
nastavitev
kamere ni bila
dokončana.

Dokončajte začetno nastavitev s
spletno aplikacijo.

Komunikacija
VISCA prek IP
ni omogočena.

Preklopite stikalo SETUP 3 na plošči
kamere za priključke v položaj ON in
znova zaženite enoto.

Naslov IP
kamere se je
spremenil.

Z možnostjo [Network] > [Wired LAN] v
spletnem meniju ali meniju kamere
preverite naslov IP kamere.

Naslov IP kamere je bil
spremenjen z uporabo možnosti
AUTO IP SETUP na daljinskem
upravljalniku RM-IP500.

Od zagona
kamere je
minilo vsaj 20
minut.

Znova zaženite kamero. Naslov IP
lahko z uporabo možnosti AUTO IP
SETUP spremenite v prvih 20 minutah
po zagonu kamere.
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Spletna aplikacija

Težava Vzrok Rešitev

Ni mogoče vzpostaviti
povezave z uporabo
spletnega brskalnika.

Ni priključen kabel
LAN kategorije 5e
ali višje.

Priključite kabel LAN kategorije 5e ali
višje.

Priključitev na
omrežje LAN ni
pravilna ali pa
povezano omrežje
ne deluje normalno.

Preverite, ali LED-indikator LINK za
priključek LAN sveti. Če LED-indikator
LINK ne sveti, se obrnite na skrbnika
omrežja.

Napajanje kamere
ni priključeno.

Oglejte si zgornji razdelek "Napajanje".

Za enoto ni
konfiguriran
veljaven naslov IP.

Izvedite ponastavitev omrežja.

Konfiguriran naslov
IP se uporablja na
drugi napravi.

Prepričajte se, da so naslovi IP zunanjih
naprav edinstveni.

Konfigurirana
maska podomrežja
se ne ujema z
uporabljenim
podomrežjem
omrežja.

Izvedite ponastavitev omrežja.

Dostop do enote
poteka v istem
lokalnem omrežju
prek strežnika
proxy.

Spremenite konfiguracijo tako, da se
strežnik proxy ne uporablja.

Konfiguriran privzeti
prehod za enoto je
napačen.

Izvedite ponastavitev omrežja.

Vneseni spletni
naslov je napačen.

Vnesite pravilen spletni naslov in
poskusite znova.

Prikažite meni kamere na zunanjem
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Vrata HTTP niso
pravilna.

monitorju in preverite nastavitev
[Network] > [Wired LAN] > [HTTP Port].
Če je konfigurirana vrednost, ki ni 80,
dodajte številko vrat HTTP imenu
gostitelja ali naslovu IP, ki je vnesen v
spletni brskalnik.
Primer: Če so vrata HTTP nastavljena na
8080, vnesite http://<naslov IP>:8080

Številka vrat HTTP
enote se filtrira ali
pa je blokirana.

Spremenite številko vrat HTTP enote v
vrata, ki niso filtrirana ali blokirana.

Stari predpomnilnik
spletnega
brskalnika ima
negativen vpliv.

Izbrišite predpomnilnik iz spletnega
brskalnika.

Ni mogoče vzpostaviti
povezave s spletno
aplikacijo prek kode 2D
(kode QR).

Naprava, ki se
uporablja, ne
podpira mDNS.

Uporabljajte napravo, ki podpira mDNS. 
Če uporabljate napravo, ki ne podpira
mDNS, vnesite naslov IP neposredno v
spletni brskalnik.

Tablični računalnik
ali osebni
računalnik je
povezan z drugim
omrežjem kot
kamera.

Povežite tablični računalnik ali osebni
računalnik z istim omrežjem, kot ste
povezali kamero.

Ni mogoče vzpostaviti
povezave s spletno
aplikacijo prek ročnega
vnosa spletnega naslova.

Naprava, ki se
uporablja, ne
podpira mDNS.

Uporabljajte napravo, ki podpira mDNS.

Tablični računalnik
ali osebni
računalnik je
povezan z drugim
omrežjem kot
kamera.

Povežite tablični računalnik ali osebni
računalnik z istim omrežjem, kot ste
povezali kamero.

Ni bilo vneseno
pravilno
uporabniško ime ali

Vnesite registrirano uporabniško ime in
geslo. Če ste pozabili registrirane
podatke o uporabniku, si oglejte razdelek
"Stikalo RESET" v poglavju "Priključni
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Zaslon za preverjanje
pristnosti je prikazan
neprekinjeno.

geslo. blok" in inicializirajte informacije o
uporabniku za omrežno povezavo.

Uporabniško ime in
geslo je morda
spremenil
uporabnik, ki se je
prijavil z drugim
spletnim
brskalnikom.

Obrnite se na skrbnika kamere ter
preverite pravilno uporabniško ime in
geslo.

Slika kamere ni prikazana
v spletni aplikaciji.

Izhod HDMI kamere
je nastavljen na
720×480 ali
720×576.

Spremenite ločljivost izhoda HDMI
kamere.

Priključen je
monitor HDMI, ki ne
podpira izhodnega
signala HDMI
kamere.

Odstranite monitor HDMI ali uporabite
monitor HDMI, ki podpira izhodni signal
HDMI.

Enota se je
ponovno zagnala in
seja je bila
prekinjena.

Počakajte približno eno minuto, nato pa
znova naložite spletni brskalnik.

Stari predpomnilnik
spletnega
brskalnika ima
negativen vpliv.

Izbrišite predpomnilnik iz spletnega
brskalnika.

Ločljivost slike kamere, ki
je prikazana v spletni
aplikaciji, je nizka.

Ločljivost toka videa
3, ki ga uporablja
spletna aplikacija, je
nastavljena na
nizko vrednost.

Povečajte vrednost z uporabo možnosti
[Stream] > [Video Stream] > [Size 3] v
spletnem meniju.

Ob pritisku gumba
[MENU] se ne prikaže
meni kamere.

Meni kamere je
konfiguriran tako,
da ni dodan
izhodnemu signalu
HDMI.

Nastavite možnost [Monitoring] > [Output
Display] > [HDMI/Stream] v spletnem
meniju na [On].

Zaslon z
nastavitvami v
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Snemanje

Kamera

Vrednost nastavitve na
zaslonu z nastavitvami se
ne posodobi/prikaže
pravilno.

spletni aplikaciji ne
odraža samodejno
nastavitev, ki so bile
spremenjene v
drugi spletni
aplikaciji.

Pritisnite gumb [Reload] na dnu zaslona
z nastavitvami v spletni aplikaciji.
Vrednosti nastavitev na prikazanem
zaslonu z nastavitvami se ponovno
naložijo in posodobijo.

To so učinki
nastavitev začasnih
internetnih datotek.

Izbrišite predpomnilnik iz spletnega
brskalnika.

Ni mogoče prenesti
konfiguracijske datoteke
ali dnevnika.

Funkcija prenosa
datoteke v spletnem
brskalniku je
onemogočena.

Omogočite funkcijo prenosa datoteke v
spletnem brskalniku.

Zaslon z nastavitvami v
spletni aplikaciji je
dostopen, vendar ni
mogoče izvajati postopkov
na zaslonu delovanja v
živo in zaslonu za
upravljanje predvajanja.

Zaslon za
upravljanje spletne
aplikacije je
zaklenjen.

Preklopite stikalo za zaklepanje
upravljanja v zgornjem desnem kotu
spletne aplikacije v položaj 
(odklepanje upravljanja).

Prikaz zaslona spletne
aplikacije traja nekaj časa.

Pretočno sliko
enote si istočasno
ogleduje več
uporabnikov.

Zmanjšajte število uporabnikov, ki lahko
hkrati dostopajo do spletne aplikacije.

Težava Vzrok Rešitev

Na začetku in koncu
obračanja/nagibanja je slika
videti popačena.

Slika je lahko popačena, če je
vklopljena funkcija stabilizacije slike
v objektivu.

Izklopite funkcijo
stabilizacije slike v
objektivu.

Vidni kot se je spremenil brez
upravljanja s strani
uporabnika.

Prišlo je do premika objektiva zaradi
dihanja.

Oglejte si razdelek
"Izravnava zaradi
dihanja".

Ni mogoče upravljati ostrenja, Nastavitve stikal na objektivu so
Oglejte si razdelek
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Obračanje/nagibanje

zooma ali zaslonke. morda napačne.
"Preverjanje stikal
objektiva".

Težava Vzrok Rešitev

Ni mogoče
ponastaviti
obračanja/nagibanja.

Ročica za zaklepanje
obračanja/nagibanja je v
položaju LOCK (zaklenjeno).

Potisnite ročico za zaklepanje
obračanja/nagibanja v položaj
UNLOCK (odklenjeno).

Kamera se ne ustavi
v pričakovanem
položaju.

Blok kamere ni v ravnovesju.

Premaknite blok kamere
naprej/nazaj v ustrezen položaj, kot
je opisano v razdelku "Namestitev
objektiva", nato pa ponovno
vklopite enoto.

Nameščen je objektiv, ki ne
podpira obračanja/nagibanja.

Oglejte si informacije o združljivosti
objektivov ter namestite objektiv, ki
podpira obračanje/nagibanje, nato
pa ponovno vklopite enoto.

Ni mogoče izvesti ponastavitve
obračanja/nagibanja.

Izvedite ponastavitev
obračanja/nagibanja, kot je opisano
v razdelku "Ponastavitev
obračanja/nagibanja".

Na glavo kamere je delovala
nepričakovana sila, kar je
povzročilo napako pri
upravljanju
obračanja/nagibanja.

Ob pritisku gumba
[Pan-Tilt Home] se
kamera ne vrne na
sprednjo stran.

Aktiviran je bil način namestitve
na strop.

Nastavite možnost [Pan-Tilt] > [P/T
Direction] > [Ceiling] v spletnem
meniju v skladu z dejansko
namestitvijo, nato pa znova
zaženite enoto. Ko je kamera
nameščena na strop, se priključni
blok nahaja na sprednji strani
kamere.

Delovanje
obračanja/nagibanja

Nastavljena je omejitev
območja obračanja/nagibanja.

Po potrebi izbrišite nastavitve
omejitve območja
obračanja/nagibanja, kot je opisano
v razdelku "P/T Range Limit".
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je omejeno. Na glavo kamere je delovala
nepričakovana sila, kar je
povzročilo napako pri
obračanju/nagibanju.

Izvedite ponastavitev
obračanja/nagibanja, kot je opisano
v razdelku "Ponastavitev
obračanja/nagibanja".

Obračanje/nagibanje
se je izvedlo v
nasprotno stran.

Nastavitev načina namestitve
na strop se razlikuje od
dejanskega stanja namestitve.

Nastavite možnost [Pan-Tilt] > [P/T
Direction] > [Ceiling] v spletnem
meniju v skladu z dejansko
namestitvijo.

Spremenjene so bile
nastavitve, povezane s smerjo
obračanja/nagibanja.

Preverite nastavitve [Pan-Tilt] >
[P/T Direction] v spletnem meniju.

Na začetku in koncu
obračanja/nagibanja
se slika ne premika
gladko.

Nastavitev
pospeševanja/upočasnjevanja
za delovanje
obračanja/nagibanja je
določena previsoko.

Z možnostjo [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] v
spletnem meniju ali meniju kamere
zmanjšajte nastavitev
pospeševanja/upočasnjevanja za
delovanje obračanja/nagibanja in
tako omogočite bolj gladko
premikanje na začetku in koncu
obračanja/nagibanja. Upoštevajte,
da bo zaradi tega objektiv
potreboval več časa, da doseže
največjo hitrost.

Delovanje
obračanja/nagibanja
se je ustavilo.

Blok kamere ni v ravnovesju.

Premaknite blok kamere
naprej/nazaj v ustrezen položaj, kot
je opisano v razdelku "Namestitev
objektiva", nato pa ponovno
vklopite enoto.

Možnost Ramp Curve
(pospeševanje/upočasnjevanje)
je za nameščen objektiv
nastavljena previsoko.

Če je nameščen velik objektiv,
zmanjšajte vrednost nastavitve
[Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] v spletnem meniju ali
meniju kamere.

Uporablja se velik objektiv.
Stopite v stik s predstavnikom za
podporo pri podjetju Sony.

Oprijemalna ročica
pritrditvenega vijaka podstavka
podpore za objektiv udari v
kamero.

Obrnite oprijemalno ročico
pritrditvenega vijaka podstavka
podpore za objektiv, da bo
usmerjena navzgor.
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Enota je ovirana, ko
se izvaja
obračanje/nagibanje.

Oprijemalna ročica podpore za
objektiv udari v kamero.

Obrnite oprijemalno ročico podpore
za objektiv, da bo usmerjena
navzgor.

Ročica za zaklepanje glave
kamere udari v kamero.

Prepričajte se, da je ročica za
zaklepanje glave kamere v celoti v
položaju LOCK (zaklenjeno).

Med delovanjem
obračanja/nagibanja
prihaja do
neobičajnih zvokov.

Kamera ni v ravnovesju.

Premaknite glavo kamere
naprej/nazaj v ustrezen položaj,
tako da je drsni podstavek
vodoraven.

Možnost Ramp Curve
(pospeševanje/upočasnjevanje)
je za nameščen objektiv
nastavljena previsoko.

Če je nameščen velik objektiv,
zmanjšajte vrednost nastavitve
[Pan-Tilt] > [P/T Acceleration] >
[Ramp Curve] v spletnem meniju ali
meniju kamere.

Glava kamere ni fiksno
nameščena, med delovanjem
pa je mogoče slišati zvok
premikanja.

Nastavite ročico za zaklepanje
glave kamere v položaj LOCK
(zaklenjeno).

Ni mogoče shraniti
ali naložiti
prednastavitve.

Shranjevanje in nalaganje
prednastavitve ni na voljo, ko je
možnost [Zoom Type]
nastavljena na [On(Clear Image
Zoom)].

Nastavite možnost [Technical] >
[Zoom] > [Zoom Type] v meniju
kamere na [Optical Zoom Only].

Nadzorna plošča za
okvirjanje v spletni
aplikaciji je
zatemnjena in je ni
mogoče upravljati.

Delovanje obračanja/nagibanja
ni na voljo med prikazom
zaslona sličic in med
predvajanjem.

Zapustite prikaz zaslona sličic ali
zaustavite predvajanje.

Delovanje obračanja/nagibanja
ni na voljo, če slike kamere ni
mogoče prikazati v spletni
aplikaciji.

Oglejte si razdelek "Spletna
aplikacija" v poglavju "Odpravljanje
težav".

Ročica za zaklepanje
obračanja/nagibanja je v
položaju LOCK (zaklenjeno).

Potisnite ročico za zaklepanje
obračanja/nagibanja v položaj
UNLOCK (odklenjeno).

Pod nadzorno
Na glavo kamere je delovala Izvedite ponastavitev
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Snemanje/predvajanje

ploščo za okvirjanje
v spletni aplikaciji se
prikaže "Execute
Pan-Tilt Reset".

nepričakovana sila, kar je
povzročilo napako pri
obračanju/nagibanju.

obračanja/nagibanja, kot je opisano
v razdelku "Ponastavitev
obračanja/nagibanja".

Težava Vzrok Rešitev

Snemanje se
s pritiskom
gumba za
snemanje
START/STOP
ne začne.

Pomnilniška kartica je polna.
Zamenjajte pomnilniško kartico z drugo,
na kateri je dovolj prostora.

Pomnilniško kartico je treba
obnoviti.

Obnovite pomnilniško kartico, kot je
opisano v razdelku "Obnovitev
pomnilniških kartic".

Enota deluje na napajanje
PoE++.

Zagotovite napajanje na priključku DC
IN z uporabo omrežnega napajalnika.

Indikator za snemanje na
pomnilniško kartico/snemanje v
živo je konfiguriran kot indikator
za snemanje v živo, zato stanja
snemanja ni mogoče določiti na
podlagi indikatorja.

Konfigurirajte indikator za snemanje na
pomnilniško kartico/snemanje v živo, da
deluje kot indikator za snemanje na
pomnilniško kartico, kot je opisano v
razdelku "Priključitev signala za
snemanje v živo".

Ni mogoče
snemati
zvoka.

Mikrofon ni priključen.
Priključite mikrofon ali zvočno napravo
na priključek AUDIO IN na priključnem
bloku.

Nastavitev [Master Input Level] je
na najnižji vrednosti.

Prilagodite nastavitev [Master Input
Level].

Posneti zvok
je popačen.

Raven zvočnega vhoda je
nastavljena previsoko.

Prilagodite nastavitev [CH1 Input Level]
na [CH4 Input Level] in [Master Input
Level].

Posneti zvok
ima visoko
raven šuma.

Raven zvočnega vhoda je
nastavljena prenizko.

Prilagodite nastavitve [Audio Input
Level] in [Audio] > [Audio] > [Audio
Input] > [AUDIO IN CH1 MIC Ref.] ali
[AUDIO IN CH2 MIC Ref.].

Posnetek se ureja.

Posnetkov ni mogoče predvajati, če ste
spremenili imena datotek ali map ali če
je posnetek v uporabi na računalniku.
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Prenos datotek

Pretočno predvajanje IP

Posnetkov ni
mogoče
predvajati.

Ne gre za okvaro.

Posnetek je bil posnet z drugo
kamero in ne to enoto.

Posnetkov, ki so bili posneti z drugo
kamero in ne to enoto, včasih ni
mogoče predvajati ali pa so prikazani v
nepravilni velikosti. Ne gre za okvaro.

Težava Vzrok Rešitev

Datotek ni
mogoče
naložiti.

Uporabniško ime in geslo
na strežniku nista pravilna.

Uporabniško ime in geslo na strežniku morda
nista pravilna. Vnesite pravilne podatke.

Težava Vzrok Rešitev

Pretočno predvajanje
ni na voljo.

Uporabniško ime ali
geslo, vneseno v
odjemalsko aplikacijo
za ogled pretočnega
predvajanja iz enote, je
napačno.

Če je format pretočnega predvajanja enote
nastavljen na [RTSP], [SRT-Listener] ali
[NDI|HX], morate vnesti uporabniško ime in
geslo, ki sta za to enoto nastavljena v
odjemalski aplikaciji. Vnesite pravilno
uporabniško ime in geslo.

Protokol pretočnega
predvajanja ni
konfiguriran, ko je
način pretočnega
predvajanja nastavljen
na [RTSP/SRT] ali
[Listener/NDI].

Izberite ciljni protokol z uporabo možnosti
[Stream] > [Stream Setting] v spletnem
meniju.

Nastavljenih je bilo
šest ali več sej RTSP.

Nastavite število sej na pet ali manj.

Številka vrat UDP ni
pravilno nastavljena.

Nastavite številko vrat in druge nastavitve
za ciljni protokol z uporabo možnosti
[Stream] > [Stream] > [Stream Setting] v
spletnem meniju.

Komunikacija UDP je Preverite nastavitve varnostne programske
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blokirana. opreme.

Pretočno predvajanje
zvoka se ne izvaja.

Pretočno predvajanje
izhodnega zvoka je
nastavljeno na [Off].

Nastavite možnost [Stream] > [Audio
Stream] > [Setting] v spletnem meniju na
[On].

Pretočno predvajanje
je bilo prekinjeno.

Med pretočnim
predvajanjem so bile
spremenjene
nastavitve protokola ali
nastavitve kodeka za
pretočno predvajanje.

Pred začetkom pretočnega predvajanja
nastavite nastavitve protokola in nastavitve
kodeka za pretočno predvajanje.

Velikosti slike za
možnost [Video
Stream 1] ni mogoče
nastaviti na
4096×2160 ali
3840×2160.

Velikost slike je
1920×1080, ko je
možnost [Output
Format] nastavljena na
HDMI.

Velikosti slike za pretočno predvajanje ni
mogoče nastaviti višje od velikosti slike
HDMI. Spremenite velikost slike HDMI z
uporabo možnosti [Monitoring] > [Output
Format] v spletnem meniju.

Hitrosti sličic za
možnost [Video
Stream 1] ni mogoče
nastaviti na 60 sličic
na sekundo ali 50
sličic na sekundo.

Hitrost sličic za
pretočno predvajanje
je nastavljena na 29,97
ali manj.

Hitrost sličic, ki se uporablja za pretočno
predvajanje, je omejena s sistemsko
frekvenco. Spremenite sistemsko
frekvenco z uporabo možnosti [Rec
Format] > [Frequency] v spletnem meniju.

Dostop do toka
[Video Stream 3] ni
mogoč.

Tok [Video Stream 3]
ne podpira
RTSP/SRT/NDI.

Uporabite možnost [Video Stream 1] ali
[Video Stream 2].

Zaslon RTSP/SRT ni
pravilno
posodobljen/prikazan.

Številka vrat, ki se
uporablja za RTSP ali
SRT, se filtrira ali pa je
blokirana.

Spremenite številko vrat RTSP ali SRT v
vrata, ki jih naprave, ki sprejemajo
pretočno predvajanje, ne filtrirajo ali
blokirajo. Ali pa spremenite številko vrat, ki
se uporablja za RTSP ali SRT na enoti.

Slika je popačena ali
netekoča.

Video informacije se
zaradi preobremenitve
komunikacijske poti ne
prenašajo pravilno.

Zmanjšajte bitno hitrost pretočnega
predvajanja ali nastavite kodek za tok
[Video Stream 2] ([Codec 2]) na [OFF] in
tako povečajte območje v komunikacijskem
pasu.

Spremenil se je vrstni
red video paketov v
komunikacijskem

Uporabite istega ponudnika internetnih
storitev na strani kamere in na strani
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Povezovanje z zunanjimi napravami

Sinhronizacija z zunanjo napravo

Snemanje v živo

kanalu.
sprejemnika.

Enota ni zaznana kot
naprava NDI.

Protokol pretočnega
predvajanja ni
nastavljen na NDI|HX.

Da je mogoče enoto zaznati kot napravo
NDI, mora biti protokol pretočnega
predvajanja nastavljen na NDI|HX.
Nastavite možnost [Stream] > [Stream
Setting] v spletnem meniju na [NDI|HX].

Enote ni mogoče
uporabiti kot napravo
NDI.

Licenca NDI|HX ni
nameščena.

Namestite licenco NDI|HX. Ali obstaja
licenca NDI|HX, lahko preverite z
možnostjo [Stream] > [Stream] > [Stream
Setting] > [NDI|HX] > [License] v spletnem
meniju.

Težava Vzrok Rešitev

Sinhronizacija
z zunanjim
virom ni
mogoča.

Ne dovaja se zunanji
sinhronizacijski signal,
primeren za konfigurirani
format video signala.

Dovajajte zunanji sinhronizacijski signal,
primeren za konfigurirani format video
signala.

Enota ima dvojni zaključek.

Enota ima vgrajen zaključni upor v višini 75
?. Priključite enoto neposredno na vir
signala (ena na ena) ali uporabite
razdelilnik.

Težava Vzrok Rešitev

Indikator
za

Svetlost indikatorja za
snemanje v živo je nastavljena
na Off.

Nastavite ustrezno svetlost z uporabo
možnosti [Technical] > [Tally] > [Tally Lamp
Brightness] v spletnem meniju.

Indikator za snemanje na
pomnilniško kartico/snemanje v
živo je konfiguriran kot
indikator za snemanje na
pomnilniško kartico.

Konfigurirajte indikator za snemanje na
pomnilniško kartico/snemanje v živo, da deluje
kot indikator za snemanje v živo, kot je opisano
v razdelku "Priključitev signala za snemanje v
živo".
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[274] Dodatek

Sporočila o napakah/opozorilna sporočila

Če se na enoti pojavi opozorilo ali pride do dogodka, ki zahteva potrditev, se na slikovni plošče
kamere prikaže sporočilo, indikator POWER in indikator NETWORK na sprednji plošči ter
indikator za snemanje na pomnilniško kartico/snemanje v živo pa začnejo utripati.

Opomba

Nakazovanje z utripanjem indikatorja za snemanje na pomnilniško kartico/snemanje v živo je
omogočeno le, če je v spletnem meniju ali meniju kamere možnost [Technical] > [Tally] > [Tally
Control] nastavljena na [Internal], možnost [Tally Lamp Brightness] pa nastavljena na [Off].

Sporočila o napakah

Če indikator POWER in indikator NETWORK utripata, kot je opisano spodaj, izvedite naslednje
ukrepe.

snemanje
v živo ne
zasveti.

Daljinski upravljalnik RM-IP500
je povezan in komunikacija
VISCA prek IP je
onemogočena.

Preklopite stikalo SETUP 3 na priključnem
bloku v položaj ON.

Povezava priključka OPTION
je napačna ali pa ni izvedena
kratkostična povezava ciljne
nožice z GND.

Izvedite kratkostično povezavo nožice 7 ali
nožice 8 na priključku OPTION z GND, kot je
opisano v razdelku "Priključitev signala za
snemanje v živo".

Indikator
POWER

Indikator
NETWORK Vzrok in rešitev

Počasi
utripa
oranžno

Počasi
utripa
zeleno

Enota ne more delovati normalno. Za podrobnosti si oglejte
razdelek [Maintenance] > [System Log] v spletnem meniju. Če
težava ni odpravljena niti po tem, ko enoto preklopite v stanje
pripravljenosti ali izklopite in ponovno vklopite napajanje, stopite v
stik s servisnim predstavnikom podjetja Sony.

Hitro
utripa
oranžno

Hitro utripa
zeleno

Na enoti je prišlo do okvare. Stopite v stik s servisnim
predstavnikom podjetja Sony.
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Enota preneha delovati, ko se prikaže naslednji prikaz.

Opozorilna sporočila

Če se pojavi sledeče, sledite spodnjim navodilom.

Prikaz
sporočila

Indikator za
snemanje na
pomnilniško

kartico/snemanje
v živo

Vzrok in rešitev

E + error
code

Hitro utripa

Označuje neobičajno delovanje enote. Snemanje se ustavi,
tudi če je na slikovni plošči kamere prikazan ?REC. 
Izklopite enoto in preverite morebitne težave s povezanimi
napravami, kabli in pomnilniškimi mediji. Če je po
ponovnem vklopu enote napaka še vedno prisotna, se
obrnite na servisnega predstavnika podjetja Sony. Glede na
stanje enote se morda ne bo izpisalo sporočilo o napaki ali
predvajal opozorilni zvok.

Prikaz
sporočila

Indikator za snemanje
na pomnilniško

kartico/snemanje v živo
Vzrok in rešitev

Temperature
High

Utripa
Notranja temperatura je visoka. 
Izklopite kamero in pred ponovno uporabo
počakajte, da se ohladi.

Media
Temperature
High

Utripa
Temperatura kartice CFexpress je visoka. 
Zamenjajte kartico ali počakajte, da se ohladi,
preden jo znova uporabite.

Voltage Low Utripa
Napetost omrežnega napajanja je nizka (level 1).
Preverite vir napajanja.

Insufficient
Voltage

Hitro utripa
Napetost omrežnega napajanja je prenizka (level
2). Snemanje je onemogočeno. 
Priklopite drug vir napajanja.

Media Near
Full

Utripa
Zmanjkuje preostalega prostora na pomnilniški
kartici. 
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Čim prej zamenjajte.

Media Full Hitro utripa
Posnetkov ni mogoče posneti ali kopirati, saj ni
več prostora na pomnilniški kartici. 
Takoj zamenjajte.

Clips Near
Full

Utripa
Število dodatnih posnetkov, ki jih je mogoče
posneti na pomnilniško kartico, se zmanjšuje. 
Čim prej zamenjajte.

Clips Full Hitro utripa

Doseženo je bilo največje število posnetkov, ki jih
je mogoče posneti na pomnilniško kartico. 
Snemanje ali kopiranje novih posnetkov ni
mogoče. Takoj zamenjajte.

Last Clip
Recording

Utripa

Posnetek, ki se trenutno snema, je zadnji
posnetek, ki ga je mogoče posneti, saj je bilo
doseženo največje število posnetkov. 
Pripravite novo pomnilniško kartico.

Media(A)
Life Near
End1)

Utripa
Pomnilniška kartica se približuje koncu svoje
življenjske dobe. Čim prej zamenjajte.

Media(A)
Life End1) Hitro utripa

Pomnilniška kartica je dosegla konec svoje
življenjske dobe. Takoj zamenjajte.

Media(A)
Near Full1) Utripa Pri uporabi funkcije Simul Rec

Media(A)
Full1) Hitro utripa Pri uporabi funkcije Simul Rec

Media(A)
Clips Near
Full1)

Utripa Pri uporabi funkcije Simul Rec

Media(A)
Clips Full1) Hitro utripa Pri uporabi funkcije Simul Rec

Media(A)
Last Clip
Rec1)

Utripa Pri uporabi funkcije Simul Rec

Za kartico v reži B je prikazano "(B)".1)
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Previdnostna sporočila in sporočila o delovanju

Sledeča previdnostna sporočila in sporočila o delovanju se lahko pojavijo sredi zaslona. Za
razrešitev težave sledite spodnjim navodilom.

Sporočilo na zaslonu Vzrok in odprava

Backup Battery End
Please Change

Preostala napolnjenost pomožne baterije je
nezadostna. 
Napolnite pomožno baterijo.

Unknown Media(A)1)

Please Change

Vstavljena je bila pomnilniška kartica, ki vsebuje
particije, ali pomnilniška kartica, ki vsebuje več
posnetkov, kot jih lahko obravnava enota. 
Kartice ni mogoče uporabljati v enoti in jo je treba
zamenjati.

Cannot Use Media(A)1)

Unsupported File System

Vstavljena je bila neformatirana kartica ali kartica, ki
uporablja drugačen datotečni sistem. 
Kartice ni mogoče uporabljati v enoti in jo je treba
zamenjati ali formatirati s pomočjo enote.

Media Error
Media(A) Needs to be Restored1)

Na pomnilniški kartici je prišlo do napake in jo je treba
obnoviti. 
Pomnilniško kartico obnovite.

Media Error
Cannot Record to Media(A)1)

Pomnilniška kartica je morda poškodovana in je ni
več mogoče uporabljati za snemanje. 
Predvajanje je mogoče, zato je priporočljivo, da
naredite kopijo in zamenjate pomnilniško kartico.

Media Error
Cannot Use Media(A)1)

Pomnilniška kartica je morda poškodovana in je ni
več mogoče uporabljati za snemanje ali predvajanje. 
Kartice ni mogoče uporabljati v enoti in jo je treba
zamenjati.

Media(A) Error1)

Recording Halted
Playback Halted

Snemanje in predvajanje sta bila ustavljena, ker je
med uporabo pomnilniške kartice prišlo do napake. 
Če težave ne morete odpraviti, pomnilniško kartico
zamenjajte.

Media Reached Rewriting Limit
Change Media(A)1)

Pomnilniška kartica je dosegla konec svoje življenjske
dobe. 
Naredite varnostno kopijo in takoj zamenjajte kartico.
Če nadaljujete z uporabo kartice, snemanje ali
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[275] Dodatek

Seznam elementov menija

V naslednjih tabelah so navedeni elementi menija enote.

Legenda
"Meni kamere" in "spletni meni"
?: na voljo
^: nekateri elementi so na voljo
–: ni na voljo

predvajanje morda ne bo mogoče. 
Za podrobnosti glejte navodila za uporabo
pomnilniške kartice.

The specified address is invalid.
Navedeni naslov ni veljaven. 
Preverite, ali je nastavitev pravilna.

Cannot Use Specified Port Number
Navedena številka vrat ni veljavna. 
Preverite, ali je nastavitev pravilna.

Lens I/F Error(xx:xx)

Ob namestitvi objektiva serije E je bila zaznana
napaka v komunikaciji objektiva I/F. 
Preverite stanje povezave z objektivom serije E. 
Če je težava prisotna še naprej, se obrnite na
servisnega predstavnika podjetja Sony in mu
sporočite kodo napake (pet znakov v oklepaju).

Cannot add auto upload job of Proxy
file because maximum number of
upload jobs was reached.

Doseženo je bilo največje število prenosov. 
Izbrišite neželene prenose. Morda je tudi napačno
nastavljen cilj samodejnega nalaganja datotek proxy.
Preverite, ali je nastavitev pravilna.

Fan Stopped

Ventilator je prenehal delovati. 
Prepričajte se, da ni prahu ali tujkov. 
Če je po odstranitvi prahu ali tujkov napaka še vedno
prisotna, se obrnite na servisnega predstavnika
podjetja Sony.

Za kartico v reži B je prikazano "(B)".1)
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"All File" in "Scene File"
Da: element je shranjen v datoteki ALL ali scenski datoteki
Ne: element ni shranjen

"All Reset (except for Network Settings)"
Ko je izvedena možnost [Reset]> [Reset] > [All Reset (except for Network Settings)] v
spletnem meniju:
Da: inicializiran element (razen omrežnih nastavitev)
Ne: ni na voljo

"Network Reset"
Ko je izvedena možnost [Reset]> [Reset] > [Network Reset] v spletnem meniju:
Da: inicializiran element (omrežna nastavitev)
Ne: ni na voljo

"Factory Default"
Da: ponastavitev elementa na tovarniške nastavitve
Ne: ni na voljo

Shooting

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ? – Da Da Da Da Da

ND Filter ? – Da Da*1 Da Ne Da

Shutter ? – Da Da Da Ne Da

Iris ? – Da Da Da Ne Da

Auto
Exposure

? – Da Da*2 Da Ne Da

White ? – Da Da*3 Da Ne Da

White
Setting

? – Da Ne Da Ne Da

Offset White ? – Da Ne Da Ne Da

Focus ? ^ Da Ne Da Ne Da

S&Q Motion ? – Da Ne Da Ne Da
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Project

LUT On/Off ? – Da Ne Da Ne Da

Noise
Suppression

? – Da Da Da Ne Da

Flicker
Reduce

? – Da Ne Da Ne Da

SteadyShot ? – Da Ne Da Ne Da

Možnost [Mode] ni na voljo*1
Možnosti [Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position],
[Custom V Position] niso na voljo

*2

Možnost [Preset White] ni na voljo*3

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Base
Setting

? ? Da Ne Da Ne Da

Rec Format ? ? Da Ne Da*1 Ne Da

Cine EI
Setting

? – Da Ne Da Ne Da

Simul Rec ? ? Da Ne Da Ne Da

Proxy Rec ? ^ Da Ne Da Ne Da

Interval Rec ? ? Da*2 Ne Da Ne Da

Picture
Cache Rec

? ? Da*2 Ne Da Ne Da

SDI/HDMI
Rec Control

? – Da Ne Da Ne Da

Assignable
Button

? – Da Ne Da Ne Da

All File – ? Ne Ne Ne Ne Ne
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Paint/Look

Pan-Tilt

Možnost [Frequency] ni na voljo*1
Možnost [Setting] ni na voljo*2

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Scene File ? – Ne Ne Ne Ne Ne

Base Look ? ^ Da*1 Ne Da*1 Ne Da*1

Reset
Paint
Settings

? – Ne Ne Ne Ne Ne

Black ? – Da Da Da Ne Da

Knee ? – Da Da Da Ne Da

Detail ? – Da Ne Da Ne Da

Matrix ? – Da Da Da Ne Da

Multi
Matrix

? – Da*2 Da*2 Da Ne Da

Možnost uvoza podatkov LUT kot osnovni videz ni na voljo*1
Možnost [Axis] ni na voljo*2

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

P/T Speed – ? Ne Ne Da Ne Ne

P/T
Acceleration

? ? Ne Ne Da Ne Ne

P/T Range
Limit

– ? Ne Ne Da Ne Ne

P/T
– ? Ne Ne Da Ne Ne
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TC/Media

Monitoring

Direction

P/T Preset – ? Ne Ne Da Ne Ne

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ? – Da*1 Ne Da Ne Da

TC
Display

? – Da Ne Da Ne Da

Users Bit ? – Da*1 Ne Da Ne Da

HDMI TC
Out

? – Da Ne Da Ne Da

Clip
Name
Format

? – *2 Ne Da Ne Da

Update
Media

? – Ne Ne Ne Ne Ne

Format
Media

? – Ne Ne Ne Ne Ne

Media
Life

? – Ne Ne Ne Ne Ne

Možnost [Setting] ni na voljo*1
Možnost [Auto Naming] je na voljo, možnost [Camera ID] ni na voljo*2

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format

? ? Da Ne Da Ne Da

Output
Display

– ? Da Ne Da Ne Da
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Audio

Thumbnail

Display
On/Off

? – Da Ne Da Ne Da

Video
Signal
Monitor

? – Da Ne Da Ne Da

Marker ? – Da Ne Da Ne Da

Element
(raven

2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

? ^ Da Ne Da Ne Da

Audio
Output

? ^ Da Ne Da Ne Da

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Display Clip
Properties

? – Ne Ne Ne Ne Ne

Set Clip
Flag

? – Ne Ne Ne Ne Ne

Lock/Unlock
Clip

? – Ne Ne Ne Ne Ne

Delete Clip ? – Ne Ne Ne Ne Ne

Transfer
Clip

? – Ne Ne Ne Ne Ne

Transfer
Clip (Proxy)

? – Ne Ne Ne Ne Ne
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Technical

Network

Filter Clips ? – Ne Ne Ne Ne Ne

Customize
View

? – Da Ne Da Ne Da

Element
(raven

2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

? – *1 Ne *1 Ne Da

Genlock ? – Ne Ne Ne Ne Ne

Tally ? ? Da Ne Da Ne Da

Rec
Review

? – Da Ne Da Ne Da

Zoom ? – Da Ne Da Ne Da

IR
Remote

– ? Ne Ne Da Ne Da

Lens ? – Da Ne Da Ne Da

APR ? – Ne Ne Ne Ne Ne

Možnost [Type] je na voljo, možnost [Setting] ni na voljo*1

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Camera
Name

– ? Ne Ne Ne Ne Da

User – ? Ne Ne Ne Da Da

Wired LAN*1 ^ ? Ne Ne Ne Da Ne
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Stream

Maintenance

File Transfer ? ^ Da Ne Da Da Da

FTP Server 1 – ? Ne Ne Da Ne Da

FTP Server 2 – ? Ne Ne Da Ne Da

FTP Server 3 – ? Ne Ne Da Ne Da

SSL – ? Ne Ne Ne Da Da

Referer Check – ? Ne Ne Ne Da Da

Brute Force
Attack
Protection

– ? Ne Ne Ne Da Da

Ni mogoče konfigurirati v meniju kamere (samo prikaz)*1

Element
(raven

2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ? Ne Ne Da*1 Ne Da*1

Video
Stream

– ? Da Ne Da Ne Da

Audio
Stream

– ? Da Ne Da Ne Da

Možnost [NDI|HX] > [License] ni na voljo*1

Element 
(raven 2)

Meni
kamere

Spletni
meni

All
File

Scene
File

All Reset (except
for Network

Settings)

Network
Reset

Factory
Default

Language ? ? Da Ne Da Ne Da

Accessibility – ? Da Ne Ne Ne Da

*1 *2
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[276] Dodatek

Prednastavljen položaj shranjenih elementov

"Da" označuje nastavitev, ki je shranjena za prednastavljen položaj, "Ne" pa označuje
nastavitev, ki ni shranjena.

Elementi obračanja/nagibanja

Clock Set ? ? Da Ne Da Ne Da

Reset – ? Ne Ne Ne Ne Ne

Hours
Meter

? – Ne Ne Ne Ne Ne

Information – ? Ne Ne Ne Ne Ne

System Log – ? Ne Ne Ne Ne Da

HTTP
Access Log

– ? Ne Ne Ne Ne Da

Service – ? Ne Ne Ne Ne Ne

EULA – ? Ne Ne Ne Ne Ne

Software – ? Ne Ne Ne Ne Ne

Podatki o datumu in času niso na voljo*1
Možnost [Time Zone] ter podatki o datumu in času niso na voljo*2

Mesto prikaza Element Shranjevanje
cilja

Nadzorna plošča za okvirjanje na zaslonu
delovanja v živo

Položaj
obračanja/nagibanja

Da

[Pan-Tilt Speed] Ne1)

[P/T Speed] Ne

[P/T Acceleration] Ne



ILME-FR7/ILME-FR7K | Vodnik za pomoč

file:///corpnasunifil01.global.sdl.corp/Delivery%20(M-Z)/SON/SON_GHOAXU_110/220928_YAGI%20ILME-FR7_SG_HG%20-%20URGENT/03_Prod/03b_DTP/03_Work/HG/SL/print.html[11/16/2022 1:28:23 PM]

Elementi zooma

Elementi ostrenja

[Pan-Tilt] v spletnem meniju [P/T Range Limit] Ne

[P/T Direction] Ne

[P/T Preset] Ne

Lahko konfigurirate za vsak prednastavljen položaj ločeno. Za podrobnosti si oglejte razdelek [Pan-Tilt] > [Preset]
v spletnem meniju.

1)

Mesto prikaza Element Shranjevanje
cilja

Nadzorna plošča za okvirjanje na zaslonu
delovanja v živo

Položaj zooma (razdalja
ostrenja)

Da

[Zoom Speed] Ne1)

[Technical] > [Zoom] v meniju kamere [Zoom Type] Ne

Pri obnovitvi prednastavljenega položaja se premika z največjo hitrostjo.1)

Mesto prikaza Element Shranjevanje
cilja

Slikovna plošča kamere na
zaslonu delovanja v živo

Cilj sledenja, določen za samodejno
ostrenje s sledenjem v realnem času

Ne

Določene koordinate za točkovno ostrenje Ne

Zavihek  (ostrenje) na
zaslonu delovanja v živo

Stikalo [Touch Focus] Ne

Stikalo [Auto Focus] Da

Stanje gumba [Focus Hold] Ne

Stanje gumba [Push AF/MF] Ne

[Face/Eye Detection AF] Da

[AF Subj. Shift Sens.] Da

[AF Transition Speed] Da
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[277] Dodatek

Sheme delovanja

Zvočni vhod

Mesto ostrenja Da1)

[Shooting] > [Focus] v
spletnem meniju

[Push AF Mode] (vključno z nastavitvami z
uporabo dodeljivih gumbov)

Ne

[Touch Function in MF] Ne

[AF Assist Control] Ne

[Shooting] > [Focus] v meniju
kamere

Velikost in mesto ostrenja, nastavljena z
uporabo možnosti [Focus Area]

Da

Mesto ostrenja, nastavljeno z uporabo
možnosti [Focus Area (AF-S)]

Da

Ni obnovljeno, ko je stikalo [Auto Focus] nastavljeno v položaj On. Obnovljeno, ko je stikalo nastavljeno v položaj
Off.

1)
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Zvočni izhod

[278] Dodatek

Posodabljanje programske opreme objektiva serije E

Programsko opremo objektiva serije E lahko posodobite prek enote.
Na spletni strani za objektive poglejte, katere objektive je mogoče posodobiti in katera je
ustrezna programska oprema.
Programska oprema se posodablja prek spletnega menija.

Opomba

Dokler ni posodobitev zaključena, ne izvajajte naslednjih dejanj.

Na enoto namestite objektiv serije E.1

Preverite možnosti [Maintenance] > [Information] > [Lens] > [Model Name] in
[Version Number] v spletnem meniju.

Oznaka različice programske opreme objektiva serije E je prikazana ob strani.
Preverite številko različice programske opreme in slednjo po potrebi posodobite.

2

V napravo, v kateri je nameščena spletna aplikacija, prenesite datoteko za
posodobitev programske opreme objektiva za operacijski sistem Windows
(končnica .exe).

3

V možnosti [Maintenance] > [Information] > [Lens] > [Version Up] pritisnite gumb
[Choose File], nato pa izberite preneseno datoteko za posodobitev.

4

Upoštevajte navodila na zaslonu.5
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Odklop omrežja
Odstranitev objektiva
Izklop

Če se prikaže sporočilo o neuspešni posodobitvi, preverite prikazan opis in izvedite ponoven poskus
posodobitve.

[279] Dodatek

Namestitev pokrovčka gumba za sprostitev objektiva

Neželeno odstranitev objektiva lahko preprečite tako, da na gumb za sprostitev objektiva
namestite pokrovček, ki je predviden prav za ta gumb in je priložen stropnemu nosilcu CIB-
PCM1 (izbirno).

Namestite objektiv.

Za podrobnosti o namestitvi objektiva si oglejte razdelek "Namestitev objektiva".

1

Potisnite ročico za zaklepanje obračanja/nagibanja v položaj LOCK, da zaklenete
obračanje/nagibanje glave kamere.

2

Premaknite blok kamere v položaj, ki omogoča namestitev pokrovčka za odstranitev
objektiva.

3

Pokrovček za odstranitev objektiva namestite tako, da pokriva gumb za sprostitev
objektiva.

4

Z namenskim pritrditvenim vijakom pritrdite pokrovček za odstranitev objektiva.5
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Opomba

To ne preprečuje popolne odstranitve objektiva.

[280] Dodatek

Licence

Licenca portfelja za patent MPEG-4 AVC

TA IZDELEK JE LICENCIRAN V OKVIRU LICENCE PORTFELJA ZA PATENT AVC ZA
OSEBNO UPORABO POTROŠNIKA ALI DRUGE UPORABE, PRI KATERIH POTROŠNIK NE
PREJME FINANČNEGA NADOMESTILA ZA
(i) KODIRANJE VIDEO VSEBIN V SKLADU S STANDARDOM AVC ("AVC VIDEO") IN/ALI
(ii) ODKODIRANJE VIDEO VSEBIN AVC, KI JIH JE POTROŠNIK KODIRAL V OKVIRU
OSEBNE DEJAVNOSTI IN/ALI PRIDOBIL OD PONUDNIKA VIDEO VSEBIN Z LICENCO ZA
DISTRIBUCIJO VIDEO VSEBIN AVC.
LICENCA SE NE DODELJUJE IN NI NAMENJENA ZA KAKRŠNO KOLI DRUGO UPORABO.
DODATNE INFORMACIJE DOBITE PRI DRUŽBI MPEG LA, L. L. C. OBIŠČITE
HTTP://WWW.MPEGLA.COM

Uporaba programske opreme pod licenco GPL/LGPL

Ta izdelek uporablja programsko opremo, za katero velja licenca GPL/LGPL. To pomeni, da
imate pravico do dostopa, spreminjanja in nadaljnje distribucije izvorne kode za to programsko
opremo, in sicer v skladu s pogoji licence GPL/LGPL.
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Izvorna koda je na voljo na spletu. Uporabite sledeč naslov URL in sledite navodilom za prenos.
https://oss.sony.net/Products/Linux/
Želimo, da se v zvezi z vsebino izvorne kode ne obračate na nas.

Izvorna koda µT-Kernel

Ta izdelek uporablja izvorno kodo µT-Kernel pod licenco T-License 2.1, ki jo je podelil TRON
Forum (www.tron.org).

[281] Dodatek

Tehnični podatki

Splošno

Teža
Pribl. 4,6 kg (samo ohišje)
Pribl. 6,0 kg (vključno z objektivom SELP28135G)

Dimenzije
Oglejte si razdelek "Zunanje dimenzije".

Zahteve napajanja
19,5 V pri enosmernem toku
PoE++ (skladno s standardom IEEE802.3bt, tip 4, razred 8)

Poraba energije
19,5 V pri enosmernem toku: 80,0 W (maks.)
PoE++: 71,3 W (maks.)

Delovna temperatura
Od 0 do 40 °C

Temperatura shranjevanja
Od –20 do 60 °C

Format snemanja (video)
XAVC Intra
Način XAVC-I 4K/QFHD: VBR, 600 Mb/s (največja) bitna hitrost, MPEG-4 AVC/H.264

https://oss.sony.net/Products/Linux/
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Način XAVC-I HD: CBG, 223 Mb/s (največ), MPEG-4 AVC/H.264

XAVC Long
Način XAVC-L QFHD: VBR, 150 Mb/s (največja) bitna hitrost, MPEG-4 H.264/AVC
Način XAVC-L HD 50: VBR, 50 Mb/s (največ), MPEG-4 H.264/AVC
Način XAVC-L HD 35: VBR, 35 Mb/s (največ), MPEG-4 H.264/AVC

Format snemanja (zvok)
LPCM, 24-bitni, 48 kHz, 4-kanalni

Hitrost sličic pri snemanju

XAVC Intra
Način XAVC-I 4K: 4096×2160/59,94P, 50P, 29,97P, 25P, 24P, 23,98P
Način XAVC-I QFHD: 3840×2160/59,94P, 50P, 29,97P, 25P, 23,98P
Način XAVC-I HD: 1920×1080/59,94P, 50P, 29,97P, 25P, 23,98P

XAVC Long
Način XAVC-L QFHD: 3840×2160/59,94P, 50P, 29,97P, 25P, 23,98P
Način XAVC-L HD 50: 1920×1080/59,94P, 50P, 29,97P, 25P, 23,98P
Način XAVC-L HD 35: 1920×1080/59,94P, 50P, 29,97P, 25P, 23,98P

Čas snemanja/predvajanja
XAVC Intra
Način XAVC-I QFHD: 59,94P, pribl. 30 minut (z uporabo CEA-G160T)
Način XAVC-I HD: 59,94P, pribl. 78 minut (z uporabo CEA-G160T)

XAVC Long
Način XAVC-L QFHD: 59,94P, pribl. 115 minut (z uporabo CEA-G160T)
Način XAVC-L HD 50: 59,94P, pribl. 155 minut (z uporabo CEA-G80T)
Način XAVC-L HD 35: 59,94P, pribl. 210 minut (z uporabo CEA-G80T)

Opomba

Čas snemanja/predvajanja se lahko razlikuje glede na razmere uporabe in lastnosti pomnilnika. Časi
snemanja in predvajanja so navedeni za neprekinjeno snemanje enega posnetka. Dejanski časi so
lahko krajši, odvisno od števila posnetih posnetkov.

Področje obračanja/nagibanja

Najmanjša hitrost obračanja: 0,02 stopinje/sekundo
Najmanjša hitrost nagibanja: 0,02 stopinje/sekundo
Največja hitrost obračanja: 60 stopinj/sekundo
Največja hitrost nagibanja: 60 stopinj/sekundo
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Območje obračanja: od -170 do +170 stopinj
Območje nagibanja: od -30 do +195 stopinj
Ocena merila hrupa: NC35 ali nižja
Prednastavljeni položaji: 100

Področje kamere

Naprava za zajemanje slik
35 mm polnega formata (35,6 x 23,8 mm), senzor CMOS Exmor R

Število slikovnih pik
Pribl. 12,9 milijona slikovnih pik (skupno število slikovnih pik)
Pribl. 10,3 milijona slikovnih pik (učinkovite slikovne pike)

Samodejno ostrenje
Metoda zaznavanja: fazno zaznavanje/zaznavanje kontrasta

Notranji filtri ND
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Linearno spremenljivi ND: 1/4ND do 1/128ND

Občutljivost ISO
ISO 800/12800 (način Cine EI, svetlobni vir D55)

Nastavek za objektiv
E-mount

Razpon
Več kot 15 stopenj

Hitrost zaklopa
64F do 1/8000 s (23,98P)

Kot zaklopa
5,6° do 360°, 2 do 64 sličic

Počasni in hitri posnetki
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XAVC QFHD: od 1 do 120 sličic na sekundo
XAVC HD: od 1 do 240 sličic na sekundo
XAVC 4K: od 1 do 60 sličic na sekundo
XAVC HD (S35): od 1 do 120 sličic na sekundo

Nastavitev beline
2000 K do 15000 K

Ojačitev
Od –3 dB do +30 dB (v korakih po 1 dB)

Osnovni videz
S-Cinetone, Standard, Still, ITU709, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Področje zvoka

Podprta frekvenca vzorčenja
48 kHz

Kvantizacija
24-bitna

Frekvenčni odziv
Način MIC vhoda XLR: 20 Hz do 20 kHz (±3 dB ali manj)
Način LINE vhoda XLR: 20 Hz do 20 kHz (±3 dB ali manj)

Dinamični razpon
Način MIC vhoda XLR: 80 dB (tipično)
Način LINE vhoda XLR: 90 dB (tipično)

Popačenje
Način MIC vhoda XLR: 0,08 % ali nižje (raven vhoda –40 dBu)
Način LINE vhoda XLR: 0,08 % ali nižje (raven vhoda +14 dBu)

Področje vhodov/izhodov

Vhodni priključki
DC IN

Skladno s standardom EIAJ, 19,5 V pri enosmernem toku
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AUDIO IN

Tip XLR, 5-pinski, ženski
LINE/MIC/MIC+48V preklopno
MIC: referenca -30 dBu do -80 dBu

GENLOCK IN

Priključek BNC, 1,0 Vp-p, 75 ?

TC IN

Priključek BNC

Izhodni priključki
SDI OUT

Priključek BNC, 12G-SDI, 6G-SDI, 3G-SDI (raven A/B), HD-SDI

HDMI

Priključek tipa A

Izhodni priključek OPTICAL

Skladen s SFP+
* Enota ne podpira optičnega signalnega vhoda.

Vhod/izhod
Priključek LAN

RJ-45, 1000BASE-T

Priključek OPTION

Vhodni/izhodni priključek RJ-45 za snemanje v živo

Področje rež za kartice

Reža za kartice CFexpress Type A/SD (2)

Priložena dodatna oprema

Omrežni napajalnik (1)
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Napajalni kabel (1)
Infrardeči daljinski upravljalnik (1)
Pokrov ohišja (1) (pritrjen na enoto)
Nosilna plošča za kabel HDMI (1)
Pred uporabo tega izdelka (1)
Garancijska knjižica (1)

Zunanje dimenzije

Dimenzije so približne vrednosti.
Enota: mm (palci)
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Oblika in tehnični podatki se lahko spremenijo brez obvestila.

[282] Dodatek

Blagovne znamke

 je blagovna znamka družbe Sony Group Corporation.
XAVC in  sta zaščiteni blagovni znamki družbe Sony Group Corporation.
Izraza HDMI in večpredstavnostni vmesnik visoke ločljivosti HDMI ter logotip HDMI so
blagovne znamke ali zaščitene blagovne znamke družbe HDMI Licensing Administrator, Inc.
v ZDA in drugih državah.
Microsoft in Windows sta blagovni znamki ali zaščiteni blagovni znamki družbe Microsoft
Corporation v ZDA in/ali drugih državah.
Mac in macOS sta zaščiteni blagovni znamki družbe Apple Inc. v ZDA in drugih državah.
Logotip "Catalyst Browse" je blagovna znamka ali zaščitena blagovna znamka družbe Sony
Group Corporation.
IOS je blagovna znamka ali zaščitena blagovna znamka družbe Cisco v ZDA in drugih
državah ter se uporablja na podlagi licence.
iPadOS, Safari in iPad so blagovne znamke družbe Apple Inc., zaščitene v ZDA ter drugih
državah in regijah.
Android in Google Chrome sta blagovni znamki ali zaščiteni blagovni znamki družbe Google
LLC.
Wi-Fi je zaščitena blagovna znamka združenja Wi-Fi Alliance.
Logotip SDXC je blagovna znamka podjetja SD-3C, LLC.
Logotipa CFexpress in CFexpress Type A sta blagovni znamki zveze CompactFlash
Association.
NewTek™ in NDI® sta blagovni znamki ali zaščiteni blagovni znamki družbe NewTek, Inc.
JavaScript je zaščitena blagovna znamka družbe Oracle in/ali njenih podružnic.
Intel, logotip Intel in Intel Core so blagovne znamke družbe Intel Corporation ali njenih
podružnic.
Koda QR je blagovna znamka družbe Denso Wave Inc.
Vsa druga imena podjetij in izdelkov so zaščitene blagovne znamke ali blagovne znamke
njihovih lastnikov. Elementi, ki so blagovna znamka, v tem dokumentu niso označeni s
simbolom ™ ali ®.
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